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Model Repository

Enterprise Architect is a rich modeling platform that can be
used in a wide range of modeling and design situations,
from a single user accessing a file based repository to a
large and distributed team of thousands of modelers working
all over the world using a Cloud Based Repository. The
repositories can be scaled up and down, and a project that
started with a single user can be seamlessly scaled up to a
large multi-user repository.

Enterprise Architect has been built to support
inter-disciplinary modelers collaborating to create a single
and unified view of a system or enterprise, and the platform
has numerous built in features to support this team
development. By taking advantage of the base UML
modeling language, in addition to the numerous extension
languages such as BPMN and SysML, plus highly effective
frameworks such as TOGAF and UAF/UPDM, modelers,
designers, managers and others can build comprehensive,
inter-connected models that fully expresses the capabilities,
structure and behavior of fully functioning, multi-layered,
complex systems and/or enterprises.

In addition, there are features that allow modelers to discuss
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the model, such as the Collaboration window, and review
work that has been in progress in the Team Library window.
Modelers can even send Model Mail to communicate ideas.
Model Security can be implemented, which facilitates
collaboration and prevents work accidentally being
overridden.

There are a range of project management features, such as
tasks and resource allocation and a Gantt Chart to view
progress on tasks over time, and a Project Calendar that
keeps track of important project events.

Integration is so easy and the feature sets so powerful that
strategic thinkers, business managers, architects,
information and data modelers, testers, software engineers
and many others will derive great benefit from using the tool
and incorporating their models into the overall vision.

Key Concepts

Repository
Format

Enterprise Architect models are stored in
standard relational databases. This
approach has been built into Enterprise
Architect from the very first version.
Using a relational database provides a
huge advantage over other tools that are
limited in scope and capability by relying
on a simple text file based model storage
system. With support for two file based
repository formats (MS JET and
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Firebird) plus a number of industry
standard DBMS servers (such as SQL
Server, MySQL and Oracle) plus Cloud
based storage, Enterprise Architect
provides fast, scalable, flexible and
transparent access to models in a wide
range of deployment scenarios.

Modeling
Languages

Enterprise Architect is based on industry
standard UML, a specification
maintained by the Object Management
Group (OMG). Although initially
conceived as a modeling language
primarily for software development, over
the years the capabilities and formal
(standard) extensions have allowed the
UML to develop into a rich set of
constructs and modeling behaviors that
provide very rich and detailed support
for everything from software, to business
processes, embedded software, enterprise
architecture, organizational charts,
strategic model, mind mapping,
requirements management and much
more. The success of UML has been
proven over and over again in the real
world and the number of new
technologies and modeling profiles that
use UML as the underlying
'meta-language' are tribute to the power
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and effectiveness of UML.

Team
Development

From the very first version of Enterprise
Architect the goal has been to provide
the best and most accessible support for
Team based development. A wealth of
tools and capabilities have been designed
into the platform over the years to
support security, scalability, information
sharing, concurrent access, management,
reporting and querying. With the growth
of the internet and distributed
development scenarios, Enterprise
Architect has evolved to be the
pre-eminent platform for developing
models and designs in a globally
distributed situation. The Cloud Server
based deployment offers high
availability, excellent performance and
simple configuration to rapidly bring
diverse and distributed teams into a
single, living repository where work can
be easily shared, reviewed, discussed and
managed.

Scalability By leveraging the power of today's
DBMS servers and Cloud Based
technologies, Enterprise Architect can be
easily scaled up to truly epic proportions.
Millions of objects can be stored and
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accessed by large and dispersed teams in
real time. The level of scalability is
limited solely by the choice of DBMS or
Cloud Technology and the capabilities of
the network and server infrastructure the
model is deployed on. In practice, over
the many years that Enterprise Architect
has been used in industry, modelers and
designers have taken advantage of the
powerful in-built scalability to construct
stunning and often huge models that
capture an enormous amount of
information about complex and highly
inter-connected systems and enterprises.

Security Due to the nature of the Repository used
by Enterprise Architect and the possible
deployment scenarios, security can be
managed in a number of ways. In the
Corporate, Unified and Ultimate editions
of Enterprise Architect, there is built-in
support for defining users and groups
that permit locking and management of
elements and Packages within the model.
This will be discussed later in the section
on Security. In addition, it is also
possible to restrict general access to
models by using file-based security
access for the MS JET and
Firebird-based models (.EAP and FDB)
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and DBMS server authentication and
access for the larger database
server-based systems. As a further
refinement it is also possible to restrict
access to a model using the HTTPS
protocol when connecting to a Cloud
Based server.

Versioning Enterprise Architect uses industry
standard XMI (XML Interchange) format
files to store and version model
Packages. By integrating the import and
export of XMI model fragments into a
Version Control system (such as SVN)
supported by Enterprise Architect, you
can maintain multiple versions of the
same model in different repositories and
exercise fine control over the
development and design process. Given
the nature of this versioning system,
there are several different scenarios that
can be used to maintain different models
and how teams access information. For
example, where the versioning system is
used as the single point of truth and
de-facto Repository, it could be
convenient to use many workgroup or
single user based Repositories that
reflect the actual model at a particular
point in time. In contrast, where the
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versioned files are mainly held for
backup and baseline purposes only, a
larger, Team based DBMS server would
be used to provide the model sharing and
collaboration capabilities. So whatever
the actual needs are, Enterprise Architect
has a number of solution scenarios that
can be adapted to provide the right level
of change management and collaborative
development.

Example Repository Tasks

Task

Create a project in a simple, file-based repository (.EAP
and .FEAP files)

Create the project in one of a range of DBMS repositories
- these provide for larger models with more concurrently
connected users (Corporate and extended editions)

Manage change within the model

Maintain the integrity of the project data

(c) Sparx Systems 2018 Page   20 of 1073



User Guide - Model Repository 21 December, 2018

Share the reference data used across the project, between
models and between projects

Allow each user to configure their personal preferences
for how project tools display and behave on their
workstation

Document your model through document or web reports,
which you can tailor to your purposes
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Repository Overview

An Enterprise Architect repository is stored in a relational
database; this can be a file based database such as MS
Access or Firebird, or a database management system
(DBMS) such as Oracle or MS SQL Server, on a network or
in a Cloud Based Repository. It is common to start with a
File Based Repository and, when the project gets some
momentum and there are a number of modelers accessing
the repository, to transfer it to a DBMS. Whichever type of
repository is implemented, the user interface remains the
same and users can seamlessly move from one type of
repository to another and continue to contribute as a team
member on this powerful modeling platform.

Concepts

Concept Description

Repository as
a File

In any version of Enterprise Architect
you can store a project in a single file
with a .eap or .feap extension.

A .eap file is a Microsoft JET database,·

so you can also open it using MS
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Access 97, 2000, 2003 or 2013, or any
other reporting tool that can work with
JET databases
A .feap file is a Firebird project file·

Repository in
a DBMS
(Database
Management
System)

In the Enterprise Architect Corporate,
Unified and Ultimate editions you can
also use a suitable DBMS repository for
projects.
DBMS projects have the same logical
structure as .eap and .feap files, but
provide much greater scalability and
concurrent access. You connect to a
DBMS using ADO/ODBC (see Connect
to a Data Repository). Note that when
configuring an ODBC data source on a
64 bit machine, you should access the
ODBC data manager using the 'Configure
> User Tools > ODBC Data Sources'
ribbon option, as this will load the correct
ODBC manager to access 32 bit data
sources as used by Enterprise Architect.

Repository in
the Cloud

In the Corporate, Unified and Ultimate
editions of Enterprise Architect you can
further enable the distributed capabilities
of Enterprise Architect and use the
Internet or local network to connect to a
Cloud-based server on which one or more
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Repositories have been installed and
configured for access. The Cloud Server
is free software available from Sparx
Systems, and is relatively simple to set up
and configure on a suitable
Windows-based machine. Firebird files
or any DBMS server are the required
Repository types supported by the Cloud
Server, and these can reside on the same
machine for best performance, or on
another machine to maximize local and
network access. Cloud-based repositories
provide the ultimate in distributed
development and minimal client
configuration. It is, in fact, much easier to
deploy a Firebird-based repository on a
Cloud Server for distributed development
than to set up and manage a full DBMS
solution.

Models Enterprise Architect uses this
terminology when discussing
Repositories and their contents.

A Model is a related group of content1.
that expresses some focused aspect of a
system or enterprise that is related by
the modeling tools and paradigm used.
For example, you might build a
'Usecase Model' that describes
behavior and scenarios using UML Use
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Cases. Process models, architectural
models, behavioral models, structural
models, Class models and so on are all
Models within the current Project.
A Project is a group of models that has2.
a single unifying purpose. For example,
a Project to design the navigation
systems for a new aircraft or
automobile would be considered a
single Project. Within this Project there
would be multiple models. Projects
typically define levels of security,
necessary types of views and models,
necessary procedures and other
management tasks to deliver the
product. Project management
capabilities in Enterprise Architect are
quite rich and allow for resource
management, security, change
management, testing and other typical
project management tasks.
A Repository is a single File, DBMS3.
database or Cloud Server address that
contains one or more Projects.
Typically, file based repositories such
as MS JET and Firebird models contain
a single Project with multiple models
that can be shared by a small
workgroup or only accessed by a single
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modeler. DBMS and Cloud based
Repositories will often contain more
than one Project, especially where the
Projects are in some way inter-related
or co-dependent.

Adding
Initial
Content

After creating and accessing your new
project in whatever form the Repository
takes, you can now use the Model Wizard
to create Model Packages that range from
generic and simple views to more
complex and pattern based content.
You can add Models to a project from the
Project Browser by:

Right-clicking on an existing model·

and selecting the 'New Model' or 'Add
a New Model using Wizard' options
Right-clicking on a Package and·

selecting the 'Add | Add a New Model
using Wizard' option
Clicking on an existing model, pressing·

the Insert key and selecting the 'New
Model' or 'Add a New Model using
Wizard' menu options
Clicking on a Package, pressing the·

Insert key and selecting the 'Add a New
Model using Wizard' menu option

Opening Existing Projects are accessible via the
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Existing
Projects

'Recent Documents' list under the 'File
Management' icon ( ), the 'Recent'
list on the Start Page, and through the
'Open Project' option under the 'File
Management' icon.
Connecting to an existing DBMS or
Cloud based Repository is discussed in
more detail under the relevant sections on
working with those Repository types.
For new users, you can use the 'Start >
Help > Help > Open the Example Model'
ribbon option to open and explore the
Enterprise Architect Example Repository
supplied with Enterprise Architect. This
example is not so much a fully worked
example as a collection of models that
show how you can leverage the power of
the Enterprise Architect platform and the
UML to create a wide range of visual and
text based models.

DBMS
Repositories

You can connect to any of these data
repositories:

MS Access 97, 2000, 2003 (in all·

editions - .eap files are stored in
Microsoft JET databases)
MS Access 2007 onwards·

Firebird·
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SQL Server 2000 onwards·

SQL Server Express 2005 onwards·

MySQL·

MariaDB·

Oracle 9i, 10g, 11g and 12c·

PostgreSQL·

Adaptive Server Anywhere·

In brief, to create a new data repository,
you first create a new database with the
DBMS management software, then run
supplied scripts to create the logical
structure.
You then use Enterprise Architect data
transfer functions to move a project from
a .eap, .feap or DBMS model into the
new project. Details are available under
the Server Based Repositories section.
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Projects Defined

An Enterprise Architect Project is a repository for storing,
manipulating and managing one or more Models. A single
repository can contain many models, and a Repository can
be either file based, hosted in a larger DBMS system or
based in the Cloud.

Concepts

Concept Detail

Project A project can contain a single model, or a
number of models, each of which defines
a particular system or process. A model
contains the diagrams, elements,
relationships and associated metadata that
define the structure and function of the
system or process. These components are
organized into a hierarchy of Packages,
which help to group and manage related
components.

Model Different aspects of the process or system
- or their development - are defined by
Model Packages, which you generate
from templates specifically structured to
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support the aspects that the Model
Packages represent, such as requirements
or deployment. You can generate these
templated Packages at any level of the
hierarchy, but as they are created with
their own content they are more useful at
the top levels.

View The top-level Packages in a model can
also be Views, which represent partitions
of the model that you define yourself.
You can start with standard Views such
as Class or Component, or create
whatever partitions are appropriate to
your model.

Example
Project
Structure

Each View or Model Package contains
Packages; Use Case Model Package
contains:

Actors and·

Primary Use Cases·

It also contains the Use Case diagram,
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which could be an overview of the
Package structure or function.
Each Package itself can contain one or
more diagrams, one or more Packages,
and several elements; the Primary Use
Cases Package contains the:

Primary UCDiagram·

Customer Setup Package·

Use Case1 element·

Use Case2 element·

Each subordinate Package also contains
diagrams, elements and (if necessary)
further Packages; the elements are related
by connectors created in the diagrams,
and each element and connector has
properties, attributes, operations and
extensions defined in the respective
'Properties' dialogs.
Note that models do not have to be
constructed this way. Depending on the
methodology you are following and
information you need to model, the
project structure might look completely
different. In addition, many architectural
frameworks such as TOGAF and
ArchiMate specify their own project
structure as part of their overall solution
architecture.
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Managing Connections to Projects

An Enterprise Architect project is used for storing and
managing the components of one or more UML models. The
Professional edition of Enterprise Architect works on
file-based projects (.eap files). If you are using the
Corporate edition (or above), you can also use one of a
number of DBMSs such as Oracle or MySQL, or a Cloud
Based server to host the project repository.

When you select to open a project, you can:

Select a shortcut to a recent project, to open it·

Browse for another existing project to open·

Remove a shortcut from the list of recently-opened·

projects

Specify connection details for opening a project hosted on·

a DBMS

Connect to a project via the Cloud·

Create a new Enterprise Architect project file·

Access

Ribbon  > Open Project

Keyboard
Shortcuts

Ctrl+O
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Other Start Page | New | Manage projects

Options

Field/Button Action

Local File Click on this button to open a file
browser dialog, and locate and select an
existing .EAP, .EAPX or .FEAP file; the
.EAP file can be a project file or a
shortcut to a project hosted on a DBMS.
Alternatively, click on the drop-down
arrow and select the 'New Project' option
to create a new project.

Connect to
Server

Click on this button to specify connection
details for opening an Enterprise
Architect project that is hosted on a
DBMS. The 'Windows Data Link
Properties' dialog displays; start to define
the connection to the project's
server-based repository.
You can also click on the drop-down
arrow and select:

'Connection Wizard' - the 'Data Link·

(c) Sparx Systems 2018 Page   34 of 1073



User Guide - Model Repository 21 December, 2018

Properties' dialog again displays
'Connection String' - the 'Connection·

String' dialog displays; type in or paste
the connection string and click on the
OK button to connect directly to the
project

Connect to
Cloud

Click on this button to connect to a
project through the Cloud. The 'Cloud
Connection' dialog displays, on which
you specify the server, URL and model
name to access via the Cloud.

Recent
Projects

This panel lists the most recently opened
projects, up to a maximum of ten. To
open one of these projects either
double-click on the name, or click on it
and then click on the Open button.
Each project name is shown with its
access path. You can edit the access path
by right-clicking on it and selecting the
'Edit Connection String' context menu
option; make the changes on the
'Connection String' dialog, and click on
the OK button.
Similarly, if the project has a connection
string (not a shortcut), you can change the
name of the project by right-clicking on it
and selecting the 'Edit Project Name'
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menu option; type a new name in the
'Edit Project Name' dialog and click on
the OK button.
The list of recent projects is also
displayed:

On the Start Page, under the 'Recent'·

heading
As a drop-down menu under the Open·

Project button on the Default Tools
toolbar
With the  list of options·

Remove
Selection
from List

Click on a project name and click on this
button to remove that project name from
the 'Recent' list.

Show this
Dialog at
Startup

Select the checkbox to show this 'Open
Enterprise Architect Project' dialog
automatically upon starting Enterprise
Architect. Deselect the checkbox to hide
the dialog.

Default
Project to
Open

Click on a project name in the 'Recent'
list and select this checkbox to open the
selected project automatically whenever
you start up Enterprise Architect.

Open Click on this button to open the currently
selected project in the 'Recent Projects'
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list.

Cancel Click on this button to close this dialog
without any further action.

Help Click on this button to display this Help
topic.

Notes

Use of a DBMS and/or Cloud for hosting the model·

repository is available in the Corporate, Unified and
Ultimate editions of Enterprise Architect

Enterprise Architect supports these DBMS products for·

hosting model repositories:
    - SQL Server and SQL Server Express;
    - MySQL
    - Oracle 9i, 10g, 11g or 12c
    - Postgre SQL and
    - ASA
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Project Shortcuts

Enterprise Architect enables you to create a desktop shortcut
(or proxy file) to an Enterprise Architect project (Cloud,
DBMS or file-based). Each shortcut is a file containing the
connection string for the model. In addition, the shortcut
also defines views that Enterprise Architect should open
when it opens the model, as outlined here. In this manner it
is a convenient and customizable way of quickly sharing a
connection to a Cloud based model without requiring other
users to know the details of the connections string, model
name and other parameters.

Access

Ribbon  > Save As Shortcut

Topics

View Detail

Diagrams Define one or more specific diagram(s) to
be loaded on opening the project.
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Model
Search

Open the Model Search with a specific
text string and search type.
For searches operating on the current tree
selection, a diagram in the target Package
must be opened first.
If you use a custom SQL search, the SQL
must include ea_guid AS CLASSGUID
and the object type.
You specify a single Model Search to
open.

The
Relationship
Matrix with a
saved profile

Open the Relationship Matrix with a
saved profile.
You specify a single Relationship Matrix
profile to open.

The default
Team Library

Open the default Team Library
document.
You specify the Team Library once.

Working Set Open a working set.
You specify a single Working Set to
open.
This is very similar to the shortcut itself,
opening a defined set of diagrams and
views. However, the working set can also
open source code editors, therefore

(c) Sparx Systems 2018 Page   39 of 1073



User Guide - Model Repository 21 December, 2018

widening the capabilities of the shortcut
alone.
Working sets make it easy to customize
the main views you want to open without
having to resave your project short cuts.
The working set is easy to tailor to your
changing requirements, adding greater
flexibility to any short cut that calls the
working set.
Also, working sets provide the capability
of storing the currently-engaged files
when closing a model, and reopening
them in the context in which you were
last using them. The basic project
shortcut can also do this, but once the
work environment is captured the
shortcut returns to the same set up each
time you use it. The working set always
captures the current work environment
each time the model closes.
This option can be very useful in, for
example, a coding environment when you
want to return to the last files you were
editing.

Workspace
Layout

Apply a selected Workspace Layout,
which opens and sets out the appropriate
screens and windows for a specific area
of work, such as model simulation.
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You specify a single Workspace Layout
to open. However, by creating and using
separate shortcuts you can open
Enterprise Architect in exactly the
configuration you need for the work you
want to do - modeling, coding, or
debugging, for example.

An example
shortcut

You might create a shortcut to open, in
sequence:

A Development module·

The Model Search for a simple search·

on the term Issue
The module Issues diagram·

The module 'Changes' diagram·

Enterprise Architect opens the
appropriate windows in the sequence in
which you list the options, displaying the
last view in the list as the active view.
In this example, the project opens with
the Enterprise Architect work area
showing the two diagram tabs and the
'Model Search' tab, and with the
'Changes' diagram displayed in the
Diagram View.
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Notes

If specified, the shortcut views override any default·

diagram defined for the model or current user

A shortcut does not affect the original Enterprise·

Architect .exe file or icon, or any other shortcut you might
have defined; you can use all of these independently

If you are using a database repository other than MS·

Access 97, 2000, 2003 or 2013, you can configure the
shortcut to encrypt the password used to set up the
connection between Enterprise Architect and the
repository; the Enterprise Architect user does not have the
real password, thereby preventing them from accessing
the repository using other tools such as Query Analyzer or
SQLPlus
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Create Project Shortcut

You can create a shortcut to an Enterprise Architect project
(either a DBMS project or file based project). The shortcut
can specify additional windows and diagrams to open up
automatically every time the shortcut is run, to create a
working environment in advance for other users.

Shortcuts are stored with a .EAP extension, but are actually
small text files that tell Enterprise Architect what project to
open and what initial views and windows to display.

Access

Ribbon : Save as Shortcut

Create a project shortcut

Ste
p

Action

1 Open Enterprise Architect.

2 Open the required project.
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3 Select the '  |Save as Shortcut' option.
The 'Save Project Shortcut' dialog displays.

4 Click on the  button at the end of the 'Target File'
field.
The 'Save Project As' dialog displays.

5 Browse for the appropriate file location and, in the
'File name' field, type an appropriate filename.
All shortcuts are .EAP files, regardless of whether
the model itself is a .EAP file or a DBMS model.

6 Click on the Save button to return to the 'Save
Project Shortcut' dialog.

7 Click on the Add Other button and select the
required option to define:

A diagram to open·

A Relationship Matrix profile to open·

The Team Library·

A Model Search to perform·

A working set to apply·

A workspace layout to apply·

8 The appropriate browser or dialog displays to define
the view to display; enter the details and click on the
OK button.
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The view is added to the 'Actions when model is
opened' field; the entry is automatically selected,
with a tick in the checkbox.

9 Repeat steps 7 and 8 for as many additional views as
you require.

10 Review the items in the 'Actions when model is
opened' field.

If you decide not to have an item in the shortcut,·

deselect its checkbox
If you want to clear all selected items, click on the·

Include None button
Unselected entries are deleted when you save the
shortcut.

11 If you decide to change the sequence and/or make a
different view display first in the Diagram View:

Click on the appropriate entry·

Click on the 'Up Hand' or 'Down Hand' buttons·

12 Click on the OK button to save the shortcut.

Notes
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When you subsequently open the 'Save Project Shortcut'·

dialog, it lists the currently-opened views in the order in
which they were opened; you can add further views or
remove them from the shortcut
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Capture Current Work Environment

You can capture the current Enterprise Architect work
environment in your shortcut. This maintains the work
environment from that point, and is useful if you intend to
close and re-open the model and return to the same
configuration many times.

If you simply want to return to whatever work environment
you happen to be in each time you close the model, you
should use a work set that captures the current environment,
either by itself or as part of a broader project shortcut.

Access

Ribbon : Save as Shortcut

Capture your current work environment

Ste
p

Action

1 Open Enterprise Architect.
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2 Open the required project and work in it.

3 At the point at which you decide to capture your
work environment in a shortcut, ensure that:

You have opened all diagrams you require·

If necessary, you have opened the Team Library,·

Model Search (with appropriate search term and
type) and/or Relationship Matrix (at the
appropriate profile)
The view you want to resume work on is the last·

one opened

4 Select the 'Save As Shortcut' menu option.
The 'Save Project Shortcut' dialog displays, showing
a list of actions derived from the views you currently
have open.

5 If you accessed Enterprise Architect via a shortcut,
the 'Target File' field displays the file location of that
shortcut.
Otherwise, click on the  button at the end of the
'Target File' field.
The 'Save Project As' dialog displays.

6 Browse for the appropriate file location and, in the
'File name' field, type an appropriate filename.
All shortcuts are .EAP files, regardless of whether
the model itself is a .EAP file, .FEAP file or DBMS
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model.

7 Click on the Save button to return to the 'Save
Project Shortcut' dialog.

8 In the 'Actions when model is opened' field, click on
the Include All button.

9 If you also want to save current window positions
click 'Add Other' followed by 'Add Workspace
Layout'. The dialog shown allows you to select an
existing layout or save the current layout.

10 Click on the OK button to save the shortcut.
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Encrypt Repository Password

If your model is developed on a DBMS repository, the 'Save
Project Shortcut' dialog has an 'Encrypt Connection String'
checkbox.

You can create the shortcut actions and, if necessary, select
the checkbox to encrypt the database connection string.

You distribute the shortcut file to the database users who are
to access the model. The users then have an encrypted string
that prevents them from directly accessing the database
using other tools.
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File Based Projects

Enterprise Architect provides a convenient light-weight,
low-barrier and portable file-based repository
out-of-the-box, which is ideal for modelers who want to
start work immediately; with the file-based repository you
can be modeling within a few minutes. When a number of
colleagues want to contribute to the models, the file can be
moved to a file-share and it is possible to work with this
setup even when the model becomes quite large and the
number of users increases to ten or more. All editions of
Enterprise Architect support this type of repository in the
form of a .eap file in an Access database, or a .feap file in a
Firebird repository.

You can create your own repository from scratch, but a
default repository (EABase.eap) is conveniently supplied,
located in the Enterprise Architect installation directory. The
file acts as a template for creating new projects and can be
copied to give you a head start in creating a repository. You
can tailor this repository to suit your organization or create
your own base repository. A File Based Repository can be
easily transferred to a DBMS based repository using the
Project Transfer feature, allowing a project to be scaled up
when the team increases in size or when organizational
policy dictates it.
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File-based project tasks

Task Detail

Create .EAP
Project Files

Select one of:
 > New Project menu option·

'Local File | New Project' option on the·
'Manage Projects' dialog, or
'Create a new project' option on the·
Start Page

All of these options display the 'New
Project' dialog; select a directory and
enter a file name for your project (.eap
under JET 3 or .eapx under JET 4).
Once the project has been saved, the
Model Wizard displays, which makes a
selection of Model Patterns available;
select the Model Patterns to use.
Enterprise Architect adds a model
containing the selected Model Packages
to the Project Browser.

Create .FEAP
Project Files

As for a .eap/.eapx file, except that in the
'New Project' dialog, in the 'Save as Type'
field, click on the drop-down arrow and
select the .feap file extension.
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Enterprise Architect will check your input
and display an error message if:

Your Firebird repository is not located·

on the local drive; a Firebird repository
is not appropriate for a network shared
project
The file path contains characters that·

are not in the system codepage

Location of
default
(EABase.eap
) repository
template

The default installation directories,
depending on which version you have
installed, are:

Registered version: C:\Program·

Files\Sparx Systems\EA
Trial version: C:\Program Files\Sparx·

Systems\EA Trial
Lite version: C:\Program Files\Sparx·

Systems\EA Lite
A base project contains templates and
reference data from which you can
quickly develop your own project.
Note that in addition to deriving a new
model from EABase.eap. it is also
possible to start a new project by copying
an existing one. While it is possible to
simply 'copy' the .EAP file at the file
system level, this results in two identical
models and should only be used when
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that is the required behavior; for example,
when distributing a model to a client for
verification. If you use the built in
functions of Enterprise Architect to create
a new model based on an existing one,
Enterprise Architect will modify the
unique identifiers (GUIDS) for all
elements and related constructs so that
the new model is essentially unique, and
not a simple copy of the existing one.

Configure
Project

Having created your project, you can set
a range of project parameters to define
defaults, tailor the project to particular
coding languages, and ensure consistent
development and use of the project.

Create
Custom
Templates

You can customize any Enterprise
Architect project as a template project
with company standards, tutorials,
frameworks and any other common piece
of modeling already in-built; with careful
planning you can save yourself many
hours of work at project start-up.

Best Practices for File Based Repositories
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Single User Simple file based repositories (.eap and
.feap files) are best suited to single user
development with the model file placed
on the modelers local drive. This is fast,
very efficient and provides a powerful
means of getting started in modeling a
particular solution. Many models will
start out as single user repositories and
only later be migrated into a DBMS or
Cloud based scenario for larger team
access. If you need to quickly start work
on a project and do some exploratory
work, or you are working alone as a
consultant, the .eap or .feap file format is
ideal.

Small
Workgroup

With all versions of Enterprise Architect
it is possible to share a .eap file at the
network file level. This is really only a
suitable solution for small workgroups
(up to, say, five members) who are
collaborating on a shared model. This
solution is very much at the mercy of the
quality of the network connection and
could be less than ideal if collaborating
users increase in number and/or the
model grows very large. As Enterprise
Architect on the user's machine is still
running all the queries and performing all
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database operations on a network file, a
slow network will result in less than ideal
performance. As team size and model
size increases it is best to upsize to either
a DBMS or Cloud-based architecture.

In
Conjunction
with Version
Control

One additional scenario in which file
based repositories can be used to great
effect is with a Version Control system
such as SVN. If the SVN system holds
the master content, then individual
developers/modelers can check out the
material of interest to them into a local
.eap or .feap file. When they have made
their changes they can migrate their work
back into the shared master. This style of
development is quite effective, and as the
import and export of model material from
the Version Control system works best
with single user local project files, it is a
good match and a good use of the two
technologies.

Copy of
Repository
for Storage or
Review

A further use of the single file repository
is for distribution to clients and others for
review and comment, where the original
model(s) is located in a DBMS or Cloud
that the recipient would not have access
to. As it is relatively easy to bulk copy a
DBMS model to a local .eap file, this is a
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good method for passing on a model to a
client or another interested party. If some
of the material is restricted, it is possible
to delete sections from this single file
repository after the bulk copy is complete
and before passing it on.

Replication If network access is limited and DBMS
and Cloud based solutions are not
possible, another (less than optimal but
still effective) team based solution is to
use the built in replication features of the
.EAP file format. By creating a design
master and distributing replicas to other
modelers, it is possible to effectively
share and contribute to a model without
having direct shared access to the
common model. On the down side,
someone will have to perform the model
merges as required and if there are
replication conflicts (two changes to the
same item) this will require manual
resolution.

Notes

You can also add Model Packages to a project by clicking·
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on the Project Browser header bar and selecting the 'New
Model From Pattern' menu option
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Copy a Base Project

When you create a new project, you can use the Model
Wizard to define the structure and contents. Alternatively,
you can copy an existing template or base project which is
already largely set up, containing company standards,
tutorials, frameworks and any other common modeling
structures. You can also copy an operational .EAP or .FEAP
project file to a new file location under a new name to, for
example:

Provide separate copies for individual team members·

Create an evaluation or distribution version of the project·

If you intend to use an existing project file as the template
for a new project, it is important to use this method rather
than simply copying the .EAP file using Windows Explorer.
This process provides the option to reset all the unique
identifiers for Packages and elements, so that your new
project is truly unique - otherwise you create an exact copy
of the original project.

Access

Open the template project or existing operational project
then;

Ribbon : Save Project As
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Create a new project from a base project

Option Action

Target
Project

Type the new project filename.
You can either type in the file path as
well, or click on the Browse button and
browse for the required file path.
If this is to be a shared project, store the
file on a shared network resource such as
a Network Server or Workgroup Server.

Source
Project

Defaults to the path and name of the
currently-open template or project.

Reset New
Project
GUIDs

If the target project is to be a different
project from the source (such as when
you copy a base template), select this
checkbox to replace all GUIDs from the
base model with fresh GUIDs in the new
model.
However, if the new project is to be a
direct copy of the source, or based on a
project that is under Version Control, we
recommend that you deselect this
checkbox to prevent duplication of
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Packages when the 'Get Latest' facility is
used.

Save As Click on this button to save and open the
new project.
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Sharing File Based Projects

Enterprise Architect offers a diverse range of functionality
designed specifically for sharing projects in team-based and
distributed development environments, through network
deployment of model repositories, DBMS based
repositories, Cloud based models, replication and XMI
Import/Export.

Features

Feature Detail

Network
Deployment

Network deployment is possible under
three different schemas:

File based repositories·

DBMS server based repositories, or·

Cloud based deployment·

(recommended)
DBMS server based repositories offer
better:

Response times than files on networks,·

due to the inherent structure of the
DBMS
Solutions when networking problems·

are encountered, as they have the
ability to backtrack transactions caused
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by external breakdowns

Replication Replication enables data interchange
between .EAP based repositories and is
suitable for where many different users
work independently in parallel
development.
Modelers merge their changes into a
Design Master only as required; it is
recommended that a backup is carried out
prior to replication.
Replication cannot be performed on
repositories stored on a DBMS server.

XMI Import
and Export

XMI Import/Export can be used to export
and share discrete Packages between
developers; XMI enables the export of
Packages into XML files that can then be
imported into any model.
Package control can be used to set up
Packages for Version Control and to
enable batch export of Packages using
XMI; Version Control enables a
repository to be maintained by a
third-party source code control
application that is used to control access
and record revisions.
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Notes

DBMS Repository support is available with the·

Corporate, Unified and Ultimate editions of Enterprise
Architect
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Share Enterprise Architect Projects

The most efficient way of using Enterprise Architect to
manage a team development is to share a project amongst a
team of designers, developers and analysts.

Facilities

Facility Detail

By Sharing a
project

Many people can work on the model at·

the same time and contribute their
particular skill
Team members can always see what·

the latest changes are, keeping the team
informed and up to date with the
project status

You can
share a
project in
three ways

Place the project in a shared network·

directory
Use replication·

Use a shared DBMS-based repository·

Notes
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Project Sharing and Replication are available in the·

Professional, Corporate, Unified and Ultimate editions of
Enterprise Architect

DBMS repositories are supported in the Corporate,·

Unified and Ultimate editions of Enterprise Architect
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Refresh View of Shared Project

When a user of a shared model checks out a Package and
makes changes, other users can see those changes by
refreshing their view of the Package or the changed diagram
within the Package, in a number of ways.

Refresh the view

Object Options

Project Right-click on the Package name in the·

Project Browser and select the
'Contents | Reload Current Package'
option, or
Press F5 to refresh the Package, or·

Select the  (Reload Project) icon in·

the Project Tools toolbar, or
Press Ctrl+Shift+F11, or·

Close the project and reopen it·

Diagram Select the 'Start > View > Workspace >·

Manage Views > Reload View' ribbon
option, or
Right-click on the opened diagram tab·

in the Diagram View, and select the
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'Reload <diagram name>' option
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Share a Project

The easiest way to share a project amongst a work group of
developers and analysts is to place the project file on a
shared network drive, to which people connect from their
workstations.

Individual developers and analysts can then open and work
on the project concurrently.

Network Issues

Enterprise Architect accepts a number of concurrent
connections without issue; however, there are points you
should consider:

Issue Description

Lock Outs There can be occasional 'lock-outs' when
one user tries to access or update
something another user is in the process
of modifying.

Other
Changes

Changes to the Project Browser (and
other project views) are not automatically
updated; to compensate for this, users
must occasionally reload their project to
see changes made by other users.
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Diagrams If two or more people work on the same
diagram concurrently, unexpected results
can occur; it is best to allow only one
analyst to work on a diagram at a time.

System
crashes

(.EAPX/.EAP files only) If a user's
machine crashes, the network suffers an
outage or a machine is turned off
unexpectedly, the project file might
require repair to compensate for the
sudden inconsistency; a repair facility is
provided ('Configure > Model > Integrity
Check> Manage .EAPX/.EAP File >
Repair .EAPX/.EAP File') to carry out
this task.

Notes

Firebird-based projects (.feap files) are not suitable for·

sharing over a network
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Distributed Development

Enterprise Architect supports distributed development using
two different techniques.

Replication

Using replication, geographically separated analysts can
update and modify parts of the model in replicas, then
merge these back together at a central location.

XMI Import/Export

Using XMI-based import/export, you can export discrete
Packages to XML to share among the development team;
this has several benefits over replication:

You can assemble a model from only the parts necessary·

to get your job done

You can assemble a full model if required·

You can assemble a model from different Package·

versions for different purposes (such as customer visible,
internal release only)

You can roll-back parts of a model as required·

There is less chance of 'collisions' between developers if·

each works on a discrete Package
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The process is controllable using a Version Control·

system, or through Package control

XMI based import/export is UML1.3 / XMI1.1 compliant;
you can also write XML based tools to manipulate and
extract information from XML files to enhance the
development process.

XMI-based Import/Export is accessed through the 'Publish >
Model Exchange > Export XMI' and 'Import XMI' ribbon
options.
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Replication

Apart from sharing Enterprise Architect projects in real time
over a network, you can also share projects using
replication.

Guide

Facility Detail

Replication Replication is a powerful means of
sharing projects between isolated or
mobile users; it enables different users to
work independently of one another, and
to merge their changes at a later time.
In Replication:

A project is converted to a design·
master, then replicas are made of the
master
Users take the replicas away, modify·
the project, then bring their replicas
back to be synchronized with the
master file

Use
Replication

To use replication:
Convert the base project to a design1.
master.
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Create replicas from the design master.2.
Take the replica away and work on it3.
as required, then bring it back for
synchronization with the design master.
Synchronize the replicas, during which4.
all changes to both the master and the
replica are propagated in both
directions, so they both finally contain
the same information.

Enterprise
Architect
Merge Rules

Enterprise Architect follows these rules
in merging:

Additions are cumulative; that is, two·

replicas each creating three new
Classes result in six new Classes after
merging
Deletions prevail over modifications; if·

one replica changes a Class name and
other deletes the Class, merging
replicas results in both files losing the
Class

Conflicting modifications appear in the
'Resolve Replication Conflicts' dialog.

Upgrades and
Replicas

When you upgrade your version of
Enterprise Architect, you must not open a
replica until you have opened the design
master and then synchronized the replicas
with the master; you cannot directly
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upgrade a replica.

Avoid
Change
Collisions

If two or more people make changes to
the same element, Enterprise Architect
arbitrarily overwrites one person's change
with the other's; to avoid this, different
users should work on different Packages.
However, since Enterprise Architect does
not enforce this rule, it is possible for
users' work to conflict; to minimize
difficulties, please note these guidelines:

If users are likely to have worked in the·

same area of the model, they should
both witness the synchronization and
confirm that they are happy with the
net result
If small pieces of information have·

been lost, they should be typed into one
of the merged models after
synchronization
If a large piece of information has been·

lost (for example, an overwritten large
Class note) use the 'Resolve
Replication Conflicts' dialog

Disable or
Remove
Replication
Features

If you have converted a project to a
design master but now want to disable the
replication features, you can remove
Replication; ensure that you back up all
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your files first.
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Design Masters

A design master is the first converted Enterprise Architect
project that supports replication. You create the master
project from which you create replicas that can be modified
independently of the master project and re-merged later.

Access

Ribbon Configure > Model > Integrity Check >
Manage .EAPX/.EAP File > Make
Design Master

Create a design master

Ste
p

Action

1 Take a back-up of the required Enterprise Architect
project.

2 Select the project in the Project Browser.
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3 Select the 'Make Design Master' menu option and
follow the on-screen instructions.
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Create Replicas

A replica is one of several copies of the design master of an
Enterprise Architect project. You create the copy of the
master project for you or another user to modify
independently and re-merge later.

Access

Ribbon Configure > Model > Integrity Check >
Manage .EAPX/.EAP File > Create New
Replica

Create a replica

Ste
p

Action

1 First create a design master, then select the 'Create
New Replica' menu option and follow the on-screen
instructions.

2 Edit the replica over time and, when required, return
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the file for merging with the design master.

Notes

In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
'Manage Replicas' permission to create a replica
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Synchronize Replicas

Synchronizing replicas combines the changes made to each
file. You can:

Merge the changes made to each replica with the design·

master, so that a new set of replicas with all changes can
be generated and distributed

Combine the changes made to two replicas, should it be·

necessary for two team members to combine their work

Access

Ribbon Configure > Model > Integrity Check >
Manage .EAPX/.EAP File > Synchronize
Replicas

Synchronize replicas

Ste
p

Action

1 Open the design master project file (or the first
required replica).
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2 Select the 'Synchronize Replicas' menu option.

3 Locate and select the (second) required replica to
merge the open project and the replica.

Notes

Information is copied both ways, including deletes,·

updates and inserts; both projects end up containing
identical information

If this process generates 'conflicting changes' errors, you·

should review and, if necessary, resolve these conflicts

In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
'Manage Replicas' permission to create a replica
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Remove Replication

Replication makes many changes to the database structure
of your model, so the model file becomes considerably
larger with additional information; you might, therefore,
decide not to use the replication feature any more.

Access

Ribbon Configure > Model > Integrity Check >
Manage .EAPX/.EAP File > Remove
Replication

Remove replication from your model

Ste
p

Action

1 Open a .EAP file (any .EAP file, other than the one
having replication removed) - the menu option is not
available if no file is open.

2 Select the 'Remove Replication' menu option.
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The 'Remove Replication Wizard' dialog displays.

3 Enter the full path and file name of the project to
have replication removed.
Click on the Next button.
If the project displays Version Number 7.0 this
indicates that Auditing is enabled. Auditing should
be disabled before proceeding (see Notes).

4 Enter the full path and file name of the base
Enterprise Architect model (with no replication) to
act as template.
Click on the Next button.

5 Enter the full path and required file name for the
output file.
Click on the Next button.

6 Select whether to have a log file created and, if so,
enter a file name for the log file.

7 Click on the Run button to begin removing
replication.
Enterprise Architect creates a new project containing
all the model information.
Your model has now had replication removed, and
should be considerably smaller.

(c) Sparx Systems 2018 Page   84 of 1073



User Guide - Model Repository 21 December, 2018

Notes

You cannot remove replication from a model with·

Auditing enabled - if you want to remove replication:

Disable Auditing.1.

If prompted to do so, allow Enterprise Architect to roll2.
back the database version.

Remove replication.3.
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Upgrade Replicas

A new release of Enterprise Architect might contain changes
to the underlying project structure, such as more tables or
changed queries. If you use Replication, you must take care
with your upgrade.

Considerations

Consideratio
n

Detail

Open Design
Master
Project first

After installing the new version of
Enterprise Architect, it is very important
that you open the design master before
opening any of the replicas with the
updated version.

Changes to
the database
design

Changes to the database design in a
replicated project can ONLY be done to
the design master; trying to update a
replica at best does nothing, and at worst
causes the update of the master to fail.

Propagate
Changes

Design changes are propagated through
to the replicas the next time the replicas
are synchronized with the master.
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Alternatively One other strategy is to remove
replication from a copy of the replica set,
upgrade that project and convert it into a
new design master from which new
replicas are created.
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Resolve Conflicts

If two or more people each work on the same model object
in their respective replicas between synchronizations, the
replication engine has problems in resolving which change
is the master. You need to select which of two conflicting
changes you should save to the Design Master and/or
replicas, where a substantial piece of information has been
overridden by a user and you want to retrieve it.

Access

Ribbon Configure > Model > Integrity Check >
Manage .EAPX/.EAP File > Resolve
Replication Conflicts

Considerations

Consideratio
n

Detail

Avoid the
problem

Ensure that each team member always
works in a separate area of the model
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within their replica.

Check for
conflicts

After synchronizing replicas, open the
'Resolve Conflicts' dialog (see next table)
and check if there were any conflicts.

Response to
conflicts

When a project record has been modified
in different ways by different users, the
replication engine selects one of the
conflicting values based on rules within
the JET replication manager.
However, the replication engine stores
the discarded changes and flags the
conflict on the 'Resolve Conflicts' dialog
so that you can choose to roll in the
discarded change instead.
Normally it is not necessary or desirable
to examine conflicts, since they represent
relatively inconsequential pieces of
information that can very easily be
modified through the normal Enterprise
Architect interface; for example, by
moving a diagram element.
The only case in which the 'Resolve
Conflicts' dialog should be used is where
a substantial piece of information has
been overridden by a user, and you want
to retrieve it.
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Resolve conflicts in changes to the same
model object in two separate replicas

Ste
p

Action

1 Synchronize a replica with the Design Master, and
display the 'Resolve Conflicts' dialog.

2 In the 'Table with Conflicts' list, click on the entry
that is likely to contain the lost information.

3 Click on each entry in the Conflicting Records list.
When the lost information appears in the Conflict
Details list, click on the Overwrite with Conflict
button.

4 In the 'Conflicting Records' list, you can also copy
each Row ID to the clipboard by right-clicking on
the row and selecting the 'Copy to Clipboard' menu
option.
You can locate the object that is in conflict in the
Project Browser or diagrams, by right-clicking on it
and selecting the 'Find in Project Browser' or 'Find in
Diagrams' option.
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Server Based Repositories

As a repository becomes larger, or the number of concurrent
users increases or organizational policy dictates, it might be
more appropriate to use a database management system
(DBMS) to store the repository. A File Based Repository
can be created and used in any edition of Enterprise
Architect; however, if you decide to use a DBMS based
repository you will need to use the Corporate, Unified or
Ultimate editions. Enterprise Architect has a function to
transfer your repository from a file based repository to a
server based one, helping you to get started quickly and with
no changes in the user-interface.

Note that the performance of the Repository as experienced
by end users will depend very much on the quality and
power of the server machine and the network infrastructure
on which the DBMS and user are located. Using a DBMS
over a very high latency (10ms or higher) network can result
in significant delays and visibly inferior performance. When
network latency is an issue, Sparx Systems recommends
using a Cloud Based Server as the interactions are optimized
to reduce the effect of network latency.

Also it is important to note that all models are quite different
and although Sparx Systems does its best to maximize
performance based on what is expected to be held in a
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repository, sometimes this is not quite sufficient. In these
rare cases a review of the database indexes would be good
practice to maximize data retrieval and access. This will
ensure that end users receive the best possible performance
even when models contain millions of constructs.

Set up a Project on a DBMS repository

To set up your project on a DBMS repository, you work
through these stages:

Set up your DBMS software and create a repository.1.

Create the required tables in your repository, by running a2.
script supplied on the Sparx Systems website.

(For certain DBMS products) Set up an ODBC driver to3.
enable connection to the repository.

Transfer the project from the source file to the DBMS4.
repository; the source file can be:
    - a .EAP or .FEAP base model, to begin a new project
from scratch, or
    - a previously-developed project file, to move an
existing project into the DBMS repository

Connect to your repository.5.

DBMS Products you can use

You can set up your project on a repository in:
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Firebird from v2·

MySQL from v5·

MariaDB·

Microsoft SQL Server from 2005, all editions including·

Express and Azure

Microsoft Access from 2007·

Oracle from 9i (all editions)·

PostgreSQL from v8·

Sybase Adaptive Server Anywhere 8 or 9, or SQL·

Anywhere 10, 11 or 12

For information on creating a project on a specific DBMS
from this list, see Learn more.

Notes

You cannot move a model from a source .eap file of an·

Enterprise Architect version earlier than 3.5.0 without
updating it first

Before proceeding, you must have MDAC 2.6 or higher·

installed on your system

(Optional, but recommended) before actually transferring·

the project structure from the file to the repository,
perform a Project Data Integrity Check on the file
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Create a Project in a MariaDB
Database

To create a project in a repository on MariaDB, you work
through these stages:

Stage 1: Create an empty database repository and set up·

the data tables

Stage 2: Set up the ODBC Driver·

Stage 3: Perform a project integrity check on the project·

file you are using as a base (optional, but recommended)

Stage 4: Transfer the data·

Stage 5: Connect to the repository and open the project·

Prerequisites

A machine with MariaDB version 10.1.2 or higher·

installed and running,

MySQL ODBC·

Create a MariaDB Repository

Create the repository as outlined here.

Ste
p

Action
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1 Create a new empty database and configure it to
your installation's defaults.

2 Load the EASchema_1220_MySQL.sql file from the
Sparx Systems website into your SQL management
console of choice (such as HeidiSQL).

3 Run the script to create the required database
schema.

Set Up the ODBC DSN

Ste
p

Action

1 Create a suitable ODBC Data Source (using the
MySQL ODBC driver and NOT the MariaDB
driver), to point to your new database.
Select the extended option:

'Return matched rows instead of affected rows'·

Perform a Project Integrity Check
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Ste
p

Action

1 In Enterprise Architect, open the file-based project
or template from which you are creating the project
on the repository.

2 Select and execute the 'Configure > Model >
Integrity Check > Project Integrity' ribbon option.
This ensures your project data is 'clean' and free
from errors before being copied to the repository.

Transfer the Project Data

Ste
p

Action

1 Open Enterprise Architect.
(If the 'Open Project' dialog displays, click on the
Cancel button to open with no project loaded.)

2 Select the 'Configure > Model > Transfer > Project
Transfer' ribbon option.
The 'Project Transfer' dialog displays.
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3 In the 'Transfer Type' panel, select 'File to DBMS'.

4 In the 'Source Project' field, click on the  button
and browse for the name of the project file to copy to
the repository.
If the .EAP file has Replication enabled, this must be
removed before performing the transfer.

5 At the right of the 'Target Project' field, click on the
 button.

The 'Datalink Properties' dialog displays.

6 Select 'Microsoft OLE DB Provider for ODBC
Drivers' from the list.
Click on the Next button.

7 In the 'Use Data source name' field, click on the
drop-down arrow and select the ODBC Data Source
you configured to point to your new database.
Click on the OK button. The 'Project Transfer' dialog
redisplays.

8 If required, select the 'Logfile' checkbox and type a
path and filename for the data transfer log file.

9 Click on the Transfer button to begin the data
transfer process.
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10 When the process is complete, you have created a
project on a MariaDB database and can now connect
to it and open it from Enterprise Architect.
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Create a MariaDB Repository

Creating a MariaDB database is fully documented in the
product information provided with your MariaDB installer.

Having created your MariaDB database, use the SQL script
provided by Sparx Systems to create the required table
definitions for Enterprise Architect.

You can obtain the scripts from the Sparx Systems website,
on the:

Registered Corporate edition 'Resources' page (Registered·

users)

Corporate edition 'Resources' page (Trial users)·

Third Party Tools

If you are unfamiliar with MariaDB and DBMS systems in
general, you might want to consider a suitable front end
tool. HeidiSQL is installed with MariaDB, providing a
convenient graphical user interface to enable the creation of
databases, the execution of scripts, and backups and
restores.

You might, therefore:

Run HeidiSQL and create a new database1.

After creating a MariaDB data repository in Enterprise
Architect, you must set up the MariaDB ODBC driver.
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Notes

This feature is available in the Corporate, Unified and·

Ultimate editions

Ensure that the collation is set to the alphabet you use,·

such as Latin or Cyrillic
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Set up a MariaDB ODBC Driver

After you have created a MariaDB database, you will need
to set up an ODBC DSN to the new database in order for
Enterprise Architect to connect to it. However Sparx
Systems recommend that the MySQL ODBC driver is used
to connect to MariaDB based repositories as the native
MariaDB ODBC driver is not fully compatible with
connection methods employed by Enterprise Architect.

Prerequisites

Install:

MariaDB DBMS and repository·

MySQL ODBC driver software·

Set up the ODBC Driver

Ste
p

Action

1 Under both 32-bit and 64-bit operating systems,
Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can
quickly load the correct 32-bit ODBC Data Source
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Administrator by selecting the 'Configure > User
Tools > ODBC Data Sources' ribbon option.
The ODBC Data Source Administrator window
displays.

2 Click on the Add button.
The 'Create New Data Source' dialog displays,
enabling you to add a new DSN.

3 Select the appropriate MySQL ODBC Driver from
the list.

4 Click on the Finish button.
The 'MySQL Connector/ODBC' dialog displays.

5 Enter these configuration details:
A data source name for the connection·

A description (optional)·

The host address of the DBMS server·

User name and password·

The database name on the selected server·

6 To set the advanced options, click on the Details>>
button.

7 Select these checkboxes (where provided):
Return matched rows instead of affected rows·
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('Connection' or 'Cursors/Results' tab)
Allow big result sets ('Connection' tab)·

8 Click on the Test Connection button to confirm that
the details are correct.

9 If the test succeeds, click on the OK button to
complete the configuration.
If the test does not succeed, review your settings.

(c) Sparx Systems 2018 Page  104 of 1073



User Guide - Model Repository 21 December, 2018

Connect to a MariaDB Data Repository

To access a project in your MariaDB data repository, you
must connect to the data repository from Enterprise
Architect.

Prerequisites

The MariaDB repository and the project already exist·

You have SELECT, INSERT, UPDATE, DELETE,·

EXECUTE and SHOW VIEW access permissions

The MariaDB ODBC driver has been set up·

Access

Ribbon : Open Project

Keyboard
Shortcuts

Ctrl+O

Connect to the repository
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Ste
p

Action

1 In the 'Open Project' dialog, select the 'Connect to
Server' checkbox.

2 Click on the  button.
The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC
Drivers' from the list.

4 Click on the Next>> button.
The 'Connection' tab displays.

5 Click on the 'Use data source name' radio button and
on the drop-down arrow in its field.
From the list, select the ODBC driver you have set
up to connect to your MariaDB repository.

6 If required, type in a User name and Password.

7 If required, type in an initial catalog.

8 Click on the Test Connection button to confirm that
the details are correct.

9 If the test does not succeed, revise your settings.
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If the test succeeds, click on the OK button; the
'Connection Name & Type' dialog displays.

10 Give the connection a suitable name so that you can
recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

11 If required, select the 'Encrypt Connection String'
checkbox.
This encrypts and hides the connection details of the
database from the users that the connection string is
given to.

12 If required, select the 'Lazy Load' checkbox to not
load the full project view when the model is loaded;
instead, only the parts that are necessary to display
the visible portion of the tree are loaded.
With this setting, the model loads faster and users
can begin work sooner, but at the expense of later
small delays as Enterprise Architect loads specific
portions of the model.

13 If required, select the 'Use WAN Optimization'
checkbox.
To improve performance over a Wide Area Network,
remote database calls can be routed through a WAN
Optimizer that compresses the data returned from the
repository, reducing transfer time.
If you select this checkbox, complete the next three
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fields (see your administrator for the correct values);
otherwise go to step 17.

14 In the 'Server' field, type the network name or
address of the optimizer server.

15 In the 'Port' field, type the port on which the server is
running on the remote machine.

16 In the 'DSN' field, type the data source name of the
database as it appears on the remote machine.

17 Click on the OK button to complete the
configuration and open the project.
This also adds the project name to the 'Recent' list on
the 'Start Page'; from now on, you can open the
project again just by clicking on this name.

Notes

This feature is available in the Corporate, Unified and·

Ultimate editions of Enterprise Architect
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Create a Project in a MySQL Database

To create a project in a repository on MySQL 5, you work
through these stages:

Stage 1: Create an empty database repository and set up·

the data tables

Stage 2: Set up the ODBC Driver·

Stage 3: Perform a project integrity check on the project·

file you are using as a base (optional, but recommended)

Stage 4: Transfer the data·

Stage 5: Connect to the repository and open the project·

Prerequisites

A machine with MySQL version 5 or higher installed and·

running,

MySQL 32bit ODBC driver, between versions 5.2.4 and·

5.3.6 (other versions are not recommended)

Create a MySQL Repository

MySQL supports two different storage engines - InnoDB
and MyISAM. In older versions of MySQL MyISAM was
the default storage engine, but from MySQL v5.5 onwards
InnoDB is the default. As of Enterprise Architect v13, Sparx
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Systems will no longer provide updates to the MyISAM
script and recommend all users to choose InnoDB, as it
supports transactions and UTF8.

Ste
p

Action

1 Create a new empty database and configure it to
your installation's defaults.

2 Load the EASchema_1220_MySQL.sql file from the
Sparx Systems website into your SQL management
console of choice (such as MySQL Workbench).

3 Run the script to create the required database
schema.

Set Up the ODBC DSN

Ste
p

Action

1 Create a suitable ODBC Data Source to point to your
new database.
Select these extended options:

'Return matched rows instead of affected rows'·
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'Allow big result sets'·

Perform a Project Integrity Check

Ste
p

Action

1 In Enterprise Architect, open the file-based project
or template from which you are creating the project
on the repository.

2 Select and execute the 'Configure > Model >
Integrity Check > Project Integrity' ribbon option.
This ensures your project data is 'clean' and free
from errors before being copied to the repository.

Transfer the Project Data

Ste
p

Action

1 Open Enterprise Architect.
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(If the 'Open Project' dialog displays, click on the
Cancel button to open with no project loaded.)

2 Select the 'Configure > Model > Transfer > Project
Transfer' ribbon option.
The 'Project Transfer' dialog displays.

3 In the 'Transfer Type' panel, select 'File to DBMS'.

4 In the 'Source Project' field, click on the  button
and browse for the name of the project file to copy to
the repository.
If the .EAP file has Replication enabled, this must be
removed before performing the transfer.

5 At the right of the 'Target Project' field, click on the
 button.

The 'Datalink Properties' dialog displays.

6 Select 'Microsoft OLE DB Provider for ODBC
Drivers' from the list.
Click on the Next button.

7 In the 'Use Data source name' field, click on the
drop-down arrow and select the ODBC Data Source
you configured to point to your new database.
Click on the OK button. The 'Project Transfer' dialog
redisplays.
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8 If required, select the 'Logfile' checkbox and type a
path and filename for the data transfer log file.

9 Click on the Transfer button to begin the data
transfer process.

10 When the process is complete, you have created a
project on a MySQL database and can now connect
to it and open it from Enterprise Architect.
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Create a MySQL Repository

Creating a MySQL database is fully documented in the
product information provided with your MySQL installer.

Having created your MySQL database, use the SQL script
provided by Sparx Systems to create the required table
definitions for Enterprise Architect.

You can obtain the scripts from the Sparx Systems website,
on the:

Registered Corporate edition 'Resources' page (Registered·

users)

Corporate edition 'Resources' page (Trial users)·

Third Party Tools

If you are unfamiliar with MySQL and DBMS systems in
general, you might want to consider a suitable front end
tool. MySQL Administrator is one such tool, providing a
convenient graphical user interface to enable the creation of
databases, the execution of scripts, and backups and
restores.

You might, therefore:

Run MySQL Administrator and create a new database,1.
then

Run MySQL Query Browser, and open and execute the2.
MySQL repository script
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After creating a MySQL data repository in Enterprise
Architect, you must set up the MySQL ODBC driver.

Notes

This feature is available in the Corporate, Unified and·

Ultimate editions

Ensure that the collation is set to the alphabet you use,·

such as Latin or Cyrillic
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Set up a MySQL ODBC Driver

After you have created a MySQL database, you will need to
set up an ODBC DSN to the new database in order for
Enterprise Architect to connect to it.

Prerequisites

Install:

MySQL DBMS and repository·

MySQL 32bit ODBC driver, between versions 5.2.4 and·

5.3.6

Set up the ODBC Driver

Your MySQL driver is now available to connect to the
repository from Enterprise Architect.

Ste
p

Action

1 Under both 32-bit and 64-bit operating systems,
Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can
quickly load the correct 32-bit ODBC Data Source
Administrator by selecting the 'Configure > User
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Tools > ODBC Data Sources' ribbon option.
The ODBC Data Source Administrator window
displays.

2 Click on the Add button.
The 'Create New Data Source' dialog displays,
enabling you to add a new DSN.

3 Select the appropriate MySQL ODBC Driver from
the list.

4 Click on the Finish button.
The 'MySQL Connector/ODBC' dialog displays.

5 Enter these configuration details:
A data source name for the connection·

A description (optional)·

The host address of the DBMS server·

User name and password·

The database name on the selected server·

6 To set the advanced options, click on the Details>>
button.

7 Select these checkboxes (where provided):
Return matched rows instead of affected rows·

('Connection' or 'Cursors/Results' tab)
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Allow big result sets ('Connection' tab)·

8 Click on the Test Connection button to confirm that
the details are correct.

9 If the test succeeds, click on the OK button to
complete the configuration.
If the test does not succeed, review your settings.
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Connect to a MySQL Data Repository

To access a project in your MySQL data repository, you
must connect to the data repository from Enterprise
Architect.

Prerequisites

The MySQL repository and the project already exist·

You have SELECT, INSERT, UPDATE, DELETE,·

EXECUTE and SHOW VIEW access permissions

The MySQL ODBC driver has been set up·

Access

Ribbon : Open Project

Keyboard
Shortcuts

Ctrl+O

Connect to the repository
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Ste
p

Action

1 In the 'Open Project' dialog, select the 'Connect to
Server' checkbox.

2 Click on the  button.
The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC
Drivers' from the list.

4 Click on the Next>> button.
The 'Connection' tab displays.

5 Click on the 'Use data source name' radio button and
on the drop-down arrow in its field.
From the list, select the ODBC driver you have set
up to connect to your MySQL repository.

6 If required, type in a User name and Password.

7 If required, type in an initial catalog.

8 Click on the Test Connection button to confirm that
the details are correct.

9 If the test does not succeed, revise your settings.
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If the test succeeds, click on the OK button; the
'Connection Name & Type' dialog displays.

10 Give the connection a suitable name so that you can
recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

11 If required, select the 'Encrypt Connection String'
checkbox.
This encrypts and hides the connection details of the
database from the users that the connection string is
given to.

12 If required, select the 'Lazy Load' checkbox to not
load the full project view when the model is loaded;
instead, only the parts that are necessary to display
the visible portion of the tree are loaded.
With this setting, the model loads faster and users
can begin work sooner, but at the expense of later
small delays as Enterprise Architect loads specific
portions of the model.

13 If required, select the 'Use WAN Optimization'
checkbox.
To improve performance over a Wide Area Network,
remote database calls can be routed through a WAN
Optimizer that compresses the data returned from the
repository, reducing transfer time.
If you select this checkbox, complete the next three
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fields (see your administrator for the correct values);
otherwise go to step 17.

14 In the 'Server' field, type the network name or
address of the optimizer server.

15 In the 'Port' field, type the port on which the server is
running on the remote machine.

16 In the 'DSN' field, type the data source name of the
database as it appears on the remote machine.

17 Click on the OK button to complete the
configuration and open the project.
This also adds the project name to the 'Recent' list on
the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

This feature is available in the Corporate, Unified and·

Ultimate editions of Enterprise Architect
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Create a Project in an Oracle Database

To create a project in a repository on Oracle 9i, 10g, 11g or
12c, you work through these stages:

Stage 1: Create an empty database repository and set up·

the data tables

Stage 2: Connect to the Oracle repository; Sparx Systems·

recommends using Oracle Provider for OLE DB -
connecting with either Microsoft OLE DB Provider for
ODBC or Microsoft OLE DB Provider for Oracle could
cause unexpected behavior or performance issues due to
known limitations of those drivers

Stage 3: Perform a project integrity check on the project·

file you are using as a base (optional, but recommended)

Stage 4: Transfer the data·

Stage 5: Connect to the repository to open the project·

Prerequisites

A machine with Oracle 9i, 10g or 11 g installed and·

running

Oracle Client installed on the client machine, please·

ensure that the OLE/DB drivers are installed (you can
download the drivers from the Oracle Technology
Network web site, as part of the Oracle Data Access
Components (ODAC) package; see Learn more)

(c) Sparx Systems 2018 Page  123 of 1073



User Guide - Model Repository 21 December, 2018

Create Database Repository

Ste
p

Action

1 Create the empty database.

2 Load the EASchema_1220_Oracle.sql file from the
Sparx Systems website into your SQL management
console of choice (such as Oracle SQL Developer).

3 Run the script to create the required database
schema.

Perform Project Integrity Check

Ste
p

Action

1 Open the file-based project or template.

2 Select and execute the 'Configure > Model >
Integrity Check > Project Integrity' ribbon option.
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This ensures your project data is 'clean' before
uploading.

Transfer the project data to the repository

Ste
p

Action

1 Open Enterprise Architect.
(If the 'Open Project' dialog displays, click on the
Cancel button to open with no project loaded.)

2 Select the 'Configure > Model > Transfer > Project
Transfer' ribbon option.
The 'Project Transfer' dialog displays.

3 In the 'Transfer Type' panel, select 'File to DBMS'.

4 At the right of the 'Source Project' field, click on the
 button and browse for the name of the project file

to copy to Oracle.
If the file has Replication enabled, this must be
removed before performing the transfer.

5 At the right of the 'Target Project' field, click on the
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 button.
The 'Datalink Properties' dialog displays.

6 Select 'Oracle Provider for OLE DB' from the list.
Click on the Next button.

7 On the 'Connection' page of the 'Datalink Properties'
dialog, enter the Oracle service name in the 'Data
Source' field, and the user name and password as
required.
Click on the OK button. The 'Project Transfer' dialog
redisplays.

8 If required, select the 'Logfile' checkbox and type a
path and filename for the data transfer log file.

9 Click on the Transfer button to begin the data
transfer process.

10 When the process is complete, you have created a
project on a Oracle database and can now connect to
it and open it from Enterprise Architect.

Notes

When transferring a project to Oracle you must have·
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access rights to execute the CREATE SEQUENCE
command
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Create an Oracle Data Repository

Creating an Oracle database is fully documented in the
product information provided with your Oracle installer.

Before creating an Oracle data repository, install the
appropriate version of Oracle (9i, 10g, 11g or 12c) and
MDAC 2.6 or higher, and obtain access permission to create
a new database.

Having created your Oracle database, use the SQL script
(Oracle_EASchema.sql) provided by Sparx Systems to
create the required table definitions and indexes for
Enterprise Architect. You can obtain the script from the
Sparx Systems website, on the:

Registered Corporate edition 'Resources' page (Registered·

users), or

Corporate edition 'Resources' page (Trial users)·

When you eventually connect to the Oracle database from
Enterprise Architect, Sparx Systems recommends using
Oracle Provider for OLE DB. Connecting with either
Microsoft OLE DB Provider for ODBC or Microsoft OLE
DB Provider for Oracle could cause unexpected behavior or
performance issues due to known limitations of those
drivers.

Third Party Tools

If you are unfamiliar with Oracle and DBMS systems in
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general, you might want to consider a suitable front end
tool. You could connect to the database and execute the
scripts with a program such as Oracle SQL*Plus or SQL
Plus Worksheet.

Notes

This feature is available in the Corporate, Unified and·

Ultimate editions

The OLE DB client must be the 32-bit version·

Set the collation to the alphabet you use, such as Latin or·

Cyrillic
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Set up an Oracle ODBC Driver

After you have created an Oracle database, you can either
set up an ODBC DSN to the new database in order for
Enterprise Architect to connect to it, or you configure
Enterprise Architect to use the Oracle OLE DB provider in
connection strings to the new database.

Note that Sparx Systems recommends using Oracle Provider
for OLE DB. Connecting with either Microsoft OLE DB
Provider for ODBC or Microsoft OLE DB Provider for
Oracle could cause unexpected behavior or performance
issues due to known limitations of those drivers.

Prerequisites

Install:

Oracle DBMS and repository·

Set up the Oracle ODBC driver

Your Oracle driver is now available to connect to the
repository from Enterprise Architect.

Ste
p

Action
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1 Under both 32-bit and 64-bit operating systems,
Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can
quickly load the correct 32-bit ODBC Data Source
Administrator by selecting the 'Configure > User
Tools > ODBC Data Sources' ribbon option.
The ODBC Data Source Administrator window
displays.

2 Click on the Add button.
The 'Create New Data Source' dialog displays,
enabling you to add a new DSN.

3 Select 'Oracle in OraDB11g_home1' from the list (or
similar, depending on the ODBC installation).

4 Click on the Finish button.
The 'Oracle ODBC Driver Configuration' dialog
displays.

5 Enter these configuration details:
A data source name for the connection·

A description (optional)·

The TNS Service Name (click on the drop down·

arrow and select from the list)
User ID·

6 Click on the Test Connection button and enter the
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Oracle user password to confirm that the details are
correct.

7 If the test succeeds, click on the OK button to
complete the configuration.
If the test does not succeed, review your settings.
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Connect to an Oracle Data Repository
(ODBC)

To access a project in your Oracle 9i, 10g, 11g or 12c data
repository, you connect to the data repository from
Enterprise Architect.

Note that Sparx Systems recommends using Oracle Provider
for OLE DB (see Connect to an Oracle Data Repository
(OLE DB)). Connecting with either Microsoft OLE DB
Provider for ODBC or Microsoft OLE DB Provider for
Oracle could cause unexpected behavior or performance
issues due to known limitations of those drivers.

Prerequisites

The Oracle repository and the project already exist·

You have SELECT, UPDATE, INSERT and DELETE·

access permissions

The Oracle ODBC driver has been set up·

Access

Ribbon : Open Project
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Keyboard
Shortcuts

Ctrl+O

Connect to an Oracle Data Repository using
an ODBC Driver

Ste
p

Action

1 In the 'Open Project' dialog, select the 'Connect to
Server' checkbox.

2 Click on the  button.
The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC
Drivers' from the list.

4 Click on the Next>> button.
The 'Connection' tab displays.

5 In the 'Data source' field, click on the drop-down
arrow and select the data source name.

6 Type in the User name and Password.
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7 Click on the Test Connection button to confirm that
the details are correct.

8 If the test does not succeed, revise your settings.
If the test succeeds, click on the OK button; Oracle
prompts you for the password.

9 Type in the password.
The 'Connection Name and Type' dialog displays.

10 Give the connection a suitable name so that you can
recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

11 If you want to encrypt and hide the connection
details of the database from the users that the
connection string is given to, select the 'Encrypt
Connection String' checkbox.

12 The Lazy Load facility does not load the full project
view when the model is loaded; instead, it loads only
the parts that are necessary to display the visible
portion of the tree. With this set, the model loads
faster and users can begin work sooner, but at the
expense of later small delays as Enterprise Architect
loads specific portions of the model.
If you want to use the Lazy load facility, select the
'Lazy Load' checkbox.
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13 To improve performance over a Wide Area Network,
remote database calls can be routed through a WAN
Optimizer that compresses the data returned from the
repository, reducing transfer time. If you are using a
WAN, and want to apply this facility, select the 'Use
WAN Optimization' checkbox; otherwise go to step
16.
If you select this checkbox, complete the next two
fields (see your administrator for the correct values).

14 In the 'Server' field, type the network name or
address of the optimizer server.

15 In the 'Port' field, type the port on which the server is
running on the remote machine.

16 Click on the OK button to complete the
configuration and open the project.
This also adds the project name to the 'Recent' list on
the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

This feature is available in the Corporate, Unified and·
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Ultimate editions
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Connect to an Oracle Data Repository
(OLE DB)

To access a project in your Oracle 9i, 10g, 11g or 12c data
repository, you connect to the data repository from
Enterprise Architect.

Prerequisites

Oracle Client already installed on the client machine,·

please ensure that the OLE/DB drivers are installed (you
can download the drivers from the Oracle Technology
Network web site, as part of the Oracle Data Access
Components (ODAC) package; see Learn more)

The Oracle repository and the project already exist·

You have SELECT, UPDATE, INSERT and DELETE·

access permissions

Access

Ribbon : Open Project

Keyboard
Shortcuts

Ctrl+O
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Connect to an Oracle Repository using OLE
DB

Ste
p

Action

1 In the 'Open Project' dialog, select the 'Connect to
Server' checkbox.

2 Click on the  button.
The 'Data Link Properties' dialog displays.

3 Select 'Oracle Provider for OLE DB' from the list.
Do not select 'Microsoft OLE DB Provider for
Oracle'; Enterprise Architect might not work as
expected.

4 Click on the Next>> button.
The 'Connection' tab displays.

5 In the 'Data source' field, click on the drop-down
arrow and select the data source name (the service
name of the Oracle database).
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6 Type in the User name and Password.

7 Click on the Test Connection button to confirm that
the details are correct.

8 If the test does not succeed, revise your settings.
If the test succeeds, click on the OK button; the
'Connection Name and Type' dialog displays.

9 Give the connection a suitable name so that you can
recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

10 If you want to encrypt and hide the connection
details of the database from the users that the
connection string is given to, select the 'Encrypt
Connection String' checkbox.

11 If required, select the 'Lazy Load' checkbox to not
load the full project view when the model is loaded;
instead, only the parts that are necessary to display
the visible portion of the tree are loaded.
With this setting, the model loads faster and users
can begin work sooner, but at the expense of later
small delays as Enterprise Architect loads specific
portions of the model.

12 To improve performance over a Wide Area Network,
remote database calls can be routed through a WAN
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Optimizer that compresses the data returned from the
repository, reducing transfer time. If you are using a
WAN, and want to apply this facility, select the 'Use
WAN Optimization' checkbox; otherwise go to step
15.
If you select this checkbox, complete the next two
fields (see your administrator for the correct values).

13 In the 'Server' field, type the network name or
address of the optimizer server.

14 In the 'Port' field, type the port on which the server is
running on the remote machine.

15 Click on the OK button to complete the
configuration and open the project.
This also adds the project name to the 'Recent' list on
the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

This feature is available in the Corporate, Unified and·

Ultimate editions
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Create a Project in a PostgreSQL
Database

To create a project in a repository on PostgreSQL, you work
through these stages:

Stage 1: Create an empty database repository and set up·

the data tables

Stage 2: Set up the PostgreSQL ODBC Driver·

Stage 3: Perform a project integrity check on the project·

file you are using as a base (optional, but recommended)

Stage 4: Transfer the data·

Stage 5: Connect to the repository to open the project·

Prerequisites

A machine with PostgreSQL 9 or higher installed and·

running

psqlODBC, version 8.03 or higher has been installed (do·

not use version 8.3.4 or 8.4.1)

Create Database Repository

Ste
p

Action
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1 Create the empty database.

2 Load the EASchema_PostgreSQL_1220.sql file from
the Sparx Systems website into your SQL
management console of choice (such as
pgAdminIII).

3 Run the script to create the required database
schema.

Set Up the ODBC DSN

Ste
p

Action

1 Create a suitable ODBC Data Source to point to your
new database.

Select these extended options:
Page 1:
 Disable Genetic Optimizer - Uncheck
 Use Declare/Fetch - Check
 Unknowns as LongVarChar - Check
 Bools as Char - Uncheck
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 Max Varchar - 1024
 Max LongVarChar - 1000000

Page 2:
 bytea as LO - Check
 Disallow Premature - Check
 Protocol - 7.4+

Perform a Project Integrity Check

Ste
p

Action

1 In Enterprise Architect, open the file-based project
or template from which you are creating the project
on the repository.

2 Select and run the 'Configure > Model > Integrity
Check > Project Integrity' ribbon option.
This ensures your project data is 'clean' before being
copied to the repository.

(c) Sparx Systems 2018 Page  144 of 1073



User Guide - Model Repository 21 December, 2018

Transfer the project data to the repository

Ste
p

Action

1 Open Enterprise Architect.
(If the 'Open Project' dialog displays, click on the
Cancel button to open with no project loaded.)

2 Select the 'Configure > Model > Transfer > Project
Transfer' ribbon option.
The 'Project Transfer' dialog displays.

3 In the 'Transfer Type' panel, select 'File to DBMS'.

4 In the 'Source Project' field, click on the  button
and browse for the name of the project file to copy to
the repository.
If the .EAP file has Replication enabled, this must be
removed before performing the transfer.

5 At the right of the 'Target Project' field, click on the
 button.

The 'Datalink Properties' dialog displays.

6 Select 'Microsoft OLE DB Provider for ODBC
Drivers' from the list.
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Click on the Next button.

7 On the 'Use Data Source Name' field, click on the
drop-down arrow and select the ODBC Data Source
you configured to point to your new database.
Click on the OK button. The 'Project Transfer' dialog
redisplays.

8 If required, select the 'Logfile' checkbox and type a
path and filename for the data transfer log file.

9 Click on the Transfer button to begin the data
transfer process.

10 When the process is complete, you have created a
project on a PostgreSQL database and can now
connect to it and open it from Enterprise Architect.

Notes

During the transfer, if an error message displays reporting·

'...nonstandard use of \\ in a string literal...', set the server
variable in the postgresql.conf file to:
escape_string_warning = off
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Create a PostgreSQL Repository

Creating a PostgreSQL database is fully documented in the
product information provided with your PostgreSQL
installer.

Having created your PostgreSQL database, use the SQL
script provided by Sparx Systems to create the required
table definitions for Enterprise Architect. You can obtain the
scripts from the Sparx Systems website, on the:

Registered Corporate edition 'Resources' page (Registered·

users)

Corporate edition 'Resources' page (Trial users)·

Third Party Tools

If you are unfamiliar with PostgreSQL and DBMS systems
in general, you might want to consider a suitable front end
tool. One such tool is pgAdminIII. It provides a convenient
graphical user interface to enable creation of databases,
execution of scripts and restores.

After creating a PostgreSQL data repository in Enterprise
Architect, you must set up the PostgreSQL ODBC driver.

Notes
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This feature is available in the Corporate, Unified and·

Ultimate editions

Ensure that the collation is set to the alphabet you use,·

such as Latin or Cyrillic
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Set up a PostgreSQL ODBC Driver

After you have created a PostgreSQL database, you will
need to set up an ODBC DSN to the new database in order
for Enterprise Architect to connect to it.

Prerequisites

Install:

PostgreSQL DBMS and repository·

PostgreSQL ODBC driver software version 7.03.01.00 or·

above (note that versions 8.3.4, 8.4.1 and 9.03 of the
PostgreSQL ODBC Driver are not supported)

Set up the ODBC driver

Your PostgreSQL driver is now available to connect to the
repository from Enterprise Architect.

Ste
p

Action

1 Under both 32-bit and 64-bit operating systems,
Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can
quickly load the correct 32-bit ODBC Data Source
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Administrator by selecting the 'Configure > User
Tools > ODBC Data Sources' ribbon option.
The ODBC Data Source Administrator window
displays.

2 Click on the Add button.
The 'Create New Data Source' dialog displays,
enabling you to add a new DSN.

3 Select 'PostgreSQL UNICODE' from the list.

4 Click on the Finish button.
The 'Postgre SQL Connector/ODBC' dialog displays.

5 Enter these configuration details:
A data source name for the connection·

The actual name of the database·

The host address of the DBMS server·

User name·

A description (optional)·

The password·

6 To set the advanced options, click on the Datasource
button and set the options on 'Page 1' as shown:
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Note: From version 9.5.4 onwards some options
shown in this image are no longer available and can
be ignored.

7 If you are using PostgreSQL version 8 to 9.5.4, set
the options on Page 2 as shown:
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The 'Disallow Premature' checkbox should be·

checked
In the 'Protocol' panel, the '7.4+' radio button·

should be selected
Note: From version 9.5.4 onwards the two options
are no longer available and can be ignored.

8 Click on the OK button to complete the
configuration.
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Connect to a PostgreSQL Data
Repository

To access a project in your MySQL data repository, you
must connect to the data repository from Enterprise
Architect.

Prerequisites

The PostgreSQL repository and the project already exist·

You have SELECT, UPDATE, INSERT and DELETE·

access permissions

The PostgreSQL ODBC driver has been set up·

Access

Ribbon : Open Project

Keyboard
Shortcuts

Ctrl+O
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Connect to the repository

Ste
p

Action

1 In the 'Open Project' dialog, select the 'Connect to
Server' checkbox.

2 Click on the  button.
The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC
Drivers' from the list.

4 Click on the Next>> button.
The 'Connection' tab displays.

5 Click on the 'Use data source name' radio button and
on the drop-down arrow in its field.
From the list, select the ODBC driver you have set
up to connect to your PostgreSQL repository.

6 Click on the Test Connection button to confirm that
the details are correct.

7 If the test does not succeed, revise your settings.
If the test succeeds, click on the OK button; the
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'Connection Name & Type' dialog displays.

8 Give the connection a suitable name so that you can
recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

9 If required, select the 'Encrypt Connection String'
checkbox.
This encrypts and hides the connection details of the
database from the users that the connection string is
given to.

10 If required, select the 'Lazy Load' checkbox to not
load the full project view when the model is loaded;
instead, only the parts that are necessary to display
the visible portion of the tree are loaded.
With this setting, the model loads faster and users
can begin work sooner, but at the expense of later
small delays as Enterprise Architect loads specific
portions of the model.

11 If required, select the 'Use WAN Optimization'
checkbox.
To improve performance over a Wide Area Network,
remote database calls can be routed through a WAN
Optimizer that compresses the data returned from the
repository, reducing transfer time.
If you select this checkbox, complete the next three
fields (see your administrator for the correct values);
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otherwise go to step 15.

12 In the 'Server' field, type the network name or
address of the optimizer server.

13 In the 'Port' field, type the port on which the server is
running on the remote machine.

14 In the 'DSN' field, type the data source name of the
database as it appears on the remote machine.

15 Click on the OK button to complete the
configuration and open the project.
This also adds the project name to the 'Recent' list on
the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

This feature is available in the Corporate, Unified and·

Ultimate editions
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Create a Project in an Access 2007
Database

In setting up a project in an Access 2007 repository, you
could be working in one of two situations:

You are able to work in Access 2007 itself, in which case·

you can convert your .eap project directly to an Access
2007 .accdb database file, which you can connect to and
open in Enterprise Architect

You have access to an empty Access 2007 .accdb file, and·

need to transfer a .eap project into that .accdb file

In either case, before you convert or transfer the project
data, you could perform a project integrity check on the .eap
file you are using as a base (optional, but recommended).

Prerequisites

The 'Microsoft Office 12.0 Access Database Engine OLE·

DB Provider' ODBC driver installed

Perform a Project Integrity Check

Ste
p

Action
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1 Open the base project or template .eap file.

2 Select and run 'Configure > Model > Integrity Check
> Project Integrity'.
This ensures your project data is 'clean' before
uploading.

Convert a .eap file in Access 2007

Ste
p

Action

1 Open MS Access 2007 and open the source .eap file
within this product.
Allow Access to convert the .eap file to a .accdb file.
This forms the Access 2007 repository.

Transfer the project data into an empty
.accdb file

Ste
p

Action
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1 Open Enterprise Architect.
(If the 'Open Project' dialog displays, click on the
Cancel button to open with no project loaded.)

2 Select the 'Configure > Model > Transfer > Project
Transfer' ribbon option.
The 'Project Transfer' dialog displays.

3 In the 'Transfer Type' panel, select 'File to DBMS'.

4 In the 'Source Project' field, type the name of the
.EAP file to copy to the repository.
If the .EAP file has Replication enabled, this must be
removed before performing the transfer.

5 At the right of the 'Target Project' field, click on the
 button.

The 'Datalink Properties' dialog displays.

6 Select 'Microsoft Office 12.0 Access Database
Engine OLE DB Provider' from the list.
Click on the Next button.

7 On the 'Data Source Details' page of the 'Datalink
Properties' dialog, type in the full path to the Access
2007 .accdb file.
Click on the OK button to return to the 'Project

(c) Sparx Systems 2018 Page  159 of 1073



User Guide - Model Repository 21 December, 2018

Transfer' dialog.

8 If required, select the 'Logfile' checkbox and type a
path and filename for the data transfer log file.

9 Click on the Transfer button to begin the data
transfer process.
When the process is complete, you have created your
project in an Access 2007 database and can now
open it directly from Enterprise Architect, browsing
for the .accdb file location in the 'Open Project'
dialog.

Notes

This feature is available in the Corporate, Unified and·

Ultimate editions

If you do not have Access 2007, you can download the·

Access Database Engine from the Microsoft downloads 
site

Ensure that the collation is set to the alphabet you use,·

such as Latin or Cyrillic
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Create a Project in a SQL Server
Database

To create a project on a repository in SQL Server 2005 and
above, or SQL Server Express 2005 and above, work
through these stages:

Stage 1: Create an empty database repository and set up·

the data tables

Stage 2: Perform a project integrity check on the project·

file you are using as a base (optional, but recommended)

Stage 3: Transfer the data·

Stage 4: Connect to the repository to open the project·

Prerequisites

A machine with SQL Server installed and running·

MDAC 2.6 or higher on the client machine·

Permissions to create databases on SQL Server (see the·

SQL Server Security Permissions Help topic)

ALTER permission on the t_image table in Enterprise·

Architect, to be able to import model images

Create a SQL Server Repository
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Ste
p

Action

1 Create a new empty database.

2 Load the EASchema_1220_SQLServer.sql file from
the Sparx Systems website into your SQL
management console of choice (such as Microsoft
SQL Server Management Studio).

3 Run the script to create the required database
schema.

Perform a Project Integrity Check

Ste
p

Action

1 In Enterprise Architect, open the file-based project
or template from which you are creating the project
on the repository.

2 Select the 'Configure > Model > Integrity Check >
Project Integrity' ribbon option, and execute the
check.
This ensures your project data is 'clean' before being
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copied to the repository.

Transfer the project data to the repository

Ste
p

Action

1 Open Enterprise Architect.
(If the 'Open Project' dialog displays, click on the
Cancel button to open with no project loaded.)

2 Select the 'Configure > Model > Transfer > Project
Transfer' ribbon option.
The 'Project Transfer' dialog displays.

3 In the 'Transfer Type' panel, select '.EAP to DBMS'.

4 In the 'Source Project' field, type the name of the
project file to copy to the repository.
If the .EAP file has Replication enabled, this must be
removed before performing the transfer.

5 At the right of the 'Target Project' field, click on the
 button.

The 'Datalink Properties' dialog displays.
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6 Select 'Microsoft OLE DB Provider for SQL Server'
or 'Microsoft OLE DB Driver for SQL Server' from
the list.
Click on the Next button.

7 On the 'Data Source Details' page of the 'Datalink
Properties' dialog, type in the server name, database
name and any security details required.
Click on the OK button. The 'Project Transfer' dialog
redisplays.

8 If required, select the 'Logfile' checkbox and type a
path and filename for the data transfer log file.

9 Click on the Transfer button to begin the data
transfer process.

10 When the process is complete, you have created a
project on a SQL Server database and can now
connect to it and open it from Enterprise Architect.
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Create a SQL Server Repository

Creating a SQL Server database is fully documented in the
product information provided with your SQL Server
installer.

Having created your SQL Server database, use the SQL
script provided by Sparx Systems to create the required
table definitions for Enterprise Architect. You can obtain the
script from the Sparx Systems website, on the Corporate
edition 'Resources' page.

If you are unfamiliar with SQL Server and DBMS systems
in general, you might want to consider a suitable front end
tool, such as SQL Server Management Studio.

SQL Enterprise Manager example

Ste
p

Action

1 In SQL Server Management Studio, locate the server
on which to create your new project; for example:
DBSERVER02\SQLEXPRESS.

2 Right-click and choose the 'New Database' option.

3 Enter a suitable name for the database. Set any file
options as required.
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Ensure that the database collation is set to the
alphabet you use, such as Latin or Cyrillic, and
case-insensitive.

4 Click on the database to select it, then select the
'New Query' menu option.

5 In the Query window, use the 'Open File' dialog to
locate the EASchema_1220_SQLServer.sql script
file.

6 Click on the Open button. In the drop-down menu,
check that you have selected the correct database to
run the script in.

7 Click on the Execute button; SQL Server executes
the script, which creates the base tables for an
Enterprise Architect project.

Notes

This feature is available in the Corporate, Unified and·

Ultimate editions

You should have ALTER permission on the t_image table·

in Enterprise Architect, to be able to import model images

When creating a project in a SQL Server database you·
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must have 'db_ddladmin' permission in order to execute
the SET IDENTITY_INSERT (table) {ON | OFF}
command
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SQL Server Security Permissions

The security model implemented by Microsoft's SQL Server
is quite powerful and highly configurable, supporting many
different possible solutions for securing the data contained
in SQL Server databases and ensuring it is only accessible to
users with the required permissions. For a more detailed
description and explanation of SQL Server permissions, see
the SQL Server documentation.

Enterprise Architect users who plan to add, edit and delete
contents in a SQL Server repository must have permissions
to execute SELECT, UPDATE, INSERT and DELETE
statements on all Tables in the Enterprise Architect
database. The easiest way to achieve this is to grant the
database roles of 'db_datareader' and 'db_datawriter' to each
user.

Additional Permissions for Project Transfers

When an Enterprise Architect repository is transferred into a
SQL Server based repository, it is necessary for Enterprise
Architect to execute a number of SET IDENTITY_INSERT
(table) {ON | OFF} commands during the process. This
means the user performing the transfer must have a high
level of security, in the role of 'db_ddladmin'.
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Does Enterprise Architect support Windows
Authentication?

Enterprise Architect does support Windows Authentication.
However, the type of authentication is determined by the
configuration of the connection used, and not by Enterprise
Architect.

Windows Authentication to SQL Server is commonly used
by Enterprise Architect users, but this requires that all
Windows users in Enterprise Architect be defined on the
SQL Server server and be granted the security roles
'db_datareader' and 'db_datawriter' for the repository.
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Connect to a SQL Server Data
Repository

After you have created a Microsoft SQL Server database,
you can connect to it immediately without any further
configuration directly from Enterprise Architect.

Prerequisites

The SQL Server repository and the project already exist·

You have SELECT, UPDATE, INSERT and DELETE·

access permissions

You have ALTER permission on the t_image table in·

Enterprise Architect, to be able to import model images

Microsoft OLE DB Provider for SQL (this is usually part·

of the Windows Operating System, otherwise install
MDAC 2.8)

Access

Ribbon : Open Project

Keyboard
Shortcuts

Ctrl+O
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Connect to the repository

Ste
p

Action

1 In the 'Open Project' dialog, select the 'Connect to
Server' checkbox.

2 Click on the  button.
The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for SQL Server'
or 'Microsoft OLE DB Driver for SQL Server' from
the list.

4 Click on the Next>> button.
The 'Connection' tab displays.

5 Type in the server details, including Server Name,
User Name and Password.

6 Click on the 'Select the database on the server' option
and on the drop-down arrow.
From the list, select the project to connect to.
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7 Click on the Test Connection button to confirm that
the details are correct.

8 If the test does not succeed, revise your settings.
If the test succeeds, click on the OK button; the
'Connection Name & Type' dialog displays.

9 Give the connection a suitable name so that you can
recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

10 If required, select the 'Encrypt Connection String'
checkbox.
This encrypts and hides the connection details of the
database from the users that the connection string is
given to.

11 If required, select the 'Lazy Load' checkbox to not
load the full project view when the model is loaded;
instead, only the parts that are necessary to display
the visible portion of the tree are loaded.
With this setting, the model loads faster and users
can begin work sooner, but at the expense of later
small delays as Enterprise Architect loads specific
portions of the model.

12 If required, select the 'Use WAN Optimization'
checkbox.
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To improve performance over a Wide Area Network,
remote database calls can be routed through a WAN
Optimizer that compresses the data returned from the
repository, reducing transfer time.
If you select this checkbox, complete the next two
fields (see your administrator for the correct values);
otherwise go to step 15.

13 In the 'Server' field, type the network name or
address of the optimizer server.

14 In the 'Port' field, type the port on which the server is
running on the remote machine.

15 Click on the OK button to complete the
configuration and open the project.
This also adds the project name to the 'Recent' list on
the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

This feature is available in the Corporate, Unified and·

Ultimate editions
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Create a Project in a Sybase ASA/SQL
Anywhere Database

To create a project in a repository on Sybase Adaptive
Server Anywhere 8 or 9, or SQL Anywhere 10, 11 or 12,
you work through these stages:

Stage 1: Create an empty database repository·

Stage 2: Set up the ASA ODBC Driver·

Stage 3: Perform a project integrity check on the project·

file you are using as a base (optional, but recommended)

Stage 4: Transfer the data·

Stage 5: Connect to the repository and open the project·

Prerequisites

A machine with Adaptive Server Anywhere installed and·

running

Install SQL Anywhere Studio, this also installs the ASA·

ODBC driver

Create Database Repository

Ste
p

Action
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1 Create a new empty database.

2 Load the EASchema_1220_ SybaseASA.sql file
from the Sparx Systems website into your SQL
management console of choice (such as Sybase
Central).

3 Run the script to create the required database
schema.

Set up the ODBC DSN

Ste
p

Action

1 Create a suitable ODBC Data Source to point to your
new database.

Perform Project Integrity Check

Ste
p

Action
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1 In Enterprise Architect, open the file-based project
or template from which you are creating the project
on the repository.

2 Select and run 'Configure > Model > Integrity Check
> Project Integrity'.
This ensures your project data is 'clean' before being
copied to the repository.

Transfer the Project Data

Ste
p

Action

1 Open Enterprise Architect.
(If the 'Open Project' dialog displays, click on the
Cancel button to open with no project loaded.)

2 Select the 'Configure > Model > Transfer > Project
Transfer' ribbon option.
The 'Project Transfer' dialog displays.

3 In the 'Transfer Type' panel, select '.EAP to DBMS'.
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4 In the 'Source Project' field, type the name of the
project file to copy to the repository.
If the .EAP file has Replication enabled, this must be
removed before performing the transfer.

5 At the right of the 'Target Project' field, click on the
 button.

The 'Datalink Properties' dialog displays.

6 Select 'Microsoft OLE DB Provider for ODBC
Drivers' from the list.
Click on the Next button.

7 In the 'Use Data source name' field, click on the
drop-down arrow and select the ODBC Data Source
you configured to point to your new database.
Click on the OK button. The 'Project Transfer' dialog
redisplays.

8 If required, select the 'Logfile' checkbox and type a
path and filename for the data transfer log file.

9 Click on the Transfer button to begin the data
transfer process.

10 When the process is complete, you have created a
project on an ASA database and can now connect to
it and open it from Enterprise Architect.
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Create an Adaptive Server Anywhere
Repository

Creating an ASA database is fully documented in the
product information provided with your ASA installer.

Having created your ASA database, use the SQL script
(ASA_EASchema.sql) provided by Sparx Systems to create
the required table definitions for Enterprise Architect. You
can obtain the scripts from the Sparx Systems website, on
the:

Registered Corporate edition 'Resources' page (Registered·

users)

Corporate edition 'Resources' page (Trial users)·

Third Party Tools

If you are unfamiliar with ASA and DBMS systems in
general, you might want to consider a suitable front end
tool. Sybase Central is one such tool, that can be installed
along with the DBMS. It provides a convenient graphical
user interface to enable creation of databases, execution of
scripts and restores.

After creating an ASA data repository in Enterprise
Architect, you must set up the ASA ODBC driver.
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Notes

This feature is available in the Corporate, Unified and·

Ultimate editions

Ensure that the collation is set to the alphabet you use,·

such as Latin or Cyrillic
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Set up an ASA ODBC Driver

After you have created a Sybase ASA database, you will
need to set up an ODBC DSN to the new database in order
for Enterprise Architect to connect to it.

Prerequisites

Install:

Adaptive Server Anywhere - SQL Anywhere Studio 8 or·

higher, and create a repository

ASA ODBC driver software (installed with the ASA·

DBMS)

Set up the ODBC Driver

Your ASA driver is now available to connect to the
repository from Enterprise Architect.

Ste
p

Action

1 Under both 32-bit and 64-bit operating systems,
Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can
quickly load the correct 32-bit ODBC Data Source
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Administrator by selecting the 'Configure > User
Tools > ODBC Data Sources' ribbon option.
The ODBC Data Source Administrator window
displays.

2 Click on the Add button.
The 'Create New Data Source' dialog displays,
enabling you to add a new DSN.

3 Select 'Adaptive Server Anywhere' or 'SQL
Anywhere' from the list.

4 Click on the Finish button.
The 'ASA Connector/ODBC' dialog displays.

5 Enter these configuration details:
A data source name for the connection, on the·

'ODBC' tab
User name and password on the 'Login' tab (dba,·

sql are the defaults when ASA is installed)
The server name and the path to the database, on·

the 'Database' tab
The network protocol on the 'Network' tab (if the·

database is on a network location)

6 Return to the 'ODBC' tab and click on the Test
Connection button to confirm that the details are
correct.
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7 If the test succeeds, click on the OK button to
complete the configuration.
If the test does not succeed, review your settings.
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Connect to an ASA Data Repository

To access a project in your Adaptive Server Anywhere
(ASA) data repository, you must connect to the data
repository from Enterprise Architect.

Prerequisites

The ASA repository and the project already exist·

You have SELECT, UPDATE, INSERT and DELETE·

access permissions

The ASA ODBC driver has been set up·

Access

Ribbon : Open Project

Keyboard
Shortcuts

Ctrl+O

Connect to the repository
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Ste
p

Action

1 In the 'Open Project' dialog, select the Connect to
Server button.

2 Click on the  button.
The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC
Drivers' from the list.

4 Click on the Next>> button.
The 'Connection' tab displays.

5 Click on the 'Use data source name' radio button and
on the drop-down arrow in its field.
From the list, select the ODBC driver you have set
up to connect to your ASA repository.

6 Click on the Test Connection button to confirm that
the details are correct.

7 If the test does not succeed, revise your settings.
If the test succeeds, click on the OK button; the
'Connection Name & Type' dialog displays.

8 Give the connection a suitable name so that you can
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recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

9 If required, select the 'Encrypt Connection String'
checkbox.
This encrypts and hides the connection details of the
database from the users that the connection string is
given to.

10 If required, select the 'Lazy Load' checkbox to not
load the full project view when the model is loaded;
instead, only the parts that are necessary to display
the visible portion of the tree are loaded.
With this setting, the model loads faster and users
can begin work sooner, but at the expense of later
small delays as Enterprise Architect loads specific
portions of the model.

11 If required, select the 'Use WAN Optimization'
checkbox.
To improve performance over a Wide Area Network,
remote database calls can be routed through a WAN
Optimizer that compresses the data returned from the
repository, reducing transfer time.
If you select this checkbox, complete the next three
fields (see your administrator for the correct values);
otherwise go to step 15.

In the 'Server' field, type the network name or
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12 address of the optimizer server.

13 In the 'Port' field, type the port on which the server is
running on the remote machine.

14 In the 'DSN' field, type the data source name of the
database as it appears on the remote machine.

15 Click on the OK button to complete the
configuration and open the project.
This also adds the project name to the 'Recent' list on
the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

This feature is available in the Corporate, Unified and·

Ultimate editions
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The WAN Optimizer

You can significantly improve Enterprise Architect's
performance in a Wide Area Network (WAN) by reducing
the amount of data transmitted and, in turn, the number of
network calls made. To achieve this, you can use the Sparx
Systems Wide Area Network (WAN) Optimizer, a
lightweight server installed on a Local Area Network (LAN)
connection to a Database Management System (DBMS) that
hosts an Enterprise Architect repository. You can configure
the server to listen for client connections on a particular
port; it acts as a local proxy to execute queries and return the
results in a compressed format to the client.

In this diagram, transmission between Enterprise Architect
and a DBMS is depicted first without and then with the
WAN Optimizer.
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You can download the WAN Optimizer installer from the
'Downloads' page of the Registered Users section of the
Sparx Systems website. The Wan Optimizer Service
installer package provides two installable features for the
target machine:

WAN Optimizer Service - the installer also helps register·

and start the service on the target machine, and add it to
the Windows Startup folder

WAN Optimizer Admin Client - to enable an·

administrator to administer and configure the service from
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a remote client

The Optimizer has its own Sparx Systems WAN Optimizer
User Guide. See that Guide for more information on:

WAN Optimizer Components·

Installing and Starting the WAN Optimizer Service·

Configuring the Service·

Troubleshooting·

Notes

The WAN optimizer forms the basis for the Sparx·

Systems Cloud Services, which in turn is the core of the
Sparx Systems Pro Cloud Server

Both of these facilities provide the basic function of the
WAN Optimizer, but do so faster and more securely; they
also have many more additional features

Whilst you can still use the WAN Optimizer as described
here, we recommend that you review the Cloud Services
products and use one of them instead
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Cloud Based Repositories

With a simple connection to the internet or web - the 'Cloud'
- you can access and work on projects stored in repositories
at remote locations anywhere in the world, or access local
repositories from such locations, using the Enterprise
Architect installation on your machine. The advantages of
working in this way include:

You, as a user, do not need to have database drivers·

installed on your machine or to create a database
connection, as you do to work directly on projects held on
a DBMS server; your system administrator performs the
driver set-up and connection once only, during server
configuration

The http and, especially, https connections apply a·

firewall and all the security facilities provided by the web
server - whether Apache or IIS - to your project work,
such as URL authorization, domain authentication and IP
security
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The Cloud Server can be configured to encrypt all·

communications using standard TLS/SSL protocols; you
can be certain that your data is not intercepted during
transmission across insecure networks

Using the Cloud can help to reduce lag time for common
tasks such as opening Packages and editing model data.
Requests are cached and sent together, rather than
individually, which minimizes communication delays.

Using the Cloud server is most beneficial when:

You and other users want to minimize the set-up·

requirements each user has on their workstation

You want to expose models held outside your private·

network

You and other users are accessing your models over slow·

connections

Notes

This facility is integrated with the Professional,·

Corporate, Unified and Ultimate editions of Enterprise
Architect

An enhanced version of Cloud Services, called Pro Cloud·

Server, is available for purchase under a separate license;
this version supports the WebEA facility, in which users
can review models through a web browser on various
portable devices, without the need for an Enterprise
Architect workstation client
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Introducing Cloud Services

The Sparx Systems Cloud Services solution provides
seamless access to Enterprise Architect models in
repositories held anywhere in the world, providing high
performance for remote access, secure encrypted links and
optimization for high latency WAN connections.

Cloud-based repositories provide easy access to models, not
only for people within your local team but also for remote
team members, external customers and consultants with
Internet access, anywhere around the world. Collaborative
and distributive modeling and design are dramatically
enhanced by using a Cloud-based repository, which can
provide the shared backbone for a wealth of development
scenarios.

This section will:

Familiarize you with the concepts of the Cloud Services1.

Discuss considerations of when and where you should use2.
a Cloud server

Walk you through the process of setting up a server3.

Walk you through the process of connecting for the first4.
time

Highlight some of the additional functionality available5.
through the Cloud server

Outline working with Active Directory using IIS6.
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Overview

Enterprise Architect models are stored in databases, such as
MySQL, SQL Server and Oracle. Traditional installations of
Enterprise Architect require each user to install the
appropriate drivers for each DBMS, and in some cases
define an ODBC DSN with the database connection details.

When connecting to a Cloud Server, the procedure for a user
to connect to a model is dramatically simplified. For users
connecting to models stored in a Cloud Server, the process
is as simple as entering a single URL to the provided Cloud
repository. No special drivers or further configuration is
required.

Connecting to a Cloud Server provides a number of key
benefits:

Improved performance for models used for distributed1.
development. The Cloud Server provides benefits to
connections that involve high latency and reduced data
transfer speeds.

The process of setting up drivers and connections is2.
performed once by an administrator during the server
configuration. The only set-up required on a user machine
is to install Enterprise Architect and to connect to a model
on the Cloud server.

Database servers no longer have to be exposed through a3.
firewall; the Cloud server can be run from inside the
corporate firewall. All model connections are created
using HTTP, allowing firewalls to completely isolate your
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database server.

A Cloud server can be configured to encrypt all4.
communication. Using standard TLS/SSL protocols, you
can be confident that your data is not intercepted during
transmission on insecure networks.

A Cloud server can be configured to provide HTTP-level5.
authorization to any model taken directly from the model
user list. Even when the model is exposed on a public
network, you can be assured that only authorized users are
able to access your model.

A Cloud server can be configured to provide read-only6.
access to any model; for example, for clients required to
review a model.

Security Considerations

The Sparx Systems Cloud Service runs as a Windows
Service, accepting network connections from Enterprise
Architect clients and sending the data required by the
system back over the network. As with any web connected
service, there are security concerns that must be addressed
when setting up a new service. To help you minimize risks,
consider these points:

If any data is considered private, always use an HTTPS·

connection and require user authentication; there is an
option on each of the service's database configurations to
prompt for this
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There is an implicit trust in sharing a model with anyone;·

security is available in models, which prevents a wide
range of possible interactions, but with Enterprise
Architect's flexibility determined users can circumvent
this

In particular, Model Search SQL queries can be run in a
number of places that allow data to be read that would not
otherwise be accessible, including user IDs and hashes of
their passwords; to block this type of access for a list of
users, you could use Global Authentication instead of
Model Authentication, as discussed in the Cloud Server
Configuration Help topic

Cloud Services Products

Sparx Systems offer three configurations of their Cloud
Services product.

Product Description

Cloud
Services

The core Cloud Services product.
Allows you to host an unlimited number
of Cloud Models, which can be accessed
using a Corporate, Unified or Ultimate
edition of Enterprise Architect.

Pro Cloud A light weight version of the Pro Cloud
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Express Server, specifically aimed at allowing
WebEA access. Offered for free to users
with five or more Enterprise Architect
licenses (Corporate edition or higher) that
are currently in maintenance.
Pro Cloud Express license expiry
matches the maintenance expiry of the
Enterprise Architect licenses.
Features:

The core Cloud Services functionality·

Models can be configured to support·

WebEA access
There is no limit to the number of models
that can have WebEA access enabled;
however, the number of concurrent
WebEA users is limited based on the
number of Pro Cloud Express licenses.

Pro Cloud
Server

A separately purchased and licensed
product.
Features:

The core Cloud Services functionality·

The Sparx Systems Keystore and·

floating license server
Models can be configured to support·

Pro Features (WebEA access,
Row-level security, and OSLC restful
api access)
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The number and type of models that can
be configured to support Pro Features is
limited based on the edition of Pro Cloud
Server; however, there is no limit on the
number of concurrent users who can
access models (either via Enterprise
Architect or WebEA).

Webinar

Before you go on to set up the Cloud Server, Sparx Systems
recommend that you watch the 'Introduction to Sparx
Systems Cloud Services' webinar, which you can access by
clicking on this link:

https://sparxsystems.com/resources/webinar/model-repositor
y/cloud/introduction/introduction-cloud-services.html

You can also watch this second webinar, which
demonstrates setting up a MySQL repository on the Amazon
Web Services (AWS) Cloud using Amazon Relational
Database Services (RDS), and creating and configuring an
Enterprise Architect project in the repository via the Cloud
connection.

https://sparxsystems.com/resources/webinar/partners/cloud-
server/amazon/deploy-enterprise-architect-model-on-amazo
n-cloud-aws.html
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Cloud Server Setup Overview

This is an overview of the typical process for setting up the
Cloud Server.

Typical steps for setting up a Cloud Server

Ste
p

Description

1 Install the Cloud Server.

2 Define the Cloud Service SERVER_PORT and
SERVER_PASSWORD in the
'SSCloudServices.config' file.

3 Restart the Cloud Service.

4 Open the Configuration Client.

5 If you are using the Pro Cloud, add your license key.

6 Define Ports to be used for accessing Cloud Models.

7 Define connections to your repositories.

8 Restart the Cloud Service.
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9 Configure your Firewall.

10 Test access to models via Cloud Connection from
Enterprise Architect.

11 Optionally, if you are using the Pro Cloud Server or
Pro Cloud Server Express you could then configure
Pro features such as WebEA or Integration Plugins.

(c) Sparx Systems 2018 Page  202 of 1073



User Guide - Model Repository 21 December, 2018

Cloud Server Installation

The basic installation process is quite straightforward and
you, as the System or Network Administrator, can install
and/or configure some of the components at a later time,
allowing you to set up your working service in stages.

As outlined in the Introducing Cloud Services topic, there
are 3 different Cloud Services products available. Each of
these products has its own installer. Ensure you use the
appropriate installer based on your requirements and
licence/s:

Installers

Product Access

Sparx
Systems
Cloud
Services
(SparxCloud.
msi)

This installer can be downloaded from
the 'Registered User' section of the Sparx
Systems website:
https://sparxsystems.com.au/registered/in
dex.html#cloud-services

Sparx
Systems Pro

If you have requested and received a Pro
Cloud Server Express license then you
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Cloud Server
Express
(SparxProClo
udExpress.m
si)

will have received an email with a link to
the installer.

Sparx
Systems Pro
Cloud Server
(SparxProClo
ud.msi)

If you have purchased the Pro Cloud
Server you will have received an email
with a link to the installer.

Installation Steps

If you already have the Sparx System WAN optimizer
installed on your server we recommend you remove it
before starting the Cloud Server Installation.

The installer requires you to have Administration rights;
right-click on the installer (msi file), select 'Run as
Administrator', then follow these steps:

Click on the Next button.1.

Select the option to accept the End User Licence2.
Agreement.
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Click on the Next button on that page, and on the next3.
two pages of the dialog, to display the 'Select Features'
page.

For a simple default installation on the one machine, go4.
straight to step 6.

If you want to install only specific components, for5.
example, to have different components on separate
machines, refer to the Cloud Server Components table and
the Installation Options table, then return here to step 6.

Click on the Next button. The system installs the Cloud6.
Services components and displays a message to indicate
success.

Click on the Finish button. Now refer to the Cloud Server7.
Configuration Help topic.

Cloud Server Components

The 'Custom Setup' page lists the various components that
are available in the installer. There is some variation to the
component presented depending on which product/edition of
the Pro Cloud Server is being installed.

For example the Pro Cloud Server Express will present:

     All Features

        + Pro Cloud Services

        + Management Client

        + WebEA
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        - IIS Integration

While the "Pro Cloud Server" will present:

      All Features

        + Pro Cloud Services

        + Management Client

        + WebEA

        + Integration Plugins

        + Visibility Levels

        - IIS Integration

Each component can be controlled separately by clicking the
small image in front of the component name and selecting
the option you require.

Component Description

Cloud
Services

This component is the Windows service
that will accept connections from
Enterprise Architect and the
configuration client. For Pro Cloud
Server, this includes the Sparx Systems
Floating License Server. The default
option is to install this component.
Generally, the only time you would
choose not to install this component is
when you have already installed it on one
machine and are now installing other
components on a different machine.
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Management
Client

When the Management Client component
is selected the Cloud Configuration
Client application will be installed, which
supports the execution of management
tasks, including:
- setting which databases a Cloud Service
can connect to
- configuring those database connections
- configuring what HTTP/HTTPS ports
the Cloud Service will listen on
- configuring various server options
The default option is to install the
component; Sparx Systems recommends
that the Configuration Client should be
installed whenever the Cloud Service is
installed.

WebEA (For a Pro Cloud or Pro Cloud Express
Installation); this component installs the
WebEA application files (PHP, CSS and
JavaScript) that enable a web user to
view an Enterprise Architect model on a
mobile, android or remote desktop
machine without having to install
Enterprise Architect on that device.
The default option is to install this
component; you can unselect this
component if you do not plan to use
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WebEA.

Integration
Plugins

(For a Pro Cloud installation) Integration
Plugins or Server Based Plugin Interface
(SBPI); this component installs the SBPI
Server and the SBPI Plugins that allow
the Pro Cloud Server to read data from
external products such as Dropbox, Jira
and Team Foundation Server.
The default option is to install this
component; you can unselect the
component if you do not plan to link your
Enterprise Architect models to external
products.

Visibility
Levels

(For a Pro Cloud installation) Visibility
Levels; this component installs a set of
SQL scripts to be applied to your MS
SQL Server 2016 + or Oracle based
Enterprise Architect repositories.
The default option is install this
component; you can unselect this
component if you do not plan to use the
Visibility Level functionality.

IIS
Integration

An optional component providing
integration with IIS.
The default option is to not install this
component; however, if your server
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requires advanced authentication methods
available through IIS then this component
should be installed.

Installing New Versions

If you are installing a newer version of the same Cloud
Server product then the new installer will automatically
uninstall the old version; if, however, you are installing a
different product (for example, you previously had Pro
Cloud Express and you are about to install Pro Cloud) then
you need to manually uninstall the original product.

If you choose to perform a re-install, typically it is better to
manually stop the Sparx System Cloud Server service
because the installer might have problems performing this
task and will require the machine to be rebooted after the
installation is finished.

Note: The installer has been designed to not override any
configuration settings of a previous installation.

Steps

1. Run the installer using the earlier installation steps.

2. The installer will have copied the newest version of
WebEA to the location specified during installation; if this
location is not being used by your web server, you need to
manually copy (and override) all WebEA files (except the
includes/webea_config.ini file) from the installation folder
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to the web server folder. See WebEA Note.

WebEA Note: In regard to WebEA, consider the situation
that WebEA was installed to the default location and your
website is being served by Apache in
C:\Xampp\htdocs\webea, this command would perform the
required copy:

    robocopy "C:\Program Files (x86)\Sparx Systems\Cloud
Services\WebEA" "C:\xampp\htdocs\webea" /MIR /e
/DCOPY:T /njh /ndl /nfl /xf webea_config*.ini

Firewall Note: The installer creates a Firewall rule for the
Cloud Service. This rule is removed and re-created during
an upgrade. If you had previously modified this rule then
you will need to apply these changes again after the Cloud
Service installation.
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Cloud Server Configuration

This topic discusses the configuration of the Cloud Server,
whether as the original Sparx Systems Cloud Services or as
a component of the Pro Cloud Server. If you are installing
the Pro Cloud Server, there are several other configuration
files associated with the Floating License Server, WebEA
and Visibility Levels components of the server. The
procedures for editing those files are described in the
separate topics for those features.

The SERVER_PORT and SERVER_PASSWORD need to
be set by directly editing the configuration file
SSCloudServices.config, which is found in your Service
directory. To edit the configuration file, open it in a text
editor (using the 'Run as administrator' option).

A number of additional general options can be defined in the
config file as described below, however these can typically
be left with their default values.

After defining the Server Port/Password, you can open the
Cloud Services Configuration Client and configure Ports
and Model/Database connections.

Note: It is important to realize that the Cloud Service only
reads the configuration file once, when it starts up. If you
manually change the options in the configuration file then
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the Cloud Service must be restarted.

Configuration Client Connection Settings

Normally the first settings you will see in the configuration
file are to control how the Configuration Client will connect
to the server. The default values are:

    SERVER_PORT=803

    SERVER_PASSWORD=

Use of the Configuration Client is discussed in the Cloud
Services Configuration Client topic.

Setting Description

SERVER_P
ASSWORD

SERVER_PASSWORD is the password
to protect the administration functions of
the server.
Note: This can be changed within the
Configuration Client, which means a full
server restart will not be necessary.

SERVER_P
ORT

SERVER_PORT is used when you
connect to the Configuration Client or opt
to use the IIS integration instead of the
integrated web-server. For more detail
see the Cloud Server Using IIS Help
topic.
Note: When changing this, check firewall
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settings and other services using the port.
Additionally, when the service is running
on Wine you should not use privileged
ports - those below 1024. Under Wine,
most applications are only able to listen
on ports above 1024.

General Settings

The next list of settings includes the default global settings
across the entire service:

    DBMAN_DEFAULTMAXSIMQUERIES=10

    AUDIT_TIME_PERIOD=3600

    TEMP_DIRECTORY=%SERVICE_PATH%\Temp

    LOGGING_LEVEL=SYSTEM

    LOGGING_DIRECTORY=%SERVICE_PATH%\Logs

    LOGGING_FILECOUNT=3

    LOGGING_FILESIZE=1048576

Setting Description

DBMAN_DE
FAULTMAX
SIMQUERIE
S

The default for the maximum number of
simultaneous queries that can be run at a
time for any configured database. This
can be changed directly within the
Management Client (see Default Max
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Simultaneous Queries under Global
Server Options in the Cloud Services
Configuration Client topic). There is no
explicit limit for this default value.
Note: As this can be set directly within
the Configuration Client, a full server
restart will not be required if you change
it.

AUDIT_TIM
E_PERIOD

The number of seconds between the
recording activities by system logs on
each database.

TEMP_DIRE
CTORY

The location to write temporary files
before they are sent to clients. You
should not generally have to change this.

LOGGING_
LEVEL

Determines how verbose the server
should be when writing log files. The
valid values are: OFF, FATAL,
WARNING, INFO and SYSTEM. The
value can be changed directly within the
Management Client. (See Log Level
under Global Server Options in the Cloud
Services Configuration Client topic).
Note: As this can be set directly within
the Configuration Client, a full server
restart will not be required if you change
it.
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LOGGING_
DIRECTOR
Y

Defines where the log files are to be
stored. The default is set to:
    =%SERVICE_PATH%\Logs
Note: The =%SERVICE_PATH% refers
to the directory where the Cloud service
is installed.

LOGGING_
FILECOUNT

Determines the maximum number of
rolling log files that should be kept.
When the file count is exceeded, the
oldest file is automatically deleted.

LOGGING_
FILESIZE

Determines the maximum file size of
each log file. When the logging file size
is reached a new log file is created.
For more details on using the logs see the
Cloud Server Troubleshooting topic.

Restarting the Sparx Cloud Service

If you make any changes to the configuration file you must
restart the service for the changes to take effect (unless
otherwise stated). A service restart is carried out in the
Windows Services application.

Depending on the operating system, there are two methods
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for restarting the Cloud Service:

1) Using Windows Services. This is available in all versions
of Windows (see 'Control Panel | Administrative Tools |
Services').

2) Using the Server Manager on Windows Server 2012.

Notes

If you need to assign passwords to user IDs for a model or
models that will be accessed via the Cloud, then:

Open the reference model using a direct connection or via1.
a Cloud connection on a port that does not have either
MODEL_AUTHENTICATION or
GLOBAL_AUTHENTICATION set.

Enable security and assign a new administrator password.2.

Open the Cloud Server Management Client for the new3.
database and set the checkbox 'Require a secure and
authenticated connection'. (Now that you have a valid
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account, this model will no longer be accessible without
https and http level authentication.)

Connect to the model on a port that does have an4.
_AUTHENTICATION setting and use the Maintain
Users procedure to assign passwords to the user IDs in the
model.
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Cloud Services Configuration Client

At any point after installation you can configure the Cloud
Server using the Configuration Client application; the
installer will create a Cloud Services Configuration Client
shortcut on the desktop (this name might vary slightly
depending on which of the Cloud Service Products you
installed).

By default the Configuration Client executable is accessible
from the 'C:\Program Files (x86)\Sparx Systems\Cloud
Services\Client' folder.

The Configuration Client can be used from any machine on
your local network; however, communications between it
and the Cloud Service are not secure, so it should not be
used from outside a secure network.

The Configuration Client is used to configure various
settings related to the Cloud Service and the repositories it
connects to. When the application first starts, a prompt
displays to log into a Cloud Service (see the Cloud Services 
Logon Screen topic for details). Once you have logged in,
the main screen displays.

The Main Screen

This screen shows a list of all defined database managers
and the details of the connected Cloud Service. It is also the
entry point for all management functions; that is, new
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database connections can be created, existing ones edited
and old ones removed.

Sparx Systems Cloud Services support connections to these
DBMS products:

Firebird·

Microsoft SQL Server·

MySQL·

Oracle·

PostgreSQL·

Item Description

Database
Managers

This panel lists the defined repositories
that the Cloud Service managers. Each
database manager definition contains the
details of one database connection and a
number of other properties that control
how the database connection will be
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managed. The most important of these
properties are displayed as columns in
this list:
Columns
Database Manager - the database
connection string of the repository

Alias - a unique name that identifies the
repository. On Enterprise Architect's
'Cloud Connection' screen this is the
value entered into the 'Model Name' field.
An alias can be assigned when a database
manager is defined, if this field is left
blank the Cloud Service will determine
its value.

Connections - the number of active user
connections and the maximum number of
connections possible. Note: typically the
number of active user connections is
zero, since they are only considered
'active' while a request is being
processed, as soon as the data is returned
to the client the connection is set to
inactive. The number of connections is
only refreshed when either the Refresh
button is pressed or a change is made to a
database manager's definition.
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Enabled - a flag to indicate if the database
manager accepts requests from clients

R/O - a flag to indicate if the database
manager has been configured as
Read-Only

SSL - a flag to indicate if the database
manager has been configured to only
allow secure connections

Pro - a flag to indicates if 'Pro features'
has been enabled for the repository, this
is controlled by the 'Enable Pro Features
(OSLC, WebEA and Integration)' option
on the Configure Database Manager
screen.

Ports This panel allows you to view and
configure Ports which the Cloud Service
will use for accessing Models.

Integration Only available when using the Pro Cloud
Server. This panel allows you to
configure Cloud Models to use
Integration Plugins.
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Server
Properties

The properties on the right hand side
specify the details of the connected Cloud
Service.
Main Properties

Server name - the server name hosting·

the currently connected Cloud Service
Configuration port - the port the Cloud·

Client is using for communication with
the Cloud Service
Protocol version - an internal version·

number that identifies the message
version level the current Cloud service
supports
Edition - the edition of the Cloud·

Service
Expiry - the expiry date for the current·

license
The Edition and Expiry apply to Pro
Cloud licenses. If no license has been
added, or the license is invalid, or it has
expired, then the Edition will display
'Free' and the Expiry 'Never'

Extended
Properties

Click on this button to display the screen
that shows all extended properties for the
connected Cloud Server. A number of
these extended properties can also be
modified.
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Licensing Only available when using a Pro Cloud
Client. This button allows you to enter
the license for the Pro Cloud Server.

Edit Click on this button to display the dialog
on which you change the settings for the
currently selected database.

Remove Click on this button to permanently delete
the selected database from the Cloud
Server.

Refresh Click on this button to reload the contents
of the 'Database Managers' list.

Add Click on this button to display the dialog
on which you define a new database.
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Cloud Services Logon Screen

The Cloud Services Logon screen is the first to be shown
when launching the Management Client, and at a minimum
requires the address and port of the Cloud Server to connect
to.

Cloud Services Logon

Option Description

Server
Address

The Server Address format is:
    <ServerURI>:<Port>
The server URI can be ‘localhost’, an IP
address, a DNS name or a machine name;
for example, MyWebServer. If you are
working on the web server, 'localhost'
will be sufficient.
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Password Enter the password you defined in
Management Client Connection Settings,
in the Cloud Server Configuration topic.
By default this password is blank; you
can reset it to a new value, as described in
the Help topic Global Server Options.

OK Click on this button to log in to the
Management Client.
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Extended Server Properties

The Extended Server Properties screen displays when you
click on the 'Extended Properties' button on the Main screen.
It helps you to configure the global options applied to the
Cloud Server. Each of these options can also be set in the
configuration file; however, the service does not require a
restart if the options are changed using this screen.

Options

Option Description

Audit Time
Period

Read-only display showing the number of
seconds between audit reports.
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Default Max
Simultaneous
Queries

Provides a default value for the setting of
'Max Simultaneous Queries' when
defining new database managers.

Logging File
Count

Read-only display showing the number of
log files that should be retained. All
logging is written to files named
'SparxCloudServicesLog-X.log' where X
represents the file number.
File 'SparxCloudServicesLog-1.log' is
always the current file. When the
maximum file size is reached, all existing
files are renamed by incrementing the file
number and a new
'SparxCloudServicesLog-1.log' created.

Logging File
Size

Read-only display showing the maximum
file size of each log file. When the file
reaches this maximum, a new file is
created.

Log Level Click on the drop-down arrow and select
the level of information to be written to
the log file. The valid options are:
 OFF - No logging is performed
 FATAL - Only fatal errors are logged
 WARNING - Warning are logged
 INFO - Information messages that
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provide general message advising what
actions are occurring
 SYSTEM - More detailed messages
Log Levels are cumulative, therefore
each level includes its own level
messages as well of those that are
considered 'higher' levels. For example
the INFO level includes all messages of
type FATAL, WARNING and INFO

Logging
Directory

Read-only display showing the physical
directory into which the log files are
saved.

License Store Displayed when using the Pro Cloud
Server. Displays the path of the license
store file, by default this is C:\Program
Files (x86)\Sparx Systems\Cloud
Services\Service\sskeys.dat

Temp
Directory

Read-only display showing the physical
path of the temp directory, by default this
is C:\Program Files (x86)\Sparx
Systems\Cloud Services\Service\Temp.

Set New
Password

Select this checkbox to set/change the
administrator password for the currently
connected Cloud Server. If a Password is
set then all users attempting to use the
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Cloud Configuration Client will be
required to provide the specified
password.
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License Screen

The 'License' screen displays whenever you click on the
Licensing button on the Main screen. It allows the user to
quickly and easily see what Pro Cloud Server licenses have
been defined, and the complete details of each license.

Note: The 'License' screen is only available in the Pro Cloud
Server and Pro Cloud Server Express builds of the Sparx
Systems Cloud Server.

On a new installation, when the 'License' screen is first
shown it should look resemble this:

However, over time as your Pro Cloud Licenses expire you
will be able to see a complete history of all licenses:
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If there are multiple licenses defined, the Pro Cloud Server
will determine the 'best' one, or the one with the latest
expiry date when licenses are for the same Product. Any
license shown with 'True' in the 'Active' column is a license
currently being used. In the example, none of the licenses
are shown as 'Active' since they have all expired.

Add a new License

Click on the Add.. button and you will be prompted for the
complete license key (including the { and }),

Enter the License key provided and click OK. If the entered
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value is a valid Pro Cloud Server license for the current
edition then the License is added to the list of allocated
licenses.

Note: After adding a License to the Pro Cloud Server the
Cloud Service should be manually restarted in order for all
components to detect the change in license details and
potentially start additional components enabled by the new
license.

Remove a License

At any time it is possible to remove an existing license
simply by selecting the license in the list and pressing the
Remove button. The list of allocated licenses will be
refreshed accordingly.

Note: After removing a License from the Pro Cloud Server
the Cloud Service should be manually restarted in order for
all components to detect the change in license details and
potentially start/stop components enabled or disabled by the
removal of the license.
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Add Database Manager

The Add Database Manager screen displays when you click
on the Add button on the 'Sparx Systems Cloud Services
Configuration Client' dialog; it helps you to define a new
database connection to either a local Firebird repository or a
DBMS repository (via ODBC or OLE/DB).

This note is shown on the Add Database Manager screen:

'Note: The Data Source Names and network paths provided
by the Data Link Properties and ODBC Data Sources
dialogs are relative to this machine and may need to be
modified to match those on the server.'

This means if the Cloud Services Client application is
running from a remote machine (that is, not the machine
running the Cloud Server) the screens that are shown by
clicking on the  button and ODBC Data Sources button
are relative to the current machine and not the Cloud Server
machine, so care should be taken.

By default and as a safety precaution, whenever a new
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Database is defined it is automatically configured to be
disabled. You can enable the database during definition by
selecting the 'Enabled' checkbox on the Configure Database
Manager screen.

Adding New Databases

It is important to note that the Cloud Server uniquely
identifies Databases by a single identifying value; this value
is referred to as the database 'Alias'.

When adding a new database manager, the Alias can be
specified using the 'Alias' field on the 'Add Database
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Manager' dialog.

If no Alias is specified, then a default Alias is determined.
For:

Firebird definitions, the 'Alias' is the filename minus the·

extension

ODBC based definitions, the 'Alias' is the 'Data Source'·

Oracle OLE DB based definitions, the 'Alias' is the 'net·

service name'

SQLServer OLE DB based definitions, the 'Alias' is the·

'Initial Catalog'

Therefore, take care when defining database connections, to
ensure that you do not create duplicate database aliases.
However, if two or more database definitions do share the
same alias then all Enterprise Architect clients will connect
to the first database found with the requested alias.

Item Description

Firebird
Database

Sparx Systems, in the 'Introduction to
Sparx Systems Cloud Services' webinar,
demonstrate the Cloud Services with a
Firebird database as it is so easy to set up
and use, and it works extremely well with
Sparx Systems Cloud service technology.
Firebird is a free, open source rational
database that runs on a variety of
platforms. Firebird is very sophisticated
and offers great concurrency, scalability
and performance. It can be used in an
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enterprise setting and has been used in
production systems, under a variety of
names, since 1981.
To discover more about the Firebird
database, please visit this website:

http://www.firebirdsql.org/en/about-firebi
rd/
You can view the webinar by clicking on
this link:

https://sparxsystems.com/resources/webi
nar/model-repository/cloud/introduction/i
ntroduction-cloud-services.html
You can define a connection to a Firebird
database by entering its filename (and
extension) only; for
example,'MyFireBird.feap'.

The Cloud Server assumes all Firebird
databases physically reside under the
directory %SERVICE_PATH%\Models\.
The Cloud Server is, by default, installed
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to the folder of:
    ...\Program Files (x86)\Sparx
Systems\Cloud Services\
In this case all Firebird models will be
located at:
    ...\Program Files (x86)\Sparx
Systems\Cloud Services\Models\

ODBC
Database

You can define a connection to a
database under a DBMS such as MySQL
or PostgreSQL, by specifying the
connection string to the database. If you
are running the Management Client on
the same machine as the server you can:

Click on the  button to open the 'Data1.
Link Properties' dialog to build the
connection string.
Select the provider 'Microsoft OLE DB2.
Provider for ODBC Drivers' and click
on the Next >> button.
Select the pre-defined System DSN3.
from the 'Use data source name' field.
Fill in the user name and password and4.
select the 'Allow saving password'
checkbox.
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Notes:
Define all ODBC DSNs as SYSTEM·

DSNs, because the Cloud Server runs
as a Windows Service and User DSNs
might not be available to the Cloud
Server
The step for filling in the user name·

and password might not be required if
the user name and password have been
saved with the ODBC DSN
The ODBC Data Sources button·

displays the Windows 'ODBC Data
Source Administrator' dialog, which
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you can use to set up a new ODBC
system data source to be listed on the
'Data Link Properties' dialog (if you are
running the administration client on the
same machine as the server); it is
particularly helpful because it shows
the 32-bit ODBC data source list that
matches Enterprise Architect and the
Cloud Services

Oracle
Database (via
OLE DB)

You can define a connection to an Oracle
Database (via OLE/DB) by specifying the
connection string to the database. If you
are running the Management Client on
the same machine as the server you can:

Click on the  button to open the 'Data1.
Link Properties' dialog to build the
connection string.
Select the provider 'Oracle Provider for2.
OLE DB' and click on the Next >>
button.
Type in the name of the 'Data Source';3.
this is the Oracle net service name as
defined in the TNSNAMES.ORA.
Fill in the user name and password and4.
select the 'Allow saving password'
checkbox.
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Note:
The Cloud Server identifies databases·

by the 'Data Source' value and Oracle
OLE DB defines the 'Data Source' as
the net service name, so it is only
possible to access one Oracle
repository per net service name; the
workaround to this limitation is to
define multiple net service names in
TNSNAMES.ORA that differ only by
name

SQLServer Microsoft SQL Server supports two
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Database (via
OLE DB
using SQL
Server
authenticatio
n)

different forms of database
authentication:

Windows NT authentication, and·

SQL Server authentication·

The Cloud Service will work with either,
but SQL Server authentication is easier to
configure.
Prior to defining the Cloud Service
connection, define a SQL Server user
with db_datareader and db_datawriter
roles to the database that will act as the
Enterprise Architect repository.
You can define a connection to a
SQLServer Database by specifying the
connection string to the database. If you
are running the Management Client on
the same machine as the server you can:

Click on the  button to open the 'Data1.
Link Properties' dialog to build the
connection string.
Select 'Microsoft OLE DB Provider for2.
SQL Server' or 'Microsoft OLE DB
Driver for SQL Server' and click on the
Next >> button.
Select or type in the instance of SQL3.
Server.
Select the 'Use a specific user name4.
and password' checkbox and fill in the
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user name and password, then select
the 'Allow saving password' checkbox.
Select the database that is the5.
Enterprise Architect repository in
'Select the database on the server'.

SQLServer
Database (via
OLE DB
using
Windows
authenticatio
n)

Microsoft SQL Server supports two
different forms of database
authentication:

Windows NT authentication and·

SQL Server authentication·

The Cloud Service will work with either,
but Windows authentication requires
some special consideration. The Cloud
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Server runs as a Windows Service, and
by default all Windows Services run as
'Local System Account'; therefore, if
Windows authentication is to be used, the
Sparx Systems Cloud Service should be
configured to run under a predefined
network user (configured with the
Windows Services console) and this
network user must have access rights to
the database (configured with Microsoft
SQL Server Management Studio or
similar).
You can define a connection to a
SQLServer Database by specifying the
connection string to the database. If you
are running the Management Client on
the same machine as the server you can:

Click on the  button to open the 'Data1.
Link Properties' dialog to build the
connection string.
Select the provider 'Microsoft OLE DB2.
Provider for SQL Server' or 'Microsoft
OLE DB Driver for SQL Server' and
click on the Next >> button.
Select or type in the instance of SQL3.
Server.
Select the 'Use Windows NT4.
Integrated security' checkbox.
Select the database that is the5.
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Enterprise Architect repository in
'Select the database on the server'.

Note:
Because the Cloud Service is run under·

a single account, all database access
will be under that account, so it will not
be possible to keep track of what
records are updated in the database by
individual users
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Configure Database Manager

The Configure Database Manager screen is shown when you
click on the Configure button on the 'Sparx Systems Cloud
Services Configuration Client' dialog. It helps you to modify
the various options for the selected Database.

Options

Option Description
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Database
Manager

Read-only display showing the
description of the database as shown in
the 'Database Manager' List. The format
of the description quickly describes the
database, as shown here:
{odbc provider}:{user}@{datasource}

Enabled Select this checkbox to allow the Cloud
service to respond to requests for the
connection.

Alias The database Alias. This is the value all
Enterprise Architect clients will need to
select in the 'Model Name' field of the
'Cloud Connection' screen. If necessary,
you can edit this Alias to enable users to
reference it from Enterprise Architect and
WebEA.

Database
Type

Read-only display showing the DBMS of
the database, such as Firebird, MySQL,
Postgres, SQLSvr or Oracle.

Connection
String

Read-only display showing the
connection string used to connect to the
database.

Max Type in the maximum number of
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Simultaneous
Queries

connections that can be open. You can
use the up/down arrows to adjust this
figure to balance resource usage with
concurrent user performance.
There is no explicit limit for this value,
but the higher the value the more
resources are consumed on your server,
without a matching increase in benefit in
user performance. Connections are held
so briefly that the reduction in user wait
time due to more connections being
opened is not usually noticeable. If you
are reaching the number of connections
you have defined here, increase it by
small increments (units) rather than large
ones (tens).

Minimum
EA Build

Optional. If you want to ensure that all
users of the model are on an appropriate
build of Enterprise Architect, type in the
lowest build number required.

OSLC
Access Code

Optional. Type in the access code that all
OSLC clients, including WebEA, are
required to send in an HTTP header.
Leave blank to indicate that the OSLC
clients are not required to send an access
code.
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Require a
secure and
authenticated
connection

Select this checkbox to ensure this
database is only used by https
connections using http authentication.

Read-only
connection

Select this checkbox to prevent users
from modifying the database referenced
by this connection.

Enable Pro
Features
(OSLC,
WebEA and
Integration)

This option is only available in Pro Cloud
Server editions. A checked state indicates
that the current model has 'Pro Features'
enabled, which includes OSLC, WebEA
and Integration to external systems.
If this option is disabled then the reason
for disabling it will be shown in the text.
For example:
Free Edition - The 'Free' version of the
Cloud Server does not support Pro
Features
No License - There is no license defined
or the license has expired
Not Firebird - The 'Small' edition of the
Pro Cloud Server only allows Firebird
models to be configured as Pro-enabled,
and the current model is not a Firebird
model
Model Limit Reached - Both the 'Small'
and 'Team' editions of the Pro Cloud
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Server are limited to a certain number of
models that can be Pro-enabled; this
reason code implies the maximum
number of models has already been
Pro-enabled

Run
Scheduled
Tasks

When this option is checked the Cloud
Service will update Time Series charts in
the current model as a schedule task.

Periodically
Generate
Diagram
Images for
WebEA &
Prolaborate

This option is only available in Pro Cloud
Server editions and when the given
Database Manager has Pro Features
enabled. When this option is checked the
Pro Cloud Server will start the Enterprise
Architect Worker process for the current
model, so that all modified Diagram
Images and Linked Documents are
generated at a regular interval. Once
checked the 'Configure...' button becomes
enabled which when clicked opens the
'Configure Worker' screen. This screen
allows you to define the interval (in
seconds) the EAWorker will wait
inbetween generation 'runs'.

OK Click on this button to save the settings
and close the dialog.
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Port Configuration

When setting up the Cloud Service you will need to define
at least one Port which will be used for communication
between the Cloud Service and Enterprise Architect when
accessing a Cloud Model.

Ports can be configured via the Ports tab in the Cloud
Configuration client.

The Ports Tab

The 'Ports' tab provides information and a number of
options:

Item Description

Port List The main area of the Ports tab provides a
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list of the existing Port definitions.
These Port settings are also covered in
more detail in the Add a Port Definition
topic.

Columns

Port - The Port Number

Require SSL - When True, models can
only be accessed on this port via the
HTTPS protocol

OSLC Supported - Displays True if
OSLC support is enabled for this port.
OSLC Support is required for WebEA
access.

Default Model - If the port is configured
to open a specific default model, it's name
is displayed

Authentication - Indicates what type of
Authentication is required (if any).

Resource
Monitor

Located in the lower left of the Ports Tab,
this button can be used to open the
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Windows Resource Monitor. This allows
you to check which Ports are already in
use before adding a new Port Definition.
Please note: this will open the Windows
Resource Monitor for the current
machine, which is only relevant if the
Configuration Client is running on the
machine hosting the Cloud Server.

Add Click on this button to add a new Port
Definition.

Edit Click on this button to edit the
configuration of the selected Port. Editing
a Port provides the same options as when
adding a new one, however the Port
number cannot be changed.

Remove Click on this button to permanently delete
the selected Port Configuration
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Add a Port Definition

As mentioned in the Port Configuration topic, when setting
up the Cloud Server you will need to define at least one Port
for communication between the Cloud Service and
Enterprise Architect.

To add a new Port Definition:

1) Open the Cloud Services Configuration Client.

2) Select the Ports tab.

3) Click on the Add button.

4) The Add TCP Port dialog will be display. Referring to the
table below, enter the Port details, then Click OK.

5) Confirm that your Firewall Settings are correct.

6) Restart the Cloud Service so that the changes take effect.
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Add TCP Port

Field Description

Server Port Enter the Port number to be used for
Cloud Connections.
Each defined Port must be unique and not
used by any other service or application
on the current machine. The standard
HTTP Port (80) and HTTPS Port (443)
are no different; if they are available, the
Cloud Service can be configured to use
them. You can use the Windows
Resource Monitor (which is accessibly
via an icon on the Configuration Client
'Ports' tab) to check which Ports are
already in use.
Firewall Note: When changing or adding
a new Port, check that incoming requests
are allowed by the firewall settings at
both the local machine and network
levels.
Wine Note: When the service is running
on Wine you should not use privileged
Ports - those below 1024; under Wine,
most applications are only able to listen
on ports above 1024.
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Requires SSL Enabling this option will require all
connections on this port to use the
HTTPS protocol.
When you enable this option, a file
named server.pem, must also exist in the
same directory as the configuration file,
and it must contain a valid private key /
certificate. For more details on
server.pem see the SSL Certificates
section.

OSLC
Supported

Enable this option to allow OSLC access
to Models.
Note, WebEA makes use of OSLC. If
you intend to access Models via WebEA
then this option should be enabled.

Default
Model

Optionally, enter the name of a default
model which will be used by OSLC.
Typically OSLC URL's include the
model name. If a default model has been
specified then the model name can be
omitted from the URL.

Authenticatio
n

Select the type of authentication that will
be required for this Port:
Model - All model connections that use
the current port will be forced to request
HTTP authorization using the user
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security defined in the Enterprise
Architect model being connected to.
Passwords must be explicitly and
individually assigned in that model using
the Maintain Users procedure; the default
administrator password and any
passwords imported from Windows
Active Directory do not work. Note that
if you are not using SSL to connect, the
usernames and passwords will be sent in
plain text.
If the model does not have security
enabled, the Cloud user is not prompted
for a password.

Global - Selecting this option displays an
additional Global Model field. In this
field enter the name of a model which
will be used to provide the security
profile to all connections opened with the
current port. This is helpful if you want to
provide multiple models but only manage
one list of users. Passwords must be
explicitly and individually assigned in the
reference model using the Maintain
Users procedure; the default
administrator password and any
passwords imported from Windows
Active Directory do not work.
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SSL Certificates

In order for the Cloud Service's internal Web Server to start
a port using SSL, two individual files, cacert.pem and
server.pem are required in the same folder as the Cloud
Services configuration file.

cacert.pem - contains a collection of trusted certificates·
(in .X509 format); that is, CA certificates

server.pem - contains a certificate and private key (in·
.X509 format) for your server

Sparx Systems do not supply a server.pem, because
typically SSL certificates have to include the current server's
details as well as individual details about your organization.
Although this is an additional step, it is a particularly good
idea to apply it if you are providing access to external users.
Creating and signing a SSL certificate for your Cloud Server
should be performed using an appropriate certificate
authority (CA).

However, to help with initial setup and testing purposes, or
for setups that are entirely within a closed network, you can
generate your own self-signed certificate.

In general, self-signed certificates are not trusted by major
browsers or operating systems and will generate errors or
warnings visible to end users. See the Self-Signed SSL 
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Certificates section on how to create a self-signed
certificate.

To add trust to a self-signed certificate when it is not
practical to generate globally trusted certificates, see Add 
Trust with a Certificate Authority (CA).

Note: If the Cloud Service is started without a valid
server.pem file and a port is defined with REQUIRE_SSL=1
then the internal web server will not be able to open the
port. If this situation occurs, error messages to this effect
will be written to the .LOG file.

Advanced Port Configuration

Optionally, Ports can also be configured by directly editing
the Cloud Server's configuration file
(SSCloudServices.config). This allows some additional
settings which are not available in the Cloud Configuration
Client.

The definition of a Port is denoted in the configuration file,
with open and close parentheses, each on their own lines
without any leading whitespace. Inside the parentheses
contain a number of supporting options that control and
limit how the port can be used. All options except
SERVER_PORT are optional.

    (
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    SERVER_PORT=804

    REQUIRE_SSL=0

    OSLC_SUPPORT=1

    DEFAULT_MODEL=

    MODEL_AUTHENTICATION=

    GLOBAL_AUTHENTICATION=user model

    EA_MINIMUM_BUILD=

    EA_MAXIMUM_BUILD=

    )

Settings Explained

Setting Description

SERVER_P
ORT

This option expects a numeric value
(whole number) that defines a Port
number; there is no default value.
For example, SERVER_PORT=804
states that the Cloud Service will listen to
HTTP connections on port 804. Each
defined port must be unique and not used
by any other service or application on the
current machine. The standard HTTP port
(80) and HTTPS port (443) are no
different, if they are available the Cloud
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Service can be configured to use them.
Firewall Note: When changing or adding
a new port, check that incoming requests
are allowed by the firewall settings at
both the local machine and network
levels.
Wine Note: When the service is running
on Wine you should not use privileged
ports - those below 1024. Under Wine,
most applications are only able to listen
on ports above 1024.

REQUIRE_S
SL

This option expects either a value of 0 or
1; the default is 0.
A value of 1 will enforce the use of SSL
on the current port; that is, all
connections must be performed using
HTTPS, which is useful when
connections need to be exposed on public
networks.
In order for the Cloud Service to be able
to successfully configure ports as
REQUIRE_SSL=1, a file called
server.pem must exist in the same
directory as the configuration file, and
contain a valid private key / certificate.
For more details on server.pem see the
SSL Certificates section.
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OSLC_SUPP
ORT

This option expects either a value of 0 or
1, the default is 1.
A value of 1 defines that connections that
use the current port will be able to
perform queries using the 'Open Services
for Lifecycle Collaboration' standard.
This is discussed further in the OSLC
Requirements Management topic.

DEFAULT_
MODEL

This option expects the alias of a defined
database manager, or blank, the default is
blank.
By defining a value for this option allows
a single model to be exposed on a port,
making it possible to use a different port
for each model. Model names are
discussed further in the Connecting
Enterprise Architect to a Cloud Server
topic.

MODEL_AU
THENTICA
TION

This option expects either a value of 0 or
1, the default is 0.
By defining this option as 1, all model
connections that use the current port will
be forced to request HTTP authorization
using the user security defined in the
Enterprise Architect model being
connected to. Passwords must be
explicitly and individually assigned in
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that model using the Maintain Users
procedure; the default administrator
password and any passwords imported
from Windows Active Directory do not
work. Note that if you are not using SSL
to connect, the usernames and passwords
will be sent in plain text.
If the model does not have security
enabled, the Cloud user is not prompted
for a password.
This option is mutually exclusive with
GLOBAL_AUTHENTICATION.

GLOBAL_A
UTHENTIC
ATION

This option expects the alias of a defined
database manager, or blank, the default is
blank.
By defining this option a single
Enterprise Architect model with security
enabled can be used to provide the
security profile to all connections opened
with the current port. This is helpful if
you want to provide multiple models but
only manage one list of users. Passwords
must be explicitly and individually
assigned in the reference model using the
Maintain Users procedure; the default
administrator password and any
passwords imported from Windows
Active Directory do not work.
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This option is mutually exclusive with
MODEL_AUTHENTICATION.

EA_MINIM
UM_BUILD

This option expects a numeric value that
represents the minimum Enterprise
Architect version that can connect to
models using this port. The default is
undefined which implies all versions are
allowed.

EA_MAXIM
UM_BUILD

This option expects a numeric value that
represents the maximum Enterprise
Architect version that can connect to
models using this port. The default is
undefined which implies all versions are
allowed.
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Advanced SSL

In general, self-signed certificates are not trusted by major
browsers or operating systems and will generate errors or
warnings visible to end users. See the Self-Signed SSL 
Certificates section on how to create a self-signed
certificate.

To add trust to a self-signed certificate when it is not
practical to generate globally trusted certificates, see Add 
Trust with a Certificate Authority (CA).
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Add Trust with a Certificate Authority
(CA)

In general, it is preferable to use a certificate that has been
signed by a globally trusted root Certificate Authority (CA).
There are many CAs that are trusted by all major browser
and operating systems that can be used to sign certificates
for use with a https server.

If the system architecture makes using a globally trusted CA
impractical then it is still possible to have client browsers
and operating systems set up to trust a self-signed certificate
and avoid security errors or showing warnings to end users.

One way is to simply add the certificate to the trust store of
the client browser or operating system, however this would
need to be done for each certificate generated. A better
approach is to create your own root Certificate Authority
and use that to sign each server certificate.

To do this, a self-signed SSL certificate needs to be signed
with your own Certificate Authority (CA) certificate and
key. And the clients (browsers, operating systems) need to
be told to trust the CA certificate. The instructions for
adding a CA to a client vary by operating system or browser
used.

Create a Certificate Authority
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There are many ways to create CA certificates, however, the
OpenSSL toolkit is one of the easiest and most
comprehensive. As the name suggests, OpenSSL is an open
source toolkit for SSL/TLS; see the official website for
details. You will need to download and install the OpenSSL
product that suits your environment.

To create a CA there are two steps:

Generate new key and certificate request.1.

Self-sign the request to generate a CA certificate.2.

1. Generate new key and certificate request

This can be done in multiple steps, or generated from an
existing key file, but for simplicity a new key and new
request can be generated in one command. The example
below shows how to create a request for a company named
'My Company'. Change this to something more appropriate
for your organisation:

openssl req -new -sha256 -nodes -newkey rsa:4096 -subj·
'/O=My Company/CN=My Company Internal CA'
-keyout MyCompanyCA.key -out MyCompanyCA.csr

2. Self-sign the request to generate a CA
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certificate

This step self-signs the CA certificate request, and makes
the CA valid for 1 year (-days 365). Change 'MyCompany'
to match the key and csr request generated in the previous
step:

openssl x509 -req -sha256 -in MyCompanyCA.csr·

-signkey MyCompanyCA.key -days 365 -out
MyCompanyCA.crt

Create a server certificate and use the CA to
sign it

Now that the MyCompanyCA.crt is generated, it can be
used to sign your own certificates for a cloud server or
WebEA.

First, similarly to Self-Signed SSL Certificates, create a new
certificate request. The following example creates a new key
and certificate request for a server named
'cloud.mycompany.com':

openssl req -new -nodes -newkey rsa:4096 -subj·

'/CN=cloud.mycompany.com' -keyout
cloud.mycompany.com.key -out
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cloud.mycompany.com.csr

Sign the new certificate request with the CA:

openssl x509 -req -CA MyCompanyCA.crt -CAkey·

MyCompanyCA.key -CAcreateserial -sha256 -days 365
-in cloud.mycompany.com.csr -out
cloud.mycompany.com.crt

The final step for use with a Pro Cloud Server is to
concatenate the key and certificate into a 'server.pem' file:

Windows: copy /b·

cloud.mycompany.com.crt+cloud.mycompany.com.key
server.pem

Linux: cat cloud.mycompany.com.crt·

cloud.mycompany.com.key > server.pem

Allow clients to trust the root CA

The client operating system or browser now needs to have
the CA certificate added to its list of trusted CAs. The
instructions vary by operating system and browser but
instructions for a few major clients are listed below. For all
these steps the 'certificate' referred to is the
'MyCompanyCA.crt' generated in Step 2 above:

Client Instructions
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(Operating
System,
Browser)

Microsoft
Windows

Right click the CA certificate file and
select 'Install Certificate'. Follow the
prompts to add the certificate to the trust
store either for the current user only or all
users of the computer.

Linux -
Ubuntu

Copy CA cetificate to
/usr/local/share/ca-certificates
eg:

sudo cp ~/MyCompanyCA.crt·

/usr/local/share/ca-certificates/

Update certificates with the following
command:

sudo update-ca-certificates·

The output should show something
similar to 'Adding
debian:~/MyCompanyCA.pem'.

If using Wine then close all Wine
programs and restart Wine:

wineserver -k·

See Ubuntu Help for more information.
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Firefox Firefox does not use the operating
systems trust store so the CA needs to be
added manually.
If the certificate has a '.pem' extension,
then the simplest way is to drag-and-drop
the CA certificate file onto Firefox and a
prompt will ask to trust the certificate.
Otherwise, manually add certificates and
manage added certificates through
Firefox's Privacy & Security preferences.
More information can be found on the
Firefox wiki

Chrome/Chro
mium

Chrome & Chromium do not use the
operating system trust store so the CA
needs to be added manually.
Open Settings > Advanced > Manage
Certificates > Authorities, and select
Import.

Internet
Explorer

Internet Explorer uses the Windows trust
store so adding the certificate to
Windows (see above) is sufficient to add
trust to the browser as well.

WebEA WebEA uses php to communicate with a
Pro Cloud model. If the connection
between php and the Pro Cloud uses
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https, then the CA can be added to php's
configuration to allow it to trust the
certificate.
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Self-Signed SSL Certificates

Create a certificate

There are many ways to create SSL certificates; however,
we have found the OpenSSL toolkit to be the easiest and
most comprehensive. As the name suggests, OpenSSL is an
open source toolkit for SSL/TLS; see the official website for
details.

You will need to download and install the OpenSSL product
that suits your environment. For the purpose of this
document OpenSSL was installed into C:\OpenSSL-Win64.
If your OpenSSL is installed into a different directory then
these steps will have to be adjusted to suit.

Create a new command/batch file in·

C:\OpenSSL-Win64\bin\

Open this file and paste these details into it·

     set SRVNAME=localhost

     openssl genrsa -out %SRVNAME%.key 2048

     openssl req -new -x509 -key %SRVNAME%.key -out
%SRVNAME%.cert -days 3650 -subj /CN=%SRVNAME%

     copy /b %SRVNAME%.cert+%SRVNAME%.key
server.pem

Change the value 'localhost' in the first line to suit your·

server's name and save the file
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Run the batch file·

Move the generated 'server.pem' file to the Cloud·

Service's 'Service' folder (that is, C:\Program Files
(x86)\Sparx Systems\Cloud Services\Service\)

In the statements, the 'openssl genrsa' command will use
OpenSSL to generate a new SSL private key, and save it to
'localhost.key'.

The 'openssl req' command will generate a .X509
self-signed certificate using the key generated, specifying
'localhost' as the common name (CN), setting the expiry to
be 10 years from the current date and saving the certificate
as 'localhost.cert'.

The final command simply copies the contents of the
certificate and key files into the new file 'server.pem'.
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Firewall Settings

When setting up a server, you must check that the Firewall
on the server is set to allow the incoming ports for the
database connections that you have created.

For example, in the default SSCloudServices.config
configuration file the ports 804 and 805 and are set as
operative. If you have a firewall you must set these ports as
enabled for inbound traffic.

For information on creating the Inbound Rule to identify the
ports you have specified in the config file (the 'Sparx
Systems Cloud Services' rule in the illustration), see the
Microsoft Windows online topic Create an Inbound Port 
Rule.

Note: A common cause of failure is that other services or
programs are already using the allocated ports. This is
especially likely when using the default http (80) and https
(443) ports. Check that no other services are using the
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allocated ports.
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Using Multiple Configurations

Using Multiple Configurations

The Sparx Systems Cloud Service can be run multiple times
with different configurations by passing these additional
arguments.

Argument Description

--config / -c The argument following this will be
interpreted as the path to the
configuration file to read on startup. This
allows a secondary instance of the Cloud
server to run on a different set of ports,
use an altered logging level or different
directories.
When multiple configurations are being
used, you need to ensure that each
instance reads a configuration file that
specifies different paths. Otherwise only
the first instance will start successfully.
By default this references
SSCloudServices.config in the directory
containing the service executable.

--path / -p The argument following this will be
interpreted as the absolute path to search
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for other resources. Changing this
parameter changes where the
configuration file is read from, along with
all paths in the configuration file that
specify %SERVICE_PATH%. Setting
this to a directory other than the default is
an easy way to separate multiple running
instances of the Cloud service.

--registry / -r The argument following this will be
interpreted as a registry path within
HKEY_LOCAL_MACHINE where the
models the Cloud server provides are
specified. Changing this parameter allows
using different Cloud servers to provide
access to different models.
By default this is Software\Sparx
Systems\SQLBridge.

standalone This argument allows starting the
SSCloudServices.exe as a standalone
executable instead of requiring it to be
launched as a Windows service.
This can be important if Windows
firewall is blocking the service, as it will
prompt to create a firewall exception.

Additionally, Wine by default closes
services automatically when the last user
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process closes, but using the 'standalone'
argument to run the server as an
application will ensure that the service
isn't terminated when no more user
applications are running. Use the
command line:
    wine SSCloudServices.exe standalone
Or, if you are launching from a terminal
and want to close it:
    wine SSCloudServices.exe standalone
& disown    or
    nohup wine SSCloudServices.exe
standalone
(The 'disown' parameter and 'nohup'
command both close the terminal but
ignore the 'hangup' message that would
otherwise disconnect Cloud Services
again.)
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Cloud Service using IIS (Optional)

For most users, the built-in web server provided with the
Cloud Service provides all the functionality they require. It
is also the easiest method to set up and use.

However, the Cloud Service also provides the option of
integrating with Internet Information Services (IIS). This is
recommended only for users for whom the built-in
authentication methods are insufficient, and who want to use
Windows Active Directory or certificate-based
authentication (see the Import User IDs from Active
Directory Help topic). Note that the use of IIS does not
eliminate the login process, and users must still enter their
user IDs and passwords.

To configure IIS to host the Cloud Service, you must first
set the SparxCloudLink.sseap file to refer to the Cloud
Service, and then in Windows open the Internet Information
Services (IIS) Manager and configure it to send requests to
the appropriate module. Depending on your preferences you
can choose either an HTTP Module or an ISAPI module.

Prior to setting up HTTP or ISAPI, these settings must be
made in IIS:

Application Pool settings·

Feature Settings·

For a secure HTTPS setup (optional):

Set up a Certificate·

Set up HTTPS·

(c) Sparx Systems 2018 Page  280 of 1073



User Guide - Model Repository 21 December, 2018

Configuration Settings

Before setting up your HTTP module or ISAPI module, you
must first check that the sscloudservices.config file for the
service is configured as required, and note the port used so
that you can specify it when you go on to set the
SparxCloudLink.sseap file to refer to the Cloud Service.

The directory path containing the ISAPI dll also contains the
SparxCloudLink.sseap configuration file.

The path should resemble this example:

    “C:\Program Files (x86)\Sparx Systems\Cloud
Services\ISAPI”

Edit this file in a text editor, running as an Administrator.

The default contents are:

   [cloud]

   server=localhost

   port=803

server:

The address to look up the machine running the Cloud
Service. In most circumstances it is best to run the HTTP
module and the Cloud Service on the same machine. In this
case, the default value of localhost can be used. If the Cloud
Service is running on a different machine, use the IP address
or server name where the service is running.

port:

The port the Cloud Service is listening on for admin
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requests. By default this takes the value of 803, but this
should be cross-referenced against your service
configuration in the sscloudservices.config file.

Optional settings

These points are optional. For testing purposes you might
prefer to leave these changes until any issues with IIS are
resolved.

In the SSCloudServices.config file, remove all the1.
references to ports other than the administration port
(default 803). In other words, remove the bracketed
entries (…) from the config file.

Save the SSCloudService.config file.2.

Restart the Service.3.

Application Pool Settings

HTTP or ISAPI will require an Application pool that is
32-bit and not managed code. This illustration shows the
settings for 32-bit applications in the IIS Application Pools
Advanced Settings view.

Feature Permissions
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This illustration shows the access path and the 'Default Web
Site | Handler' mappings to permit Script Execution.

Setting up a Certificate

In order to run the HTTPS service you must set up a security
certificate in IIS.

In the IIS Manager:

Under 'Connections', select the root connection (machine1.
name).

Double-click on the 'Server Certificates' icon.2.

Click on 'Create Self Signed Certificate'.3.

Specify a simple, user-friendly name for the certificate.4.
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Setting up HTTPS

To set the bindings through which HTTPS will operate, you
must include a port and a certificate in the site bindings.

In the IIS Manager:

Under 'Connections', select the 'Default Web Site' option·

Under 'Actions' click on the 'Bindings' option·

In the Site Bindings window click on 'Add'·

This will open the Add Site Binding window.
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Set these parameters:

Type: HTTPS·

Port: 443·

SSL Certificate: select the certificate created in Setting up·

a Certificate

HTTP Module

To set up the HTTP module in the Internet Information
Services (IIS) Manager:

In the 'Connections' panel, select the machine properties1.
(top of the tree).

Double-click on the 'Modules' icon in the middle panel.2.
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This returns the 'Modules' list and the 'Actions' view.

In the 'Actions' list, click on the 'Configure Native3.
Modules…' option.

This opens the 'Configure Native Modules' view.

Click on the Register button to open the 'Register Native4.
Module' dialog.

Type in the name and the path of the SSCSIISHttpLink.dll
file.

Click on the OK button. The 'SSCloudServices' checkbox5.
will now be selected.

Click on the OK button to close the 'Configure Native6.
Modules' dialog.

In the 'Connections' panel (see Step 1), click on your web7.
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site.

Double-click on the 'Handler Mappings' in the middle8.
pane.

This opens the Handler Mappings view:

In the 'Actions' list, click on the 'Add Module Mapping'9.
option to open the 'Add Module Mapping' dialog.

As illustrated, set the 'Request path' and 'Name'.10.

In the 'Module' field, click on the drop-down arrow and11.
select the module added in step 4.
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Click on the Request Restrictions button. On the12.
'Request Restrictions' dialog, select the 'Access' tab.
Select the 'Execute' radio button to enable Execute
permission.

Select the 'Mappings' tab and deselect the 'Invoke13.
Handler only if request is mapped to' checkbox.

Click on the OK button.14.

Close the 'Add Module Mapping' dialog by clicking on15.
the OK button again.

To complete this HTTP module set up, see the
Configuration Settings section at the start of this topic. You
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should then be able to connect to a model using Enterprise
Architect via your IIS server using the HTTP module.

ISAPI Module

To configure an ISAPI module instead of the HTTP module:

In the 'Connections' panel, select the machine properties:1.

Double-click on the 'Handler Mappings' icon:2.

In the 'Actions' list, click on the 'Add Module Mapping'3.
option.

In the 'Add Module Mapping' dialog, set 'Request path' to4.
'sparxCloudLink.sseap', 'Module' to 'IsapiModule', and
'Executable' to 'SSCSIISIsapiLink.dll', as shown.
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Click on the OK button to close the dialog. You should5.
now be able to connect to a model using Enterprise
Architect via your IIS server using ISAPI.
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Connecting Enterprise Architect to a
Cloud Service

Once your Cloud Service has been set up with at least one
port listening for communication and at least one model you
can connect to, you can connect to the model in Enterprise
Architect. When you first open Enterprise Architect, the
'Manage Projects' dialog displays. The Connect to Cloud
button on the top right provides access to Cloud
connections.

In later work sessions you can access this dialog and button
by selecting the 'New > Manage projects' option on the Start
Page. However, there is also a Cloud Connection link on the
'Start Page' itself.
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Cloud Connection Dialog

The 'Cloud Connection' dialog prompts you for the details of
the model.

Option Action

Name Type the name to use to refer to this
model. It does not have to match any
values on the server, and will appear in
your recent models list.

Protocol Click on the drop-down arrow and select
a secure (https) or insecure (http)
connection, as supported by the server
you are connecting to. When you select
the protocol, the port will be
automatically set to match the default for
that protocol.

Server Type in the machine name
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(sparxcloud.com) or IP address
(192.168.0.20) of your server.

Port Define the port number the service is
listening on. This should match the
settings in the configuration file on the
server.
Note: For a server, the default settings
will use port 804 for http and port 805 for
https.

Model Name Type in the name of the model available
on the server.
Note: Generally a system administrator
will provide you with a list of available
models. However, for those with
permission to use the Management Client
the model name to access the given
database can be found in the read-only
'Alias' field on the Configure Database
Manager screen in the Cloud Services
Configuration Client application.
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Pro Cloud Server

Sparx Systems Pro Cloud Server is an enhanced, separately
purchased and separately licensed edition of Sparx Systems
Cloud Services. Once the Cloud Service has been installed
and configured, it runs on the installed machine as a
Windows service, listening for requests for data from
Enterprise Architect.

In order to support the new Pro Cloud Server functionality,
the service has these enhancements:

The ability to define individual database managers as·

'Enable Pro Features (OSLC, WebEA and Integration)'

The main screen of the Configuration Client displays the·

Pro Cloud Server's edition, the date it expires and' if
appropriate, the number of WebEA users licensed
(Express edition only)

The ability to define a 'Default Schema' option against·

individual database managers

As well as providing all the features and benefits of Sparx
Systems Cloud Services, the Pro Cloud Server also includes:

The Sparx Systems Floating License Server·

Integration Plugins·

WebEA, a web based application that allows users to view·

and discuss elements in Enterprise Architect models
through a web browser, while on portable devices or
remote desk-top systems

Visibility Levels for Oracle and SQL Server 2016 based·
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models, so that it is possible to restrict the access of a user
or group of users to parts of the model that are only
relevant to them

Prolaborate, a team Sharing and Collaboration Software·

package

Sparx Systems Pro Cloud is available in three premium
editions, to support small, medium and large projects with
differing numbers of models; the editions have the same
installer but the License key determines what functionality
is enabled:

Small Business, which supports up to three Firebird·

repositories; Visibility Levels is not available in this
edition, as the feature is for Oracle and SQL Server
databases

Team Server, which supports up to five repositories of·

any type

Enterprise Server, which supports any number of·

repositories of any type, within any restrictions imposed
by your server and network

Sparx Systems Pro Cloud Express Edition provides WebEA
access for a limited number of concurrent users, based on
the number of licenses.

Installation

The Sparx Systems Pro Cloud Server product is installed
using a standard Windows Installer package. While it is
possible to change the install location of the Pro Cloud
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Server, most users elect to keep the default of C:\Program
Files (x86)\Sparx Systems\Cloud Services\ (assuming a
64bit machine is being used).

The Pro Cloud Server installer consists of multiple optional
components; all but the 'IIS Integration' is installed by
default. The installation supports any number and
combination of components being installed; for example, it
would be possible to run the installer and choose to only
install the 'Management Client', which would useful to users
that require the ability to configure the Pro Cloud Server
from their desktops.  By default each component is installed
into a sub-folder immediately under the installation folder;
however, some of the components allow their folder to be
installed to a different location.

The Pro Cloud Server installation consists of these
components:

Pro Cloud Service - installed in Service folder,·

containing the Windows service and sub-folders for log
files, local models and various driver/supports files

Management Client - installed in Client folder, and will·

contain separate applications to configure the Pro Cloud
Service and the Keystore

WebEA - installed in WebEA folder, and will contain the·

PHP, Javascript and CSS files that make up the WebEA
application; typically the entire contents of this folder
should be copied to a location that is controlled by your
web server

Plugin Interface - installed in the SBPI folder, and will·

contain various executables to support linking elements
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within an Enterprise Architect model to external products

Visibility Levels - installed in the VisibilityLevels folder,·

and will contain the SQL scripts needed to enable (or
disable) visibility levels within Oracle or SQL Server
2016+ models

IIS Integration - installed in the ISAPI folder, and will·

contain the runtime APIs needed by the Cloud Service for
IIS integration

To assist you in performing and understanding the
installation process, watch the Sparx Systems webinar
Installing the Sparx Systems Pro Cloud Server. Click on the
link to access this webinar.

WebEA

One of the most requested features from the Enterprise
Architect user base recently has been the ability to access
Enterprise Architect models on mobile devices or from
desktops without the need to install the Enterprise Architect
application.

Sparx Systems has developed WebEA using PHP,
JavaScript and CSS to provide a solution that can be
deployed easily, that runs on the widest variety of systems,
and that doesn't require any special hardware or additional
licensing.

WebEA has a large array of configuration options that give
the Enterprise Architect customer the power to control
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exactly how each model can be accessed and what types of
actions can be performed.

Plugin Interface

Or Server Based Plugin Interface (SBPI), is a framework
developed to extend the Pro Cloud Server via Plugins. In the
initial release of SBPI, the plugins developed will enable the
Pro Cloud Server to support the ability to link Enterprise
Architect elements to elements/objects defined in external
products and directly view (and potentially update) the
details.

Floating License Server

The Sparx Systems Floating License Server functionality
has been available for many years as the Key Store,
providing users of Enterprise Architect with the ability to
manage their floating licenses. Up until the creation of Pro
Cloud Server, the Key Store was only offered as an
independent Windows service. Now that it has been
integrated into the Pro Cloud Server, users only need to
install, configure and maintain one service for all their
Enterprise Architect needs.
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Visibility Levels

The 'Visibility Levels' feature within Enterprise Architect
gives model managers the ability to restrict access to certain
sections of a model. Only models hosted by a Pro Cloud
Server are able to make use of this feature. Visibility Levels
are implemented by taking advantage of the Row Level
Security feature included in Oracle 8+ and Microsoft SQL
Server 2016 (onwards).

Row Level Security is a security feature that controls which
users can access which rows of data in a database.
Traditional database security only allows for the ability to
control which users have access to read, write or delete data
down to the table level. Since Row Level Security
functionality is implemented by the database, it is
impossible for users to bypass security implemented at the
application level by writing their own scripts or databases
queries. That is, the database ensures that users can only
view and update data they are authorized to access.

Since Row Level Security is functionality implemented by
the database, most of the changes needed for Enterprise
Architect and the Pro Cloud Server to support it are made
directly to the database without needing to change the
application code base, which means there is less to go
wrong from an application point of view.
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Floating License Server

The Sparx Systems Key Store server has been available for
many years, providing users of Enterprise Architect with the
ability to manage their floating licenses. Up until version 2.1
of Pro Cloud Server, Floating License functionality was
only offered as an independent Microsoft Windows service.
Now that it has been integrated into the Pro Cloud Server,
users only need to install, configure and maintain one
Microsoft Windows Service for all their Enterprise
Architect needs.
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Install and Config

The Sparx Systems Pro Cloud Server product is installed
using a standard Microsoft Windows Installer package that
includes a number of components. The Floating License
Server is included in the main 'Pro Cloud Services'
component, and consists of a number of extra files over the
standard Sparx Systems Cloud Service.

It is possible to change the install location of the Cloud
Service; however this document assumes the default install
location of C:\Program Files (x86)\Sparx Systems\Cloud
Services\ (assuming a 64 bit machine is being used).

Important: All communications to the Pro Cloud's Floating
License Server are performed via HTTPS, therefore to use
the Pro Cloud Server's Floating License Server functionality
at least one Port has to be configured to REQUIRE_SSL=1
and a valid certificate/private key file is defined in the Pro
Cloud Server's Services folder. See the Self-Signed
Certificate using OpenSSL section in Port Configuration for
more details.

The main Pro Cloud Server's configuration file
(SSCloudService.config) defines two settings related to the
Floating License Server, FLOATLIC_PATH and
FLOATLIC_CONFIG.

The FLOATLIC_PATH option defines the path and file
name of the Key Store file; by default this is:

    %SERVICE_PATH%\sskeys.dat
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where "%SERVICE_PATH%" is replaced with the physical
path of the 'Services' folder (that is, 'C:\Program Files
(x86)\Sparx Systems\Cloud Services\Service').

The FLOATLIC_CONFIG option defines the path and file
name of the Key Store group file; by default this is:

    %SERVICE_PATH%\ssflsgroup.config

Floating License Server Group Configuration
File

The Pro Cloud Server's Floating License Server component
installs a configuration file called ssflsgroup.config into the
Service folder (C:\Program Files (x86)\Sparx
Systems\Cloud Services\Service\ssflsgroup.config). This
files defines 'groups' of users that can obtain Licenses from
the Floating License Server, and also controls which
Enterprise Architect Product Licenses each group can
utilize.

A group is identified by a group name and a set of
credentials (user ID and password) which will be used to
securely communicate to the Floating License Server over
HTTPS.

The Floating License Server's configuration file will
typically consists of multiple group definitions, each group
definition needs to be defined as shown:

GROUP
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    Name=human_resources

    UserName={user name}

    Password={password}

    IsManager=false

    ENTITLEMENT

        Product=UltimateSuite

                Academic=false

        Limit=10

    END ENTITLEMENT

    ENTITLEMENT

        :

    END ENTITLEMENT

END GROUP

Group Definition Properties

A Group definition begins when the token GROUP is
encountered on a new line, and extends until the token END
GROUP is found on a new line.

Property Description

Name The common name of the Floating
License group.

UserName Required. Specifies the User ID for the
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Floating License Group.

Password Required. Specifies the Password for the
Floating License Group.

StartDate Optional. Used in combination with the
EndDate property to define the date range
that the Group can be used.

EndDate Optional. Used in combination with the
StartDate property to define the date
range that the Group can be used.

Entitlement -
Section

Each Group can define multiple
Entitlements. An Entitlement definition
begins when the token ENTITLEMENT
is encountered on a new line, and extends
until the token END ENTITLEMENT is
found on a new line.
Each Entitlement definition accepts each
of these sub-properties:
   Product={Product Code} - The product
that this entitlement gives grants access to
this group.
   Academic={true or false} - Determines
if this entitlement applies to the academic
edition of the specified Product.
   Limit={number} - Optionally restrict
the number of Product keys available to
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this group.

The valid Product codes are:
Professional·

Corporate·

UnifiedSuite·

UltimateSuite·

EclipseIntegration·

MDGCodeAnalysis·

MDGDDS·

MDGDoors·

MDGLinkEclipse·

MDGLinkVS·

MDGRealTime·

MDGSysML·

MDGTogaf·

MDGUPDM·

MDGZachman·

RaQuest·

TCSEIntegration·

TCSESuite·

VSIntegration·

IsManager Optional. Specifies whether members of
this group are permitted to perform
management operations (such as
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add/remove keys) on the keystore.
Default Value: false

Configuration Changes

Changes to the Pro Cloud Server's Floating License Group
file can be made while the Pro Cloud Server is running,
without the need to restart it. The Floating License Server
component will detects the last modified time, if the
configuration file has changed since it was last read the
entire contents of the file is re-read.
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User Guide

This topic (the Floating License Server User Guide) mainly
describes how to use the Floating License Configuration
Client, a purpose written application which allows
environments that use Enterprise Architect to easily manage
their floating licenses.
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Floating License Configuration Client

Administration of License keys that are stored in the Pro
Cloud Server's Floating License Server are managed by a
Windows application installed in the Client folder
(C:\Program Files (x86)\Sparx Systems\Cloud
Services\Client\SSFloatLicClient.exe).

When the Floating License Configuration Client application
is first started it will attempt to open a connection to the
most recent Floating License Server or KeyStore, if this is
the first time running the Configuration Client, you will be
automatically prompted for the connection details of a
Floating License Server. See Floating License Server 
Connections for more details

(c) Sparx Systems 2018 Page  308 of 1073

http://www.sparxsystems.com/enterprise_architect_user_guide/14.0/keystore_connections.html
http://www.sparxsystems.com/enterprise_architect_user_guide/14.0/keystore_connections.html


User Guide - Model Repository 21 December, 2018

The Floating License Configuration Client application is
capable of performing actions that can be broadly classified
into two different areas. Floating License Server based
actions and Key based actions.

The Floating License Configuration Client is capable of
connecting and administering multiple Floating License
Servers and Shared KeyStores at any given time. The
'Floating License Servers/ Key Stores' list (in the upper left)
will display each store that the Configuration Client has a
connection to.

Floating License Server based Actions

Floating License Server Connections

Set Shared Key Lease Periods

Migrate Shared Keys between Stores

Selecting a connected store from the 'Key Store' list will
enable the user to maintain the keys assigned to that store,
using these functions:

Key based Actions

Add Shared Keys

Release Shared Keys

Delete Shared Keys

(c) Sparx Systems 2018 Page  309 of 1073

http://www.sparxsystems.com/enterprise_architect_user_guide/14.0/keystore_connections.html
http://www.sparxsystems.com/enterprise_architect_user_guide/14.0/set_shared_key_lease_periods.html
http://www.sparxsystems.com/enterprise_architect_user_guide/14.0/migrate_shared_keys_between_stores.html
http://www.sparxsystems.com/enterprise_architect_user_guide/14.0/add_shared_keys.html
http://www.sparxsystems.com/enterprise_architect_user_guide/14.0/release_shared_keys.html
http://www.sparxsystems.com/enterprise_architect_user_guide/14.0/delete_shared_keys.html


User Guide - Model Repository 21 December, 2018

Floating License Server Connections

The top left corner of the 'Floating License Configuration
Client' screen displays a list of connected Floating License
Servers and Shared Keystores. Each entry in the list can be
one of three different types of store:

Floating License Server based (prefix: https://)1.

Shared KeyStore or network based (prefix: ssks://)2.

File based3.

The type of store can be determined by the connection's
prefix (or lack of it); the network and file based keystore
types are historical, from earlier versions of the Floating
License Server.

Floating License Server actions can be performed by
selecting a Floating License Server/KeyStore item in the list
and then selecting a menu item from the 'File' menu, or
simply right-clicking on an item in the list; the menu options
shown are:
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Create...

Selecting the Create... menu option allows for the creation
of a new file based keystore.

Link to...

Selecting the Link to... menu option will prompt the user for
the connection details of a Floating License Server (or key
store) to be added to the list of connected stores.

Unlink
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Selecting the Unlink menu option while a Floating License
Server is selected in the list will release the Floating License
Configuration Client's connection to the store and remove it
from the list.

Delete

Selecting the Delete menu option while a file base Key
Store is selected in the Key Store list will physical and
permanently delete the file used to store the keys. This
option is disabled when the selected Keystore is either a
Floating License Server or shared network KeyStore.

Migrate to...

Selecting the Migrate to... menu option while a file base
Key Store is selected in the Floating License Server / Key
Store list will allow the migration of keys from one store to
another. This option is disabled when the selected store is
either a Floating License Server or shared network KeyStore
based. See Migrate Shared Keys between Stores section for
more details

Options...
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Selecting the Options... menu option will display the
Options screen for the selected Floating License Server. See
Set Shared Key Lease Periods section for more details
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Set Shared Key Lease Periods

Normally in an environment that requires licenses to be
shared, an Enterprise Architect user 'releases' the license
they have 'leased' immediate upon closing the application.
However in an environment where Enterprise Architect
users work offline for periods of time (for example, using
laptops) this type of configuration would not allow an
offline user to open Enterprise Architect once they have
disconnected from the main network.

For this reason a Floating License Server / Key Store can be
configured to have a longer retention period and the 'auto
check on exit' option can be disabled.

To administer the lease period of a Floating License Server /
Key Store, select a store from the list and then select the
'Tools | Options' menu option. The 'Keystore Options' dialog
is then shown.

(Alternatively, you can right-click on the Floating License
Server / Key Store name in the list and select the 'Options...'
context menu item)
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Migrate Shared Keys between Stores

You might want to upgrade from a legacy file or network
based Key Store to a new Pro Cloud Server Floating License
Server. This process effectively removes all keys from the
original keystore, leaving it empty, and places the keys into
the Floating License Server.

To migrate shared keys from other keystores, you will first
need to define a connection to each source keystore, using
the File | Link To menu item. Then making sure the source
keystore is selected in the list, select menu item File |
Migrate to...

The 'Migrate Keystore File' screen will be shown:
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Click on the [ ... ] button on the right of the Destination
field, and browse for the details of the Floating License
Server into which the shared keys are to be transferred.
Click on the OK button to migrate the shared keys from the
source to the destination Floating License Server.
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Add Shared Keys

To add shared keys to a Key Store, select the 'Floating
License Server / Key Store' in the list, and then select 'Key |
Add...' from the main menu.

Alternatively, right-click on 'Keys contained in this store'
list and select 'Add...'.
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Release Shared Keys

It is usually not necessary to manually release a shared key
from a workstation, as this happens automatically if:

The keystore's AutoCheckin option has been enabled and·

you close all running instances of Enterprise Architect on
your workstation

The lease on the key expires.·

However, if further users want to access Enterprise
Architect and there is some technical anomaly that has
prevented the return of a key, you can manually release the
key using the Sparx Systems Floating License Configuration
Client.

To release a key from its active association with a particular
workstation, click on the key in the 'Keys contained in this
store' list, and then select the Key | Release menu item.

(Alternatively, click on the Release Key icon in the toolbar,
or right-click on the key and select the Release context
menu option.)
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Delete Shared Keys

To delete a key from the selected Floating License Server /
Key Store, open the Floating License Configuration Client,
click on the key in the 'Keys contained in this store' list, and
then select the Key | Delete menu option.

(Alternatively, click on the Delete Key icon in the toolbar,
or right-click on the key and select the Delete context menu
option.)
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Troubleshooting

If users experience a problem with the Pro Cloud Server's
Floating License Server the error message will either be
displayed on the screen for Floating License Configuration
Client related errors or written to the Pro Cloud Server's log
file when an error occurs within the Cloud Service. This
topic provides a list of common Floating License related
errors that could occur. Each entry describes the situation
that has occurred and provides guidance on how to correct
the error.

Configuration related Floating License Server
errors

Issue Comments

EA Users are
not able to
connect to a
Floating
License
Group

Enterprise Architect users cannot connect
to a defined Floating License Group,
even when the entered details exactly
match the definition.
Possible reasons:

The Pro Cloud Server configuration·

file does not contain a valid PCS
license key, therefore all Pro Cloud
features will be disabled.
If an entitlement in the Floating·
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License Group file is defined with an
invalid Enterprise Architect product,
the entire Group will be disabled.
Check the Cloud Service's log file for
error messages, the invalid product will
be mentioned by name and line
number.

The Key
Store
connection
screen in EA
does not
include
HTTPS
option

In order for Enterprise Architect to
connect to the Pro Cloud Server's Key
Store, a protocol of HTTPS is required
for secure communications.
Possible reasons:

A version prior to Enterprise Architect·

version 14 is in use

The Key
Store
connection
screen in EA
cannot
perform a
successful
'Test'

Your client is not able to communicate
with a Pro Cloud Server using the
supplied details.
Possible reasons:

Pro Cloud Service is not installed·

Pro Cloud Service is not running·

Pro Cloud Service is not listening on·

the expected port using HTTPS
There is not network connectivity·

between the client and server
A firewall is limiting communications·
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between the client and server

Errors while using Floating License
Configuration Client

Issue Comments

Could not
open
keystore at
[FilePath].
The file does
not exist and
could not be
created

The service was unable to open the key
store file specified by the
FLOATLIC_PATH property in the Cloud
Service configuration file
(SSCloudServices.config).
Ensure that this path exists, and that the
user account the Pro Cloud Server
Windows Service is running under has
the necessary permissions to read and
write to the specified file.

The Floating
License
Configuratio
n Client is
not able to
connect

The machine running the Floating
License Configuration Client is not able
to communicate with a Floating License
Server using the supplied details.
Possible reasons:

Pro Cloud Service is not installed·

Pro Cloud Service is not running·
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Pro Cloud Service is not listening on·

the expected port using HTTPS
There is no network connectivity·

between the client and server
A firewall is limiting communications·

between the client and server
The Pro Cloud Server configuration·

file does not contain a valid PCS
license key, therefore all Pro Cloud
features are disabled, including the
Floating License Server
The entered user credentials do not·

match any of the defined Floating
License Groups in 'ssflsgroup.config'
The user credentials for the entered·

Floating License Group have not been
defined as 'IsManager=true'
If an entitlement in the Floating·

License group file is defined with an
invalid Enterprise Architect product,
the entire Group will be disabled;
check the Cloud Service's log file for
error messages - the invalid product
will be mentioned by name and line
number

Could not
open
keystore, no

No file path was specified in the property
in the configuration file.
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keystore file
specified Type a file path into the

FLOATLIC_PATH configuration
property that the user account the Pro
Cloud Server Windows Service is
running under can read and write to.

Invalid or
missing
keystore file -
Keystore file
cannot be
opened by
this version
of the service
or the file has
been
corrupted

The keystore file specified by the
configuration property
FLOATLIC_PATH is either incompatible
with the current version of the Floating
License Server, or has somehow been
corrupted on the file system.
Restore the key store file specified in the
configuration property
FLOATLIC_PATH from a recent
backup, or contact Sparx Systems
Support for assistance.

Key file has
been moved

The key store file specified by the
configuration property
FLOATLIC_PATH is locked to the serial
number of the hard drive it is created on.
If the key store file is moved from this
hard drive, then other Floating License
Servers are unable to open it.
If the key store file has been moved,
restore the file to its initial location.
Certain RAID configurations can affect
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how the hard drive's serial number is
presented to the Floating License Server.
Thus, it is recommended that you house
the key store file on a non RAID drive,
wherever possible.

Errors while using Enterprise Architect and
the Floating License Server

Issue Comments

Checkout
Failure:
There are no
more
available
keys for this
product in the
key store

Keys for this product exist; however, they
are all checked out to other users.
If this error is frequently reported,
consider limiting the use of the product
across your enterprise or purchasing more
keys to meet the demand for the product.

Checkout
Failure: The
key store
does not
contain any
keys for this

This keystore does not contain keys for
the requested product. Keys for the
product might have been provided by the
keystore in the past, but have since been
removed.
Uninstall the product and return any
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product shared keys on the client machine.

Checkin
Failure: Key
not found in
keystore.

The key being checked in has either been
deleted since it was checked out, or was
checked out from another keystore.
Ensure that users return any shared keys
to the key store they were leased from
before swapping Floating License Servers
/ key stores.
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WebEA

Sparx System's WebEA is an application designed to display
the data from Enterprise Architect models in a web browser,
which means users can review and comment on a model in
real time, on a range of mobile devices or a remote work
station, without needing to install Enterprise Architect.

WebEA is a component of the Sparx Systems Pro Cloud
Server, which is a separately-installed and licensed product,
to complement Enterprise Architect. WebEA makes use of
the PHP, HTML, CSS3 and javascript technologies and
requires a web server (such as Apache or IIS) to host it. The
topics of this chapter explain how to install and configure
WebEA in detail, but if you are interested in getting started
quickly see the WebEA Quick Start Guide for the necessary
steps.

Requirements

Users of WebEA require a HTML5 / CSS3 compatible·

web browser

The WebEA interface requires JavaScript to be enabled in·

the web browser

A client's device will require network connectivity to the·

web server hosting WebEA

Users of WebEA will require this information in order to·

connect to and log into a WebEA model:
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    - The complete URL; that is, machine name/IP number
and optionally the port number and/or the
       path to the WebEA files, depending on how the web
server has been configured
    - The name of the model to access
    - (Optional) an access code necessary to open a model,
if one has been configured
    - (Optional) the user ID and password required to open
a model, if user security has been applied
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WebEA Quick Start Guide

The purpose of the WebEA Quick Start Guide is to provide
the complete process for quickly installing and configuring
WebEA in a new environment using the most common
options.

The process is based on these assumptions:

A clean Windows 7 (or later) based machine has been·

selected to host both the Pro Cloud Server and Web
Server; that is, no other Web Servers or applications are
configured to listen on port 80

The latest version of XAMPP will be used to install·

Apache as the Web Server

WebEA will access one brand new Firebird model·

(because it is the simplest, as it does not require any third
party ODBC drivers)

The Enterprise Architect user base is using Enterprise·

Architect 13.5 or later

1. Download the Pro Cloud Server

Ste
p

Description

1.
1

When you purchase the Sparx Systems Pro Cloud
Server the sales team will send you a link to

(c) Sparx Systems 2018 Page  331 of 1073



User Guide - Model Repository 21 December, 2018

download the installer.

2. Install the Web Server

Ste
p

Description

2.
1

XAMPP is available at
https://www.apachefriends.org/download.html.
Download the latest version for Windows, to the
machine's desktop.

2.
2

The XAMPP installer should be run with
Administration privileges; on the desktop, right-click
on the XAMPP installer icon and select 'Run as
Administrator'.

2.
3

Proceed through the installation process, accepting
the defaults until the Select Components screen
displays.
Deselect these checkboxes: MySQL, FileZilla,
Mercury, Tomcat, Perl, phpMyAdmin, Webalizer
and Fake Sendmail. WebEA only requires the
minimum XAMPP installation of Apache and PHP.
Click on the Next button.
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2.
4

The installation folder should be set to C:\xampp.
Click on the Next button until the installation starts.
When the installation finishes, select the option to
open the Control Panel, then complete the
installation.

3. Configure the Web Server

With the default XAMPP configuration, the default website
will use port 80. Its base folder is C:\xampp\htdocs.

Ste
p

Description

3.
1

Using the XAMPP control panel, start Apache. No
errors should be reported at this stage.

4. Install Pro Cloud Server

Ste
p

Description

4.
1

The Pro Cloud Server installer is a standard MSI;
double-click on it to start the installation.
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Note: Depending on a number of factors, you might
be prompted for the credentials of a user with
elevated permissions; these must be entered before
the installation will continue.

4.
2

The 'Sparx Systems Pro Cloud Services Setup' dialog
displays. Click on the Next button.

4.
3

Read the license agreement and select the checkbox
for indicating that you accept the terms. Click on the
Next button.

4.
4

Read the information about the Pro Cloud Server.
Click on the Next button.

4.
5

The 'Custom Setup' page displays. Click on the Next
button to accept the defaults.

4.
6

Click on the Install button to run the installation.

5. Configure the Pro Cloud Server

The Pro Cloud Server will have installed all of its files to the
'C:\Program Files (x86)\Sparx Systems\Cloud Services\'
folder and added a Shortcut to the desktop.
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Ste
p

Description

5.
1

Run the 'Pro Cloud Config Client' or 'Pro Cloud
Express Configuration Client' shortcut which was
added to your desktop.

5.
2

Enter the Server address of "localhost:803" and click
on the OK button.

5.
3

Click on the Licensing button, then Add.

Enter your Pro Cloud server License key, then click
OK.

Click on OK to close the Pro Cloud Server License
Manager dialog.

5.
4

Select the Ports tab

Select Port "804" from the list and click on the Edit
button.

Tick the checkbox OSLC Supported, then click
OK.

5.
5

Select the Database Managers tab, then click on the
Add button.
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Type the name 'fb-procloud.feap' in the connection
string field, then click on the OK button.

Select the new entry in the list and click on the Edit
button.

On the Configure Database Manager screen, select
the Enabled and Enable Pro Features (OSLC,
WebEA and Integration) checkboxes.

Click on the OK button.

For a more in depth explanation of how to add
database managers, see the Help topic Add Database 
Manager.

5.
6

Open the standard Windows Services console
(command "services.msc"), locate and select the
service "Sparx Systems Professional Cloud", then
restart it.

6. Copy WebEA files to Website

Ste Description
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p

6.
1

Copy the folder C:\Program Files (x86)\Sparx
Systems\Cloud Services\WebEA\ to
C:\xampp\htdocs.

7. Configure WebEA to access the model

To give a better demonstration of the WebEA options, we
will define three different WebEA model connections. All
will connect to the same physical Firebird database.

Each model connection will have its own set of options that
control how users will be able to interact with the data.

Ste
p

Description

7.
1

Open the file
'C:\xampp\htdocs\WebEA\includes\webea_config.ini
' with a text editor.

7.
2

In the "[model_list]" section, remove the 'model4'
and 'model5' lines. Edit the remaining model names
to:
model1 = "Pro Cloud Model (no updates)"
model2 = "Pro Cloud Model with discussions"
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model3 = "Pro Cloud Model with access code"

7.
3

In the "[model1 : settings]" section change the
SSCS_DB_ALIAS option to "fb-procloud". The
remaining default options should remain unchanged.

7.
4

In the "[model2 : settings]" section change the
SSCS_DB_ALIAS option to "fb-procloud". The
remaining default options should remain unchanged.

7.
5

Delete the "[model3 : settings]" and "[model5 :
settings]" sections, rename the "[model4 : settings]
section header to [model3 : settings]", then set these
options as shown:
  sscs_db_alias = "fb-procloud"
  sscs_port = "804"
  sscs_use_ssl = "false"
  sscs_model_user = ""
  ssc_model_pwd = ""
  auth_code = "password01".
  login_prompt = "false"

7.
6

Save the changes to the file webea_config.ini in
C:\xampp\htdocs\WebEA\includes.
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8. Configure your firewall(s) to allow client
access

Ste
p

Description

8.
1

Firewall rules will have to be adjusted to allow
traffic between the [Client] and [Web Server], on
ports 80 and 443.

8.
2

Firewall rules will have to be adjusted to allow
traffic between the [Web Server] and [Pro Cloud
Server], on ports 804 and 805.

9. Use Enterprise Architect to add content

The initial Firebird model we created earlier will be empty.
The easiest way to add content to the model is with
Enterprise Architect.

Ste
p

Description

9.
1

On a client machine with access to the web server,
open Enterprise Architect v13.5 or later.
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9.
2

From the main menu select 'Open Project...' or, from
the ribbon, select the '  > Open Project' option.

9.
3

Click on the Connect to Cloud button.

9.
4

On the 'Cloud Connection' screen set these
parameters:
Name:         fb-procloud
Protocol:     http://
Server:        {your servername}
Port:        804
Model Name:    fb-procloud

Click on the OK button.

9.
5

Open the 'Configure > Model > Options > Cloud'
options and tick these checkboxes:

Auto create Diagram Image and Image Map (each·

time a Diagram is saved)
Auto create HTML Page (each time a Linked·

Document is saved)
These options ensure diagrams and Linked
Documents are saved in a format that allows them to
be viewed in WebEA.

9. Create a sample set of Model Views, Packages,
diagrams and elements, so that they can be viewed in
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6 WebEA later.

10. Test WebEA access

Ste
p

Description

10
.1

On a client machine, open an internet browser and
enter the URL
http://{yourwebserver}/WebEA/login.php, where the
value '{yourwebserver}' is either the name or IP
number of the machine hosting the WebEA website.
The WebEA login screen displays, listing the three
model connections we defined earlier:

Pro Cloud Model (no updates)·

Pro Cloud Model with discussions·

Pro Cloud Model with access code·

10
.2

Select the first model connection - Pro Cloud Model
(no updates) - and click on the Next button. This
connects you to the model and displays the model
views that are defined.
From here you should be able to navigate through
the model by selecting Packages, diagrams and
elements. When you select an element, its complete
details are displayed. Because of the way this model
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connection is defined, the bottom of the properties
section will NOT contain the 'Discussions' section.

10
.3

Click on the 'hamburger' icon in the top right corner
of the display, and select the 'Logout' option. Then
select the second model connection - Pro Cloud
Model with discussions - and click on the Next
button. You should see the same model views as
before; now navigate to an element and confirm that
the 'Discussions' section is visible.

10
.4

Once again, click on the 'hamburger' icon in the top
right corner, and select the 'Logout' option.
Select the third model connection, 'Pro Cloud Model
with access code' and click on the Next button. This
time you should be presented with a prompt for the
Access Code; enter 'password01' (as we defined in
step 7.5) and click on the Login button. You should
see the same model views as before. Navigate to an
element; this time there should be a blue 'hamburger'
menu in the element details area that allows the
creation of element features such as tests and
resource allocations. There should also be a pencil
icon next to the element notes area that, when
clicked on, will allow the modification of element
notes.
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Complete

This quick start procedure is now complete. It has shown
you how to install and configure a basic installation of
WebEA. The Sparx System's online Help documentation has
more detailed instructions and explains all possible options
that can be configured. See the section Model Repository |
Cloud Based Repositories | Pro Cloud Server in the
Enterprise Architect online Help.
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WebEA Quick Start Guide - IIS

The purpose of the WebEA Quick Start Guide - IIS is to
provide the complete process for quickly installing and
configuring WebEA in a new IIS environment using the
most common options.

The process is based on these assumptions:

A clean Windows Server 2012 (or later) based machine·

has been selected to host both the Pro Cloud Server and
Web Server; that is, no other Web Servers or applications
are configured to listen on port 80

IIS will be used as the Web Server·

WebEA will access one brand new Firebird model·

(because it is the simplest, as it does not require any third
party ODBC drivers)

The Enterprise Architect user base is using Enterprise·

Architect 13.5 or later

1. Download the Pro Cloud Server

Ste
p

Description

1.
1

When you purchase the Sparx Systems Pro Cloud
Server the sales team will send you a link to
download the installer.
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2. Install the Web Server

Ste
p

Description

2.
1

Enable IIS on Windows Server by running the
Server Manager and selecting 'Add roles and
features'

2.
2

Proceed through the installation process, accepting
the defaults until the Server Roles screen displays.
Select the 'Web Server (IIS)' checkbox.
Continue through the installation, accepting defaults.

2.
3
-
In
st
all
P
H
P

Install PHP for IIS with 'Microsoft Web Platform
Installer', available from:
https://www.microsoft.com/web/downloads/platform
.aspx
Run Microsoft Web Platform Install and select
'Products > Frameworks'.
Select the version of PHP required (for example,
'PHP 7.2.2 (x64)').
Click on the Add button and Install button.
(This will download the required files and install
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them for use with IIS.)

3. Configure the Web Server

With the default IIS configuration, the default website will
use port 80. Its base folder is
%SystemDrive%\inetpub\wwwroot which is normally
C:\inetpub\wwwroot.

Ste
p

Description

3.
1

No additional configuration is required. Test the
connection by browsing to server address from
another computer. "Internet Information Services"
landing page should display.

4. Install Pro Cloud Server

Ste
p

Description

4.
1

The Pro Cloud Server installer is a standard MSI;
double-click on it to start the installation.
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Note: Depending on a number of factors, you might
be prompted for the credentials of a user with
elevated permissions; these must be entered before
the installation will continue.

4.
2

The 'Sparx Systems Pro Cloud Services Setup' dialog
displays. Click on the Next button.

4.
3

Read the license agreement and select the checkbox
for indicating that you accept the terms. Click on the
Next button.

4.
4

Read the information about the Pro Cloud Server.
Click on the Next button.

4.
5

The 'Custom Setup' page displays. Click on the Next
button to accept the defaults.

4.
6

Click on the Install button to run the installation.

5. Configure the Pro Cloud Server

The Pro Cloud Server will have installed all of its files to the
'C:\Program Files (x86)\Sparx Systems\Cloud Services\'
folder and added a Shortcut to the desktop.
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Ste
p

Description

5.
1

Run the 'Pro Cloud Config Client' or 'Pro Cloud
Express Configuration Client' shortcut which was
added to your desktop.

5.
2

Enter the Server address of "localhost:803" and click
on the OK button.

5.
3

Click on the Licensing button, then Add.

Enter your Pro Cloud server License key, then click
OK.

Click on OK to close the Pro Cloud Server License
Manager dialog.

5.
4

Select the Ports tab

Select Port "804" from the list and click on the Edit
button.

Tick the checkbox OSLC Supported, then click
OK.

5.
5

Select the Database Managers tab, then click on the
Add button.
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Type the name 'fb-procloud.feap' in the connection
string field, then click on the OK button.

Select the new entry in the list and click on the Edit
button.

On the Configure Database Manager screen, select
the Enabled and Enable Pro Features (OSLC,
WebEA and Integration) checkboxes.

Click on the OK button.

For a more in depth explanation of how to add
database managers, see the Help topic Add Database 
Manager.

5.
6

Open the standard Windows Services console
(command "services.msc"), locate and select the
service "Sparx Systems Professional Cloud", then
restart it.

6. Copy WebEA files to Website

Ste Description
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p

6.
1

Delete the default IIS files from C:\inetpub\wwwroot

6.
2

Copy the folder C:\Program Files (x86)\Sparx
Systems\Cloud Services\WebEA\ to
C:\inetpub\wwwroot.

7. Configure WebEA to access the model

To give a better demonstration of the WebEA options, we
will define three different WebEA model connections. All
will connect to the same physical Firebird database.

Each model connection will have its own set of options that
control how users will be able to interact with the data.

Ste
p

Description

7.
1

Open the file
'C:\inetpub\wwwroot\WebEA\includes\webea_confi
g.ini' with a text editor.

7.
2

In the "[model_list]" section, remove the 'model4'
and 'model5' lines. Edit the remaining model names
to:
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model1 = "Pro Cloud Model (no updates)"
model2 = "Pro Cloud Model with discussions"
model3 = "Pro Cloud Model with access code"

7.
3

In the "[model1 : settings]" section change the
SSCS_DB_ALIAS option to "fb-procloud". The
remaining default options should remain unchanged.

7.
4

In the "[model2 : settings]" section change the
SSCS_DB_ALIAS option to "fb-procloud". The
remaining default options should remain unchanged.

7.
5

Delete the "[model3 : settings]" and "[model5 :
settings]" sections, rename the "[model4 : settings]
section header to [model3 : settings]", then set these
options as shown:
  sscs_db_alias = "fb-procloud"
  sscs_port = "804"
  sscs_use_ssl = "false"
  sscs_model_user = ""
  ssc_model_pwd = ""
  auth_code = "password01".
  login_prompt = "false"

7.
6

Save the changes to the file webea_config.ini in
C:\inetpub\wwwroot\WebEA\includes.
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8. Configure your firewall(s) to allow client
access

Ste
p

Description

8.
1

Firewall rules will have to be adjusted to allow
traffic between the [Client] and [Web Server], on
ports 80 and 443.

8.
2

Firewall rules will have to be adjusted to allow
traffic between the [Web Server] and [Pro Cloud
Server], on ports 804 and 805.

9. Use Enterprise Architect to add content

The initial Firebird model we created earlier will be empty.
The easiest way to add content to the model is with
Enterprise Architect.

Ste
p

Description

9. On a client machine with access to the web server,
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1 open Enterprise Architect v13.5 or later.

9.
2

From the main menu select 'Open Project...' or, from
the ribbon, select the '  > Open Project' option.

9.
3

Click on the Connect to Cloud button.

9.
4

On the 'Cloud Connection' screen set these
parameters:
Name:         fb-procloud
Protocol:     http://
Server:        {your servername}
Port:        804
Model Name:    fb-procloud

Click on the OK button.

9.
5

Open the 'Configure > Model > Options > Cloud'
options and tick these checkboxes:

Auto create Diagram Image and Image Map (each·

time a Diagram is saved)
Auto create HTML Page (each time a Linked·

Document is saved)
These options ensure diagrams and Linked
Documents are saved in a format that allows them to
be viewed in WebEA.
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9.
6

Create a sample set of Model Views, Packages,
diagrams and elements, so that they can be viewed in
WebEA later.

10. Test WebEA access

Ste
p

Description

10
.1

On a client machine, open an internet browser and
enter the URL
http://{yourwebserver}/WebEA/login.php, where the
value '{yourwebserver}' is either the name or IP
number of the machine hosting the WebEA website.
The WebEA login screen displays, listing the three
model connections we defined earlier:

Pro Cloud Model (no updates)·

Pro Cloud Model with discussions·

Pro Cloud Model with access code·

10
.2

Select the first model connection - Pro Cloud Model
(no updates) - and click on the Next button. This
connects you to the model and displays the model
views that are defined.
From here you should be able to navigate through
the model by selecting Packages, diagrams and
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elements. When you select an element, its complete
details are displayed. Because of the way this model
connection is defined, the bottom of the properties
section will NOT contain the 'Discussions' section.

10
.3

Click on the 'hamburger' icon in the top right corner
of the display, and select the 'Logout' option. Then
select the second model connection - Pro Cloud
Model with discussions - and click on the Next
button. You should see the same model views as
before; now navigate to an element and confirm that
the 'Discussions' section is visible.

10
.4

Once again, click on the 'hamburger' icon in the top
right corner, and select the 'Logout' option.
Select the third model connection, 'Pro Cloud Model
with access code' and click on the Next button. This
time you should be presented with a prompt for the
Access Code; enter 'password01' (as we defined in
step 7.5) and click on the Login button. You should
see the same model views as before. Navigate to an
element; this time there should be a blue 'hamburger'
menu in the element details area that allows the
creation of element features such as tests and
resource allocations. There should also be a pencil
icon next to the element notes area that, when
clicked on, will allow the modification of element
notes.
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Complete

This quick start procedure is now complete. It has shown
you how to install and configure a basic installation of
WebEA on IIS. The Sparx System's online Help
documentation has more detailed instructions and explains
all possible options that can be configured. See the section
'Model Repository | Cloud Based Repositories | Pro Cloud
Server' in the Enterprise Architect online Help.
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WebEA Installation and Configuration

The Sparx Systems Pro Cloud Server product is installed
using a standard Microsoft Windows Installer package that
includes a number of optional components. WebEA is one
of these components and is installed by default. It is possible
to change the install location of WebEA; however, if the
defaults are used WebEA will be installed into the
C:\Program Files (x86)\Sparx Systems\Cloud
Services\WebEA\ folder (assuming a 64 bit machine is
being used).

See the Cloud Server Installation and Cloud Service
Configuration Help topics for a full description of how to
install and configure the Sparx Systems Cloud Service.

Important: If you are installing the Pro Cloud Server on a
machine that already has the Sparx Systems Cloud Services
or Sparx Systems WAN Optimizer installed then these
should be uninstalled first.

WebEA Server Requirements

In order to run WebEA in your environment you must have:

A Web Server (Apache or IIS) capable of hosting PHP·

v7.0 (or later)

A Web Server with these standard PHP extensions·

installed and enabled: core, curl, date, gettext, hash, json,
libxml, mbstring, pcre, session, standard and tokenizer
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A Web Server with PHP sessions enabled·

Communication between the web server and the server·

hosting the Pro Cloud Server

A base folder (on the web server) to store the WebEA·

website pages

Configuration Steps

The installation of the WebEA application should have
already been completed by following the steps outlined in
the Cloud Server Installation topic, making sure that the
WebEA component was installed.

In additional to installing the Pro Cloud server, WebEA also
needs a web server to host it. In the simplest configuration
the web server would be installed on the same machine as
the Pro Cloud Server.

Configuring WebEA applies these steps:

Ste
p

Action

1 Decide what models are going to be available to
WebEA users.
At the same time it is worth considering these points,
which will determine the configuration options of
each model.

Is user security currently configured on the model?·
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Should WebEA users be prompted for their model·

user and password?
Should WebEA users be able to view element·

discussions?
Should WebEA users be able to add element·

discussions?
Should WebEA users be able to join and·

participate in reviews?
Should WebEA users be able to insert new·

objects, and if so, what types?
Should WebEA users be able to add new element·

features, and if so, what types?
Should WebEA users be able to edit element·

notes?
Should WebEA users be able to edit element tests?·

Should WebEA users be able to edit element·

resource allocations?
What is the default list of watchlist items for the·

model?

2 Ensure a database manager is defined for each model
decided on in step 1, in the Cloud Service's database
manager list. The process to do this is as outlined for
the core Sparx Systems Cloud Service, in Add
Database Manager.

3 Enter your License key into the
SSCloudServices.config file (by default found in the
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'C:\Program Files (x86)\Sparx Systems\Cloud
Services\Service\' folder). To edit this file you will
require Administrator privileges.
Tip: Add this line, replacing the zeroes with your
license key.
LICENSE={00000000-0000-0000-0000-000000000
000}

4 For each of the Cloud Services ports that will be
accessed by WebEA models, check that the option
'OSLC_SUPPORT' is set to '1' in the
SSCloudServices.config file, and save any changes.
Tip: Add/edit the OSLC_SUPPORT option to
enable OSLC on the given port.
OSLC_SUPPORT=1

5 Ensure that the Windows service 'Sparx Systems
Professional Cloud' has been restarted since making
changes to the configuration file (in the previous
steps), so that new options are loaded.

6 For each of the models decided on in step 1, select
the model on the 'Sparx Systems Cloud Services
Configuration Client', click on the Configure button
and select the 'Enable Pro Features (OSLC, WebEA
and Integration)' checkbox.

7 Check that you can access the model(s) in Enterprise
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Architect using the 'Connect to Cloud' option.
After opening each model in Enterprise Architect,
enable the 'Data Cache' options and click on the
Create button to generate the initial set of viewable
diagrams and Linked Documents. See the Model
Configuration topic for details.

8 Download/install and configure your web server for
PHP, according to your requirements.
Tip: XAMPP is the most common Apache/PHP web
server that includes all the required components; it is
available for Windows/Linux and OS X at
https://www.apachefriends.org/download.html.
WebEA has been tested on all of the currently
available versions of PHP, but if your environment
has no special requirements then Sparx Systems
would recommend v7.1.1 for Windows. All further
Quick Start points will assume this configuration.
Note: WebEA only requires the minimum XAMPP
installation, Apache and PHP; it does not require
MySQL, FileZilla Mercury, Tomcat or any of the
other optional components, so if you have no need
for these components Sparx Systems would
recommend to not install them.

9 Define and configure a website for WebEA in your
web server.
As there are many different web servers and
configurations, configuring the web site for WebEA,
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deciding what port the web server will listen to, and
making sure the website is secure from external
attacks, are all outside the scope of this
documentation.
Tip: Using the default XAMPP configuration, the
port for the default website is 80 and the base folder
is at 'C:\xampp\htdocs'. XAMPP will already have
added files to this folder; WebEA does not require
these files, so if you have no need for them, move
them to a backup location.

10 Copy the contents of the entire WebEA installation
folder ('C:\Program Files (x86)\Sparx Systems\Cloud
Services\WebEA\') to the base folder of the website.
Tip: Copy WebEA folder from 'C:\Program Files
(x86)\Sparx Systems\Cloud Services\WebEA\' to
'C:\xampp\htdocs'.
Special Note regarding reinstalls: before updating
the WebEA files, take a backup of the files you have
modified, ie \includes\webea_config.ini and
\includes\webea_strings.ini.

11 Due to the sensitive nature of some of the
information contained in the WebEA configuration
file, we recommend that the '\includes\' folder within
the WebEA folder is severely restricted so that only
PHP can access the files within. For example, in
Apache this is achieved with this entry in the Apache
configure file:
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    <Directory "{website_path}/includes">
         AllowOverride none
         options none
         Require all denied
    </Directory>

Once your web server is configured and the WebEA
application files copied into the base folder,
restart/start the web server.
Tip: Using the XAMPP control panel, Stop/Start
Apache.

12 Edit the '\includes\webea_config.ini' file and define
each model decided on in step 1.
See the How to configure WebEA models Help topic
for more details on what each option means in
WebEA's config file.
Tip: Edit
'C:\xampp\htdocs\includes\webea_config.ini' file,
and update all parameters with the prefix 'SSCS_' to
that of a defined repository in your Cloud Service.
Special Note regarding reinstalls: if you a have a
previous backup of the \includes\webea_config.ini
file and wish to use the same configuration, you can
simply restore the backup file.

13 On a remote machine, open an internet browser and
enter the URL of http://{yourwebserver}/login.php,
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where the value '{yourwebserver}' is either the name
or IP number of the machine hosting the WebEA
website. This should display the WebEA login
screen that lists the models which are defined in the
webea_config.ini file.

14 Other considerations:
If you require different lists of models (or different·

options) for different user bases, then it is possible
to define multiple websites, each with their own
dedicated port and base folder, using Apache's
virtual hosts. This could mean user group A could
access its set of models with the URL
http://{yourwebserver}:180/ while user group B
would use the URL http://{yourwebserver}:200/
Firewall rules will have to be adjusted to allow·

traffic between the [Client] and [Web Server]
Firewall rules will have to be adjusted to allow·

traffic between the [Web Server] and [Pro Cloud
Server]

HTTPS and SSL

If the models have SSL enabled and are using self-signed
certificates, then see Advanced SSL for advanced
configuration of WebEA.
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Model Configuration

Action Description

Configure
Enterprise
Architect
model
options

By default, diagrams and Linked
Documents are not saved in a format that
is viewable by web browsers. In order for
users of WebEA to view these
components, Enterprise Architect must be
configured to generate (and store)
viewable versions of them whenever
changes are made. The options to
generate viewable diagrams and Linked
Documents are defined at the model
level.
With the model open in Enterprise
Architect, select the 'Configure > Model
> Options' ribbon option. On the 'Manage
Project Options' dialog, refer to the 'Data
Cache' options at the foot of the 'Cloud'
page.

The first option (if enabled), in addition
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to saving a diagram normally will also
generate and save a static image of the
diagram.
The second option (if enabled), in
addition to saving a Linked Document
normally will also generate and save the
document in HTML format.
If these options are not enabled, diagrams
and Linked Documents will not be
viewable from within WebEA.
When initially configuring a model to
auto create viewable diagrams and
Linked Documents, it is advisable to
click on the Create button to generate the
initial set of viewable diagrams and
Linked Documents. While this is not
mandatory, viewable versions of all
existing diagrams and Linked Documents
will not exist until they are saved.
Note: This approach is relevant when all
Enterprise Architect users are using a
build later than 1350. If, however, some
of your user base is using older versions
of Enterprise Architect then updates to
diagrams and Linked Documents will not
be reflected immediately when saved.
See the How to configure automatic
viewable components Help topic for the
recommended approach to overcome this

(c) Sparx Systems 2018 Page  366 of 1073



User Guide - Model Repository 21 December, 2018

situation.

Configure
model users

It is possible for WebEA users to connect
to user security enabled models in one of
two ways:

Using their model User Login and·

Password; that is, the same credentials
they use when connecting to the model
with Enterprise Architect, or
If the model has been configured in·

WebEA to not require login credentials
then all users will be logged in under
the one user account (using the
sscs_model_user and sscs_model_pwd
defined in the 'webea_config.ini' file)

Acknowledgements
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How to configure automatic viewable
components

While Sparx Systems recommend that users should always
use the latest release of Enterprise Architect, we do
acknowledge that in some situations this is hard to achieve.
Therefore, in order for WebEA (and the Pro Cloud Server)
to function correctly when users are using builds of
Enterprise Architect earlier than 1350, the Pro Cloud Server
includes a custom version of Enterprise Architect (referred
to as the EA Worker) that will automate the generation of
WebEA viewable diagrams and Linked Documents.

Each instance of an EA Worker is capable of connecting to
a single model, and typically runs on the same server as the
Pro Cloud Service.

How to run EA Worker

The 'EA Worker' application does not have a GUI of any
kind, therefore it is started with two command line options:

cloudupdate: - the frequency (measured in seconds) of1.
how often the application should check for new or
modified diagrams and Linked Documents.

A connection string to the model, defined as a .EAP file.2.

An example command line is:

    C:\> EA.exe /cloudupdate:30

(c) Sparx Systems 2018 Page  369 of 1073



User Guide - Model Repository 21 December, 2018

"C:\EA\shortcuts\model1.eap"

Typically the easiest and most efficient method to run the
EA Worker is with a Windows batch/command file.

Model shortcuts for EA Worker

Within Enterprise Architect it is possible to save model
connections (no matter what type of DBMS is in use) as a
.EAP file. These model shortcuts are not .EAP file
databases, but plain text files that contain a connection
string to a model.

An example .EAP shortcut to a model without security:

   EAConnectString:model1 ---
;Connect=Cloud=protocol:http,address:localhost,port:804;D
ata Source=model1;

However, when the model has security enabled the
connection string requires a USER and PASSWORD
parameters:

   EAConnectString:model1 ---
;Connect=Cloud=protocol:http,address:localhost,port:804,us
er:fred,pwd:pwdxxx;Data Source=model1;

EA Worker Configuration Steps

Ste Description
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p

1 Create a .EAP shortcut to the model.
The creation of a .EAP shortcut file can be achieved
by either:
1) Manually creating a plain text file, renaming its
extension to .EAP and entering the complete
connection string as shown (making sure to replace
all values enclosed in {}):
    EAConnectString:{modelname} ---
;Connect=Cloud=protocol:http,address:{servername
},port:{port},user:{username},pwd:{password};Data
Source={modelname};
    or
2) In Enterprise Architect, open a Cloud connection
to the model in question and then choose 'Save As
Shortcut...' from the  drop-down menu.

2 Create a batch/command file.
Create a plain text file, give it a meaningful name,
and change its extension to .CMD. Then edit the file
and enter this text, making sure to replace {seconds}
with the number of seconds and {filepath} with the
location of the fully qualified .EAP created in the
previous step:
    "C:\Program Files (x86)\Sparx Systems\Cloud
Services\Worker\EA.exe" /cloudupdate:{seconds}
"{filepath}"
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3 Run the batch/command file.
Double-click on the file created in the previous step.
Sparx System recommends that this batch/command
file is added to Startup so that it is automatically run
when the server starts.

Lifecycle of EA Worker

The EA Worker application is designed to connect to the
specified model automatically when it starts; if there is a
problem with the connection the application ends. If the
connection string is valid and the EA Worker connects to
the model it will run continually until the server is restarted
or until the process is manually terminated.
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How to configure WebEA models

All WebEA configuration is controlled by a single file,
which must reside in the '\includes\' folder and which must
have the name 'webea_config.ini'.

The configuration file is a plain text file. Options are
grouped under section headers, which are enclosed by
square brackets. Each option must be defined on a separate
line and follow the syntax:

  {option name} = "{option value}"

Note that:

Option values are enclosed by double quotes·

The configuration file supports comments; the semi-colon·

character starts a comment

The default 'webea_config.ini' file included in the·

installation package contains samples of how models can
be configured

Why are there so many options?

In order to offer the greatest level of flexibility in how
WebEA models can be accessed and used, Sparx Systems
provides a large number of configuration options, which can
be daunting when the complete list is viewed for the first
time. However, to minimize your effort in understanding
and managing the options, most are also grouped by prefix
(sscs, login, add, edit and wl), which helps you to quickly
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understand what a particular option is used for.

The Model List

The first section in the configuration file is '[model_list]';
this section defines the model names that will be displayed
to WebEA users on the 'Login' page. There is no limit to the
number of models that can be defined; however, when there
are more than ten models the login screen will automatically
show a vertical scroll bar.

The model names have no direct link to the physical server
or database name of the models they are describing, so you
are free to use any meaningful name.

For example:

    [model_list]

    model1 = "Model One (no updates)"

    model2 = "Model One with discussions"

    model3 = "Model Two with user login"

    model4 = "Model Three with all options"

    model5 = "Sparx Systems Sample Model"

Note: it is important that the 'modelx' definitions are
consecutive; any out-of-sequence model numbers will be
ignored and no further models will be added to the WebEA
Login page.
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Model options

For each numbered model found in the '[model_list]' section
a matching '[modelx : settings]' section is expected, further
down the configuration file. All options within this section
relate to that model only; that is, options can not be shared
between models.

For example:

    [model1 : settings]

    sscs_protocol = "http"

    sscs_server = "localhost"

    sscs_port = "80"

    sscs_db_alias = "model1"

    auth_code = ""

    login_prompt = "false"

    default_diagram = ""

    show_discuss = "false"

Model connection settings

Probably the most important settings for any model are the
connection-related ones, prefixed with sscs_ (which stands
for 'Sparx Systems Cloud Service'). This group of settings
defines how WebEA will connect and communicate with the
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Cloud Service for data retrieval.

All communication between WebEA and the Cloud Service
is performed via the PHP cURL library, therefore some of
the connection settings relate directly to the cURL options.

Option Description

sscs_protocol Defines the protocol to be used to
connect to the Sparx Systems Cloud
Service.
Options:     http or https
Default:     http
Example:    sscs_protocol = "http"

Note: When using the https protocol the
configuration should also include
sscs_use_ssl = "true". If you are using a
self-signed certificate then
sscs_enforce_certs = "false" should also
be included.

sscs_port Defines the TCP port used to connect to
the Sparx Systems Cloud Service. This
port number must match one of the ports
the Sparx Systems Cloud Service is
listening to or, in the case of an IIS setup,
the IIS port servicing this repository.
Default:        80
Example:    sscs_port = "804"
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sscs_server Defines the fully qualified machine name
or IP address of the server hosting the
Cloud Service.
Default:    localhost
Example:     sscs_server =
"sparxpublic.com" or sscs_server =
"197.168.0.10"

sscs_use_ssl As of WebEA version 3.01.23.1690
(included in Pro Cloud Server 3.0.23)
this option is no longer used, instead
WebEA determines this value
dynamically based on the protocol in use,
HTTP - sscs_use_ssl=false and HTTPS -
sscs_use_ssl=true.
WebEA versions prior to 3.0.23.1690
uses this value to defines if all
communications between WebEA and
Cloud Services should use SSL (secure
socket layer). When this value is true, the
protocol should be set to "https".
Options:     true or false
Default:    false
Example:     sscs_use_ssl = "false"

sscs_db_alias Defines the database alias name of the
model repository hosted on the Cloud
Service. This corresponds to the
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'Database Alias' identified in the Cloud
Services Configuration Client or the
'Model Name' on the Enterprise
Architect's Cloud Connection screen. The
value is case sensitive.
Default:    ea
Example:    sscs_db_alias =
"RepositoryName"

sscs_enforce
_certs

When SSL is set to true this option
defines whether or not cURL will enforce
that the certificate installed in Cloud
Services is correctly signed by a
Certificate Authority.
Note: If you are using a self-signed
certificate for Cloud Services, this option
must be set to false.
Options:     true or false
Default:    true
Example:     sscs_enforce_certs = "false"

sscs_model_
user

Defines the model user login (as defined
in Enterprise Architect User Security)
that will be used in combination with the
sscs_model_pwd option to login to a
security enabled model.
Note:

Starting in Pro Cloud Server version·
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3.0.23 - When set, all other
authentication schemes are bypassed,
including Windows Authentication,
OpenID and basic username/password
login.
Sparx Systems would recommend the·

use of this option only on a model that
has been configured as read only, since
all updates made by WebEA users in
this configuration will be identified as
the same user.

Default:
Example:    sscs_model_user =
"webuser"

sscs_model_
pwd

Defines the password (as defined in
Enterprise Architect User Security) that
will be used in combination with the
sscs_model_user option to login to a
security enabled model.
Note:

Starting in Pro Cloud Server version·

3.0.23 - When set, all other
authentication schemes are bypassed,
including Windows Authentication,
OpenID and basic username/password
login.
Sparx Systems would recommend the·

use of this option only on a model that
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has been configured as read only, since
all updates made by WebEA users in
this configuration will be identified as
the same user.

Default:
Example:    sscs_model_pwd =
"pwdxxx"

Model general settings

These options define how WebEA users can access and
display objects within the model.

Option Description

auth_code Defines the authorization code all
WebEA users must enter before they can
access the model. If this value is blank,
WebEA users are not prompted to enter a
code.
This option is only used for basic
username/password authentication and is
not used for Windows Authentication or
OpenID.
It's possible to set this option and also set
sscs_model_user. In this case the user
will be required to enter the access code
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only and will not be prompted for a
username or password.
Options:    text
Default:    blank
Example:     auth_code = "JWG478"

navigate_to_
diagram

As of WebEA version 3.01.23.1690
(included in Pro Cloud Server 3.0.23) the
default selection of some objects on
diagrams has changed to match
Enterprise Architect behavior.  This
applies to i) Composite Elements and ii)
Package elements that contain a diagram.
Composite Elements
A composite element on a diagram will
navigate directly its composite diagram.
Package Elements
A Package element on a diagram will
navigate to the first child diagram
contained within the selected Package. If
the selected Package does not contain any
diagrams then the package's properties
are displayed.

When navigate_to_diagram is set to false,
selecting either a composite element or
package element on a diagram will
display the selected elements properties.
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Options:    true or false
Default:    true
Example:    composite_navigates =
"false"

login_prompt This option is no longer used as of
WebEA version 3.0.23.1690 (included in
Pro Cloud Server 3.0.23). Basic
authentication username and password
fields will show for models that allow
basic authentication (that is, are not
restricted to SSO logins).

The basic authentication
(username/password) will show for
security enabled models that have not set
sscs_model_user.
Windows Authentication, if enabled for
the model, will be attempted
automatically when selecting the model.
OpenID authentication, if enabled in the
model, will show above any basic
authentication prompt.

For older versions of WebEA the option
is used to define whether or not all
WebEA users must enter a model
user/password before they can access the
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model.
Note: When this option is set to false and
the model has security enabled, the
sscs_model_user and sscs_model_pwd
options must also be used to specify the
logon credentials.
Options:     true or false
Default:    false
Example:     login_prompt = "false"

login_allow_
blank_pwd

When the 'login_prompt' option is set to
true, this option defines whether or not
WebEA will attempt to send blank
passwords to the Cloud Services for
validation.
Options:     true or false
Default:    false
Example:     login_allow_blank_pwd =
"false"

miniprops_na
vigates

When the 'miniprops_navigates' option is
set to true selecting certain 'navigable'
elements will cause WebEA to navigate
to the target of these elements. Examples
of such 'navigable' elements are
Hyperlinks and Navigation Cells.  For all
other elements, selecting them will
display the properties of the element in
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the Properties View. This option has no
effect when the Properties View is not
shown.
Options:     true or false
Default:    true
Example:     miniprops_navigates =
"false"

participate_in
_reviews

When set to true, 'participate_in_reviews'
allows users of WebEA to Join reviews
that will automatically assign all
discussions to the joined review. In order
to make full use of this option
show_discuss and add_discuss would
also have to be set to true.
Options:    true or false
Default:    false
Example:     participate_in_reviews =
"false"

recent_search
_days

Defines the number of days the
predefined 'Recent ...' searches should
consider. For example if this value was
set to '7' then whenever a user invokes the
search for 'Recent elements', all elements
modified in the previous 7 days will be
returned.
Options:    any positive integer value
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Default:    3
Example:    recent_search_days = "10"

use_avatars When the 'use_avatars' option is set to
true, all discussion messages are
displayed with the creating user's avatar.
When set to false a set of generic images
representing discussions and replies is
used instead.
Options:     true or false
Default:    true
Example:     use_avatars = "false"

prop_sec_<se
ction>_visibl
e

Defines whether or not a property section
(or "feature") is accessible.
If a feature is not visible then the button
to display that feature will not be
available in the Main View, and the
Feature will not be listed in the "Select
Feature" menu in the Properties View.

<section> can be one of:
location·

instances·

relationships·

taggedvalues·

testing·
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resourcealloc·

attributes·

operations·

runstates·

changes·

defects·

issues·

tasks·

events·

decisions·

efforts·

risks·

metrics·

Options:     true or false
Default:    true
Example:     prop_sec_testing_visible =
"true"

prop_sec_<se
ction>_expan
ded

This option is no longer used as of
WebEA version 3.0.23.1690 (included in
Pro Cloud Server 3.0.23). Property
sections are no longer display as
expandable/collapsible panels.

Defines whether or not a property section
is expanded by default when the model is
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opened.
The property view includes numerous
sections that can be optionally expanded
or collapsed; these options set the default
values for the model.
<section> can be one of:

info·

location·

instances·

relationships·

taggedvalues·

testing·

resourcealloc·

attributes·

operations·

runstates·

changes·

defects·

issues·

tasks·

events·

decisions·

efforts·

risks·

metrics·
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Options:     true or false
Default:    false for all sections except
'info' and 'location', which are true
Example:     prop_sec_testing_expanded
= "true"

default_diagr
am

Defines the GUID of the diagram that
should be automatically loaded when
users log onto the model. If this option is
not defined or an empty value is
specified, WebEA assumes that no
diagram should be loaded and displays
the model root instead. The GUID of any
diagram can be obtained from WebEA by
loading the diagram properties.
Note: The entire GUID (including {})
must be used.
Example:     default_diagram =
"{C89E174A-19B0-47c7-B4A8-8A9807
1CD838}"

default_main
_layout

Defines the default layout of container
items for the current model. WebEA can
display child items of a container in one
of three layouts. Either Icon view (the
default), Notes view (resembling the
Enterprise Architect Specification
Manager view) or List view.
Options:     icon, notes or list
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Default:        icon
Example:     default_main_layout = "list"

navigate_to_
diagram

Defines whether or not the first child
Diagram of a Package element should be
automatically loaded, if the selected
Package Element does not have any child
diagrams defined then the selected
Package's details are loaded.
This option was added in WebEA version
3.0.23.1690, prior versions would simply
open the details of the selected Package.
Options:     true or false
Default:    true
Example:     navigate_to_diagram = "true"

show_discuss Defines whether or not discussions on
Packages and elements should be
displayed within the WebEA interface.
Options:     true or false
Default:    false
Example:     show_discuss = "true"

Model update settings
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This group of settings determine what insert/edit options are
available to WebEA users.

Note: Within the Cloud Service it is possible to configure a
model as 'Read-only'; this setting in the Cloud Service will
override any WebEA update setting, forcing them to false.

Option Description

add_discuss Defines whether or not new discussions
on Packages and elements can be added
to the model. Note: This option is forced
to false if 'show_discuss' has been set to
false.
Options:    true or false
Default:    false
Example:     add_discuss = "true"

add_objects Defines whether or not new objects can
be added to the model.
Note: this option will be internally set
and restricted to 'false" for Pro Cloud
Server Express installations.
Options:     true or false
Default:    false
Example:     add_objects = "true"

add_diagram
s

Defines whether or not new diagrams can
be added to the model.
Note: this option will be internally set
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and restricted to 'false" for Pro Cloud
Server Express installations.
Options:     true or false
Default:    false
Example:     add_diagrams = "true"

add_objectty
pe_<type>

Defines whether or not elements of the
given object type can be added to the
model.
These options are forced to false if
'add_objects' has been set to false.
<type> can be one of:

package·

review·

actor·

change·

component·

feature·

issue·

node·

requirement·

task·

usecase·

Options:     true or false
Default:        false
Example:     add_objecttype_actor =
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"true"

add_object_f
eatures

Defines whether or not element features
can be added to the model.
Note: this option will be internally set
and restricted to 'false" for Pro Cloud
Server Express installations.
Options:     true or false
Default:    false
Example:     add_object_features = "true"

add_objectfe
ature_<type>

Defines whether or not element features
of the given type can be added to the
model.
These options are forced to false if
'add_object_features' has been set to
false.
<type> can be one of:

tests·

resources·

changes·

defects·

issues·

tasks·

risks·

Options:     true or false
Default:    false
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Examples:     add_objectfeature_changes
= "true"

edit_objectfe
ature_resourc
es

Defines whether or not the details of
element resource allocations can be
edited in the model.
Note: this option will be internally set
and restricted to 'false" for Pro Cloud
Server Express installations.
Options:     true or false
Default:        false
Example:
edit_objectfeature_resources = "true"

edit_objectfe
ature_tests

Defines whether or not the details of
element tests can be edited in the model.
Note: this option will be internally set
and restricted to 'false" for Pro Cloud
Server Express installations.
Options:     true or false
Default:        false
Example:     edit_objectfeature_tests =
"true"

Model watchlist settings
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The watchlist functionality allows users to quickly see a
wide variety of objects that have changed recently in the
model. WebEA users can configure their personal
preferences to control what sort of objects they are
interested in 'watching'.

All watchlist settings are prefixed by 'wl_' and represent the
default value for the model. However, once a user saves
their own watchlist settings the model defaults will no
longer be used.

In order to persist the watchlist preferences across sessions,
WebEA saves them in a browser cookie. If the user's
browser does not allow the saving of cookies, personal
watchlist settings can not be persisted across sessions.

Option Description

cookie_retent
ion

Defines the period over which a WebEA
user's set of Watch list options are stored.
The value is the number of days that the
cookies will be retained for.
Options:    any positive integer value
Default:    365
Example:    cookie_retention = "180"

wl_period Defines the default activity period of the
model watchlist. The value is a number of
days; for example, look for activity in the
last 10 days.
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Options:    any positive integer value
Default:    0
Example :    wl_period = "10"

wl_recent_di
scuss

Define whether or not the watch list
should display a count of elements that
have had discussions during the activity
period.
Options:     true or false
Default:    false

wl_recent_re
views

Define whether or not the watch list
should display a count of review elements
that have been added or modified during
the activity period.
Options:     true or false
Default:    false

wl_recent_di
agram

Define whether or not the watch list
should display a count of added/modified
diagrams during the activity period.
Options:     true or false
Default:    false

wl_recent_el
ement

Define whether or not the watch list
should display a count of added/modified
elements during the activity period.
Options:     true or false
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Default:    false

wl_resalloc_a
ctive

Define whether or not the watch list
should display a count of elements with
active resource allocations during the
activity period.
Options:     true or false
Default:    false

wl_resalloc_t
oday

Define whether or not the watch list
should display a count of elements with
resource allocations ending during the
activity period.
Options:     true or false
Default:    false

wl_resalloc_
overdue

Define whether or not the watch list
should display a count of elements with
resource allocations that fall overdue
during the activity period.
Options:     true or false
Default:    false

wl_test_recen
tpass

Define whether or not the watch list
should display a count of elements with
tests that passed during the activity
period.
Options:     true or false

(c) Sparx Systems 2018 Page  396 of 1073



User Guide - Model Repository 21 December, 2018

Default:    false

wl_test_recen
tfail

Define whether or not the watch list
should display a count of elements with
tests that failed during the activity period.
Options:     true or false
Default:    false

wl_test_recen
tdefer

Define whether or not the watch list
should display a count of elements with
tests that were deferred during the
activity period.
Options:     true or false
Default:    false

wl_test_recen
tnotchk

Define whether or not the watch list
should display a count of elements with
tests that were not checked during the
activity period.
Options:     true or false
Default:    false

wl_test_notru
n

Define whether or not the watch list
should display a count of elements with
tests that were not run during the activity
period.
Options:     true or false
Default:    false
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wl_change_v
erified

Define whether or not the watch list
should display a count of elements with
verified changes during the activity
period.
Options:     true or false
Default:    false

wl_change_r
equested

Define whether or not the watch list
should display a count of elements with
requested changes during the activity
period.
Options:     true or false
Default:    false

wl_change_c
ompleted

Define whether or not the watch list
should display a count of elements with
changes completed during the activity
period.
Options:     true or false
Default:    false

wl_change_n
ew

Define whether or not the watch list
should display a count of elements with
new changes added during the activity
period.
Options:     true or false
Default:    false
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wl_change_i
ncomplete

Define whether or not the watch list
should display a count of elements with
incomplete changes during the activity
period.
Options:     true or false
Default:    false

wl_defect_ve
rified

Define whether or not the watch list
should display a count of elements with
verified defects during the activity period.
Options:     true or false
Default:    false

wl_defect_re
quested

Define whether or not the watch list
should display a count of elements with
defects reported or 'requested' during the
activity period.
Options:     true or false
Default:    false

wl_defect_co
mpleted

Define whether or not the watch list
should display a count of elements with
defects completed during the activity
period.
Options:     true or false
Default:    false
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wl_defect_ne
w

Define whether or not the watch list
should display a count of elements with
defects added during the activity period.
Options:     true or false
Default:    false

wl_defect_in
complete

Define whether or not the watch list
should display a count of elements with
incomplete defects during the activity
period.
Options:     true or false
Default:    false

wl_issue_veri
fied

Define whether or not the watch list
should display a count of elements with
verified issues during the activity period.
Options:     true or false
Default:    false

wl_issue_req
uested

Define whether or not the watch list
should display a count of elements with
issues reported or 'requested' during the
activity period.
Options:     true or false
Default:    false

wl_issue_co
mpleted

Define whether or not the watch list
should display a count of elements with
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issues completed during the activity
period.
Options:     true or false
Default:    false

wl_issue_ne
w

Define whether or not the watch list
should display a count of elements with
issues added during the activity period.
Options:     true or false
Default:    false

wl_issue_inc
omplete

Define whether or not the watch list
should display a count of elements with
incomplete issues during the activity
period.
Options:     true or false
Default:    false

wl_task_verif
ied

Define whether or not the watch list
should display a count of elements with
verified tasks during the activity period.
Options:     true or false
Default:    false

wl_task_requ
ested

Define whether or not the watch list
should display a count of elements with
requested tasks during the activity period.
Options:     true or false
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Default:    false

wl_task_com
pleted

Define whether or not the watch list
should display a count of elements with
tasks completed during the activity
period.
Options:     true or false
Default:    false

wl_task_new Define whether or not the watch list
should display a count of elements with
tasks added during the activity period.
Options:     true or false
Default:    false

wl_task_inco
mplete

Define whether or not the watch list
should display a count of elements with
incomplete tasks during the activity
period.
Options:     true or false
Default:    false

wl_event_req
uested

Define whether or not the watch list
should display a count of elements with
requested events during the activity
period.
Options:     true or false
Default:    false
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wl_event_co
mpleted

Define whether or not the watch list
should display a count of elements with
events completed during the activity
period.
Options:     true or false
Default:    false

wl_event_hig
h

Define whether or not the watch list
should display a count of elements with
events set to high during the activity
period.
Options:     true or false
Default:    false

wl_decision_
verified

Define whether or not the watch list
should display a count of elements with
verified decisions during the activity
period.
Options:     true or false
Default:    false

wl_decision_
requested

Define whether or not the watch list
should display a count of elements with
requested decisions during the activity
period.
Options:     true or false
Default:    false
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wl_decison_c
ompleted

Define whether or not the watch list
should display a count of elements with
decisions completed during the activity
period.
Options:     true or false
Default:    false

wl_decision_
new

Define whether or not the watch list
should display a count of elements with
decisions added during the activity
period.
Options:     true or false
Default:    false

wl_decision_
incomplete

Define whether or not the watch list
should display a count of elements with
incomplete decisions during the activity
period.
Options:     true or false
Default:    false
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How to configure WebEA Localization

The physical text values of all labels and messages within
WebEA are defined in a single file that is read when the web
pages are being built. This allows WebEA customers to
tailor the content of web pages displayed to their users.

WebEA's default language is English. As pages are built on
the server, the WebEA application will check whether there
is a defined localization for a string and use that. If a
localized version of the string is not defined then WebEA
will use the default English value.

The WebEA localization definitions are saved in the file
'webea_strings.ini' in the '\includes\' folder. The localization
file is saved in plain text format with each localized string
being defined on a separate line with the syntax:

  {default_english_string} = "{localized_string}"

Note that:

Localized string values are enclosed by double quotes·

The configuration file supports comments; the semi-colon·

character starts a comment

The supplied 'webea_strings.ini' file includes a definition·

of all strings used within the WebEA application,
therefore there is no need to add any new lines to the file

For example, on the login page the first label is "Select
Model" in the English version; however, a French user
would want to change this text to:

    Select Model = "Sélectionnez le modèle"
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Replacements

The wording of some labels/messages within WebEA
requires the names of items to be added to the string
displayed. Such replacements are denoted by the %s
placeholder. The localized versions of these strings should
also include the %s placeholder in the appropriate position.

The other standard replacement that WebEA supports is the
replacement of %NN% with a number. For example, in the
Watchlist when WebEA detects that elements have been
modified recently, this message is used:

    %NN% recently modified element%S% = "%NN%
recently modified element%S%"

%NN% will be replaced with a count of recently modified
elements.

Plurals

Given the nature of the English language, some of the
localized strings support the ability to display words in their
plural form. WebEA supports the special substitution of
%S% which will replace, %S% with 's' when the supplied
number is greater than 1. Using our example, when a single
element has been modified recently the message displayed
on the watchlist page is:

    1 recently modified element
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However, when there are five recently modified elements,
WebEA would generate the message:

    5 recently modified elements
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Advanced SSL

Adding trust to a Self-Signed Certificate

A self-signed SSL certificate can be signed with your own
Certificate Authority (CA). This allows trust to be added to
clients to avoid security warnings. The instructions for
adding a CA to a client vary by operating system or browser
used.

See Add Trust with a Certificate Authority (CA) for
instructions on generating a CA and using it to sign server
certificates.

WebEA uses PHP and cURL to communicate with a Pro
Cloud Server. To enable PHP/curl to trust a new CA:

Add/edit 'curl.cainfo' in php.ini to point to either a single
root CA certificate or a CA bundle file (this is multiple crt
files concatenated together).

[curl]

; A default value for the CURLOPT_CAINFO option. This
is required to be an

; absolute path.

curl.cainfo="C:\xampp\php\MyCompanyCA.crt"

Restart Apache/PHP.
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WebEA User Guide

Sparx System's WebEA is an external interface to Enterprise
Architect models through which users can review and
comment on a model, in real time via the web, on a range of
mobile devices or a remote work station, without needing to
install Enterprise Architect. The reviewer can be anywhere
in the world, and does not need to be in an office, just
somewhere where internet access is available. It is ideal for
stakeholders and clients to see the work in which they are
invested, and to comment on and discuss aspects of the
model.

WebEA models can be configured to allow users to update
element notes, add element features (such as tests and
resource allocations) and even create Project Management
elements (to record issues, changes and similar), or Use
Cases, Requirements and system components.

WebEA is the interface to the model, so although you are
using your web browser, the data shown is the same as that
shown when you use Enterprise Architect. This means that
all model updates occur in real time, so WebEA users can be
confident that they are seeing the latest version of the model
structure.

How to Open WebEA

Open the web browser on your device and, in the address
bar, type in the complete WebEA URL. Press the Enter key
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or tap the Go key.

These are some examples of the complete URL that might
be needed to open WebEA.

     http://demo.sparxpublic.com

In the case where the web server has the IP of 11.22.33.44
and has been configured to use the non-standard port of 800,
the complete URL would be:

     http://11.22.33.44:800

If the WebEA application files were placed in a sub-folder
called 'WebEA' under the web server's root folder, then the
complete URL would be:

     http://11.22.33.44:800/WebEA/

If the entered URL is a valid, the WebEA Login page is
shown, which will show all the models that are available.
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Login

WebEA websites are configured to allow access to one or
more Enterprise Architect models, each of which can be
configured independently to only grant access to users with
valid logon credentials. WebEA user validation supports
two forms of security: 1) an access code and 2) standard
Enterprise Architect model security. These two validation
methods can be used independently or in combination in
each model.

Prerequisites

Users of WebEA will need to be advised of their login
credentials for each model, which will include:

An access code, or·

A user ID and password, or·

Possibly all three·

This data will be provided to you by your Web
Administrator or by the Project Manager responsible for the
model.

Logging In

The first page that is displayed in WebEA is the 'Login'
page, which lists the models available to you.
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Select the model you want to open, then click or tap on
either the Mobile, Tablet, or Desktop button. The button
selected determines whether the Browser and Properties
View will be enabled by default.

If access to your model requires only an access code, then
the 'Login' page prompts you for this.

Note:

The red asterix (*) denotes a mandatory field.·

Access Codes are not required for Windows·

Authentication or OpenID authentication.
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If User Security has been applied to the model, the 'Login'
page prompts you for your user ID and password.

If the model requires both an access code and a user
id/password, the 'Login' page prompts for both together:
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Single Sign On

This feature is available from Enterprise Architect Release
14.1 and Pro Cloud Server Release 3.0 build 23.

If the Enterprise Architect model has been configured to for
Windows and or OpenID authentication then the 'Login'
page will show the relevant single sign buttons 'Login with
OpenID' or 'Login with Windows ID'. Clicking the OpenID
login button will redirect the user to the OpenID Server
Authentication page. After authenticating with OpenID the
browser will automatically return to WebEA and log the
user in.

If the user is already authenticated with OpenID, the
OpenID website might not be displayed, and the user will
simply be logged in.

If the model is configured to also allow manual login then
both the Single Sign On buttons and manual login fields will
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be visible on the Login page. If the option 'Restrict access to
Windows & OpenID users only' is checked then the manual
login fields will not be available.

See:

Single Sign-On (SSO) Options·

If you do not have the authorization data, click or tap on the
Back button to go back and select another model.

Otherwise, type in your access code and/or user ID and
password, and click on the Login button.
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WebEA's layout

Having logged on to a model in WebEA, and depending on
how the model has been configured to display on opening,
you will be initially shown the model root icons; a simple
specification list of the model root nodes; a list showing the
root node names, types and last modification date; or a
default diagram (if one is defined for the model). From this
point you can start navigating the model by selecting objects
or links, review the organization and contents of the model
elements, and read and add to discussions or reviews of
particular structures.

Note: WebEA only supports single click when using a PC,
or single touch when using a touch-enabled device.

These images show the WebEA screen when the root node
of the example model is displayed in Icon and List views.
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The WebEA view can be broken into four sections: heading,
navigation bar, content area and status bar.

Note: In order to support small screen devices, some layout
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sections move or merge with others to minimize the amount
of screen real estate needed. For example, the heading
section merges with the Navigation bar when the screen
height goes below 400 pixels.

Heading

WebEA's heading area displays the application logo in the
top right corner, the name of the currently opened model, a
search icon and a 'hamburger' icon. The search and
'hamburger' icons contain further options that are accessible
when selected.

Search

The search icon provides access to the search functionality
offered by WebEA. The functionality includes a number of
standard searches, the Watchlist and the custom search.

Icon Description
Goto item

Select to display the 'Goto WebEA item'
dialog, into which you paste (Ctrl+V) a
WebEA item's unique ID that you have
copied earlier, using the 'Direct Link' icon
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in the page Navigation Bar (see the
Navigation Bar table in this topic). Click
on the Go button to load the details of the
specified object.

Reviews
Select to display a list of all recently
modified Review elements.
Note: The number of days that are
considered 'recent' is defined as a
configuration option for the model.

Discussions
Select to display a list of all elements to
which a Discussion item has been
recently added.

Diagrams
Select to display a list of all recently
modified diagrams.

Elements
Select to display a list of all recently
modified elements (new Discussion items
are not regarded as modifications to the
element).

Watchlist
Select to display the 'Watchlist summary'.
The Watch List facility in WebEA helps
you to quickly identify recent activity in
the model.

Matrix
Select to display the 'Matrix Profiles'
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page, which helps you to select any
matrix profile defined in the model and to
display the associated Relationship
Matrix.

Custom
search Select to display the 'Custom Search'

dialog. WebEA provides a facility that
enables you to search through the model
for a specific item or group of items that
have certain characteristics.

Hamburger

The hamburger icon provides access to these options:

Icon Description
Browser

Choose this option if you prefer to
display a 'context browser' view on the
left side of the main content area. This
area will contain the currently selected
object and a list of all of its child objects.
Between the object name and the name of
the first child object is a  icon;
clicking on this icon refreshes the display
to show the next-highest level of the
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hierarchy.
Note: This option is disabled when the
screen is less than 800 pixels in width.

Properties
Choose this option to display the
'Properties View' on the right side of the
main content area.
When viewing a diagram the Properties
View allows you to access properties of
an element without navigating away from
the diagram.
When viewing an element, the Properties
View allows you to have a Split View of
the element's properties, displaying one
feature in the Main View while also
showing another in the Properties View
(for example, you could add Discussions
in the Main View while referring to the
element's notes in the Properties View).
Note: This option is disabled when the
screen is less than 800 pixels in width.
Note: By enabling this option, links in the
Diagram View are changed to populate
the Properties View instead of navigating
to the selected object. It is important to
realize that selecting objects in the
Diagram View while the Properties View
is displayed will not affect the navigation
history, so you can select as many objects
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as you need in the current view and see
their properties without navigating away
from the current diagram.

Icon view
Choose this option if you prefer the
display of the model content to be in icon
format (as illustrated at the start of this
topic).

List view
Choose this option if you prefer the
display of the model content to be in list
format (as illustrated at the start of this
topic).

Notes view
Choose this option to display the model
content to be displayed as a list of
element names and notes (if present).
This is similar to the Enterprise Architect
Specification Manager display.

Logout
Choose this option if you want to
disconnect from the current model. After
the logout process has run, the 'Login'
dialog automatically displays.

Navigation Bar
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The Navigation bar provides information and buttons that
assist in navigating an Enterprise Architect model. The
various buttons available in the Navigation bar are explained
in this table.

Icon Description
Home

Click on this button to return focus to the
'home' object for the current model. The
home object is either the model's default
diagram (if defined in the configuration
file) or the model root Package.

Object Path
Click on this button to display the
complete path of parent nodes, Views,
Packages and elements for the current
object, all the way to the model's root
node.
You can click on any item in the list
(except for the last one, which is the
current object) and navigate directly to
that object.
Note: When viewing the root node there
will be only one entry, which is not
selectable.

Current
object This is a read-only text field that displays
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the name and object type (displayed as an
image) of the current object.

Refresh
Click on this button to refresh the current
view. For example, if you are currently
viewing a diagram and a user in
Enterprise Architect has made changes to
it since you opened it, simply click the
Refresh button; WebEA will display the
newly updated diagram.

Direct Link
Click on this button to display the 'Link
to WebEA item' dialog, which shows the
current item's unique ID and full URL.
You can highlight the ID and press
Ctrl+C to copy it, then at a later point use
it in the 'Goto WebEA item' dialog to
return directly to that page, as described
in the Search table earlier.
Alternatively, you can copy the full URL
and send it to another user if you want
them look at a particular item.

Properties
Click on this button to display the
properties of the currently opened
Package or diagram.
Note: This button is only enabled when
properties can be shown for the current
item.

(c) Sparx Systems 2018 Page  426 of 1073



User Guide - Model Repository 21 December, 2018

Content Area

WebEA's content area adjusts and adapts to display a
custom layout for the currently selected item, depending on
its type. For example, when a diagram is selected the
content area consists entirely of the diagram image, but
when a Package is selected the content area displays a view
of child objects in that Package.

See the Content Area section later in this guide for more
details.

Status bar

The WebEA Status bar is displayed at the very bottom of
the page, and is an area reserved for the display of
information about the application. However, typically it will
only consist of a single 'A' button in the right corner which,
when clicked or tapped, will display the 'WebEA About'
screen.

Review element

If you have joined a review, the name of the Review
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element will display in the Status bar on the left side of the
About button, as shown in the image.

iOS Scrolling

When accessing WebEA via iPad or iPhone the status bar
will display "iPad Diagram Scrolling: Off" or "iPhone
Diagram Scrolling: Off" respectively. Touch this text to
toggle the option On/Off.

Typically images can be scrolled on mobile devices by
touching/dragging on the image, however iOS browsers will
not scroll if you are touching a clickable area (such as an
element on a diagram). This could make scrolling difficult
on diagrams which are densely populated with clickable
elements.

iPad/iPhone Diagram Scrolling: On

Diagram elements will not be selectable, allowing you to
scroll by touching/dragging anywhere on the diagram.

iPad/iPhone Diagram Scrolling: Off

Diagram elements will be selectable, however to drag the
diagram image you will need to ensure you are not touching
a selectable element.
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Content Area

The main content area of WebEA consists of:

- The Main View in the center. This is used for displaying
such things as diagrams and element properties

- Optionally, the Browser on the left. This is used to assist in
navigating the model.

- Optionally, the Properties View on the right. This allows
you to view properties of an element while simultaneously
viewing something else (such as a diagram) in the main
view.

Details

(c) Sparx Systems 2018 Page  429 of 1073



User Guide - Model Repository 21 December, 2018

Main View The Main View typically displays these
types of content:
- A Diagram Image
- The Properties of an element
- A list of objects that are contained in a
specific Package (or objects that are
children of a specific element). This
object list is only accessible when the
Browser is not displayed (as the Browser
functions as an alternative).

Browser The Browser assists with Navigation, and
provides context for the object which is
currently displayed in the Main View

Properties
View

The Properties View displays properties
of a selected object. When viewing a
Diagram, it allows you to view some
properties of an element without
navigating away from the diagram.
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Main View - Object List

In Main View's Object List the child objects of a container
are represented in one of three viewing styles: Icon, List or
Notes view.

It is possible to define a default viewing style for a model, in
the configuration file. However, you can also change the
style for the current session using the menu items in the
'Hamburger' menu; see the WebEA's Layout Help topic.

Icon View

In Icon view, each object is represented by an image and
object name. As an example, a root node with the name
'ASA Finance' would be represented by:

A View object with the name 'Class Model' would be
represented by:

List View
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In List view each object is represented as a row in a table,
which includes columns for name, type, author and modified
date. The earlier examples would be represented in List
view like this:

Notes View

In Notes view each object is represented by the object name
and any text from the object's 'Notes' field.

Display Order

In Object View, objects are displayed in the predefined
order: Packages, diagrams and elements; if there are
multiples of any object type then they will be sorted in
alphabetical order. This is different to Enterprise Architect's
behavior, which can allow elements to be manually ordered.

As an example:

(c) Sparx Systems 2018 Page  432 of 1073



User Guide - Model Repository 21 December, 2018

Additional Symbols

While navigating the model structure with WebEA you
might see a number of symbols applied to the object images.
Each symbol has a meaning: the  symbol indicates that the
object contains children, whilst the  symbol indicates the
object is locked to the current user.

The action taken when an item is selected is dependent on
the object type of the item.

For Packages, the default action is to navigate down one·

level of the Project Browser and display the child objects
contained within that Package

For diagrams the default action is to open the diagram·

image

For elements the default action is to display the Properties·

for the selected element

To open the properties of a Package while viewing it in the
Object View, click on the  button in the Navigation bar.

If you navigate to a Package that does not have children, the
message 'No child element(s)' will be displayed.
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Adding New Elements

If the model has been configured to allow the addition of
elements and the current user has the required permissions,

the  icon will be shown as the last element of a
Package's object view. For more details see the Object
Creation in WebEA Help topic.

Notes

WebEA's WebEA - Browser acts as an alternative to the·

Object List. If the WebEA Browser is displayed then the
Object List is not accessible.
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Main View - Diagram

When a diagram is selected, the Main View content area
displays the entire diagram as a single image. As an
example, this is the default diagram in the EAExample
model:

Objects on the diagram are selectable and, based on the
object type and if the 'Properties View' is visible, will
behave slightly differently.

The behavior when the 'Properties View' is not visible:

Packages: opens the select Package in the Object View·

mode

Diagrams: opens the selected diagram image·
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Elements: opens the selected element in the Main View·

Hyperlinks to external URLs: navigates away from·

WebEA and loads the external URL

The behavior when the 'Properties View' is visible:

Packages: main properties are displayed in the 'Properties·

View'

Diagrams: main properties are displayed in the 'Properties·

View'

Elements: main properties are displayed in the 'Properties·

View'

panel·

Hyperlinks: navigate to link target·

Notes

To open the properties of a diagram while viewing the·

diagram image click the  button in the Navigation bar
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Main View - Object Properties

When selecting an element in WebEA its properties are
displayed in the Main View. The Main View Properties
consist of a section at the top with common element
properties, followed by a row of feature buttons (Notes,
Relationships, etc) which can be used to access specific
features. By default the Notes are displayed.

Common Properties
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The common properties section displays an image
representing the object's type, and its name, type and
stereotype. This is followed by general information about
the object, such as author, time and date created and last
modified, the version, phase and status. Note, the Properties
View can also be enabled and displayed alongside the Main
View's Object Properties. In this case the author, version,
and other characteristics will only be displayed in the
Properties View.

If the model has been configured to allow it, there will be·

an element 'Hamburger' icon that allows the creation of
object features; see the Object Creation in WebEA Help
topic for further details

If the element has a regular Linked Document applied, a·

line with 'Linked Document' and an Open button will be
displayed immediately under the object's name and type
fields; clicking on the Open button will display the
contents of the Linked Document

If the element has an encrypted Linked Document·

applied, in addition to the 'Linked Document' label and
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Open button a password textbox displays; if you enter the
correct password and click or tap on the Open button the
contents of the encrypted document will be displayed

If the element has a stored Document applied, a·

Download button (along with the label 'Stored Document')
will be displayed; clicking on the Download button will
save the document to the user's machine where they can
use the appropriate application to view it

If the element has an image asset applied, a Download·

button (along with the label 'Image Asset') will be
displayed; clicking on the Download button will save the
image to the user's machine where they can use the
appropriate application to view it

Selectable Features

After the Common Properties a number of buttons are
displayed that allow you to view other features of the object
(including Location, Tagged Values, Attributes and
Operations). By default, the element Notes will be selected
and displayed. Clicking on one of the other buttons will
display the relevant details.

Buttons are available for displaying these features:

Notes: the notes of the current object·
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Location: information relating to the current object's·

parent, any diagrams that the element appears on, and a
list of instances that the element is a classifier of

Tagged Values: a list of defined Tagged Values for the·

current object

Relationships: a list of incoming and outgoing·

connections for the current object; clicking on the
connector type will display the connector's properties

Attributes: a list of all defined attributes for the current·

object

Operations: a list of all defined operations for the current·

object

Requirements: a list of all defined internal requirements·

(responsibilities) for the current object

Constraints: a list of all defined constraints for the current·

object

Scenarios: a list of all defined scenarios for the current·

object

Tests: a list of all defined tests for the current object.·

Selecting a test from the list will display more
information. If you have the required permissions and the
model has been configured correctly, clicking or tapping
the pencil icon will allow you to edit the details of the
selected test

Resources: a list of all defined Resource Allocations for·

the current object. Selecting a resource from the list will
display more information. If you have the required
permissions and the model has been configured correctly,

(c) Sparx Systems 2018 Page  440 of 1073



User Guide - Model Repository 21 December, 2018

clicking or tapping the 'Pencil' icon will allow you to edit
the details of the selected resource allocation

Changes: a list of all defined changes for the current·

object. Selecting a change from the list will display more
information.

Defects: a list of all defined defects for the current object.·

Selecting a defect from the list will display more
information.

Issues: a list of all defined issues for the current object.·

Selecting an issue from the list will display more
information.

Tasks: a list of all defined tasks for the current object.·

Selecting a task from the list will display more
information.

Events: a list of all defined events for the current object.·

Selecting an event from the list will display more
information.

Decisions: a list of all defined decisions for the current·

object. Selecting a decision from the list will display more
information.

Effort: a list of all defined effort items for the current·

object

Risks: a list of all defined risks for the current object·

Metrics: a list of all defined metrics for the current object·

Discussions: a list of all formal review discussions and·

informal discussions on the element; if the current model
has been configured to allow it, you can contribute to
discussions on the current object - for further information
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on these facilities, see the Reviews in WebEA and
Discussions in WebEA Help topics
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WebEA - Browser

The WebEA 'Browser' displays a context sensitive view of a
Package or Element and its children. It can be enabled via
the 'Browser' option in the main 'Hamburger' menu which is
located in the upper right corner of WebEA. When enabled,
the Browser displays on the left side of WebEA's Main
View.

If the currently selected object is a Package, or an element
with children, then the Browser displays the object at the
parent level, and the children below it.

If the currently selected object is a diagram or an element
without children, then the Browser displays the object's
parent, then its children (which include the current object
and its siblings)

If the currently selected object is not the root, then the
second item in the Browser is an up arrow, allowing
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navigation to the next level up. Selecting an object in the
'Browser' panel will cause WebEA to navigate to that object.

Notes

The Browser panel is only visible if the screen is greater·

than 800 pixels wide.

The Browser acts as an alternative to viewing the object·

list in WebEA's Main View. When the Browser is enabled
the Main View - Object List is not accessible.
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WebEA - Properties View

The WebEA 'Properties View' displays a context sensitive
view of a Package or element and its children. It can be
enabled via the 'Properties' option in the main 'Hamburger'
menu which is located in the upper right corner of WebEA.
When enabled, the Properties View displays on the right
side of WebEA's Main View.

The 'Properties View' displays the principle property details
of the object currently selected in the main content area,
these being the name, type, notes, creation and modification
dates, version and location details.

By default, the 'Properties View' will also display the
element Notes; however, you can select a different feature to
display in this location by using the 'Select Feature'
Hamburger menu (to the right of the 'Notes' heading).
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The main purpose of the 'Properties View' is to allow users
to quickly and easily see details of elements without
navigating away from a diagram.

The 'Properties View' is also displayed while viewing the
Full Properties of an object in WebEA's Main View. This
allows you to access one feature of the element (such as
Notes) in the 'Properties View' while also accessing another
(such as Discussions) in the Main View.

Navigation Buttons
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When appropriate, the Properties View will also include
navigation buttons that allow you to either display the
object's full properties in WebEA's Main View, or view the
element/Package's children.

Button Description

This can be used to navigate to the object,
showing its full properties in the Main
View.

If you have selected a Package or an
Element with children, and the Browser
is not currently enabled then an additional
icon is displayed. This allows you to view
the object's children in the object list/icon
view.

Navigation Element Behavior

Within Enterprise Architect it is possible to define a number
of different element types that make it easier to navigate
your model (Hyperlinks, Navigation Cells, etc). By default
selecting one of these objects in WebEA will navigate
directly to the target (instead of displaying its properties in
the Properties View).

If necessary, you can change this behavior using the 'How to 
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configure WebEA models' configuration option.

Notes

The Properties View is only visible if the screen is greater·

than 800 pixels wide.

Selecting elements on a diagram while the Properties·

View is shown will not effect the browsing history.
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Object Creation in WebEA

Depending on how the current model has been configured in
the WebEA configuration file and your security access to
the model, you might have the ability to create a range of
objects in the model through WebEA. These objects
include: Packages and diagrams; elements such as Use
Cases, Requirements, Components, Changes and Issues; and
features of elements such as Tests, Decisions, Defects and
Events. You can therefore define additional scope or
problems that have arisen, directly in the model, with
precision and in detail, adding to the accuracy and quality of
the solution that the model represents.

The Project Manager responsible for the model should guide
you in how to create objects and in the purpose of you doing
so.

In addition to adding new elements you might also be able
to edit the Notes of any object regardless of type, and the
details of element Tests and Resource Allocations for any
element in the model, whether you have created it or not.
See the Edit Objects Help topic.

Note: the ability to Create objects is only possible in the
Premium (Small Business, Team and Enterprise) editions of
the Pro Cloud Server.

Adding Objects
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You can quickly establish if you have the ability to create
objects in WebEA by checking the WebEA - Browser or the
Main View - Object List.

If you are able to create objects then the final item in the list
will be a '<new>' button.

For example:

Click on this button to display the 'Add Object' page.
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Field Description

Element type Click on the drop-down arrow and select
the type of object to create. Depending on
your security permissions and the model's
options, you can create some or all of
these objects:

Package·

Diagram·

Review·

Actor·

Change·

Component·

Feature·

Issue·

Node·

Requirement·

Task·

Use Case·

Technology This is an optional field that is only
visible when 'Diagram' is selected as the
element type. It allows the selection of a
Technology that provides an additional
set of diagram types.

Diagram This is an optional field that is only
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Type visible when 'Diagram' is selected as the
element type. Click on the drop-down
arrow and select the type of diagram to
create.

Name Type in an appropriate name for the
object, preferably giving some indication
of its purpose or function.

Notes Type in a more detailed description of the
element, such as why you are creating it
and what other elements it might be
associated with.
You can format this text using the
facilities provided in the Notes toolbar.
These are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

Add Click on this button to add the new object
to the Package in which you are creating
it. This message displays:
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    Object added
Either:

Work through the fields again, defining·

another new object in this Package, or

Click on the  icon and select the·

Package line to return to the 'Hierarchy'
view of the Package, now containing
the new element

Adding Element Features

You can, again, quickly establish if you have the ability to
create element features in WebEA, by displaying the
Properties of an element in WebEA's Main View - Object 
Properties; if the  icon displays in the right corner of the
element name/notes panel, you can add element features.

Display the Properties of the element to which you want to
add a feature, and click on the  icon. A menu displays
offering options to add to the element each feature that you
have the access permissions to create. These features might
include:

Other Objects·

Tests·

Resources·

Changes·
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Defects·

Issues·

Tasks, or·

Risks·

Select the appropriate option; a dialog displays in which you
complete the fields to define the feature for the element.
Each type of feature has a different dialog; refer to these
topics for the details appropriate to each dialog.

Add Test Records·

Add Resource Records·

Add Change Requests·

Add a Defect·

Add an Issue Notification·

Add a Task·

Add a Risk·

Notes

As suggested in the Adding Element Features section, you·

can also add an object to a Package or to another object
within the Main View's Object Properties page; click on
the 'Hamburger' icon and select the 'Add Object' option,
and complete the 'Add Object' page as described at the
start of this topic
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Add Test Records

Within an element, you can create a record for each Test
that you want to add to the element.

Add a Test

Display the Properties of the element to which you want to
add the Test record, and click on the  icon. A menu
displays offering options to add various features to the
element. Select the 'Add Test' option. The 'Add Test to
<element name>' dialog displays.
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Mandatory fields on the dialog are indicated by a red
asterisk (*).

Complete the fields as directed here.

Field Action

Test name Type an appropriate and meaningful
name for the Test.

Click on the drop-down arrow and select
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Class Type the appropriate test group; that is:
Unit·

Integration·

System·

Acceptance·

Scenario, or·

Inspection·

Type Click on the drop-down arrow and select
the appropriate test type; that is:

Load·

Regression or·

Standard·

Status Click on the drop-down arrow and select
the appropriate test status; that is:

Not Run (the most likely value for a·

new record from you)
Pass·

Fail·

Deferred or·

Cancelled·

Run by If the test has been run, click on the
drop-down arrow and select the name of
the person who ran it.
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Last Run If the test has been run, click on the
calendar icon and select the date on
which the test was most recently run.

Checked by If the test has been run, click on the
drop-down arrow and select the name of
the person who checked the test
execution and results.

Description Type in a description of the test, what it is
intended to show and why it is necessary.
You can format this text using the
facilities provided in the Notes toolbar.
These are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

Input Type a description of what actions or
parameters are required as input to this
test.
You can format this text using the
facilities provided in the Notes toolbar.
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Acceptance
Criteria

Type a description of what criteria must
be satisfied to indicate that the test has
passed.
You can format this text using the
facilities provided in the Notes toolbar.

Results Type a description of the expected and/or
actual results of this test.
You can format this text using the
facilities provided in the Notes toolbar.

Add Click on this button to submit the details
and create the Test record on the selected
element.
This message is displayed:
    Test <name> was successfully added
to <element name>.
Either:

Work through the fields again, defining·

another new Test on this element, or
Click on the browser's Back button to·

return to the 'Properties' view of the
element, which will be refreshed to
show the new record in the 'Testing'
panel
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Add Resource Records

Within an element, you can create a record for each
Resource that you want to add to the element.

Add a Resource

Display the Properties of the element to which you want to
add the Resource record, and click on the  icon. A menu
displays offering options to add various features to the
element. Select the 'Add resource' option. The 'Add resource
allocation to <element name>' dialog displays.

Mandatory fields on the dialog are indicated by a red
asterisk (*).
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Complete the fields as directed here.

Field Action

Resource Click on the drop-down arrow and select
the name of the person to be allocated as
the resource.

Role Click on the drop-down arrow and select
the role of the resource in this work; for
example:

Application Analyst·

Business Analyst·

C++ Programmer·

Project Manager·

Start date Click on the calendar icon and select the
date on which the resource is expected to
start the assigned work.

End date Click on the calendar icon and select the
date on which the resource is expected to
complete the assigned work.

% Complete Click on the up and down arrows to
change the field value to the percentage
completion of work that the resource has
achieved.
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Description Type in a description of the resource
allocation - what the work is, why this
(kind of) resource is required to do it, and
any criteria that must be satisfied.
You can format this text using the
facilities provided in the Notes toolbar.
These are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

Add Click on this button to submit the details
and create the Resource Allocation record
on the selected element.
This message is displayed:
    Resource allocation for <name> was
successfully added to <element name>.
Either:

Work through the fields again, defining·

another new Resource Allocation on
this element, or
Click on the browser's back button to·
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return to the 'Properties' view of the
element, which will be refreshed to
show the new record in the 'Resource
Allocation' panel
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Add Change Requests

Within an element, you can create a record for each Change
Request that you want to add to the element.

Add a Change Request

Display the Properties of the element to which you want to
add the Change Request, and click on the  icon. A menu
displays offering options to add various features to the
element. Select the 'Add change' option. The 'Add change to
<element name>' dialog displays.
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Mandatory fields on the dialog are indicated by a red
asterisk (*).

Complete the fields as directed here.

Field Action

Name Type an appropriate and meaningful
name for the requested change.

Status Click on the drop-down arrow and select
the appropriate request status; that is:

New·
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Verified, or·

Complete·

Priority Click on the drop-down arrow and select
the appropriate priority value; that is:

High·

Medium, or·

Low·

Requested by Click on the drop-down arrow and select
the name of the person requesting the
change.

Requested on Click on the calendar icon and select the
date on which the request was made.

Completed
by

If the change has been completed, click
on the drop-down arrow and select the
name of the person who completed it.

Completed
on

Click on the calendar icon and select the
date on which the requested change was
completed.

Version Type in a version number or letter to
indicate any evolution of the same
change. Generally, '1.0' indicates the first
instance of a change.
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Description Type in a description of the change, what
it is intended to be and why it is
necessary.
You can format this text using the
facilities provided in the Notes toolbar.
These are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

History If there is any background to this change,
such as previous versions, document
them here (you might copy the
'Description' from the last version or
iteration of this change, for example). It is
recommended that you include a date
stamp and user initials in the entry.
You can format this text using the
facilities provided in the Notes toolbar.

Add Click on this button to submit the details
and create the change request on the
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selected element.
This message is displayed:
    Change <name> was successfully
added to <element name>.
Either:

Work through the fields again, defining·

another new change request on this
element, or
Click on the browser's back button to·

return to the 'Properties' view of the
element, which will be refreshed to
show the new record in the 'Changes'
panel
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Add a Defect

Within an element, you can create a record for each defect
that you want to add to the element.

Add a Defect Record

Display the Properties of the element to which you want to
add the defect record, and click on the  icon. A menu
displays offering options to add various features to the
element. Select the 'Add defect' option. The 'Add defect to
<element name>' dialog displays.
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Mandatory fields on the dialog are indicated by a red
asterisk (*).

Complete the fields as directed here.

Field Action

Name Type an appropriate and meaningful
name for the defect.

Status Click on the drop-down arrow and select
the appropriate record status; that is:

New·

Verified, or·

Complete·

Priority Click on the drop-down arrow and select
the appropriate priority value; that is:

High·

Medium, or·

Low·

Reported by Click on the drop-down arrow and select
the name of the person reporting the
defect.

Reported on Click on the calendar icon and select the
date on which the record was made.
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Resolved by If the defect has been resolved, click on
the drop-down arrow and select the name
of the person who resolved it.

Resolved on Click on the calendar icon and select the
date on which the recorded defect was
fixed.

Version Type in a version number or letter to
indicate any evolution of the same defect.
Generally, '1.0' indicates the first instance
of a defect.

Description Type in a description of the defect, what
it is, what the solution might be, and why
it is a problem.
You can format this text using the
facilities provided in the Notes toolbar.
These are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·
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History If there is any background to this defect,
such as previous occurrences, document
them here (you might copy the
'Description' from the last version or
iteration of this defect record, for
example). It is recommended that you
include a date stamp and user initials in
the entry.
You can format this text using the
facilities provided in the Notes toolbar.

Add Click on this button to submit the details
and create the defect record on the
selected element.
This message is displayed:
    Defect <name> was successfully added
to <element name>.
Either:

Work through the fields again, defining·

another new defect record on this
element, or
Click on the browser's back button to·

return to the 'Properties' view of the
element, which will be refreshed to
show the new record in the 'Defects'
panel
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Add an Issue Notification

Within an element, you can create a record for each issue
notification that you want to add to the element.

Add an Issue

Display the Properties of the element to which you want to
add the issue notification, and click on the  icon. A menu
displays offering options to add various features to the
element. Select the 'Add issue' option. The 'Add issue to
<element name>' dialog displays.
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Mandatory fields on the dialog are indicated by a red
asterisk (*).

Complete the fields as directed here.

Field Action

Name Type an appropriate and meaningful
name for the reported issue.

Status Click on the drop-down arrow and select
the appropriate issue status; that is:

New·
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Verified, or·

Complete·

Priority Defaults to 'High'. If necessary, click on
the drop-down arrow and select the
appropriate priority value; that is:

Medium, or·

Low·

Raised by Defaults to the first name in the list of
project users. If necessary, click on the
drop-down arrow and select the name of
the person raising the issue.

Raised on Defaults to today's date. If necessary,
click on the calendar icon and select the
actual date on which the issue was raised.

Completed
by

If the issue has been resolved, click on
the drop-down arrow and select the name
of the person who resolved it.

Completed
on

Click on the calendar icon and select the
date on which the issue was resolved.

Version Type in a version number or letter to
indicate any evolution of the same issue.
Defaults to '1.0', indicating the first
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instance of an issue.

Description Type in a description of the issue, what it
is, what the solution might be, and why it
is a problem.
You can format this text using the
facilities provided in the Notes toolbar.
These are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

History If there is any background to this issue,
such as previous occurrences, document
them here (you might copy the
'Description' from the last version or
iteration of this issue, for example). It is
recommended that you include a date
stamp and user initials in the entry.
You can format this text using the
facilities provided in the Notes toolbar.

Add Click on this button to submit the details
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and create the issue report on the selected
element.
This message is displayed:
    Issue <name> was successfully added
to <element name>.
Either:

Work through the fields again, defining·

another new issue on this element, or
Click on the browser's back button to·

return to the 'Properties' view of the
element, which will be refreshed to
show the new record in the 'Issues'
panel
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Add a Task

Within an element, you can create a record for each task that
you want to add to the element.

Add a Task Record

Display the Properties of the element to which you want to
add the task record, and click on the  icon. A menu
displays offering options to add various features to the
element. Select the 'Add task' option. The 'Add task to
<element name>' dialog displays.
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Mandatory fields on the dialog are indicated by a red
asterisk (*).

Complete the fields as directed here.

Field Action

Name Type an appropriate and meaningful
name for the new task.

Status Click on the drop-down arrow and select
the appropriate task status; that is:

New·
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Verified, or·

Complete·

Priority Defaults to 'High'. If necessary, click on
the drop-down arrow and select the
appropriate priority value; that is:

Medium, or·

Low·

Requested by Click on the drop-down arrow and select
the name of the person requesting the
task. This defaults to the name selected
for the previous record.

Reported on Defaults to today's date. If necessary,
click on the calendar icon and select the
correct date on which the request was
made.

Completed
by

If the task has been completed, click on
the drop-down arrow and select the name
of the person who completed it.

Completed
on

Click on the calendar icon and select the
date on which the task was completed.

Version Type in a version number or letter to
indicate any evolution of the same task.
Defaults to '1.0', indicating the first
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instance of a task.

Description Type in a description of the task, what it
is, what the objective might be, and why
it is a required.
You can format this text using the
facilities provided in the Notes toolbar.
These are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·

Superscript text·

Subscript text·

Set color of selected text·

History If there is any background to this task,
such as previous occurences, document
them here (you might copy the
'Description' from the last version or
iteration of this task, for example). It is
recommended that you include a date
stamp and user initials in the entry.
You can format this text using the
facilities provided in the Notes toolbar.

Add Click on this button to submit the details
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and create the task record on the selected
element.
This message is displayed:
    Task <name> was successfully added
to <element name>.
Either:

Work through the fields again, defining·

another new task request on this
element, or
Click on the browser's Back button to·

return to the 'Properties' view of the
element, which will be refreshed to
show the new record in the 'Tasks'
panel
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Add a Risk

A Risk is a condition that could cause the disruption, loss or
compromise of a system. It can refer to either technical or
business risks.

Within an element, you can create a record for each risk that
you want to record against the element.

Add a Risk Record

Display the Properties of the element to which you want to
add the risk record, and click on the  icon. A menu
displays offering options to add various features to the
element. Select the 'Add risk' option. The 'Add risk to
<element name>' dialog displays.

Mandatory fields on the dialog are indicated by a red
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asterisk (*).

Complete the fields as directed here.

Field Action

Name Type an appropriate and meaningful
name for the new risk.

Type Type in the risk type.

Weight Defaults to 1. Click on the up and down
arrows to set a different weighting on the
risk. There is no limit to the value that
you can set, but within Enterprise
Architect the usual value is a small
number between, say, 1.0 (normal) and
5.0 (heavily weighted).

Description Type in a description of the risk, what it
is and what the mitigation might be.
You can format this text using the
facilities provided in the Notes toolbar.
These are:

Bold·

Italic·

Underline·

Numbered list·

Bulleted list·
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Superscript text·

Subscript text·

Set color of selected text·

Add Click on this button to submit the details
and create the risk record on the selected
element.
This message is displayed:
   Risk <name> was successfully added to
<element name>.
Either:

Work through the fields again, defining·

another new risk on this element, or
Click on the browser's back button to·

return to the 'Properties' view of the
element, which will be refreshed to
show the new record in the 'Risks'
panel
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Edit Objects

Within any model in which you have the security
permissions to create elements, you can also edit the Notes,
Resource Allocation and Testing details of any object in
which they occur. On the right of the item field for these
three properties you will see a  icon, which indicates that
you have the ability to edit that property.

Note: the ability to Edit objects is only possible in the
Premium (Small Business, Team and Enterprise) editions of
the Pro Cloud Server.

Edit Notes

To edit the notes of an object, click on the  icon for the
field. The 'Edit note for <object type>' page displays.

(c) Sparx Systems 2018 Page  489 of 1073



User Guide - Model Repository 21 December, 2018

You can add, delete and change text, and use the formatting
tools in the Notes toolbar; that is, for a selected text string,
add:

Bold·

Italic·

Underline·

Numbered List·

Bulleted List·

Superscript·

Subscript·

Text color·
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You can also right-click on the selected text and select
options from the browser context menu to:

Undo the last change·

Move (cut) the text string into the buffer for pasting·

Copy the text string into the buffer for pasting·

Paste text from the buffer into the 'Notes' field·

Delete the selected text·

Select all the text in the 'Notes' field·

Search for the selected text string on the internet·

Turn spell-checking on and off (if on, possibly misspelt·

text is underlined in red)

Add a different language dictionary to check spelling·

against (this would probably have been done already for
your web browser)

Whilst you can edit the text of a hyperlink and delete the
hyperlink, you cannot change the linked object or add a new
hyperlink. The browser context menu also provides options
for working with the hyperlink, but the WebEA interface
cannot support these functions.

When you have finished editing the text, click on the Save
button. A confirmation message briefly displays and you are
returned to the object 'Properties' view.

Edit Tests
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The tests assigned to an element support a range of
situations including user acceptance and scenario. You
could be asked to define or perform tests on parts of a model
of relevance to you as a customer or user, or you might want
to add information obtained from other people you have
asked to perform an evaluation. Therefore, you might need
to edit test records to update them with your information.

To edit a test record, display the appropriate element in
WebEA's Main View, click the feature button to display
'Tests' then select the appropriate test from the list.

Once the test is displayed click on the  icon. The 'Edit
Test for <element name>' page displays.
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Edit Test for <<element name>> page

Mandatory fields on the dialog are indicated by a red
asterisk (*).

Complete the fields as directed here.

Field Action
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Test name If necessary, type a new name for the
Test.

Class type In necessary, click on the drop-down
arrow and select a different test group for
the test; that is:

Unit·

Integration·

System·

Acceptance·

Scenario, or·

Inspection·

Type If necessary, click on the drop-down
arrow and select a new test type; that is:

Load·

Regression or·

Standard·

Status If necessary, click on the drop-down
arrow and select a new test status; that is:

Not Run·

Pass·

Fail·

Deferred or·

Cancelled·
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Run by If the test has been run, click on the
drop-down arrow and select the name of
the person who ran it.

Last Run If the test has been run, click on the
calendar icon and select the date on
which the test was most recently run.

Checked by If the test has been run, click on the
drop-down arrow and select the name of
the person who checked the test
execution and results.

Description Type in a description of the test, what it
was intended to show and - if the test has
been run - what the test situation and
results were.
You can format this text using the
facilities provided in the Notes toolbar, as
described in the Edit Notes section.

Input Type a description of what actions or
parameters are or were required as input
to this test.
You can format this text using the
facilities provided in the Notes toolbar, as
described in the Edit Notes section.

Acceptance Type a description of what criteria must
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Criteria be or were satisfied to indicate that the
test has passed.
You can format this text using the
facilities provided in the Notes toolbar.

Results Type a description of the expected and/or
actual results of this test.
You can format this text using the
facilities provided in the Notes toolbar.

Save Click on this button to submit the details
and update the Test record on the selected
element.
A confirmation message briefly displays
and you are returned to the object
'Properties' view

Edit Resource Allocation

The resources allocated to an element can include reviewers
in various roles, and you might be allocated as a resource
yourself. Alternatively, you could have allocated another
person as a reviewer. Therefore, you might need to edit a
resource allocation to record either your own progress in a
review, or the progress of the resource you have allocated.

To edit the resource allocation, display the appropriate
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element in WebEA's Main View, click the feature button to
display 'Resources' then select the appropriate test from the
list.

Once the resource is displayed click on the  icon. The
'Edit resource allocation for <element name>' page displays.

Edit Resource Allocation for <element
name> page
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Notice that this page has a few more fields than the initial
'Add resource allocation ...' page.

Mandatory fields on the dialog are indicated by a red
asterisk (*).

Complete the fields as directed here.

Field Action

Resource If necessary, click on the drop-down
arrow and select the name of a different
person to be allocated as the resource.

Role If necessary, click on the drop-down
arrow and select a different role for the
resource in this work.

Start Date If necessary, click on the calendar icon
and select a different date on which the
resource started or is expected to start the
assigned work.

End Date If necessary, click on the calendar icon
and select a different date on which the
resource completed or is expected to
complete the assigned work.

% Complete Click on the up and down arrows to
change the field value to the percentage

(c) Sparx Systems 2018 Page  498 of 1073



User Guide - Model Repository 21 December, 2018

completion of work that the resource has
achieved.

Expected Type in the number of whole time units
the task is expected to take. The value
must be an integer; you cannot record
part units.
The unit of time you use will be
identified by the Project Manager, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number, and use
the same units for the expected, allocated
and actual times.

Allocated Type in the number of whole time units
the task can be spread over. For example,
you might expect the task to take 2 days
of work performed at any point over a
period of 5 days.

Actual If the task is 100% complete, type in the
number of whole time units it actually
took.

Description If necessary, edit the description of the
resource allocation, perhaps to explain
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the changes you have made to earlier
fields.
You can format this text using the
facilities provided in the Notes toolbar, as
explained in the Edit Notes section.
Before changing the text, you might want
to copy it to paste into the 'History' field
for editing there.

History Optionally, paste or type in an
explanation of what has previously taken
place with this Resource Allocation. You
can also format this text, using the
facilities in the Notes toolbar.

Save Click on this button to submit the details
and update the Resource Allocation
record on the selected element.
A confirmation message briefly displays
and you are returned to the object
'Properties' view.
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Reviews in WebEA

Review elements are a convenient way for groups of users
to collaboratively discuss one or more model objects and
capture those discussions as a formal review. A Review
element is a custom element that captures all discussions
that you participate in over a period of time. That period
begins when you select to 'join' the review, and ends either
when you select to leave the review, or when you log out of
the current model. You can also return to the review in a
subsequent work session and your continuing discussions
are also captured. The Review element would typically have
a start and end date set to define the duration of the review.

When a Review element is created, a child diagram is also
created, automatically. Both Enterprise Architect and
WebEA consider any element added to this diagram as
requiring comment during the Review. When the properties
of the Review element are loaded in WebEA the 'Objects in
Review' section will contain a list of all elements that have
already been commented on or have been added to the
Review diagram. This list provides a convenient way to
quickly navigate to each element in the Review.

When the properties of a Review element are loaded in
WebEA's Main View, the default feature which is displayed
is a Summary of the Review. This includes the status, start
and end dates, number of elements discussed and yet to be
discussed, and a break down of review topics based on
priority and status, as illustrated here:
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The Summary is followed by 'Review Diagrams' and
'Objects in Review' sections.

The 'Review Diagrams' section provides links to the
diagram which are associated with the review (I.e. those
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which are children of the Review Element).

The 'Objects in Review' section displays a list of elements to
be discussed during the review. Elements that have not yet
been discussed are presented first in the list, followed by
elements that have been commented on, showing each
review topic. The name of the object acts as a hyperlink to
that object.

Locating Reviews

There are a number of ways in which to locate existing
Review elements to join, or to switch to your active review
(the review that you have already joined).

To check on recent Review elements available in the model,
click on the 'Search' icon in the WebEA header and select
the 'Reviews' option. This conducts a search for recent
Review elements and lists them in the 'Search Results' view,
with the most recently changed element at the top of the list.

You can click on the name of a Review in the list to load the
details of the selected Review element, and then join or
leave the Review as appropriate.

The name of your active Review is displayed in the
WebEA's Status bar, and you can click on the name (in the
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Status bar) to load the details of the active Review element.

Join a Review

While the property details of a Review element are loaded,
the Join Review button will be enabled.

Clicking on this button will join you to the review and link
your discussions to the Review element. The display will
automatically be adjusted to the change of state. These
changes include:

The addition of the joined Review element's name to the·

status bar

The 'Review' section filtering elements to the current·

Review element only

The 'Discussion' section's update/add actions being·

disabled

The Join Review button being disabled, and the Leave·

Review button being enabled

The Join Review button might be disabled, for these
reasons:

You are already joined to a review on a different Review·
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element

The loaded Review is closed·

The Join Review button and Leave Review button are only
visible on Review elements when the 'participate_in_review'
configuration option is set to true for the current model. See
the How to configure WebEA models Help topic for more
information.

Add topics to a Review

When you have opened and read through the contents of a
Review element, you can add your own review topics or
respond to existing points. To do this you click on the name
of the object you want to comment on, then select the
'Discussions' feature button.
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Note, whilst you are joined to a review - the contents of the
panel are filtered to show only the review comments for that
review.

Add a Review Topic

To create a review topic on a new point, simply type into the
'Create Review Topic' field. When you have finished typing

your message, submit it by clicking on this button: 

Note: WebEA does not support editing (or deleting) review
comments, therefore you should take care to type messages
in clearly the first time, and double check before submitting.

Depending on how the WebEA model is configured, you
might connect to it using your personal user ID, or as a
single generic User that is shared by multiple people. In the
second case, Sparx Systems recommends that each user
identifies themselves in each message, either at the
beginning or at the end.

Whilst you are adding comments to a review, at any point
you can return to a posted topic and add or change its status
and priority. To the right of the review topic text are two
icons. The first is the 'Status' icon, and the second is the
'Priority' icon. The appearance of the icons depends on the
current setting for status and priority. To set a status or
priority, simply click on the appropriate icon and select from
the listed options. These are:

Status·
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Priority·

Add a reply to a comment

If you want to respond to either a review topic or a reply to
that topic, click or tap on the appropriate message. A blank
field and button underneath the conversation thread will
appear; type in your message and click or tap on this button:

Your reply is added to the end of the thread.

Note: Currently the review threads are only read from the
model when the page is loaded, which means if other users
make additional comments they will not be displayed until
the page is reloaded or refreshed.

Review another element

Click on the name of the Review element in the 'Reviews'
panel or in the page footer, to display the Properties view for
that review element. Select another element in the review
from the list.
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Leave the current Review

When you have finished contributing to the review, you can
either return to the Review element Properties view and
click on the Leave Review button, or log out of the current
model.

The Leave Review button will only be enabled when the
details of the currently joined Review element are loaded.

Creating a Review

Typically, only a Project Manager will create Review
elements in Enterprise Architect, notifying the relevant users
of their location so that each user can join and leave the
review(s) as necessary.

However, a WebEA user might create a Review element as
a direction to the Project Manager to set up. In this case you
create the Review element by clicking on the 'New' icon in
the Package hierarchy view, selecting 'Review' as the
element type. The procedure is as described in the Add
Elements and Features in WebEA Help topic.

You require specific access permissions to create a Review
element; those permissions are totally separate from the
permission to join a review.
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Discussions in WebEA

Enterprise Architect has a Discussion facility through which
users can post short messages to have informal discussions
with other users on a specific element or Package. As a
WebEA user, if the model has been configured to allow
Discussions to be viewed and added, you can also read and
participate in these Discussions. The facility is very useful
in informal reviews, as you can comment or respond
immediately on a specific point as you come across it,
without having to collate a list of comments and compose a
relatively long document or email, or schedule a telephone
call.

To access Discussions, when viewing the properties of an
object in WebEA's main view, select the 'Discussions'
feature button.

Note that if you are joined to a formal review, you can read
existing Discussion points but you cannot respond to them
or add new topics.

The input area shows as a blank field and a 'Discussion'
button to save the entered text; if there has already been
some discussion on the element, the comments of each
Discussion display above the input field.
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There are two types of discussion messages, an initial
message (usually called a Discussion) and replies. Replies
are responses to an initial message, and are displayed as
child items.

Avatars

In Enterprise Architect there is an application option for the
current users that controls if avatars of security users are
displayed with each Discussion item. In WebEA this option
is defined for a model in the configuration file; see the
option use_avatars.

When a model has been configured to 'use avatars' and the
model has security enabled, then instead of displaying
generic blue speech bubbles the author's avatar is displayed,
as shown here:

Starting a discussion

To start a discussion on a new point, simply start typing in
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the blank field. If you want to have separate paragraphs,
press the Enter key to start each new line.

When you have finished typing your message, submit it by

clicking on this button: 

Note: WebEA does not support editing (or deleting)
discussions, therefore you should take care to type messages
in clearly the first time, and double check before submitting.

Depending on how the WebEA model is configured, you
might connect to it using your personal user ID, or as a
single generic User that is shared by multiple people ('Web
User' in the first illustration). In the second case, Sparx
Systems recommends that each user identifies themselves in
each message, either at the beginning or at the end.

Replying to a discussion

If you are reading an existing discussion and want to
respond to either the opening point or a reply to that point,
click or tap on the appropriate message. A blank field and
button underneath the conversation thread will display; type

in your message and click or tap on this button: 

Your reply is added to the end of the thread.

Note: Currently the discussion threads are only read from
the model when the page is loaded, which means if other
users make additional comments they will not be displayed
until the page is reloaded or refreshed.
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Status and Priority

If you are adding comments to a discussion, at any point you
can return to a posted topic or reply and add or change its
status and priority.

To the right of the discussion text are two icons. The first is
the 'Status' icon, and the second is the 'Priority' icon. The
appearance of the icons depends on the current setting for
status and priority. To set a Status or Priority, simply click
on the appropriate icon and select from the listed options.
These are:

Status·

Priority·

Notes

As a WebEA user you cannot delete discussions or·

(c) Sparx Systems 2018 Page  513 of 1073



User Guide - Model Repository 21 December, 2018

replies; however they can be deleted using of Enterprise
Architect
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Create and check Watch Lists

The Watch List facility in WebEA helps you to quickly
identify recent activity in the model. Each user can tailor
their Watch List to monitor activity in any of a wide range
of objects and features with various characteristics.
Whenever the Watch List Summary is generated, all object
types of interested are checked for recent activity and a
count of matched objects displayed. All matched object
counts can be clicked on to display the list of objects that
match the particular activity type.

Note: Each model has a default set of activity types that
have been enabled in the WebEA configuration file; each
user can override the model defaults and save their
customized settings.

Watch Lists Summary

You can select the Watch List facility by selecting the
'Watchlist' option in the 'Search' menu. This immediately
displays the 'Watchlist summary' view that shows:

Any activity that has recently been detected, for·

All objects and features that are to be monitored·

If there is no activity for a configured activity type, that
activity type is omitted from the 'Watchlist Summary'. The
display might look like this:

(c) Sparx Systems 2018 Page  515 of 1073



User Guide - Model Repository 21 December, 2018

Every type of object on the report is represented by a line
providing the number of objects that match the given
criteria. The number of objects is a link which, if you click
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or tap it, displays a results page listing the specific objects
that match the given criteria.

The watch list results page is the same as the custom search
results page, in that if you then click or tap on an individual
item in the list, the 'Properties' view will be displayed for the
selected object. See the WebEA's Layout Help topic.

If you have finished checking the 'Watchlist summary', you
can click on the OK button to return to the WebEA view
you were displaying previously.

Alternatively, you can tailor the Watch List to provide
information relevant to you; see Configure the Watchlist.

Configure the Watchlist

If you want to customize the activity types monitored in
your Watchlist summary, click or tap the configure button

 located in the Watchlist summary header. The 'Watchlist
configuration' page displays.
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In the 'Number of days' field, type the number of days that
should be considered. This might be the number of days
since you last used WebEA, or the number of days in a
reporting period that you want to compare with.

For the remaining fields, select the checkbox against all
items that you want to monitor and include in your watch
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list. The complete list is:

Recent:·

    - Discussions
    - Active reviews
    - Modified diagrams
    - Modified elements

Resource Allocations:·

    - Active
    - Ending today
    - Overdue

Tests:·

    - Recently passed
    - Recently failed
    - Recently deferred
    - Recently not checked
    - Not run

Changes, Defects, Issues, Tasks and Decisions:·

    - Verified
    - Recently requested
    - Recently completed
    - New
    - Incomplete

Events:·

    - Recently requested
    - High Priority
    - Incomplete

The Select All and Deselect All options can be used to
select or deselect all checkboxes.
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Once you have finished choosing which items to monitor,
click or tap on the Save button to save the configuration and
redisplay the Watch List summary.

Note:

All watch list options are saved based on current model·

and User ID for the current browser, and stored as cookies
(where possible) so that the options are remembered
between sessions

If your browser does not allow the saving of cookies, then·

your customized watch list setting will only last as long as
the current session
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Relationship Matrix

The Matrix facility in WebEA enables you to view the
Relationship Matrix generated from any Relationship Matrix
profile that has been defined in the model.

The Relationship Matrix is a spreadsheet display of
relationships between model elements within a Package, or
between elements in two different Packages. It is a
convenient and simple tool for reporting and working on all
the relationships in a selected structure. The relationships
shown can be filtered according to:

The element type of the source and target elements in·

each relationship

The relationship type and direction·

The Package(s) in which the source elements and target·

elements are held

Those parameters can be defined in a Relationship Matrix
profile; to display a matrix in WebEA you select one of the
available profiles.

The matrix shows all the relationships of the specified type
between source and target elements by:

Listing the source Package elements down the side of the·

matrix

Listing the target Package elements across the top of the·

matrix, and

If a relationship exists between a source and target·

element, displaying an arrow indicating the direction of
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the relationship

Clicking on a square containing an arrow displays the
Relationship Properties screen for the relationship
represented by that arrow. On that screen you can click on
the source or target element names and display the Element
Properties screen for those elements.

Access

On the WebEA header, click on the  icon and select
the 'Matrix' option. The 'Matrix Profiles' page displays.

Matrix Profiles

The 'Matrix Profiles' page provides a drop-down field that
you use to list and select from the matrix profiles defined
within Enterprise Architect. You cannot add to or edit these
profiles.
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When you select a matrix profile, the rest of the fields on the
page will be populated with the values defined in the profile.
Click on the View Matrix button to load the relationships
selected under the profile, in a Relationship Matrix grid.

WebEA is only able to load complete matrix profiles; if an
incomplete matrix profile is requested, this error message
will be displayed:

If this message is displayed, ask the Project Manager to
update the Matrix Profile.

Matrix

(c) Sparx Systems 2018 Page  523 of 1073



User Guide - Model Repository 21 December, 2018

This is a sample Relationship Matrix as displayed by
WebEA. It is almost identical to what would be displayed in
Enterprise Architect.

When you click on a relationship arrow - such as, in the
example, the 'Add To Shopping Basket' to 'REQ014 -
Shopping Basket' arrow - the Relationship Properties screen
displays.
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Notes

A Matrix Profile can also be accessed via a Hyperlink or a·

Matrix Specification Artifact on a diagram.

Matrix Profiles which use a Model Search to populate the·

source or target elements are not supported in WebEA.
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Search the model

WebEA provides a facility that enables you to search
through the model for a specific item or group of items that
have certain characteristics. This can help you to quickly
locate objects of importance, such as elements you have
created yourself (if you have the access privileges to do so).

You access the Search facility by clicking on the 'spyglass'
icon in the WebEA header and selecting the 'Custom search'
option.

Search Specification

Define your search using these options.
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Option Description

Term Type or paste in the string of characters
or digits you want to locate - name, Notes
text or the complete object ID. Be aware
that for some DBMSs - such as Firebird
or Oracle - searches are case-sensitive.

Search for Select one of these object types to search:
Diagrams·

Elements·

Packages·

Discussions, or·

Reviews·

If you select 'Discussions', the 'Search in'
and 'Term' options are not relevant and so
are grayed out and unavailable. The
search is for elements having active
discussions within the specified time
period.
Note: the 'Discussions' option is only
available in models that have the
show_discuss parameter set to 'true' in the
WebEA configuration file, and the
'Reviews' option is only available when
the participate_in_reviews parameter is
set to 'true'.
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Search in Select from the list of fields to search:
Name·

Name, Alias and Notes (the proper·

name, an assigned alternative name,
and any text written in the object's
'Notes' field)
Author (the person who created the·

object)
ID (the GUID of the object, displayed·

as the last item in the 'Properties' panel
when you expand it)

When Select the period of time that should be
searched. You can select to search for
objects modified:

Today·

Within the last 3 days·

Within the last 7 days·

Within the last 14 days·

Within the last 30 days·

Within the last 12 months·

At any time·

Run Search Click or tap this button to execute the
search and locate the objects that meet
the search criteria.
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Search Results

When you execute the search the results are displayed in the
main content area.

The results provide the object name, type, author and
last-modified date of each object that matches the search
criteria. If you click on an item, the 'Properties' view will be
loaded for that object.
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Troubleshooting WebEA

If WebEA users experience a problem, an error message
will be displayed on the screen. This topic provides a list of
common WebEA error messages that could occur. Each
entry describes the situation that has occurred and provides
guidance on how to correct the error.

WebEA Configuration Test

On initial set up, these steps can be performed to help
identify configuration issues:

Ste
p

Action

1 On the Web Server machine, open a web browser
and test access to the WebEA login page.
E.g. http://localhost/webea/login.php
Failing this, check that the Web Server has been set
up as described in the WebEA Installation and
Configuration topic.

2 On a client machine test access to the WebEA login
page.
E.g. http://<server name>/webea/login.php
Failing this suggests there is a
network/communication issue between the client and
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the web server.

3 Before attempting to access a model via WebEA,
confirm you can successfully open the model using
Enterprise Architect's 'Connect to Cloud' option.
Failing this, refer to the Cloud Server
Troubleshooting Help topic.

4 In the webea_config.ini file, add a model connection
with the minimum required options, as outlined here.
Ensure these match the settings used when
connecting via Enterprise Architect. Note, the
'sscs_db_alias' should match the value entered in the
'Model Name' field.

sscs_protocol = "<Protocol>"
sscs_server = "<Server Name or IP address>"
sscs_port = "<Port>"
sscs_db_alias = "<Model Name>"
auth_code = ""     ;leave this empty

If the Project has Enterprise Architect User Security
enabled then also include:
login_prompt = "true"

If the Protocol being used is HTTPS then also
include:
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sscs_use_ssl = "true"

If you are using HTTPS with a Self-signed
certificate then also include:
sscs_enforce_certs = "false"

5 Try accessing the model in WebEA. Failing this, the
error returned by the WebEA login screen might
help identify the cause of the issue.

WebEA Error Messages

Issue Comments

Server could
not be found

Server could not be found on the
network!
This error usually occurs when WebEA
does not receive any kind of response
from the specified server name (or IP
number).
Possible reasons:

The server is turned off·

The server is behind a firewall and·

WebEA is unable to make a connection
to it
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Connection
refused

There was no response from the server,
check that Pro Cloud Service is running!
Possible reasons:

Pro Cloud Service is not installed·

Pro Cloud Service is not running·

Pro Cloud Service is not listening on·

the expected port

OSLC not
supported

Your server is not configured to support
OSLC.
Possible reasons:

WebEA communicates with Sparx·

Systems Cloud Service via OSLC, but
the defined Sparx Systems Cloud
Service has been configured to not
allow OSLC requests for this Port.

Using the Cloud Configuration Client,
check the configuration for the Port
which you are using to access this model.
Ensure the "OSLC Supported" option is
enabled.

Protocol
Mismatch

Protocol and Port mismatch. Check that
the correct protocol and port have been
configured.
Possible reasons:

There is a mismatch between the·
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connection settings; for example,
'sscs_use_ssl' has been set to true but a
protocol of HTTP was specified

Incorrect
login details

The specified login details were not valid
for the current model!
Possible reasons:

The supplied user ID and password·

combination did not match any user
credentials defined in the model

Connection
timed out

Request Error: Connection timed out
after 5001 milliseconds.
Possible reasons:

Invalid Cloud Server settings (sscs_*),·

WebEA cannot connect to the defined
server/port
Apache/PHP web server requires a·

proxy server to reach the Cloud Service
machine and the proxy settings defined
in the .config file are incorrect or
invalid

Failed to
Connect

Request Error: Failed to connect to
xxx.xxx.xxx.xxx port yy: Connection
refused
Possible reasons:

The 'sscs_port' option in the·
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webea_config.ini file does not match
the port setting in your Pro Cloud
Service configuration file
(SSCloudServices.config); make them
the same

Note that, if the Cloud Service is being
re-directed via IIS, you must ensure this
matches the IIS port used for the Pro
Cloud Service.

The
configured
database is
not defined

The configured database is not defined in
the Cloud Service.
Possible reasons:

The 'sscs_db_alias' option in the·

webea_config.ini file does not
correspond to the 'Database Alias'
defined in Add Database Manager;
correct the values so that they do
correspond

Problem
reading the
model root

Problem reading the model root.
Possible reasons:

The WebEA options for the current·

model do not match a Pro Cloud Server
configuration
You are attempting to access a DBMS·

repository which has not had a Project
transferred into it. See Step 4 on the
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Server Based Repositories help page.

No response
when
selecting an
Object

After WebEA loads the initial page (the
model root or default diagram), there is
no response to selecting objects.
Possible reasons:

Your browser does not have javascript·

enabled; re-enable it
The cURL PHP module/extension is·

not installed and enabled on the server;
install/enable cURL on your web
server
The PHP version is wrong; it must be·

greater than PHP 5.0 with all
extensions supported

An
unexpected
response was
received

An unexpected response was received,
check the cloud service configuration!
This error normally occurs while
attempting to login or connect to a model
from the initial page. The error message
will display whenever the response from
the configured Cloud Service does not
return the expected XML message.
Check that the defined Sparx Systems
Cloud Service server name and port are
the details of an actual Cloud Service and
not those of a web server.
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The selected
database does
not have Pro
Features
enabled

The selected database does not have Pro
Features enabled.
This error normally occurs if the selected
model does not have 'Pro Features'
enabled.
Possible reasons:

In the Cloud Service Configuration·

Client, the Database Manager for this
model does not have the 'Enable Pro
Features (OSLC, WebEA and
Integration)' option enabled
The Pro Cloud Server's license has·

expired and the server is now operating
as the free, core edition of the Cloud
Service
The License key entered is invalid and·

the Pro Cloud Server is operating as the
core edition

Using the Cloud Service Configuration
Client, check the Database Manager
configuration. Ensure that the 'Enable Pro
Features (OSLC, WebEA and
Integration)' option is enabled.

Diagram
image not
found

Diagram image not found.
This error indicates that the diagram
exists in the model, but the image of the
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diagram has not been generated.
Possible reasons:

The model does not have the 'Auto·

create Diagram Image and Image Map'
option enabled in model-specific
options
The diagram was created in Enterprise·

Architect, but has not yet been saved
Or, the user is on an old version (prior·

to build 1350) of Enterprise Architect
and the Worker application is not
running for this model (it has not been
configured, it is not currently running,
or has not run since the diagram was
saved)

Open the model in Enterprise Architect
(build 1350 or later), enabled the 'Data
Cache' options, and click on the 'Create'
button as described in the 'Model
Configuration' section of the 'WebEA
Installation and Configuration' topic.

Alternatively, ensure that the Worker
application is running for this model. See
the 'How to configure automatic viewable
components' topic for details.
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Resource not
found

404 - Resource with identifier
'{XXXXXXXX-XXXX-XXXX-XXXX-XXXX
XXXXXXXX}' could not be found
The item (element, Package or diagram)
with this GUID could not be found in the
current model.
Possible Reasons:

The item has been deleted from the·

model.
To confirm that the item has been
deleted, check the parent Package (or
parent element) in WebEA.
If the error occurred when selecting an
item on a diagram, the diagram image
might have to be regenerated.

SSL Error Error: SSL certificate problem: unable to
get local issuer certificate
This error suggests you are attempting an
HTTPS connection without having SSL
enabled.
Possible Reasons:

The webea_config.ini file does not·

include sscs_use_ssl = "true" for this
Model. Try adding this, then attempt to
access the Model again.

Self signed Request Error: SSL certificate problem:
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certificate
error

self signed certificate
This error suggests you are attempting an
HTTPS connection with SSL using a
self-signed certificate, however WebEA
has not been configured to allow
self-signed certificates.
Possible Reasons:

The webea_config.ini file does not·

include sscs_enforce_certs = "false" for
this Model. Try adding this, then
attempt to access the Model again.

No
credentials
provided

400 - User Security is enabled, however
no credentials were provided.
Possible Reasons:

The Project has Enterprise Architect·

user security enabled; however,
WebEA is not configured to either
show a login prompt or automatically
login with specific credentials

Check that the webea_config.ini contains:
    login_prompt = "true"
Or, all of these:
    login_prompt = "false"
    sscs_model_user = "<user id>"
    sscs_model_pwd = "<password>"

Version Warning - WebEA / OSLC Version
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Mismatch mismatch
Each release of the Pro Cloud Service
includes an OSLC component and the
WebEA component (php files). If you are
using the OSLC component from one
release and the WebEA component from
another, then WebEA might not function
as intended.
Possible Reasons:

A new version of the Pro Cloud·

Service was installed, however the new
version of WebEA was not copied to
the Web Server

When updating the Pro Cloud Service to
a newer version, ensure that WebEA is
also updated. That is, after performing the
installation of the Pro Cloud Server, copy
the new WebEA files from the Cloud
Server installation to the relevant location
on your web server.

Basic login
fields not
shown

The basic login fields will not be visible
when attempting to log in to a model
under these circumstances:

The webea_config.ini has·

sscs_model_user defined
The model has the user option 'Restrict·

access to Windows & OpenID users
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only' enabled

Problems loading pages

Issue Comments

No response
when
clicking on
diagram
elements

When clicking on an element on a
diagram nothing happens.
Possible reason:

The element properties are being·

loaded in the Properties View, however
the Properties View is automatically
hidden due to a narrow screen/browser
width (less than 800px).

From the hamburger menu at the top right
of WebEA, select 'Properties' to turn off
the Properties View.

Pages don't
load correctly

After the server has been updated to a
new version of WebEA, clients
experience problems with pages loading
incorrectly.
Possible reason:

The user's browser is using a cached·
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version of WebEA's client side files,
which is causing unpredictable results
The solution is to clear the browser
cache, to force the browser to
download the latest version of the
application files from the server; the
process for clearing the cache is
different for each browser/device -
consult the user manual for your
browser

Login page in
Internet
Explorer

The 'Login' page is not drawn correctly
and appears different to other browsers;
that is, the selection boxes next to each
model name are not square.
All login attempts to models with
authentication fail saying 'No model
selected!'
Possible reasons:

IE is running in 'Compatibility View'·

mode, which does not support HTML5
and CSS3; turn off 'Compatibility
View' at least for the server hosting
WebEA
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Prolaborate

The Enterprise Architect set of tools to deliver world-class
modeling and design solutions to business, industry and
companies around the world has been significantly
expanded with the inclusion of Prolaborate in the Pro Cloud
Server offering.

Prolaborate represents the next step in effectively delivering
rich models to a much-expanded set of consumers. Whilst
Enterprise Architect has become the pre-eminent modeling
and design solution globally for modelers and designers
wanting to visualize and understand complex systems,
software and architecture, Prolaborate is the next step in
delivering those models and designs to the broader
community and in enabling high level executives, business
process managers, process implementers, consultants,
customers and other stakeholders to see their personal and
curated view of the model in a way that they are personally
comfortable with!

Prolaborate is a tailored set of views that reduce complexity,
focus attention and increase the accessibility of model
information for non-modelers and others who are more
concerned with consuming the model than directly editing it
(although this can occur). Prolaborate provides a social
platform 'outside the model' that supports talking about the
model from a different viewpoint to those actively engaged
'within the model'. Prolaborate also provides dashboards,
impact analysis and other 'outside the model' features that
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derive information from the model or provide unique
windows into the model for a custom audience (such as
Chief Executive Officers, Chief Information Officers and
customers).

Benefits:

Takes the next step - beyond modeling·

A social and collaborative tool for everyone·

Highly focused and customized model views·

New ways of seeing and interacting with Enterprise·

Architect models

New tools for decision and impact analysis based on·

model content

A platform for 'out of model' reviews and discussions·

For C-level executives looking for critical and strategic·

information

For model consumers reviewing or implementing process·

flows

For customers and other stakeholders who want to review·

and discuss the model

For developers and software teams·

For those unfamiliar with modeling who want to·

understand and share their viewpoint

A rich and evocative environment tailored for individual·

domains

Discover the hidden value in your Enterprise Architect·

models
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Engage with a broader audience - present and discuss at·

the 'right level'

For further information

Full documentation on Prolaborate is provided on the
website. You can access this documentation by clicking on
this link (Javascript must be enabled on your web browser).

https://prolaborate.sparxsystems.com/resources/documentati
on
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Integration Plugins

The Integration Plugins components represent a set of
plugins (or extensions) for the Pro Cloud Server that enable
data from external providers to be displayed within
Enterprise Architect. This component is only available in
the 'premium' editions of Sparx System Pro Cloud Server, ie
Small Business, Team and Enterprise editions.

The Integration Plugins component is also known by name
Server Based Plugin Interface (SBPI).
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Install and Configure

The Sparx Systems Pro Cloud Server product is installed
using a standard Microsoft Windows Installer package that
includes a number of optional components. One of these
components is Integration Plugins, which is installed by
default into the C:\Program Files (x86)\Sparx
Systems\Cloud Services\SBPI\ folder (assuming a 64bit
machine is being used).

Requirements

In order to install a particular Integration Plugin you must
have:

A licensed Pro Cloud Server·

Physical network access to a server hosting the external·

data

User credentials to access the external data·

Enterprise Architect Corporate, Unified or Ultimate·

edition v14 or later

What is in the Package?

The Integration Plugins folder initially consists of a
Integration Server executable (SBPI.exe), a separate
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executable (*SBPI.exe) for each supported external product,
a sample configuration file and a text file describing the
manual installation and configuration steps.

Task Script

Integraton
(SBPI)
Server

The SBPI.exe application acts as the
interface between the Pro Cloud Server
and each of the plugins by translating
Enterprise Architect requests, forwarding
them to the appropriate plugin and then
returning the generated response to
Enterprise Architect.

Application
Lifecycle
Manager
Plugin

The ALMSbpi.exe plugin interacts with
the MicroFocus Application Lifecycle
Manager product (previously known as
HP Quality Center).

Autodesk
Plugin

The AutodeskSbpi.exe plugin interacts
with AutoCAD's file and management
component AutoDesk.

Bugzilla
Plugin

The BugzillaSbpi.exe plugin interacts
with the web based defect/bug tracking
system that was originally developed and
used by the Mozilla project and is now
licensed under the Mozilla Public License
agreement.
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Confluence
Plugin

The ConfluenceSbpi.exe plugin interacts
with Atlassian's Team Collaboration
Software.

Dropbox
Plugin

The DropboxSbpi.exe plugin interacts
with Dropbox's web based file hosting
service.

EA plugin The EASbpi.exe plugin interacts with
external Sparx Systems's Enterprise
Architect Cloud-based repositories.

Jazz Plugin The JazzSbpi.exe plugin interacts with
IBM Rational DOORS Next Generation's
requirements management tool.

Jira Plugin The JiraSbpi.exe plugin interacts with
Atlassian's issue tracking system.

ServiceNow
Plugin

The ServiceNowSbpi.exe plugin interacts
with ServiceNow's asset management
component of its Cloud-based enterprise
management system.

SharePoint
Plugin

The SharePointSbpi.exe plugin interacts
with Microsoft's web-based collaborative
platform, SharePoint.

Team The TFSSbpi.exe plugin interacts with
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Foundation
Server (TFS)
Plugin

Microsoft's source code management.

Wrike Plugin The WrikeSbpi.exe plugin interacts with
Wrike's project management system.

How to Set Up

The Integration framework consists of an Integration server
(SBPI.EXE) application that starts one or more plugins
(such as DropboxSbpi.exe and JiraSbpi.exe). The
Integration Server and each Integration plugin can be
configured to run either on the same machine as the Pro
Cloud Server or on completely different machines. In the
simplest configuration the Integration server and all
Integration Plugins are installed on a single server. There are
two main advantages with this configuration:

 1. The Pro Cloud Server will automatically start (and stop)
all configured plugins whenever its Windows service is
started (or stopped).

 2. The Integration configuration GUI inbuilt into the Cloud
Configuration client can be used to completely manage all
aspects of the Integration configuration; see the Steps -
Simple table.

However if you elect to run the Integration Server or
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Integration plugins on different machine(s) to the Pro Cloud
Server, each of the individual plugins must be manually
configured as well as configured to start as Windows
services with the correct parameters. See the Steps - Manual
table.

Steps - Simple

The Integration configuration GUI included in the Cloud
Configuration client removes most of the complexity
involved in configuring the Integration Server and Data
Provider(s), therefore this is the recommended method for
most users. However this configuration method is restricted
to running all Integration components (*SBPI.exe) on the
same server as the Pro Cloud Server.

Step Description

Configuring
Pro Cloud
Server for
Integration

Each installation of Sparx Systems Pro
Cloud Server can be configured to
communicate with a single Integration
Server; the configuration options of this
definition are defined as a series of
registry settings, however the 'Integration'
tab in the Cloud Configuration Client
allows the definition and maintenance of
the Integration Server options without the
need for you to manually manipulate the
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registry.
This image shows the definition of an
Integration Server with the default
settings:

Configuring
Integration
Data
Providers

Each Data Provider (or Plugin) is defined
as both a series of registry entries in
[HKEY_USERS\.DEFAULT\Software\S
parx
Systems\SQLBridge\SBPI\Plugins\{uniq
ue} and settings within a configuration
file. Again the Integration tab in the
Cloud Configuration Client allows the
definition and maintenance of Integration
Data Provider details without the need for
the user to manually manipulate the
registry and configuration files.

Configuring
the Firewall

The Integration server (SBPI.exe)
typically needs to be granted access
through any local firewall so that
Enterprise Architect clients can connect
to it. The Pro Cloud Server installer will
automatically create a Firewall exception
that allows any incoming requests to be
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passed through to SBPI.exe; however, the
default settings should be reviewed and
adjusted to suit your environment.

Steps - Manual

Important: these steps are only needed if the Integration
components need to run on different machine(s) to the Pro
Cloud Server, otherwise the Steps - Simple table should be
used.

Step Description

Configuring
Pro Cloud
Server for
Integration

Each installation of Sparx Systems Pro
Cloud Server can be configured to
communicate to a single Integration (or
SBPI) server. These configuration options
are defined as a series of registry settings.
This is an example of all valid options for
the Integration server:

[HKEY_USERS\.DEFAULT\Software\S
parx Systems\SQLBridge\SBPI\Server]
    "Arguments"="-port 8080"
    "Port"=dword:00001f90
    "Path"="C:\\Program Files
(x86)\\Sparx Systems\\Cloud
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Services\\SBPI\\SBPI.exe"
    "Protocol"="http"
    "Server"="yourdomain.com"

Arguments - the arguments that are·

used to start the SBPI server, which
include the port the server should listen
to; for example, "-port 8080"
Port - a hexadecimal value,·

representing the port number that the
SBPI server should be listening to,
which value should match the value
specified in the arguments; for
example, dword:00001f90  (decimal
8080)
Path - the full path to the SBPI server's·

EXE; for example:
    "C:\\Program Files (x86)\\Sparx
Systems\\Cloud
Services\\SBPI\\SBPI.exe"
When SBPI.EXE and the Pro Cloud
Server are running on the same
machine, PCS will attempt to start the
SBPI.exe in this location
Protocol - the protocol that should be·

used to communicate to the machine
hosting the SBPI server; that is, http or
https
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Server - the name (or IP number) of·

the machine hosting the SPBI server
(for example, yourdomain.com); it is
important to realize that this address is
forwarded to the client (Enterprise
Architect) so that it can make direct
requests, which means the name or IP
must be resolvable from the client
machines

Note:  The SBPI server typically needs to
be granted access through any local
firewall so that clients can connect to it.
The ProCloudServer installer will
automatically create a Firewall exception
that allows any incoming request to be
passed through; however, the default
settings should be reviewed and adjusted
to suit your environment.

Configuring
External Data
Sources

Each External Data Source is defined as a
series of registry entries in
[HKEY_USERS\.DEFAULT\Software\S
parx
Systems\SQLBridge\SBPI\Plugins\{uniq
ue}, where {unique} is a unique UUID
for the data source. This is an example of
a complete External Data Source
definition:
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[HKEY_USERS\.DEFAULT\Software\S
parx
Systems\SQLBridge\SBPI\Plugins\{8534
89C1-4C22-4bad-9A8E-3098D07A3FC1
}]
   "Arguments"="-port 8081 -config
Jira1.config"
   "Name"="Sparx Systems Sample
account"
   "Path"="C:\\Program Files (x86)\\Sparx
Systems\\Cloud
Services\\SBPI\\JiraSbpi.exe"
   "Port"=dword:00001f91
   "Prefix"="jira"
   "Protocol"="http"
   "Server"="127.0.0.1"
   "Type"="Jira"
Arguments - the arguments that should
be used to start the plugin, which include
the port the plugin should listen to and
the name of the configuration file; for
example, "-port 8081 -config
Jira1.config"
Name - a 'friendly' project name to
describe the external data source, which
is displayed to all Enterprise Architect
users; for example 'Sparx Systems
Sample account'
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Path - the full path to the plugin's EXE;
for example, C:\Program Files
(x86)\Sparx Systems\Cloud
Services\Service\JiraSbpi.exe
Port - a hexadecimal value representing
the port number that the external data
source expects to receive requests on,
which value should match the value
specified in the arguments; for example,
dword:00001f91
Prefix - a short unique name that is
meaningful to the users and prefixes each
link stored within the Enterprise Architect
model; for example, jira::10001 (where
10001 is the Jira object ID)
Protocol - the protocol that should be
used to communicate to the machine
hosting the plugin, such as http or https
Server - the name (or IP number) of the
machine hosting the plugin (for example,
yourdomain.com or 127.0.0.1); it is
important to realize that this address is
relative to the machine hosting the SBPI
server, therefore the name or IP must be
resolvable from the SBPI host machine
Type - a generic name to 'group' external
data sources within Enterprise Architect
Each External Data Source requires its
own set of options to define the details of
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how the configured Plugin connects to
the External Data Source. These settings
are stored in a .CONFIG file that resides
in the same location as the Plugin's .EXE
file. For example, using the above
definition a 'Jira1.config' would need to
be created, and would contain
information similar to this:
    SERVER=example.com
    PROTOCOL=https
    PORT=443
    BASEURL=myproject
    USERNAME=
    PASSWORD=
    CREATEITEMS=false
    MODIFYITEMS=false
    POSTDISCUSSIONS=true
    PROXY=10.0.0.0:3128
    PROXYBYPASS=<local>;10.*
    IGNORESSLERRORS=true

SERVER    - the name (or IP number) of
the external data source's server, such as
example.com
PROTOCOL - the communicate
protocol, such as https
PORT - the port the external data source

(c) Sparx Systems 2018 Page  559 of 1073



User Guide - Model Repository 21 December, 2018

is configured to listen on, such as 443
BASEURL - when the external data
source supports multiple 'projects', the
BaseURL property identifies which
should be used; for example, for
Enterprise Architect SBPI the BaseURL
is the DB Alias as defined in the PCS
USERNAME - optional - see Note1
PASSWORD - optional - see Note1
CREATEITEMS - defines if Enterprise
Architect users can create items in the
External Data Source - see Note2; default
value: false
MODIFYITEMS - defines if Enterprise
Architect users can modify existing items
in the External Data Source - see Note2;
default value: false
POSTDISCUSSIONS - defines if
Enterprise Architect users can add
Discussions to items within the External
Data Source - see Note2; default value:
true
PROXY - optional - the server name or
IP number and port of the proxy server,
such as 10.0.0.0:3128
PROXYBYPASS - optional - a semi
colon separated list of IP numbers that
should not be sent through the proxy; for
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example, <local>;10.*
IGNORESSLERRORS - optional - a
boolean value to ignore any SSL
certificate errors

Note1
If the external server supports OAuth 2
authentication (Autodesk, Dropbox and
Wrike), when accessing from within
Enterprise Architect, a browser window
will open and prompt you to log in to the
external account and allow Enterprise
Architect to access your account.
Enterprise Architect never sees your
credentials in this process, instead it is
provided with a unique token to access
the external account.
If the external server allows basic
authentication, then the username and
password can be optionally set in the
configuration file.
If the username and password are not
specified in the configuration file,
Enterprise Architect will prompt you for
credentials to access the external data.

Note2
Not all external products support the
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creation and modification of their objects,
for example Dropbox.

Configuring
Models for
External Data
Sources

In order for users of an Enterprise
Architect model to connect to a given
External Data Source, a 'binding' between
the Enterprise Architect model and the
External Data Source must be configured.
This is performed by a series of registry
settings in
[HKEY_USERS\.DEFAULT\Software\S
parx
Systems\SQLBridge\SBPI\Bindings\{uni
que}] for each model/external data source
combination. In this string, {unique} is an
8 hexadecimal digit number uniquely
identifying the binding. For example:

[HKEY_USERS\.DEFAULT\Software\S
parx
Systems\SQLBridge\SBPI\Bindings\B6E
E6851]
    "LocalModel"="eaexample"

"Plugin"="{853489C1-4C22-4bad-9A8E-
3098D07A3FC1}"

LocalModel - the DB Alias of the model,
such as eaexample
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Plugin - the UUID of the external data
source; for example,
{853489C1-4C22-4bad-9A8E-3098D07
A3FC1}

Special Notes

Using SSL at the Integration Server or Provider Level

If you choose to implement the HTTPS protocol at either the
Intergration Server or Integration Provider levels the
Integration Executables (*SBPI.EXE) will require a
'server.pem' file in the same folder as themselves, therefore
if using the default installation path this would mean
'server.pem' should be placed into the C:\Program Files
(x86)\Sparx Systems\Cloud Services\SBPI\ folder.

See sections SSL Certificates and Self-Signed Certificate
using OpenSSL on the page Add a Port Definition for more
information on how to create a valid 'server.pem' file.

The Integration Plugin for Enterprise Architect requires

- the BaseURL is the model's DB Alias

- the defined model must be configured as 'Enabled' and
'Enable Pro Features (OSLC, WebEA and Integration)' in
the Pro Cloud Server
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What data is returned by Integration Plugins

Each of the Integration plugins developed by Sparx Systems
returns information based on a 'Filter' or position within the
product's external data. Some products, such as Enterprise
Architect, Jira and TFS, provide a mechanism to customize
the data returned, whilst others simply return all information
at a particular position within the data.

Note: For Enterprise Architect, Jira or TFS the filters must
be configured prior to Enterprise Architect requesting that
an Integration Plugin should connect to them.

Provider Information returned

Application
Lifecycle
Manager

Information returned based on the
internal list for Defects, Requirements
and Tests.

AutoDesk Information returned based on the
contents of: Hubs | Projects | Folders

Bugzilla Information returned based on the
contents of: Product | Component | <all
items in component>

Dropbox Information returned based on the
contents of: Folders
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EA Presents a list of 'External Model'
searches as defined in the local model.
see screen 'Find in Project' | External
Models

Jazz Information returned based on the
contents of: (DoorsNG) - Folders

Jira Presents a list of 'Favorite Filters'. See
menu option Issues | Manage Filters

ServiceNow Presents a list of user defined filters,
grouped by the table they are based on.

Team
Foundation
Server

Presents a list of TFS global and 'My ...'
queries

Wrike Information returned based on the
contents of: Accounts | Folders
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User Guide

The 'Integration Plugins' component of the Pro Cloud Server
runs as a series of executables (.EXE) that do not have a
graphical user interface (GUI) themselves; however, this
User Guide describes the configuration editor screen(s) that
are included in the Pro Cloud Server's Configuration Client
that can be used to configure the Integration Plugins.

The main screen of the Configuration Client (installed as
part of the Pro Cloud Server) includes an 'Integration' tab
that is divided into two main sections. The top half defines
the details of the Integration Server (or SBPI Server) with
the lower half displaying the details of the various 'Data
Providers'; each of these sections is described in greater
detail in this topic.

Note 1: The 'Integration' tab of the Configuration Client is
only available in the premium editions of the Pro Cloud
Server; that is, the Small Business, Team and Enterprise
editions

Note 2: Any changes to the Integration Server or Plugins
(made either through the Configuration Client or manually)
will require a restart of the Pro Cloud Server

Integration Server
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All requests for external data from Enterprise Architect are
sent to the Integration Server (via the Pro Cloud Server),
which decides which Data Provider (or SBPI Plugin) needs
to action the request.

Note: the Integration Server settings are only mandatory,
when the Enabled flag is checked. The combination of
Protocol, Name and Port need to match the machine hosting
the Integration Server (in this case the Pro Cloud Server) in
order for Enterprise Architect clients to be able to
communicate to it.

Item Description

Enable
Integrations

Default value: Checked
This checkbox enables (or disables)
Integration Plugins for the current Pro
Cloud Server installation.
When this value is checked it implies that
the other fields (Protocol, Name, Port and
Path) are now mandatory and the
Integration Server definition can not be
saved without a value in each field.
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Load
Defaults

This button loads the default values for
the Integration Server settings into any
empty field.
Note: if a field already has a value, then
the 'Load Default' button will not change
or update this existing value.

Executable
Path

Default value: {PCS installation
folder}\SBPI\SBPI.exe
This value defines the complete path for
the Integration Server's executable, and if
defined, implies that the Pro Cloud Server
should automatically start this application
when it's own service starts up (assuming
the Integration Server Enabled flag is
checked).
If the Pro Cloud Server is installed into
the default location then this value should
be  C:\Program Files (x86)\Sparx
Systems\Cloud Services\SBPI\SBPI.exe.

Save This button saves any pending changes to
the Integration Server settings and is only
enabled when there are unsaved changes.

Protocol Default value: HTTP
When the 'Use Proxy' option is
unchecked, this value defines both the
Protocol the Integration Server will listen

(c) Sparx Systems 2018 Page  568 of 1073



User Guide - Model Repository 21 December, 2018

on and the Protocol Enterprise Architect
client will use to communicate to the
Integration Server.
When the 'Use Proxy' option is checked,
this value defines the Protocol that the
Integration server will listen with.

Name/IP Default value: {blank}
This value defines the machine name or
IP of the server hosting the Integration
Server.
When the 'Use Proxy' option is
unchecked, this value defines both the
machine name hosting the Integration
Server and the machine name Enterprise
Architect client will send their Integration
related requests to. It is important to
remember that this value is supplied to
the Enterprise Architect clients so the
Name/IP must be resolvable by them and
not the current machine.
When the 'Use Proxy' option is checked,
this value defines the Server Name/IP of
the machine hosting the Integration
Server, the Proxy is responsible for
converting the client Name/IP requested
by Enterprise Architect to this value.

Port Default value: 8080
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When the 'Use Proxy' option is
unchecked, this value defines both the
Port that the Integration Server will listen
on and the Port Enterprise Architect
clients will send requests to.
When the 'Use Proxy' option is checked,
this value defines the Port that the
Integration server will listen on.

Ignore SSL
Errors

Default value: unchecked
This value defines if SSL related errors
that occur while communicating to the
Integration Server component should be
ignored. The most common SSL errors
are related to self signed certificates, by
default a client does not treat self signed
certificates as being secure, therefore in
order to connect to server that use self
signed certificates this option should be
checked.

Use Proxy Default value: unchecked
This value defines if the Integration
Server is operating behind a proxy and if
Enterprise Architect clients are required
to connect to one URL, but the
Integration Server is physically listening
for requests on a completely different
URL. In most environments this option
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should be set to the default value of
unchecked.
This option was introduced in Pro Cloud
Server 3.0.23, earlier versions were not
capable of working in an environment
that used a Proxy.

Client
Protocol

Default value: {Protocol} - as set when
the 'Use Proxy' option is checked
This value is only available when the
'Use Proxy' option is checked and defines
the Protocol that Enterprise Architect
client will use to communicate to the
Integration Server.

Client
Name/IP

Default value:  {Name/IP} - as set when
the 'Use Proxy' option is checked
This value is only available when the
'Use Proxy' option is checked and defines
the machine name or IP of the server
clients should send Integration requests
to. It is important to remember that this
value is supplied to the Enterprise
Architect clients so the Name/IP must be
resolvable by them and not the current
machine.

Client Port Default value:  {Port} - as set when the
'Use Proxy' option is checked
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This value is only available when the
'Use Proxy' option is checked and defines
the Port that Enterprise Architect clients
will send requests for the Integration
Server to, this implies that when the
Integration Server starts, it will configure
itself to start listening on the specified
port.

Data Providers

A single Pro Cloud Server can support any number of
external Data Providers, and in turn each of the external
Data Providers can be available to as many models as are
supported by the installations license. Please note only
Pro-enabled repositories (or database managers) can access
external data providers. A Pro-enabled database manager is
one that has the 'Enable Pro Features (OSLC, WebEA and
Integration)' option checked.

Defined
Providers

This list defines a summary of all defined
external Data Providers.
Double-clicking an existing item will
display the 'Edit Data Providers' screen.
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Add... This button displays the "Add Data
Provider" screen to allow the entry of a
new external Data Provider. See Add/Edit 
Data Provider

Edit... This button displays the Edit Data
Provider screen to allow the modification
an existing external Data Provider
definition. See the Add/Edit Data 
Provider Help topic.

Remove This button permanently deletes the
selected Data Provider and all of its
Bindings.
Note: this button is only enabled when
there is a Data Provider selected.

Bindings This control displays a check list of all
Database Managers that are Pro enabled
(that is, the 'Enable Pro Features (OSLC,
WebEA and Integration)' option is
selected). A checked Database Manager
allocates the current Data Provider to the
given repository.

Check All This button is a quick and easy way to
allocate all defined Pro enabled Database
Managers to the currently selected Data
Provider.
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Uncheck All This button is a quick and easy way to
unallocate all defined Pro enabled
Database Managers from the currently
selected Data Provider.
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Add/Edit Data Provider

The 'Add/Edit Data Provider' screen will be shown
whenever you request to create a new Data Provider or edit
an existing one. The screen's behavior will be identical in
either mode, the one difference being that the details of the
selected Data Provider will be displayed when the screen
loads in Edit mode.

When you choose to add a new Data Provider, the screen
will initially display as shown:

Wherever possible the 'Add/Edit Data Provider' screen will
fill each field with a default value in order to make it easier
for you; if the default values are not correct, simply
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overwrite them. To this end, whenever the 'Provider' value is
changed, a number of other fields will be set to the default
values for the new Provider, such as the Data Provider's
Prefix, the Integration Plugins' Executable Path and config
filename, as shown here when Enterprise Architect is
selected:

Note: When defining a Data Provider there are a number of
mandatory fields (denoted with a '*') that require a value
before a Data Provider can be saved.

Data Provider settings

Item Description
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Name This value represents the friendly name
for the current Data Provider, it will be
shown to users of Enterprise Architect.

Provider This value specifies the Provider type of
the current Data Provider; only supported
values can be used. As mentioned,
whenever this value is changed a number
of other fields can be automatically
updated to make data entry easier for the
user.

Prefix This value represents a short unique name
to identify the current Data Provider. This
value will be saved against every
Enterprise Architect element that is
linked to an external element.

Integration Plugin settings

This group of settings related to the physical location of the
Integration Plugin relative to the Integration Server, the
combintation of Protocol, Server Name and Port must be
resolvable by the machine hosting the Integration Server, so
that requests can be forwarded to it. In the simplest case the
Integration Plugin will reside in the same folder as the
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Integration Server, ie C:\Program Files (x86)\Sparx
Systems\Cloud Services\SBPI

Item Description

Protocol This value represents the protocol that the
Integration Server should use to
communicate to the Integration Plugin, in
the simplest configuration this will be
HTTP.

Server
Name/IP

This value represents the Server Name or
IP that the Integration Server should use
to communicate to the Integration Plugin,
in the simplest configuration this will be
localhost (or 127.0.0.1).

Port This value represents that the Integration
Server should use to communicate to the
Integration Plugin. Each Integration
Plugin requires a unique Port number.
The application automatically initializes
this to 8081.

Executable
Path

This value represents the physical path to
the Integration Plugin executable file. If a
value is specified the Integration Server
will attempt to start this executable
during it own startup routine.
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Config
filename

This value represents the physical
filename of the configuration file for the
current Integration Plugin, which must
reside in the same folder as the
Integration Plugin's executable.

Provider Server settings

This group of settings relate to the details of the external
data provider, ie Dropbox, Jira or TFS.  The Integration
Plugin will use the defined details to connect to the remote
system and retrieve data from it so that it can be sent back to
Enterprise Architect. The combination of Protocol, Server
Name and Port must be resolvable by the server hosting the
Integration Plugin, which in the simplest case is the Pro
Cloud Server.

Item Description

Protocol This value represents the protocol that the
Integration Plugin should use to
communicate to the external Data
Provider.

Server
Name/IP

This value represents the Server Name/IP
that the Integration Plugin should use to
communicate to the external Data
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Provider.

Port This value represents the port that the
Integration Plugin should use to
communicate to the external Data
Provider.

Base URL Some external Data Providers allow for
the concept of multiple repositories at a
single location, for such Data Providers
this field acts as a filter.
For example it is possible to use another
Enterprise Architect model as an external
data source, in the case of Enterprise
Architect the Protocol, Server & Port
determine the Pro Cloud Server, the Base
URL is the DB Alias of the repository.

Link Base Some external Data Providers allow for
the concept of elements providing a direct
external link to themselves, for such Data
Providers this field acts as a base URL
that the individual element's unique
identifier can be appended to.
In the case of an Enterprise Architect
external Data Provider, the Link Base
field defines the WebEA address
(including the model number) for the
external data provider. ie
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"http://192.168.0.10?m=2"

User Name This value represents the user name that
should be used (in combination with the
password) to access the data within the
external system. If a value is defined in
this field all Enterprise Architect users of
the current Data Provider will use the
same set of credentials to read the
external system. Otherwise if the user
name field is left empty, Enterprise
Architect will prompt each user
independently for their credentials.

Password This value represents the matching
password for the specified user name.

Create Items Default value: unchecked
This checkbox controls if Enterprise
Architect users are able to create new
items within the external system.

Modify Items Default value: unchecked
This checkbox controls if Enterprise
Architect users are able to modify the
details of external items within the
external system.

Post Default value: checked
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Discussions This checkbox controls if Enterprise
Architect users are able to create
discussions against elements within the
external system.

Ignore SSL
Errors

Default value: unchecked
This checkbox controls if the Integration
Plugin should ignore SSL related errors
that occur as a result of communicating to
the external system.

Logging settings

This group of settings relate to the how the Integration
Plugin will create entries in it's log file(s). Since the
Integration Plugins run without user intervention, it is
important for them to be able to write to any messages or
potential problems to a log file. However special
consideration must be made to ensure that performance isn't
impacted by writing to such files, which is possible if the
log file continually grows without limits. It is also
unreasonable to expect that manual intervention should be
required to ensure that the size and number of log files don't
impact performance.  For these reasons each Integration
Plugin has it's own set of log files and configuration options
to manage its log files.
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The current log file will always include a '1' on the end of its
filename. A new log file will be created whenever the
Integration Plugin is started or the physical size of the
current log file reaches the Max File Size. When this occurs
all existing files will be 'rolled over', meaning their file
numbers will be incremented and a new '{filename}1.log'
created. If the roll over process causes more files to exist
than the 'File Count' setting allows, these additional files
will be deleted.

Item Description

File Count Default value: 3
This value represents the 'rolling' number
of log files that should be retained for the
current Integration Plugin.

Max File
Size

Default value: 1048576
This value represents the maximum
number of bytes a log file can be before a
new one is created.

Level Default value:  WARNING
This value represents what maximum
level of messages that should be written
to the log file. The levels are: OFF,
FATAL, WARNING, INFO and
SYSTEM. A defined log level is
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inclusive of all lower levels, therefore if a
Plugin is set to a log level of INFO then
all FATAL, WARNING and INFO
messages will be written to its log file.

Directory (READ-ONLY) This field displays the
physically location of where the log files
for the current Data Provider will be
saved.

Proxy settings

This group of settings relate to how the Integration Plugin
should communications to the External Data Provider when
they are separated by a Proxy Server.

Item Description

Server
Name/IP

The server name (or IP) and port number
of the Proxy Server. ie
proxyserver.com:3131

Bypass This field provides a mechanism for
certain addresses to bypass the proxy; it
accepts multiple values separated by
semi-colons (;). For example,
192.168.*;*.localdomain.com;www.myd
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omain.com

User Name If the Proxy Serer requires credentials,
then enter the user name into this field.

Password If the Proxy Serer requires credentials,
then enter the password into this field.
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Troubleshooting

Integration Server messages

There are a number of error messages that could display
during the definition of the Integration Server settings; most
are self explanatory. This table describes the most common
error messages.

Error Message

"Please enter a value for [field_names]. The Integration
Server can only be saved (while enabled) when all
mandantory fields have a value."

Reason: When the Enabled flag is checked, all remaining
Integration Server fields are mandatory. This message
occurs when one or more Integration Server fields are
empty and the Enabled flag has been checked.
[field_names] represents a placeholder for a comma
separated list of field names that are empty.

"The executable name of SBPI.EXE was expected."

Reason: The 'Executable Path' field has a value but it does
not include the filename "...\SBPI.exe", which is the only
valid filename that can be used.
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"The specified Integration Server path of [full_path] does
not exist or is invalid"

Reason: The 'Executable Path' field has a value but the
path portion of the specified value is not valid or does not
exist on the Pro Cloud Server machine.

"The specified Port is a duplicate of
[duplicate_plugin_name]"

Reason: The 'Port' field has been assigned a Port number,
however it is a duplicate of a port being used by the
Integration Data Provider with the name
[duplicate_plugin_name].

Integration Data Provider messages

There are a numerous error messages that could display
during the definition of a Integration Data Provider; most
are self explanatory. This table describes the most common
error messages.

Error Message

"Please enter a value for [field_names]. An Integration
Provider cannot be saved without all mandatory fields
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being assigned a value."

Reason: To minimize the chance of defining an invalid
Data Provider the application ensures that all mandatory
fields are given a value. [field_names] represents a
placeholder for a comma separated list of field names that
are empty.

"The specified execution path for the provider does not
exist or is invalid, [full_path]"

Reason: The 'Execution Path' for the data provider has
been assigned a value, however either the path, filename
or both cannot be found on the local machine.

"Ports needs to be unique across all Providers, the port
value of [new_port] has already been used by
[other_provider]"

Reason: A Port number has be defined for the current
Data Provider, however the value is a duplicate of another
provider's port.

"The specified Port is a duplicate of the Integration
Server"

Reason:  A Port number has be defined for the current
Data Provider, however the value is a duplicate of port
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used by the Integration Server.

"Failed to rename config file [old_filename] to
[new_filename]"

Reason: When the user changes the config filename of an
existing Data Provider the Cloud Server must rename the
old filename to the new one. This message will be shown
if the rename task is not successful, (which can occur if
the file is in use by another process) and this case manual
intervention is the only way to resolve this issue.

"Prefixes needs to be unique across all Providers, the
prefix value of [new_prefix] has already been used by
[other_provider]"

Reason:  A Prefix has be defined for the current Data
Provider, however the value is a duplicate of prefix used
by another provider.

"Config filenames needs to be unique across all Providers,
the config filename of [new_filename] has already been
used by [other_provider]"

Reason:  A Config filename has be defined for the current
Data Provider, however the value is a duplicate of config
filename used by another provider.
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General Troubleshooting

This table provides general advice to help identify and
resolve common issues with the Integration component of
the Pro Cloud Server.

Error Message

Problem: After making changes to the Integration
definitions of the Server or Data Providers, the Enterprise
Architect users do not notice any differences.

Reason: After changing the Integration configuration was
the Pro Cloud Server restarted? If not restart the Pro
Cloud Server.

Problem: A newly configured Integration Data Provider is
not listed in the navigation breadcrumb of Enterprise
Architect (after the Pro Cloud Server has been restarted).

Reason: Confirm that the currently open Model has a
Binding entry for the Data Provider. See the Bindings
item in User Guide topic for details.

Problem: Selecting items within the Integration
navigation breadcrumb of Enterprise Architect seem to
have no effect.
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Reason: It is possible that errors (or warnings) are
occurring which are logged to the System Output
Window, therefore make sure the System Output Window
is shown while using the Integration window.

Problem: General errors seem to be occurring however no
useful information is shown in the System Output
Window.

Resolution: Each Integration Data Provider has the
capability to write detailed entries to a log file, to ensure
that the most detailed information is written, change the
log level for the Data Provider to SYSTEM (restart the
Pro Cloud Server) and then retry the same action in
Enterprise Architect. Then review the Data Provider's log
file, ie in C:\Program Files (x86)\Sparx Systems\Cloud
Services\SBPI\Logs on the Pro Cloud Server.
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Visibility Levels

The 'Visibility Levels' feature within Enterprise Architect
provides the ability to restrict access to certain sections of a
model. Only models hosted by a Pro Cloud Server are able
to make use of this feature. Visibility Levels are
implemented by taking advantage of the Row Level Security
feature included in Oracle 8+ and Microsoft SQL Server
2016 (onwards).

Row Level Security is a security feature that controls which
database users can access which rows of data in a database.
Traditional database security only provides the ability to
control which users have access to read, write or delete data
down to the table level. Since Row Level Security
functionality is implemented by the database, it is
impossible for users to bypass security implemented at the
application level, by writing their own scripts or databases
queries. That is, the database ensures that users can only
view and update data they are authorized to access.

Since Row Level Security is functionality implemented by
the database, most of the configuration for Enterprise
Architect and the Pro Cloud Server to support it is
performed directly in the database without needing to
change the application code base, which means there is less
to go wrong from an application point of view.

Database / Application Users
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It is important to understand the distinction between
database and application users. The introduction mentions
that visibility levels are based on Database User
permissions. In the Sparx System Cloud Server
environment, each Database Manager is defined with all of
its connection details (including the user and password) to a
given database. It is the database user, the user identified in
the connection details, that visibility levels are based on.

This concept is not to be confused with Enterprise Architect
model users; that is, the user ID/password that is entered
when accessing a security enabled model. This is an
application user.

Note: Enterprise Architect's model security is not
mandatory, whereas all DBMSs require a database user to
be defined in order to access data within the database.

How it works

In additional to their normal permissions, database users are
granted access to one or more visibility levels. A new
column, VIS_LVL (Visibility Level), is added to 24 critical
tables within the Enterprise Architect database. This field
stores the visibility level that is needed to view/update this
record.

For each of the 24 tables a security policy is defined that
ensures each database user only sees records that their
assigned visibility level is authorized to view.
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Database triggers are then used to maintain the value of the
VIS_LVL columns in all tables for all child objects and
elements. For example, setting the visibility level of a
Package in Enterprise Architect's Project Browser will
update the selected Package and all of its children to the
entered visibility level.

Note: The base scripts supplied by Sparx Systems support
20 'levels' of security (that is, 1 to 20); however this can
easily be adjusted by manually changing the number of rows
that are inserted into the T_VISIBILITYLEVELS table at
the beginning of the script. Level 0 is a special case,
representing the default value; it implies that all database
users (even those without an assigned visibility level) can
view or update records of this level.

The Drawback

As with most things, the Visibility Levels functionality
comes at a cost when compared to the same model without
Visibility Levels enabled. Both SQL Server's and Oracle's
Row Level Security functional imposes extra processing on
the database server that needs to be performed whenever
data is selected, this extra processing takes time, how much
time depends on the type and amount of data being selected,
so it is very hard to estimate. Sparx System's
implementation of Visibility Levels has attempted to design
its solution in the most efficient way possible however it is
unavoidable that models with Visibility Levels will perform
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slower than models without.
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Install and Configure

The Sparx Systems Pro Cloud Server product is installed
using a standard Microsoft Windows Installer package that
includes a number of optional components. One of these
components is Visibility Levels, which is installed by
default into the C:\Program Files (x86)\Sparx
Systems\Cloud Services\RLS\ folder (assuming a 64bit
machine is being used). If necessary, you can change the
install location of the Visibility Levels files.

Requirements

In order to use Visibility Levels you must have:

A licensed Pro Cloud Server·

An Oracle 8+ or SQL Server 2016+ based Enterprise·

Architect model/repository that uses the EA1220 schema
definition

An SQL based management console tool that supports the·

execution of SQL scripts

Enterprise Architect build 14.0 or later·

Enterprise Architect Ultimate Edition for assignment of·

Visibility Level on a Package

What is in the Package?
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The Visibility Levels folder consists of a number of SQL
script files that will either apply or remove the required
database changes to an Enterprise Architect model so that it
can support the DBMS's native Row Level Security feature.

The implementation of Row Level Security in Oracle is
completely different to the implementation in SQL Server.
While the end result behaves the same way, the physical
objects that are needed by each DBMS are sufficiently
different for each to need its own creation script.

Task Script

Apply
Visibility
Level
changes to
Oracle model

EASchema_VL_Updates_Oracle_1220.s
ql - Oracle SQL script that will update an
existing Enterprise Architect Oracle
based repository so that it supports
Visibility Levels, by creating a set of
functions, procedures, policies, triggers
and columns.

Apply
Visibility
Level
changes to
SQL Server
model

EASchema_VL_Updates_SQLServer_12
20.sql - SQLServer specific SQL script
that will update an existing Enterprise
Architect MS SQL Server based
repository so that it supports Visibility
Levels, by creating a set of functions,
procedures, policies, triggers, roles and
columns.

(c) Sparx Systems 2018 Page  597 of 1073



User Guide - Model Repository 21 December, 2018

Remove
Visibility
Level
changes from
Oracle model

EASchema_VL_Removal_Oracle_1220.s
ql - Oracle SQL script that will remove
the functions, procedures, policies,
triggers, roles and additional columns that
were added to support Enterprise
Architect's Visibility Levels.
Note: All basic Enterprise Architect
modeling data will remain unchanged by
the removal script.

Remove
Visibility
Level
changes from
SQL Server
model

EASchema_VL_Removal_SQLServer_1
220.sql - SQLServer SQL script that will
remove the functions, policies, triggers,
roles and additional columns that were
added to support Enterprise Architect's
Visibility Levels.
Note: All basic Enterprise Architect
modeling data will remain unchanged by
the removal script.

How to execute

In order for an Enterprise Architect model to support
Visibility Levels, the appropriate update script must be
executed on that model's database. The script is standard
SQL, so any tool can be used; however, you must connect
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using an ID with owner privileges because updates will be
made to the physical schema.

Script Execution for Oracle

Identify the Enterprise Architect model database to which1.
to apply Visibility Levels.

Ask all users to log out of the model.2.

(Optional step) Physically stop any further user access to3.
the database; for example, disconnect the server from the
network.

Perform a complete backup of the database.4.

Open your SQL console of choice and connect to the5.
database as the owner.

Load the Oracle script6.
('EASchema_RLS_Updates_Oracle_1220.sql') into the
console.

Review the comments at the top of the script, in particular7.
the section that outlines the tasks that need to occur before
running the script.

Make the needed adjustments to the script for your8.
environment/preferences.

Execute the script.9.

Follow the set of instructions documented at the top of10.
the script in the 'Do the following AFTER running this
script' section
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Perform a second complete backup of the database, as a11.
restore point.

Define the Database Managers in the Pro Cloud Server12.
(refer to the Defining Visibility Level Aware Database
Managers table in the Visibility Levels User Guide).

(Optional step) If Step 3 was performed, re-enable13.
regular user access to the database.

Open Enterprise Architect Ultimate edition, connect to14.
the Pro Cloud model with the highest Visibility Level (as
defined in step 12) and set the Visibility Level on all
Packages to their required values.

Script Execution for MS SQL Server

Identify the Enterprise Architect model database to which1.
to apply Visibility Levels.

Ask all users to log out of the model.2.

(Optional step) Physically stop any further user access to3.
the database; for example, disconnect the server from the
network.

Perform a complete backup of the database.4.

Open your SQL console of choice and connect to the5.
database as the owner.

Load the SQL script6.
('EASchema_RLS_Updates_SQLServer_1220.sql').

Review the comments at the top of the script, in particular7.
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the section that outlines the tasks that need to occur before
running the script.

Make the needed adjustments to the script for your8.
environment/preferences.

Execute the script.9.

Follow the set of instructions documented at the top of10.
the script in the 'Do the following AFTER running this
script' section

Perform a second complete backup of the database, as a11.
restore point.

Define the Database Managers in the Pro Cloud Server12.
(refer to the Defining Visibility aware Database
Managers table in the Visibility Levels User Guide).

(Optional step) If Step 3 was performed, re-enable13.
regular user access to the database.

Open Enterprise Architect Ultimate edition, connect to14.
the Pro Cloud model with highest Visibility Level (as
defined in step 12) and set the Visibility Level on all
Packages to their required values.
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User Guide

The functionality of the Visibility Levels feature is primarily
restricted to System Administrators, in order to set up and
configure models to limit access to certain Packages in a
model. Generally, users will not be aware of Visibility
Levels; they simply will not see certain Packages in the
model.

Defining Visibility Level Aware Database
Managers

For the most part, defining Database Managers in the
Professional ('Pro Cloud') version of Sparx Systems Cloud
Service Configuration Client is the same process as for the
regular version. These are the exceptions:

DB
MS

Discussion

Or
ac
le

All Oracle connections require a
'DefaultSchema={schema_name};' option manually
added to the connection string, where
{schema_name} is the physical name of the schema
that owns the Enterprise Architect tables. For
example:

Provider=OraOLEDB.Oracle.1;Password=pass;Persi
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st Security Info=True;User ID=user1;Data
Source=ORA_SN;DefaultSchema=owner_user;
In a typical Oracle connection to an Enterprise
Architect model the 'User ID' option is both the
owner of the tables and the user credentials that are
being used to access the data. However, in a model
using the Visibility Levels feature, these options are
different, so the 'DefaultSchema' option has been
added to define the table owner.

M
icr
os
of
t
S
Q
L
Se
rv
er

All SQL Server connections require an 'Alias' field
value that uniquely identifies the database manager
on the current server. The 'Alias' value is the name
by which Enterprise Architect users know the model.
In previous versions of the Cloud Service, the
database manager alias for SQL Server-based
connections was automatically determined by the
database name, which meant that each SQL Server
database could only ever have one database manager
defined in the Cloud Service. Now with the use of
the 'Alias' field a single database can have an
unlimited number of database managers defined.

Enabling the Extended OLSC Interface on a
Database Manager
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In order for the Pro Cloud Server to allow the use of
Visibility Levels in a model the 'Enable Pro Features
(OSLC, WebEA and Integration)' option must be selected.
This is achieved by opening the Sparx Systems Cloud
Services Configuration Client application
(SSProCloudClient.exe) connecting to the appropriate
server. You then select the database manager in the list and
click on the Configure button. On the resulting Configure
Database Manager screen select the 'Enable Pro Features
(OSLC, WebEA and Integration)' checkbox.

Visibility Level Administration

When the Ultimate edition of Enterprise Architect is used to
connect to a model that has Visibility Levels configured,
there is an additional menu item, 'Set Visibility Level...'
available under the 'Package Control' context menu of each
Package object in the Project Browser.

If your model has security enabled, then all application users
that require access to the 'Set Visibility Level...' menu item
will need to be allocated the 'Visibility Level Admin' or
'Administer Database' security permission, using standard
Enterprise Architect permission assignment.

Set a Package's Visibility Level
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From within the Ultimate edition of Enterprise Architect,
the Visibility Level of a Package can be set using the Project
Browser context menu item 'Package Control | Set Visibility
Level...'.

This menu item will only be available in models that have
been set up for Visibility Levels, are being accessed via a
Pro Cloud server connection and the user has a Ultimate
License.

Once a Visibility Level has been set on a Package, that
Package and all of its children can be viewed, accessed and
updated only by users with the corresponding access level.

To remove a visibility level from a Package (and all its
children), simply set the Visibility Level back to
unrestricted.

Visibility Levels users can apply

Users can only set the Visibility Levels on Packages to
levels the current database user has access to. For example,
an Enterprise Architect client connected to a Cloud
connection that uses a database user that has been assigned
levels 3 & 4 can update the Visibility Level of any Package
to the levels unrestricted, 3 or 4.
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Troubleshooting

'Set Visibility Level' menu is not available

The 'Set Visibility Level' menu item can be hidden from
users for a number of reasons:

You are not connecting to the model via a Cloud·

connection

You are not using Enterprise Architect release 14 (or·

above)

You are not using the Ultimate edition of Enterprise·

Architect

The Cloud Server you are connected to has an expired·

license and is now operating as the free edition

The model you are connecting to is NOT Oracle or MS·

SQL Server based

The model in the Cloud Server you are connecting to is·

not configured with the 'Enable Pro Features (OSLC,
WebEA and Integration)' option

The model you are connecting to has not been·

configured/adjusted for Visibility Levels (that is, the
update script has not been run against the database)

The currently logged on application user has not been·

granted access to the 'Visibility Level Admin' Enterprise
Architect security permission.

(c) Sparx Systems 2018 Page  606 of 1073



User Guide - Model Repository 21 December, 2018

(c) Sparx Systems 2018 Page  607 of 1073



User Guide - Model Repository 21 December, 2018

Additional Functionality Using the
Cloud

The Cloud Services provides the facility of connecting to
models over a secure http connections (HTTPS). It also
makes it possible to use these additional facilities on or
within your models:

Open Services for Lifecycle Collaboration (OSLC)·

Reusable Asset Service (RAS)·

Scheduled Tasks·

OSLC

OSLC is an initiative to provide easier integration between
Requirement Management tools. It uses HTTP to list, add,
modify and delete requirements. The service provider
definition to direct any OSLC client to is:

    <protocol>://<server>:<port>/<model_name>/oslc/sp/

For example, if you were connecting to a server running on
your own machine using the default settings, the connection
would be:

    http://localhost:804/model/oslc/sp/

OSLC v2
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With the release the Pro Cloud Server a second OSLC
interface was introduced which provides external tools
access to a much greater range of Enterprise Architect
information. This new version is referred to as OSLC
Architecture Management. The base URL for OSLC v2 is :

    <protocol>://<server>:<port>/<model_name>/oslc/am/

For example, if you were connecting to a server running on
your own machine using the default settings, the connection
would be:

    http://localhost:804/model/oslc/am/

Reusable Asset Service (RAS)

The RAS portion of the Cloud Server helps you to define
Packages that can be used in any model. When a Package is
requested, Enterprise Architect and the Cloud Server will
track cross-Package dependencies and make available
everything required by that Package.

Scheduled Tasks

The Cloud Server includes optional support for running
time-based updates to data. Currently, this is applied to
updating a Time Series chart automatically to provide a
dynamic view of how a model is changing over time. You
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can set different time scales for these updates, such as daily,
weekly or monthly.

Notes

This facility is available through the Corporate, Unified or·

Ultimate editions
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Cloud Server Troubleshooting

Browser Test

For a simple check that the Cloud Service is operating on
the specified Ports defined in the configuration file, you can
enter this address into a web browser:

    <protocol>://<machineName>:<port>

For example, on the Cloud Server:

    http://localhost:804/

Or

    https://sparxcloud.com

If the port is enabled this message is returned:

    Sparx Systems Cloud Server

    Congratulations, your server is now ready to host your
models. Connect through the

    configuration client to add or remove models.

If this message is not displayed, confirm the server and port
name, check for other services listening on the specified port
and check the server log file for error messages.

Errors shown in Enterprise Architect System
Output
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Error
Message

Meaning

HTTP Status
401 Access
Denied

Indicates a failure to authenticate with the
server.
With the built-in web server, this error
will occur if an invalid username or
password was provided, or no username
or password were provided.

HTTP Status
403

Indicates an attempt to access a model
that is marked on the server as 'Require
authenticated and secure connection'.
This might indicate that you are
connecting using an http protocol instead
of https, or that the port you are using is
not providing authentication to the model
you are connecting to.
Check that you are using https.
Check with the system administrator that
the security authentication option is
pointing to a model with security
enabled.

HTTP Status
500 Unable
to connect to
service

The connection is not being accepted.
Check the server name·

Check the firewall settings on the client·

and server
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Check the ports the server is listening·

on

The database
manager for
this database
was shut
down

Enterprise Architect established a
connection to a Cloud Service, and
requested to connect to a known
repository, but the repository is currently
disabled.
Ask your system administrator to check
the 'Enabled' option for the database in
question.

There is no
database
manager
configured
for the
requested
repository

Enterprise Architect established a
connection to a Cloud Service, but the
model name requested does not match
any defined database on the server.

When accessing the model via Cloud
Connection, ensure that the Model Name
which is entered matches the Alias which
is shown in the Cloud Configuration
Client.

Unable to
connect to
Database

Enterprise Architect established a
connection to a Cloud Service and
requested to connect to a known
repository; however, when the server
attempted to open a connection to the
database using the supplied details, it
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failed.
Note: Whenever this error occurs, a
Warning-level message that contains
more detailed information will be written
to the Cloud Server logs.
If the repository is:

Using ODBC, ask your System·

Administrator to check that an ODBC
connection is defined as a System DSN
(and not a User DSN) on the server,
that all connection parameters are
correct, and that the database username
and password have been saved into the
ODBC DSN or the connection string
Oracle, ask your System Administrator·

to verify that the user name and
password were saved with the
connection string and that all other
options in the connection are correct
SQL Server connecting via OLE DB·

and Windows authentication, ask your
System Administrator to verify that the
user name the Cloud Service is running
under has been granted permission to
the SQL Server database (at a
minimum it will need the roles
db_datareader and db_datawriter) and
that all other options in the connection
are correct
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SQL Server connecting via OLE DB·

and SQLServer authentication, ask
your System Administrator to verify
that the defined user name has been
granted permission to the SQL Server
database (at a minimum it will need the
roles db_datareader and db_datawriter),
that the option to save the password
with the connection string was enabled,
and that all other options in the
connection are correct

After
Reinstall
Enterprise
Architect no
longer works

Your environment was working correctly,
then you updated to the latest version of
the Cloud Server and now Enterprise
Architect clients are not able to connect
to your Cloud models.
During the reinstall process the Cloud
Server installer actually uninstalls the
original version and then installs the new
one. As a result of this the Firewall
exception that is automatically added by
the installer is removed and re-created.
The problem with this is if someone
manually adjusted the Firewall exception
(after the original install) any manually
changes are lost when the installer
re-creates the Firewall exception. One
method of stopping this from occurring in
the future is to create a completely new
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firewall exception (with a different name)
that is a copy of the one created by the
installer, and make any manual changes
to that exception.

Reading Server Logs

As mentioned earlier the Sparx Systems Cloud Service is a
Windows Services application and as such it needs to
conform to some basic rules. When it comes to
troubleshooting the most important rule for Services is that
they can be run independently of user input/interaction and
as such do not contain screens/GUI of any kind. For this
reason the Sparx Systems Cloud Service writes any potential
message to Log files.

The Cloud Service configuration file contains a number of
settings that control where, how many and how large log
files can be. By default the Cloud Service will save all log
files to a \Logs\ folder under \Services\ (C:\Program Files
(x86)\Sparx Systems\Cloud Services\Service\Logs), and it
will keep up to 3 files. A new file will be created whenever
the Cloud Service is started or whenever the maximum file
size if reached. Filename 'SparxCloudServicesLog-1.log'
will always be the most recent log file and each time a new
file is created the older ones are renamed by increasing the
number. ie SparxCloudServicesLog-2.log is renamed to
SparxCloudServicesLog-3.log.
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The configuration file also contains a setting that controls
the level of logging that is performs, see the logging related
options in 'Extended Server Properties' for more details.
When troubleshooting, it is recommended that the Cloud
Services LOG_LEVEL property be set to the highest level,
SYSTEM.

Each log entry will consist of the Time, Log Level and
Message, if an error occurs the Message will normally
contain a description of the problem and from this the
appropriate action can be undertaken.

Log Message Explanation

Log File
Header

Each time new Log file is created the
Cloud Service will write out a summary
of the main settings, this information is
particular useful if you are requesting
support from Sparx Systems.
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Started
database
managers

When a Cloud Service is initially started,
and the Log Level is set to INFO (or
lower) it will log out a summary of each
configured model which includes the
connection string of the model.
    [INFO]: Added database manager -
ConnectionStr: 'eaexample ---
Connect=Provider=MSDASQL.1;...
If the Log level is lower than INFO,
additional log entries will be written for
each model, for example:
    [SYSTEM]: SUCCESS Started
database manager
firebird:anonymous@eaexample

House
keeping

The Cloud Service performs regular
'house keeping' tasks, the frequency of
which is controlled by the
AUDIT_TIME_PERIOD setting in the
Cloud Service configuration file.
When the log level is set to INFO, each
time house keeping is performed the
Cloud Service will log out a summary of
connections for each defined database
manager and report how many are
currently available, the maximum number
used concurrent and total number of uses
since the last audit.
     [AUDIT]
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firebird:anonymous@eaexample       |
Free:  0 | Max Active:  3 | Acquisitions:
192 |

Normally these entries can be ignored as
they are purely reference information
only.

Open port list When a Cloud Server is initially started,
and the Log Level is set to SYSTEM, it
will log out a success message for each
configured port, which includes the
management port (803) and any http/https
ports, you should see a line such as:
    [SYSTEM] SUCCESS Bound and
listening on port 804.
If the log file is missing any lines, or if
the message doesn't read 'SUCCESS' this
might indicate a problem with the server
port.
A common error here is:
    Unable to create secure server on port
443.
Possible causes of this are:

Certificate/Private Key file not found at·

C:\Program Files (x86)\Sparx
Systems\Cloud
Services\Service\server.pem
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The server.pem file does not contain a·

valid certificate and private key
Certificate Authority file not found or·

invalid at C:\Program Files (x86)\Sparx
Systems\Cloud
Services\Service\cacert.pem

Unable to
connect to
database

During operation, the server will write to
the log file any failed attempts to open a
model. This will generally not occur until
a user attempts to connect to the database.
Errors that can occur here are:
    REQUEST_CONNECT FAIL. Error
(5): Unable to connect to database
This means that the server attempted to
open a connect but it failed. If you see
this message, review the list of potential
reasons outlined in the Errors shown in
Enterprise Architect System Output table.
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Reuseable Asset Service (RAS)

Within a large organization, groups of users can be
separated by geographical distance be on different networks.
This can make it difficult to share common data, standards
and modeling structures, without the complexity of using
external Version Control tools or manually distributing XMI
files between projects. Enterprise Architect has a Reusable
Asset Service (RAS) that provides a simple and convenient
mechanism for modelers to distribute or download reusable
model structures, information, corporate directives and
standards. The shared repository is accessible via a Cloud
Service connection, making it accessible for distributed
teams. The person who sets up the reusable data can retain
governance of the resource or asset, whilst users of the
service can easily review the currency of the information
and download the latest versions into their models or file
folders.

The RAS gives distributed teams convenient access to a
single 'source of truth' for shared data, including project
milestones, architectural frameworks and industry standards.

Reusable Assets

Reusable Assets consist of:

Packages containing elements, diagrams and structures (as·

drawn from any point within the Project Browser), and
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Files in a range of text, code and graphic formats,·

including .eap files

An asset can be, for example:

A common Class library or framework·

A set of common Requirements or Use Cases·

A draft specification document·

Marketing collateral·

Storage Structure and Use

Reusable Assets are held in a remote registry, accessed
through a Cloud Service connection. The registry contains
any number of Storages, which can either be left
unprotected for any user to create, or change-restricted by an
Administrator password. Each Storage can contain any
number of Asset Packages holding modeling structures, and
files containing textual or graphical information and data.
When a user creates a Storage, they can protect the contents
from being updated in the Registry or downloaded into a
model, using password protection defined by that user.

For each Package, the RAS automatically identifies the:

Version of the Package held in the registry·

Diagrams and elements (including child Package·

elements) contained by the Asset Package

Dependencies on parent Packages of any external·

elements that the Asset Package references
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Dependencies on MDG Technologies·

Any user, regardless of password protection, can freely
browse and identify the contents of a Package held in a
Storage - including displaying the diagrams - without
importing the material into a model. A user that has
imported an Asset Package into their model can compare
their model Package against any version of the Asset
Package, to check for and assess any differences between
them.

Notes

The Reusable Asset Service is available in the Corporate,·

Unified and Ultimate editions of Enterprise Architect
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Connect to the Asset Service

The Reusable Asset Service provides model structures and
documents to you from one or more registries on remote
systems. You access these registries through a Cloud
connection to the appropriate server. The connection details
should be provided to you by your System Administrator or
Reusable Asset Service Administrator.

Access

Ribbon Publish > Model Exchange > Reusable
Assets

Connect to Assets

Option Detail

Registry This field normally defaults to the
last-used registry name. If the field is
empty, or if you want to switch to a
different registry, click on the  button
to the right of the field.
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The 'Cloud Connection' dialog displays.
Using the information provided by your
administrator, type in the server name,
URL and the name of the model hosting
the registry data. For example, if you
wanted to download the UBL
Frameworks into your model, you would
specify the server 'sparxcloud.com' and
the model name 'modelpatterns'.
If advised by your Administrator, type in
the user name and password for the
server.
Click on the OK button; the 'Registry'
field now shows the server name.

Storage If there is more than one Storage
available in the Registry, this field
defaults to the first listed in the Registry.
To check for or select other Storages,
click on the drop-down arrow at the right
of the field. Click on the Storage to
review. For example, if you were
downloading UBL frameworks, you
would select 'UBL' in the list.
The 'Registry Browser' tab displays the
Packages registered in the selected
Storage.
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Notes

The Reusable Asset Service is available in the Corporate,·

Unified and Ultimate editions of Enterprise Architect
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Browse Assets

When you select a Storage in the Reusable Asset Service,
the 'Registry Browser' tab immediately displays a list of the
Packages registered in that Storage. You can review and use
these Packages using the context menu and buttons on the
tab.

You can review the properties and contents of the selected
Package in the Storage, and access any files in the Storage,
using the tabs in the lower half of the Reusable Asset
Service view, underneath the 'Registry Browser' tab.

If you have left the Registry Browser open for a while and
there is a possibility that the Registry has been changed, you
can click on the  icon in the Reusable Asset Service
toolbar to refresh the Browser with the latest contents of the
Registry.

Access

Ribbon Publish > Model Exchange > Reusable
Assets > Registry Browser

Review Assets
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Option Detail

Toggle Filter
Bar

Right-click on the column headings and
select this option to show or hide the
Filter Bar on the display.

<filter bar
fields>

Type in the appropriate characters to list
only Packages that have that string of
characters in the values in the
corresponding column.

Package This column shows the name of the
Packages held in the selected Storage.

Version This column defaults to the most recent
version of each Package held in the
selected Storage.
You can click on the drop-down arrow at
the end of a field and select a different
version of the corresponding Package, if
any have been registered.

Last
Registered

This column shows the date and time at
which the currently-listed version of each
Package was registered.

Registered This column shows the user name of the
person who registered the currently-listed
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By version of each Package.

Import Click on a Package name and click on
this button to begin to import either the
Package alone or the Package and its
dependent structures into your model.
You can perform the same action by
right-clicking on the Package name and
selecting the 'Import from Registry' menu
option.
If the Package from the Registry already
exists in your model, it is deleted and
replaced by this import.
For a:

'Learning Center Library' Storage, the·

'Download Library' dialog displays
'Reference Data Library' Storage, the·

'Import Reference Data' dialog displays
'Source Code Library' Storage, the·

'Save As' dialog displays

Compare
with Package
in Model

If you have previously imported a
Package from the Registry into your
model, you can right-click on the
Package name in the Registry Browser
and select this option to compare the
imported Package with the Registry
version, and show any differences.
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The system automatically selects the
model Package from the Project Browser.

Find in
Project
Browser

If you have previously imported a
Package from the Registry into your
model, you can right-click on the
Package name in the Registry Browser
and select this option to highlight the
corresponding Package in the Project
Browser.

Notes

Some of the other options available on the Registry·

Browser are used to set up assets in the Registry

If the Storage is password-protected, a prompt for you to·

enter a password displays when you select to perform an
operation on the data; in this situation, you need the
'Read-only' password to process the information from the
Storage, and the 'All-access' password to change the
information in the Storage

The 'Registry Browser' tab will be empty for a 'Learning·

Center Library', 'Reference Data Library' or 'Source Code
Library' type Storage - the contents of these Storages will
be available in the 'Storage Files' tab of the Reusable
Asset Service view
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Asset Properties

When you select a Storage and a Package in the Registry
Browser, the first four tabs in the lower half of the Reusable
Asset Service view are updated with information from the
Package. The 'Asset Properties' tab is a read-only view of
the properties of the selected Package itself.

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then click on the 'Asset Properties' tab to
display properties for that Package.

Ribbon Publish > Model Exchange > Reusable
Assets

Review Package Properties

Field Detail

Package Displays the name of the selected
Package.
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GUID Displays the Global Unique Identifier of
the Package.

Version Displays the version reference (such as
1.1 or Beta) of the Package.

Author Displays the user ID of the person who
created the Package (the Package
Author).

Created Date Displays the date and time at which the
selected version of the Package was
created (that is, registered) in the
Registry.

Modified
Date

Displays the date and time at which the
selected version of the Package was last
modified (that is, re-registered) in the
Registry.

Comments Displays any comment recorded against
the Package when it was registered in the
Storage.

Notes Displays the notes recorded against the
Package when it was registered in the
Storage.
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Notes

The 'Asset Properties' tab will be empty for a 'Learning·

Center Library', 'Reference Data Library' and 'Source
Code Library' type Storage
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Package Contents

When you select a Storage and a Package in the 'Registry
Browser', the first four tabs in the lower half of the Reusable
Asset Service view are updated with information from the
Package. The 'Contents' tab lists the diagrams and elements
(including child Packages) held in the selected Package,
listing the two types of object separately. You can organize
the information within a column into alphabetical or
reverse-alphabetical order for ease of reference, and use the
Filter bar to filter the display to show only items with values
containing specific characters or digits.

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then click on the 'Contents' tab, to display
the contents of that Package.

Ribbon Publish > Model Exchange > Reusable
Assets

Review Package Contents
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Option Detail

Content Type Click on this button to toggle between
listing the Package diagrams first and
listing the Package elements first.

Toggle Filter
Bar

Right-click on the column headings and
select this option to show or hide the
Filter Bar on the display.

<filter bar
fields>

Type in the appropriate characters to list
only elements and diagrams that have that
string of characters in the values in the
corresponding column.

Content
Type:
Diagram
Content
Type:
Element

These are the headers for the two types of
object listed in this tab.
Click on the appropriate expansion box to
hide or show the list of diagrams or
elements under the heading.

Name Displays the name of the element or
diagram available in the Package.

Type Displays the type of the element or
diagram, such as UseCase or Use Case
diagram.
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GUID Displays the Global Unique Identifier of
the element or diagram.

Content Type Displays the object type of the item -
Element or Diagram.

Find in
Project
Browser

Right-click on an element or diagram line
and select this option to see if the element
or diagram also exists in your model and,
if it does, to highlight it in the Project
Browser.

View
Diagram

Right-click on a diagram name and select
this option to display the diagram within
a labeled frame, as an image.
Alternatively, double-click on the
diagram name.

Notes

The 'Contents' tab will be empty for a 'Learning Center·

Library', 'Reference Data Library' or 'Source Code
Library' type Storage
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Package Dependencies

A Package held as an asset in the Reusable Asset Service
registry might contain elements and diagrams that have
relationships with objects in other Packages. The Packages
containing these 'external' objects will also have been added
to the Registry to support the first Package, and will be
listed in the 'Registry Browser' tab along with other
(unrelated) Packages. You can establish whether the
selected Package in the Registry Browser has links to other
Packages in the Registry, and which they are, by reviewing
the 'Dependency' tab.

Package A depends on Package B if any of these constructs
(or their Tagged Values) in Package A references elements
in Package B:

Elements·

Attributes·

Operations·

Operation Parameters·

Diagrams·

Connectors·

Access

Open the Reusable Asset Service window using one of the
methods outlined here.
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Select a Package, then click on the 'Dependency' tab, to
display a list of Dependencies for that Package.

Ribbon Publish > Model Exchange > Reusable
Assets

Check Package Dependencies

Option Detail

Package Displays the name of the related Package.

Version Displays the latest registered version of
the related Package that has links to the
selected Package.

GUID Displays the Global Unique Identifier of
the related Package.

Find in
Project
Browser

Right-click on the 'Package' line and
select this option to see if the Package
also exists in your model and, if it does,
to highlight it in the Project Browser.
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Notes

If one Package depends on another, and that second·

Package itself depends on another Package, both the
second and third Packages are shown in the 'Dependency'
tab

The 'Dependency' tab will be empty for a 'Learning·

Center Library', 'Reference Data Library' or 'Source Code
Library' type Storage
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Package Technologies

It is possible that the asset Package in the Registry is
associated with one or more Technologies, especially if the
Package comes from a model developed as an extension or
customization of the UML. You can check whether an asset
Package has any associated Technologies, and what they
are, by viewing the 'Technology' tab of the Reusable Asset
Service view.

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then click on the 'Technology' tab, to
display a list of Technologies required to support that
Package.

Ribbon Publish > Model Exchange > Reusable
Assets

Review Technologies

Option Detail
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Name Displays the name of the Technology as
recorded in the Registry.

Version Displays the required version of the
Technology to support the asset Package,
available through the Registry.

ID Displays the unique identifier of the
Technology.

Type Identifies whether the Technology is
system-supplied and built in to Enterprise
Architect (such as BPMN 2.0 or ArcGIS),
or user-defined.
A user-defined technology can be
introduced from an external source or
developed by a user within the system.

Registry
Status

Indicates whether the Technology file is:
Available - the Technology file is·

registered in the current Storage, or
Unavailable:·

    - The Technology file is not
registered in the Storage, or
    - The Technology is a built-in
Technology and is already integrated
        with your system, or must be
purchased under license, or
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    - The Technology is available from a
URL and can be downloaded
        from that URL

Import
Technology

If your local system does not have one of
the Available Technologies, you can
quickly import it from the Registry.

Right-click on the Technology name1.
and select the 'Import Technology'
option.
A prompt displays for you to confirm2.
the import to your system; click on the
Yes button.
A message displays to confirm that the3.
Technology has been imported; click
on the OK button.

You might have to restart Enterprise
Architect to activate the Technology.
Other than the remote Technologies, you
cannot import a Technology flagged as
'Unavailable'. You can import a remote
Technology from its URL site.

Notes
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You can also import Available Technologies from the·

registry as part of the process of importing the asset
Package

If the Storage is password protected, a prompt to enter·

your password displays (this can be a Read-Only or a
Complete Access password) after you confirm that you
want to import the Technology; you cannot import the
Technology without this password

The 'Technology' tab will be empty for a 'Learning Center·

Library', 'Reference Data Library' or 'Source Code
Library' type Storage
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Storage Files

The 'Storage Files' tab of the Reusable Asset Service view
simply lists the files that have been uploaded to the specified
Storage. The files can be of any type, uploaded from any
directory on any system connected to the registry. Typically
they would be document or graphics files that provide
standards, guidelines or design information on a model
structure. The tab displays the file name and extension, and
a comment on the nature or purpose of the file.

Files held in the Registry are compressed, so to view the
contents you download them onto your local system.

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then click on the 'Storage Files' tab to
display a list of files associated with the Package, that are
available for download.

Ribbon Publish > Model Exchange > Reusable
Assets

Review files in Draft/Complete type Storage
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On the 'Storage Files' tab, check the 'Comments' field
against each file that interests you.

To view the contents of a file, right-click on the file name
and select the 'Import From Registry' option. The 'Save As'
browser displays, through which you select the directory
into which to copy the file.

Click on the Open button. The file is copied into the selected
location, from which you can open it.

Review files in Learning Center/Reference
Data/Source Code Library type Storage

On the 'Storage Files' tab, check the 'Comments' field
against each file that interests you.

To import and install a Library file, right-click on the file
name and select the 'Import From Registry' option. One of
these dialogs will display:

'Download Libraries' dialog for a 'Learning Center' type·

Storage

'Import Reference Data' dialog for a 'Reference Data·

Library' type Storage

'Save As' dialog for a 'Source Code Library' type Storage·

'Learning Center Library', 'Reference Data Library' and
'Source Code Library' type Storages do not contain any
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Assets. Therefore, clicking on the:

'Import' button in the Registry Browser will import and·

install a Library file from the Storage

'Delete' button in the Registry Browser will delete all·

Library files in the Storage

Notes

If the Storage is password-protected, the system prompts·

you to enter a password before you begin importing a file
from the Storage; in this case you require either a
'Read-Only' or a 'Complete Access' password
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Compare an Asset to the Model

If you are developing a Package in your model against a
standard structure, or using common elements from the
Reusable Asset Service, you can check that your model
conforms to the standard or incorporates any changes to the
common elements, by performing a comparison between the
asset Package and your model.

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then right-click on the Package and
choose 'Compare with Package in Model'.

Ribbon Publish > Model Exchange > Reusable
Assets

Compare Asset Package and Model

A prompt displays for you to confirm the comparison. Click
on the Yes button.

The Baseline Comparison view displays, showing the
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element hierarchy in which differences have been detected
between the Package in the model and the asset Package in
the Registry (as the Baseline).

All facilities of the standard Baseline Comparison are
available, including the ability to 'roll back' differences so
that the element or Package in the model matches the
Registry.

Notes

If the Storage is password-protected, the system prompts·

you to enter a password before you begin comparing
information in the Storage and in the model; in this case
you require either a Read-Only or a Complete Access
password
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Import an Asset into the Model

The Reusable Asset Service provides common or standard
information and data that you can import into your local
model. The unit that you import is a selected version of the
Asset Package; you can also, optionally, import:

Other Packages on which the selected Asset Package·

depends, and/or

Available Technologies that support full use of the model·

structures in the Asset Package

The Asset Package (with, if selected, any needed Packages)
is imported into the currently-selected model Package in the
Project Browser, unless the Asset Package already exists
anywhere else in the Project. In this case, the system locates
the existing Package and overwrites it with the imported
Asset Package.

Access

Open the Reusable Asset Service window, using one of the
methods outlined here.

On the 'Registry Browser' tab, either;

Select an Asset Package and click on the Import button, or·

Right-click on an Asset Package and select the 'Import·

from Registry' option

Publish > Model Exchange > Reusable
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Ribbon Assets

Import Asset Package

Before selecting an Asset Package to import into your
model, click on the 'Version' drop-down arrow and select
the appropriate version of the Package to import.

When you select to import an Asset Package into your
model, a short menu displays from which you select to
import:

The Package alone or·

The Package with the related Packages on which it is·

dependent

A prompt then displays for you to confirm the import, and to
warn you that if the Package already exists in the model, it
will be overwritten by the import. Click on the Yes button to
continue, or the No button to cancel the import.

If the Storage is password protected, after you confirm the
import a prompt displays for your 'Read-Only' or
'Complete-Access' password; enter this and click on the OK
button.

The 'Import from Registry' dialog displays, followed by
confirmation that the import of the Package or Packages is
complete. Click on the OK button.
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If the Package depends on Technologies

If the Technologies associated with an Asset Package are
not already on your system and/or enabled in your model,
during the display of the 'Import from Registry' dialog the
'Import Technology From Registry' dialog also displays.
Process this dialog as described.

Option Detail

Name Displays the name of the Technology as
recorded in the Registry.
The checkbox against each name is
selected by default. If you want to import
one technology but not another, deselect
the checkbox of the technology to ignore.

Version Displays the required version of the
Technology to support the Asset Package,
available through the Registry.

Registry
Status

Indicates whether the Technology file is:
Available - the Technology file is·

registered in the current Storage, or
Unavailable - for one of these reasons:·

    - The Technology file is not
registered in the Storage, or
    - The Technology is a built-in
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Technology and is already integrated
with your system, or must
       be purchased under license, or
    - The Technology is available from a
URL and can be downloaded from that
URL

Model Status Indicates whether the Technology is
already in your model and disabled.
(If the Technology is in your model and
enabled, there is no need to import it and
it is not listed in the dialog.)

OK Click on this button to import and/or
enable the selected Technology or
Technologies in your system.
A status message displays to indicate that
the Package and Technologies have been
imported and the Technologies enabled.
You might have to restart Enterprise
Architect for the Technologies to take full
effect.
Click on the OK button to clear the
message.
In the Project Browser, the Package has
been added to the model with (if selected)
the Packages on which it is dependent.
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Import Library

The Reusable Asset Service provides the ability to store
Library files that you can import into your local model. The
type of Library file available in a Storage will depend on the
Storage type. When you import and install a Library from a:

Learning Center Library storage, it will be available for·

use on all Enterprise Architect models in this system

Reference Data Library storage, it will be installed into·

the current model

Source Code Library storage, it will be saved in the·

specified location in the file system

Library from a Learning Center Library storage.
Either:

Click on the Import button to open the 'Download·

Libraries' dialog, showing all the Library files in this
storage as selected, or

Right-click on a Library file in the 'Storage Files' tab and·

select the 'Import from Registry' option to open the
'Download Libraries' dialog showing that specific Library
file as selected

Library from a Reference Data Library storage. Either:

Click on the Import button to open the 'Import Reference·

Data' dialog, showing all the reference data in that Library
file as selected, or
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Right-click on a Library file in the 'Storage Files' tab and·

select the 'Import from Registry' option to open the
'Import Reference Data' dialog, showing all the reference
data in that Library file as selected

Library from a Source Code Library storage. Either:

Click on the Import button to open the 'Save As' dialog·

and select a location in the file system to save the
imported Library to, or

Right-click on a Library file in the 'Storage Files' tab and·

select the 'Import from Registry' option to open the 'Save
As' dialog, then select a location in the file system to save
the imported Library to

If the Storage is password protected, a prompt for you to
enter your 'Read-Only or 'Complete-Access' password
displays. Enter the password and click on the OK button.

Notes

You can also import Technologies separately from the·

Package that is dependent on them, using the 'Technology'
tab of the Reusable Asset Service view

'Learning Center Library', 'Reference Data Library' and·

'Source Code Library' type Storages do not contain any
Asset Packages
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Set Up Registry Password

As a System Administrator, you can password-protect the
Registry server to prevent users from modifying the
Registry; that is, restrict users from creating, modifying and
deleting Storages. Once you have set password protection,
only those users who have a valid Administrator password
can modify the Registry.

You can also change the password at regular intervals, for
added security.

Access

Ribbon Publish > Model Exchange > Reusable
Assets : Set Administrator Password

Set the Administrator Password

Option Detail

Enter old
password

Disabled if no password exists for the
Registry server.
If the server has a current password, type
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it in to this field.

New
password

Type in the new Administrator password.

Retype new Type in the new Administrator password,
for confirmation.

OK Click on this button to set the password
and close the dialog.

Cancel Click on this button to abort the changes
and close the dialog.

Notes

To remove password protection from the Registry server,·

complete the 'Enter old password' field but leave the 'New
password' and 'Retype new' fields blank

If a Storage has a Complete Access password, then you·

can use either the Administrator password or the
Complete Access password to modify the Storage
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Set Up the Asset Service

The process of setting up assets and files in the Reusable
Asset Service has a number of simple stages, typically:

Identify the Registry·

Create the Storages, including copying an existing Storage·

as a template for a new one

Set password protection on each Storage·

Register the Asset Packages and Storage Files, and update·

them as necessary

Access

Ribbon Publish > Model Exchange > Reusable
Assets

Identify Registry

The Registry server holds the Storages of the Reusable
Asset Service. It will have been previously configured by
your system administrator, to be accessed through a Cloud
Connection. Your system administrator will provide the
connection details for you to use.
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In the Reusable Asset Service view, click on the  button to
the right of the 'Registry' field. The 'Cloud Connection'
dialog displays.

Using the information provided by your administrator, type
in the server name, URL and the name of the model hosting
the registry data. If advised by your administrator, also type
in the user name and password for the server.

Click on the OK button; the 'Registry' field now shows the
server name.

Create Storages

A Storage is a container within the Registry, holding related
assets and files. There can be several Storages in the
Registry, to support the different areas of work or purposes
that your organization might define.

Ste
p

Action

1 Click on the  icon in the Reusable Asset Service
toolbar.

2 If necessary, enter the Administration password that
enables update access to the Registry. Click on the
OK button.
The 'New Storage' dialog displays.
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3 In the 'Name' field, type a name that indicates the
purpose or content of the Storage.

4 In the 'Type' field, select:
'Draft' if you intend to make significant changes to·

the content of the Storage, such as populating it
with assets and/or files; you can overwrite existing
Packages or files in a Draft Storage
'Complete' if the Storage is ready for use; you·

cannot overwrite any Packages or files in a
Complete Storage, although you can delete
Packages and files and add new ones
'Learning Center Library' if the Storage should·

contain only Enterprise Architect Learning Center
Library files - this Storage type can be populated
only with Library files and not with Asset
Packages; you can overwrite existing Library files
in a Learning Center Library storage
'Reference Data Library' if the Storage should·

contain only Enterprise Architect Reference Data
Library files - this Storage type can be populated
only with Library files and not with Asset
Packages; you can overwrite existing Library files
in a Reference Data Library storage
'Source Code Library' if the Storage should·

contain only Source Code Library files - this
Storage type can be populated only with Library
files and not with Asset Packages; you can
overwrite existing Library files in a Source Code
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Library storage
You can modify a Storage at a later time, and change
this Type setting.

5 If you want to set Storage Access Passwords on this
Storage, click on the checkbox against one or both
password types, and provide and confirm the
'Complete Access' and/or 'Read-Only Access'
passwords.

6 Click on the OK button.
A prompt displays for you to confirm the creation of
the Storage, with the type of access you have set on
the Storage.

7 Click on the Yes button.
A confirmation message displays; click on the OK
button.
The name of the new Storage displays in the
'Storage' field.

Password Protection

The Registry can be protected by a Registry password, so
that only the Administrator can create and modify Storages.
If no Registry password is set, a second level of password
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protection can be applied.

The owner of a Storage can apply password protection to
restrict users in processing and modifying the contents of
the Storage either intentionally or unintentionally. Password
protection can be applied at two levels:

Complete Access - users enter their password and can·

modify or delete the Storage itself, and within the Storage
can register, update and delete Packages and files in the
Registry, view Packages and import assets into their
models

Read-Only Access - users enter their password and can·

import assets into their models

You set the 'Complete Access' password before you set the
'Read-Only Access' password.

If password protection is set and a user has no password,
they can only view the contents of the Storage. If no
password protection is set, all users can freely access and
modify the Storage and its contents.

You set the passwords on each Storage as you create that
Storage, using the 'New Storage' dialog. Once the Storage
has been created, you can change or remove an existing
password using the 'Modify Storage Access' dialog, but you
cannot add a password.

If a Storage is password protected, the system displays a
prompt for the password when the user begins to:

Change or delete a password on the Storage·

Copy the Storage to create a new Storage·

Delete the Storage·
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Register a Package or file in the Storage·

Import a Package, file or Technology from the Storage·

Delete a Package or file from the Storage·

Compare an Asset Package with a Package in the model·

The system displays the password prompt when any of those
operations is performed for the first time after the user:

Connects to a Registry·

Reloads the Registry Browser·

Selects a Storage in the 'Storage' field in the Reusable·

Asset Services view

If the user enters the correct password and therefore
establishes their credentials, the system does not display a
password prompt again for any valid operation that user
performs until they:

Select a different Storage in the 'Storage' field in the·

Reusable Asset Services view or

Reload the Registry Browser from the Registry·

Register Assets and Files

Whilst a Storage exists and, if the Storage is under password
protection, you have the 'Complete Access' password, you
can register Packages from a model and files from your
system as assets in that Storage. If the Asset Package was
developed using one or more MDG Technologies, you can
optionally register those technologies in the Storage as well.
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See the Register New Assets Help topic.

Copy Storages

It is possible to copy a Storage as the basis for creating
another Storage, for example if you want to use the same set
of assets in the context of larger set for a different
department, work area or development phase.

Note: It is not possible to change the Type of a 'Learning
Center Library', 'Reference Data Library' or 'Source Code
Library' type Storage, nor is it possible to change a 'Draft' or
'Complete' type Storage into a 'Learning Center Library',
'Reference Data Library' or 'Source Code Library' type
Storage.

Ste
p

Action

1 In the 'Storage' field, select the Storage to be copied.

2 Click on the  icon in the Reusable Asset Service
toolbar.

3 If necessary, enter the Administrator password or
your 'Complete Access' password and click on the
OK button.
The 'Save Storage As' dialog displays.
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4 In the 'Name' field, type a name that indicates the
purpose or content of the new Storage.

5 In the Type field, select:
'Draft' if you intend to make significant changes to·

the content of the Storage, such as populating it
with assets and/or files; you can overwrite existing
Packages or files in a 'Draft' Storage
'Complete' if the Storage is ready for use; you·

cannot overwrite any Packages or files in a
'Complete' Storage, although you can delete
Packages and files and add new ones

You can modify a Storage at a later time, and change
this setting.

6 If you want to set Storage Access Passwords on this
Storage, click on the checkbox against one or both
password types, and provide and confirm the
'Complete Access' and/or 'Read-Only Access'
passwords.

7 Click on the OK button.
A prompt displays for you to confirm the creation of
the Storage, with the type of access you have set on
the Storage.

8 Click on the Yes button.
A confirmation message displays; click on the OK
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button.
The name of the new Storage displays in the
'Storage' field.

Change Storage Details

After you have set up a Storage, you can update it at a later
stage to:

Change the status or Type·

Change one or both of the existing 'Complete Access' and·

'Read-Only' Access passwords

Delete one or both of the passwords·

It is not possible to add a password where one has not
previously been set.

You cannot change or delete passwords unless you have the
'Complete Access' password yourself.

Note: It is not possible to change the Type of a 'Learning
Center Library', 'Reference Data Library' or 'Source Code
Library' type Storage, nor is it possible to change a 'Draft' or
'Complete' type Storage into a 'Learning Center Library',
'Reference Data Library' or 'Source Code Library' type
Storage

Ste
p

Action
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1 On the Reusable Asset Service view, in the 'Storage'
field click on the drop-down arrow and select the
Storage to update.

2 Click on the  icon in the Reusable Asset Service
view toolbar.

3 If necessary, enter the Administrator password or
your 'Complete Access' password and click on the
OK button.
The 'Modify Storage Access' dialog displays.

4 In the 'Type' field, click on the drop-down arrow and
select:

'Complete' if the Storage has now been set up and·

is ready for use; you cannot overwrite any
Packages or files in the Storage, although you can
delete them and add new Packages and files
'Draft' if you intend to make significant changes to·

the content of the Storage; you can overwrite
existing Packages or files

5 The 'Action' field defaults to 'None', to indicate no
changes to the passwords. If you are changing or
deleting the passwords, click on the drop-down field
and select:

'Change Password' to enable both password type·

fields ready for editing
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'Remove Storage Access Password' to simply·

delete the 'Complete Access' password altogether
'Remove Read-Only Access Password' to simply·

delete the 'Read-Only Access' password altogether

6 If you have selected the 'Change Password' option,
select the appropriate password checkbox or both
checkboxes, and type in the new password(s).
Re-type the password(s) in the 'Confirm Password'
field(s).

7 Click on the OK button to save your changes and
close the 'Modify Storage Access' dialog.

Delete a Storage

If a Storage has been created by mistake, or is no longer
necessary in the Registry, you can delete it and its entire
contents of Package and files in one action.

Ste
p

Action

1 On the Reusable Asset Service view, in the 'Storage'
field click on the drop-down arrow and select the
Storage to delete.

(c) Sparx Systems 2018 Page  668 of 1073



User Guide - Model Repository 21 December, 2018

2 Click on the  icon in the Reusable Asset Service
view toolbar.
A prompt displays to confirm the deletion.

3 Click on the Yes button.
If necessary, enter the Adminstrator password or
your 'Complete Access' password and click on the
OK button.
A message displays to confirm that the Storage has
been deleted.

4 Click on the OK button to clear the message.
The Storage and its contents are cleared from the
Registry.

(c) Sparx Systems 2018 Page  669 of 1073



User Guide - Model Repository 21 December, 2018

Register New Assets

After you have set up your 'Draft' or 'Complete' Storages in
the Reusable Asset Service Registry, you can register assets
in them. The assets include:

Packages of modeling structures, held in the Project·

Browser of your model; these Packages can include
diagrams and subordinate Packages

Any Packages containing model components on which the·

primary Asset Packages depend

Any MDG Technologies that you used in developing the·

Asset Packages, and that you decide to register with the
Packages

Any text or graphics files you want to make available to·

your corporate community; these files are compressed
before being added to the Storage

You register the first three items together. You can register
files in the Storage during that same process, or separately.

You can register separate versions of the same Package. If
you register a Package that already exists in the Registry
under the same version reference, and the Storage has 'Draft'
status, the existing version is overwritten. If you register the
same Package with a different version number or reference,
it is registered separately and users can access both versions
of the Package from the Registry.

'Learning Center Library', 'Reference Data Library' and
'Source Code Library' type Storages cannot contain
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Packages of modeling structures - they can contain only
Library files, which will appear in the 'Storage Files' tab. A
Library file is :

a zipped file containing Enterprise Architect-specific·

Learning Center files for the 'Learning Center Library'
Storage type

an XML file containing Enterprise Architect-specific·

reference data XML files for the 'Reference Data Library'
Storage type

a zipped file containing source code files for the 'Source·

Code Library' Storage type

Once registered, the Library file will be available in the
'Storage Files' tab of the Reusable Asset Service view.

Access

Ribbon Publish > Model Exchange > Reusable
Assets

Register Package as Asset

Ste
p

Action
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1 In the Reusable Asset Service view, select the
appropriate Registry and Storage.

2 In the Project Browser for your model, click on the
Package to register as an Asset.

3 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.

4 The 'Register Package(s)' dialog displays, showing
the:

Name and type of the Storage·

Name and status of the selected Package (the·

status at this point being 'Pending')
The name, GUID and current version of the·

selected Package; you can type a different version
number or text string if necessary

If there is a version of the Package already in the
Registry, and the Storage has 'Draft' status, you can
either:

Overwrite the registered Package with an update·

of that version, or
Add the updated Package as another Asset under a·

different version number; in this case, the
'Packages to Register' panel shows the version
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number, registration date and comments on the
latest version of the Asset Package

You cannot overwrite an existing Package if the
Storage has 'Complete' status. In this case, add the
Package under a different version number.

5 In the 'Comments' field type a short comment and, in
the 'Notes' field, a longer explanation of the Package
being registered.

6 Click on the Check Dependency button and resolve
the dependencies of the Package.
At the end of this process, the selected Package has
the status 'Ready' (for registration).

7 You can, at this point, also register files as assets of
the Storage. See Step 4 of the next table, Register
File as Asset.
However, if you prefer you can follow the complete
procedure separate from registering Packages.

8 Click on the Register button.
A prompt displays to confirm registering the
Package. Click on the Yes button.
If the same version of the selected Package already
exists in the Registry (if the Storage is a 'Draft') a
prompt displays to confirm overwriting it. Click on
the Yes button.
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A progress dialog displays. If the Package does not
have any associated MDG Technologies, a message
displays confirming that Package registration is
complete. Go to step 10.

9 If the Package has one or more associated MDG
Technologies, the 'Register MDG Technology'
dialog displays, listing the Technologies and
prompting you to register (OK) or ignore all of them.
If you want to register some Technologies but not
others, click on those you do not want to register,
and click on the Remove button for each one in turn.
Click on the OK button or Ignore button.
A message displays confirming that Package and
Technology registration is complete.
Notes:

If a remote Technology is removed from·

registration (that is, the Technology is not
registered along with the Package), the registered
Package will refer to this Technology at its URL
When importing the Package from Registry, the
system will import this remote Technology from
its URL (if the remote Technology is not already
available in the importing model)
If a remote Technology is registered with the·

Package being registered, the system will store a
copy of the Technology file in the Registry
When importing the Package from Registry, the
system will import the Technology stored in the
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Registry and will not import it from its URL (if the
remote Technology is not already available in the
importing model)

10 Click on the OK button.
The 'Registry Browser' tab is updated with the
newly-added details of the Package and any
dependent Packages. You can review the details on
the tabs on the lower half of the Reusable Asset
Service view.

Register File as Asset

Ste
p

Action

1 In the Reusable Asset Service view, select the
appropriate Registry and Storage.

2 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password-protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.
The 'Register Package(s)' dialog displays.

(c) Sparx Systems 2018 Page  675 of 1073



User Guide - Model Repository 21 December, 2018

3 If any Packages are listed in the 'Packages to
Register' panel, and you do not want to re-register
them, clear the checkbox against each Package
name.

4 Click on the Additional Files button.
The 'Select Additional Files' dialog displays.

5 Click on the Add button.
A 'Select' screen displays, on which you browse for
and click on the required file. You can only select
one file at a time on this browser.

6 Click on the Open button.
The 'Add Comment' dialog displays.

7 Type a brief comment on the nature or purpose of
the file in the Registry, and click on the OK button.
Focus returns to the 'Select Additional Files' dialog,
which now lists the selected file.

8 Repeat steps 5-7 for each Asset file to register.
When you have finished, click on the OK button.
The 'Register Package(s)' dialog redisplays.

9 Click on the Register button.
A prompt displays to confirm registration of the
files.
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10 Click on the Yes button.
A 'Progress' dialog displays while the files are
registered, followed by a message confirming that
the (Package and) File registration is complete.

11 Click on the OK button to clear the message, and to
return focus to the Reusable Asset Service view.
You can review the files on the 'Storage Files' tab in
the lower half of the view.

Register Learning Center Library

Ste
p

Action

1 In the Reusable Asset Service view, select the
appropriate Registry and 'Learning Center Library'
Storage.

2 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.
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3 The 'Register Learning Center Library' dialog
displays.
Click on the  button next to the 'File' field and
select the Library file.
Type in a short comment on the Library being
registered, in the 'Comments' field.

4 Click on the Register button.
A prompt displays to confirm registering the Library
file. Click on the Yes button.
If the same Library file already exists in the
Registry, a prompt displays to confirm overwriting
it. Click on the Yes button.
A progress dialog displays followed by a message
confirming that Library registration is complete.

5 Click on the OK button.
The 'Storage Files' tab in the lower half of the
Reusable Asset Server view is updated with the
newly-added Library file.

Register Reference Data Library

Ste
p

Action
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1 In the Reusable Asset Service view, select the
appropriate Registry and 'Reference Data Library'
Storage.

2 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.

3 The 'Register Reference Data Library' dialog
displays.
Press the  button next to the 'File' field and select :

From File System – to select an existing Reference·

Data XML file from the file system
From Model – to open the 'Export Reference Data'·

dialog for selecting categories that will be
registered as the Reference Data Library once the
Register button is clicked and a name is entered in
the 'Enter Reference Data File Name 'dialog

Type in a short comment for the Library being
registered in the 'Comments' field.

4 Click on the Register button.
A prompt displays to confirm registering the Library
file. Click on the Yes button.
If the same Library file already exists in the
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Registry, a prompt displays to confirm overwriting
it. Click on the Yes button.
A progress dialog displays followed by a message
confirming that Library registration is complete.

5 Click on the OK button.
The 'Storage Files' tab in the lower half of the
Reusable Asset Server view is updated with the
newly-added Library file.

Register Source Code Library

Ste
p

Action

1 In the Reusable Asset Service view, select the
appropriate Registry and 'Source Code Library'
Storage.

2 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.
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3 The 'Register Source Code Library' dialog displays.
Select the Library file by pressing the  button next
to the 'File' field.
Type in a short comment for the Library being
registered, in the 'Comments' field.

4 Click on the Register button.
A prompt displays to confirm registering the Library
file. Click on the Yes button.
If the same Library file already exists in the Registry
a prompt displays to confirm overwriting it. Click on
the Yes button.
A progress dialog displays, followed by a message
confirming that Library registration is complete.

5 Click on the OK button.
The 'Storage Files' tab in the lower half of the
Reusable Asset Server view is updated with the
newly-added Library file.
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Check Package Dependencies

As you register a Package in the Reusable Asset Service, the
system provides a check on whether that Package is
dependent on any external content; that is, whether it links
to any modeling component held in Packages other than its
own child Packages. You can perform three types of
dependency check:

Complete, which will consider Package A to be dependent·

on Package B if Package A contains any element,
attribute, operation, operation parameter, diagram or
connector (or their Tagged Values) that references
elements in Package B

Normative, which is the same as a Complete Dependency·

Check except that it will not treat as a dependency for
Package A any element from Package B that is added as a
link on a diagram in Package A

Package Dependency/Import, where only those Packages·

that are the target of a Dependency/Package Import
connector from Package A will be treated as dependent
Packages for Package A

You perform this dependency check as an integral part of
the Asset Registration process (specifically, at step 6 of the
Register Package as Asset process). The check
automatically identifies, firstly, the Packages directly
needed by the Asset Package, and then any Packages needed
by those initial Packages, and so on until the needed
Packages are not dependent on any other.
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In practice, such dependency chains are likely to be quite
short. If you know that the original Asset Package is
dependent on two other Packages, one of which is
subordinate to the other, you can simplify the process
further by selecting the Parent or Ancestor Package first and
thus avoiding the extra steps of selecting the two Packages
separately.

Access

Open the Reusable Asset Service window, using one of the
methods outlined here.

In the Reusable Asset Service window, click on the·

'Register' button

Ribbon Publish > Model Exchange > Reusable
Assets

Check Package Dependencies

Ste
p

Action

1 Select the appropriate Registry, Storage and version
of the model Package to register, and provide any
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appropriate comments or notes.

2 Click on the Check Dependency button.
If there are no Packages on which the Asset Package
depends, the system sets that Package to 'Ready'. Go
to step 6.
The 'Select Needed Package: <dependent package
name>' dialog displays, showing the model hierarchy
containing the Packages needed by the Asset
Package. Each needed Package has a selected
checkbox against it.
If you know that a needed Package is a child or
grandchild of another needed Package, click on the
checkbox next to the 'higher' Package name so that
the child is validated as part of the parent. In this
example, if the Asset Package has dependencies on
both External factors and Location, click on the
'External factors' checkbox to register both
dependencies as External factors.

If the needed Package is already registered in the
Registry, it is indicated by a globe icon:

In this case, select the 'Use latest version of selected
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package in Registry (if available)' checkbox to link
to the registered version. For such Packages, no
further dependency check is performed and, on the
'Register Package(s)' dialog, the Package's Status is
set to 'Ready'.

3 Click on the OK button.
The 'Register Package(s)' dialog updates to show the
initial 'Asset Package status' as 'Ready', and to list
the needed Packages each with the status of
'Pending'.

4 Click on the Check Dependency button again.
If there are no Packages on which the needed
Package depends, the system sets that Package to
'Ready' and sets the focus on the next Pending
Package. If there are no more Pending Packages, go
to step 6.
If the needed Package is dependent on other
Packages, the 'Select Needed Package: <dependent
package name>' dialog displays again, showing the
model hierarchy containing those Packages, each
with a selected checkbox next to it. As in step 2, you
can select a 'higher' Package if appropriate.

5 Click on the OK button.
The 'Register Package(s)' dialog updates to show the
first needed Package status as 'Ready', and to list any
further needed Packages with the status of 'Pending.
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6 If there are further needed Packages in the chain,
repeat step 4. The system automatically identifies
them and lists them for validation as in step 5.
Otherwise the system sets the final needed Package
status to Ready and you can continue to register files
and MDG Technologies.

Notes

A Package with status Pending cannot be registered; only·

Packages with status Ready can be registered

If you are certain that there are no parent-child·

relationships between the needed Packages, you can work
through these steps quickly by just clicking on the Check
Dependency and OK buttons alternately until all Packages
in the Package to Register list have the status Ready

The system does not allow you to register an Asset·

Package that has dependencies on its own parent or
grandparent Package; such dependencies would cause the
Asset Package to be registered twice - by itself and as part
of the parent Package - creating the risk of differences
developing between the two instances
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Update an Asset

Over time, you might need to revise the contents of the
Registry. Such updates can include:

Registering additional Asset Packages and files·

Registering a new version of an Asset Package·

Registering a new edition of a Storage file·

Registering new Libraries·

Deleting an Asset Package·

Deleting a Storage file·

Deleting a Library·

Changing the details of a Storage·

Deleting an entire Storage and the assets and files within·

it

Access

Ribbon Publish > Model Exchange > Reusable
Assets > Registry Browser

Update Tasks
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Task Detail

Register new
Asset
Packages and
Storage files

You can add further Asset Packages and
files to a Storage at any time.

Register a
new version
of an Asset
Package

You register a new version of an Asset
Package as if it were a new Asset. In the
'Current Version' field on the 'Register
Package(s)' dialog, you type a different
number or reference to that assigned to
the currently-registered Asset.
You can overwrite an existing Asset
Package under the same version number
only if the Storage has 'Draft' status. If
the Storage has 'Complete' status, you
cannot overwrite the existing Asset
Package under the same version number.
To replace the current version, you must
delete the Asset from the Storage and
register the Package again.

Delete Asset
Package from
Storage

Click on the Package name in the
'Registry Browser' tab and either:

Click on the Delete button or·

Right-click and select the 'Delete From·

Registry' menu option
In either case a short submenu displays,
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prompting you to select to delete:
The Asset Package only, or·

The Asset Package and the Packages·

on which it is directly or indirectly
dependant

When you select the appropriate option, a
prompt displays for you to confirm the
deletion.
Click on the Yes button. A message
displays to confirm that the Package has
been deleted from the Registry, and the
name of the Package is removed from the
'Registry Browser' tab.
If the Storage is password-protected, the
system prompts you to enter a 'Complete
Access' password before it begins
deleting the Package(s).
If any of the registered Packages depend
on the Package being deleted, the system
displays the names of these Packages and
prompts for confirmation before deleting
each Package.

Register a
new version
of a Storage
File

You register a new version of a Storage
file as if it were a new file under a
different file name.
You can overwrite an existing file under
the same file name only if the Storage has
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'Draft' status. If the Storage has
'Complete' status, you cannot overwrite
the existing file. To replace the current
version, you must delete the file from the
Storage and register the file again.

Delete
Storage Files
from Storage

On the 'Storage Files' tab, right-click on
the file name and select the 'Delete From
Registry' option. A prompt displays for
you to confirm the deletion.
Click on the Yes button. A status
message confirms the deletion, the file is
removed from the Registry and the file
name is removed from the 'Storage Files'
tab.
If the Storage is password-protected, the
system prompts you to enter a 'Complete
Access' password before it begins
deleting the file.

Register a
new Library
File

You can add further Library files to a
Storage at any time.
When you register a Library file, the file
name and location will be used as the
unique identifier for the file. You can
overwrite this Library file in the Registry
by registering a file with the same name
and from the same file system location.
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Delete
Library Files
from Storage

To delete all Library files in Storage,
click on the Delete button in the 'Registry
Browser' tab.
To delete a particular Library file,
right-click on the Library file name in the
'Storage Files' tab and select the 'Delete
From Registry' option.
A prompt displays for you to confirm the
deletion. Click on the Yes button. A
status message confirms the deletion, the
Library file(s) is removed from the
Registry and the Library file(s) name is
removed from the 'Storage Files' tab.
If the Storage is password-protected, the
system prompts you to enter a 'Complete
Access' password before it begins
deleting the Library file.

Change
Storage
Details

This task is as documented for setting up
the Registry. Note that whilst you can
copy a Storage as a new Storage, you
cannot transfer assets directly between
existing Storages.

Delete a
Storage and
its contents

This task is as documented for setting up
the Registry. Note that whilst you can
copy a Storage as a new Storage, you
cannot transfer assets directly between
existing Storages.
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Refresh
Registry
Browser

If there is a possibility that another user
has updated the Registry while you have
had it open, click on the  icon in the
Reusable Asset Service toolbar to refresh
your display from the latest updates to the
Registry.
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Integrate Data from External Providers

The Pro Cloud Server helps you to integrate data from
external providers into an Enterprise Architect Cloud model.
A variety of third-party providers can be connected to,
including:

 Application Lifecycle Management (formerly HP·

Quality Center)

 Jazz (Rational DOORS Next Generation)·

 Jira and  Confluence·

 Team Foundation Server·

 Wrike·

 ServiceNow·

 Autodesk·

 Bugzilla·

 SharePoint·

 Dropbox and·

 Other Enterprise Architect models·

See the Install and Configure Help topic for information on
how to configure each provider.

All integrations offer support for linking objects and
elements from the external system into an Enterprise
Architect client. The Integration window supports browsing
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the external provider's items and retrieving lists of elements
and objects based on the provider's queries. Capabilities
include:

Link an Enterprise Architect element to an external object·

View external element properties·

View and in some cases add to, external object·

discussions

Export links to WebEA URL's that correspond to the·

current model

Open external items in a web browser·

Import elements·

Export elements·

From Enterprise Architect Release 14.1 it is possible to link
a non-Cloud model to Integration Plugins configured on a
Pro Cloud Server.

See the Cloud Page Help topic for configuration options.

Access

Ribbon Specialize > Tools > Integration
To view a list of all elements that are
linked to external items:
Specialize > Tools > Integration > Show
All Linked Items
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Context
Menu

In a diagram or the Project Browser, for
elements that are already linked to an
external item:

Right-click on element > Specialize >·

External Properties

Features

Feature Description

Pro Cloud
Server
Configuratio
n

Each external provider needs to be
configured on the Pro Cloud Server to
enable connection. Multiple
configurations can be made for each
provider (such as connecting to two
separate Jira servers).

Authorization If the Integration Provider requires
authorization the user will be prompted to
enter their credentials. If the provider
supports it, a new internet browser
window will open and prompt the user to
log in to the Integration Provider and
allow Enterprise Architect access to its
resources. Alternatively, a simple dialog
will pop up asking for the user's
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credentials, with the option to securely
store these in the current model. If stored
in the model the credentials will only be
used for the current user.

Navigate
External
Provider

Find external items to link by navigating
the external provider.

External Item
Details

Select an external item from the list to see
its properties, notes and discussions.

Link External
Items

External items can be linked to Enterprise
Architect as a generic
«ExternalReference» stereotype or as
another element type.

Add WebEA
Link

Hyperlinks to WebEA can be added to
the external item so that a user can
quickly open the WebEA element from
the external source.
Right-click on a local linked element in
the list and select 'Add WebEA Hyperlink
to External Object'. This will update the
external item with a link to the WebEA
element that is linked to it. Note that not
all provider types have a 'link'
mechanism. Where none exists, some
providers might allow adding the link as
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a comment on the item.
Ensure that the model has a valid WebEA
address set in the model options.

Configuratio
n

Each integration provider comes with a
set of default mapping values which
determines what type of local element is
created in Enterprise Architect, as well as
which fields are copied to the new
element. These mappings are
configurable via the 'Configure' option on
the Integration window toolbar menu.
Users must have the 'Configure External
Data Sources' permission to access this
functionality.

Troubleshoot
ing

The System Output window will show·

any errors while attempting to retrieve
data from the external providers
The Pro Cloud Server outputs log files·

for each external provider

Notes

'Integration' requires a Pro Cloud Server and is only·

available to Cloud models
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'Integration' is currently provided with the Corporate,·

Unified and Ultimate editions of Enterprise Architect

If you select two or more elements at the same time, you·

can perform an operation on all of the selected elements at
once

For WebEA links to work a valid URL must be set for the·

WebEA address (see the Cloud Page Help topic)
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Navigate External Data

Each integration provider can be navigated through to show
lists of external items that can be linked to Enterprise
Architect. Each provider might provide a slightly different
mechanism for navigation based on how it stores its data.
Some provide a simple folder hierarchy, while others
provide for user defined filters. See 'What data is returned
by Integration Plugins' on Install and Configure for details
of each provider.

Navigate the Hierarchy

Begin navigation by selecting the provider type from the
first drop-down menu.
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Next, each provider type offers a slightly different
navigation system; for example, Dropbox allows for
browsing the folder structure, whilst Jira give a list of
projects followed by a list of user queries.

Item List

At each navigation level, if available, a list of items
corresponding to the navigation level will populate the
left-hand panel.

Any local Enterprise Architect elements that are linked to
the external item will be shown as a child of the external
item.

All Items Linked to Model

At each navigation level there is an option to show all local
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Enterprise Architect elements that are linked to the selected
external data source. Select 'All Items Linked to Model' and
choose a recent time period (7, 30 or 90 days, or 'All') to
show.

Choose 'All Items Linked to Model' on the root navigation
level to see the linked items for all external providers.

This view is different to the regular list as it shows the local
Enterprise architect element on top, and the external linked
item as a child of the local element. All the same context
menu items are available in the view.

Show Items Linked to Current Context

In the integrations menu, select 'Items Linked to Current
Context' to show only the external items that are linked to
the currently selected local element. That is, select an item
in the Project Browser and see the external items that are
linked to it.

This view is the same as for 'All Items Linked to Model'.
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External Item Details

When an external item is selected in the list, the item's
details are retrieved and displayed.

Properties

Select an external item from the list to view its External
Properties. This window shows all available properties of
the external item, as defined by the external provider.
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Properties that will be used when creating a linked local
element are show in the top group 'Mapped Properties' while
all other properties are grouped in 'Other Properties'. The
property mapping can be configured in Configuration.

Notes

The external item's notes or description is shown below the
properties. Note that not all external providers have a notes
or description field.

Discussion

Select an external item from the list to view its External
Discussions. This window shows the discussions or
comments of the external item.

New discussions can be posted by typing into the top box
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and pressing 'Send'. The username used will be that is
authorized on the Integration Provider. If generic credentials
have been added to the server configuration then the local
model's user name will be added to the start of the comment
as well.

Show or hide the discussions by clicking the icon in the
top-right corner.

Note:

To post an external discussion the Integration Provider·

must be configured to allow this on the Pro Cloud Server
(allowed by default)

Not all external providers have discussions or comments·
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Linking Items

Create Linked Element in Enterprise
Architect

To create a new element in the Enterprise Architect model
linked to the external item:

Right-click on an external item in the list.·

Select Create Local Element·

Select either the default type (see Configuration) or·

«External Reference»

Select which Package the element will be created in·

Optionally add the new element to an open Diagram·

The local element will be filled in with the values defined in
the Field Mapping in Configuration.
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Once linked, the local element will show under the external
item:

Note: Select multiple items to create multiple elements at
the same time. All elements will be created with either the
default type or «ExternalReference»

Link an Existing Enterprise Architect Element

An existing element in Enterprise Architect can be linked to
an existing item in the external provider by dragging the
local element from the Project Browser and dropping it onto
the external item.

Create a Linked Item in the External Provider

Existing local elements in Enterprise Architect can be added
to the External Provider in this way:

Select the local Enterprise Architect element (in the1.
Project Browser).

Browse the external provider and select the required2.
destination location.

In the External Data Menu, select 'Create Linked Item'.3.
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Note:

To create a new external item, the Integration Provider·

must be configured to allow this on the Pro Cloud Server
(it is disallowed by default)

Not all providers allow for creation of new items·

Update Local Element ('Pull' changes)

If either the local element or external item have been
modified since the items were created or linked, an indicator
will be shown on top of the item's icon. Right-click on the
linked Enterprise Architect element and select the 'Pull -
Update Local Element with External Data' option.

Note: If the local element has been modified since the link
was created then its changes will be overwritten with the
external data.
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Update External Item ('Push' changes)

If either the local element or external item have been
modified since the items were created or linked, an indicator
will be shown on top of the item's icon. Right-click on the
Enterprise Architect element and select 'Push - Update
External Item with Local Data'.

Note:

If the external element has been modified since the link·

was created then its changes will be overwritten with the
local data.

To update an external item the Integration Provider must·

be configured to allow this on the Pro Cloud Server
(disallowed by default).
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Configuration

Each integration provider comes with a set of default
mapping values which determines what type of local
element is created in Enterprise Architect, as well as which
fields are copied to the new element. These mappings are
configurable for each client model.

Permission

Users must have the 'Configure External Data Sources'
permission to access this functionality.

Access

Integration
window
toolbar

Menu > Configure

Type Mapping

This defines the element type that will be created when
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'Create Local Element' is selected.

To create a new mapping, select the External Type, and use
the toolbox selector to select the local element type.

Field Mapping

This defines the element type that will be created when
'Create Local Element' is selected.

To create a new mapping, select the External Type, and use
the toolbox selector to select the local element type.
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Notes

Each mapping can be reset to default values by clicking·

'Reset to Defaults'.

If no type mapping is specified for a specific type, then·

the mapping for type 'Default' will be used.
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Change Management

As a repository is developed it will become the data store
for valuable organizational information assets, and it is
imperative that this data is protected and maintained.
Enterprise Architect has sophisticated tools to ensure the
information is protected, including full integration with all
the leading Version Control Systems, Baselines that are
snapshots of your model that can be taken at important
milestones, and Auditing that can track the finest changes to
a model. A Project Transfer function helps you to make
backups of models without involving information
technology personnel. There are also Model Validation and
Project Integrity Checkers to ensure the repository is
maintained with a clean bill of health, and a powerful role
based Security System to ensure users can collaborate easily.

Facilities

Facility Detail

Version
Control of
Packages

Enterprise Architect Model Version
Control helps you to:

Coordinate sharing of Packages·
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between users, with either read-only
access or update access, ensuring that
work on different areas of the model is
coordinated and synchronous rather
than conflicting
Save and retrieve a history of changes·

to Packages
To use Version Control in Enterprise
Architect, you require a third-party
source-code control application such as:

Subversion·

CVS·

MS Team Foundation Server (TFS), or·

Any other Version Control product that·

complies with the Microsoft Common
Source Code Control standard

Tracking
Changes

Enterprise Architect provides two
separate but complementary facilities for
tracking changes to data across the
project:

Auditing of model changes·

Baselining and differencing to capture·

and roll back changes

Project Data
Transfer

Enterprise Architect enables you to
transfer project data between project data
repositories either for:
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Sections of the project (XMI and CSV)·

or
The whole project, row by row, table·

by table (in the Corporate, Unified and
Ultimate editions of Enterprise
Architect)
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Version Control

Within Enterprise Architect, you can manage changes to and
revisions of your projects by placing individual model
Packages, view nodes or root nodes under Version Control.
This provides numerous key facilities, including:

Saving a history of changes to Packages·

The ability to retrieve previous revisions of Packages·

Propagating model updates between team members·

Coordinating the sharing of Packages between team·

members

You apply Version Control through a third-party
source-code control application that manages access to and
stores revisions of the controlled Packages. Once the
Version Control software has been installed and configured,
you must define a Version Control Configuration within
your project. You can then use Version Control to manage
changes to the Packages of your model.

Notes

Sparx Systems strongly urge you not to manipulate·

Version Controlled Package files outside of Enterprise
Architect; it is possible to leave the Package files in a
state that Enterprise Architect cannot recognize

Database replication should not be combined with·

Version Controlled Packages
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If the Packages under Version Control contain any·

alternative images and those images are subject to
frequent change, you can set the 'Export alternate images'
option on the 'Preferences' dialog to export the images to
the Version Control repository when you check in the
Packages; if the images are not subject to frequent change,
do not select this option and instead use 'Export/Import
Reference Data' to manage alternative images
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Introduction

Enterprise Architect's Version Control integration provides
several key facilities, including:

Saving a history of changes made to your model's·

Packages

Retrieving previous revisions of Packages·

Propagating model updates between team members·

Coordinating the sharing of Packages between team·

members

The steps involved in setting up a Version Control
environment and applying Version Control to an Enterprise
Architect project that is to be accessed by a number of users,
are summarized in the Help topic Applying Version Control 
in a Team Environment.

There are a number of factors to consider when setting up
and using Version Control in your model development.

Factors to consider

Factor Detail

System
Requirements
and
Configuratio

You apply Version Control through a
third-party source-code control
application that manages access to and
stores revisions of the controlled
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n Packages.
Typically the configuration consists of:

A server component that manages a·

Version Control repository, and
Client components on the workstations,·

that manage local working copies of
controlled files

Enterprise Architect uses the client
component to communicate with the
server. A Version Control client must be
installed on every machine where you run
Enterprise Architect and want to access
your Version Control system.

Version
Control
Usage

There are two main ways in which
projects can be deployed:

Centralized Shared Model·

Distributed Private Models·

Version control is employed in the same
way for both scenarios; however, when
using Private Model deployment you
have the additional facility of propagating
model updates throughout the team.
Version Control can also be used to share
standard Packages between different
projects.

Team Consider the process of setting up a
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Deployment Version Control environment and
applying Version Control to a project to
be accessed by a number of users.

Version
Control
Basics

Enterprise Architect enforces serialized
editing of Version Controlled Packages,
using the lock-modify-unlock mode of
operation.

Applying
Version
Control to
Models

Using Version Control consists of placing
individual model Packages under Version
Control, rather than Version Controlling
the project as a whole.

Version
Control and
Project
Reference
Data

To share changes in reference data
between users in a version-controlled
project deployed as multiple private
models, you periodically export the
reference data from the model where the
changes were made, and import it into the
other models maintained by the team.

Offline
Version
Control

You can prevent the system from
attempting to make any Version Control
connections by choosing to Work Offline
before loading a model.
If Enterprise Architect is unable to
connect a Version Control Configuration
for any reason, it displays warning
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messages to notify you and provides
'offline' Version Control functionality for
all Packages associated with the failed
connection.

Notes

Packages under Version Control are identified in the·

Project Browser by icons that indicate the current status of
the Package
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Version Control Usage

The Version Control facility can be used in many different
ways, although these roughly fall into one of four types of
use as discussed here.

Usage

Type Details

Single
Shared model

Users share a model stored in a central
project file or DBMS repository. In this
configuration you can view changes to
other users' Packages without explicitly
having to check them out, by simply
refreshing your view of the model.
Version control is used to:

Archive successive versions of your·

work to date
Maintain Package revision history·

Recover from unwanted changes or·

accidental deletions, through an 'undo'
facility
Regulate access to Packages·

Multiple
Private

One model is created by a single user
who configures it for Version Control.
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models The model file is then distributed to other
users, with each user storing their own
private copy of the model.
Version Control is used to:

Propagate changes to the model,·

throughout the team
Archive successive versions of your·

work to date
Maintain Package revision history·

Recover from unwanted changes or·

accidental deletions, through an 'undo'
facility
Regulate access to Packages·

Shared
Packages

Individual users create separate models
but share one or more Packages:

Users share Packages through Version·

Control

Standard
Packages

A company might have a standard set of
read-only Packages that are broadly
shared:

Individual users retrieve Packages with·

the Get Package menu option
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Version Control of Model Data

When applying Version Control in Enterprise Architect, you
place individual model Packages under Version Control, and
not the project as a whole.

All Enterprise Architect models are stored in databases -
even the .eap file is an MS Jet database. In simple terms, the
project file is a single entity of binary data. Being binary
data, the project file would require the use of the
lock-modify-unlock model of Version Control, which would
mean that only a single user at a time could work on any
given (Version Controlled) model. Therefore, it is not
practical to apply Version Control to the database (.eap file)
as a whole; this can also create problems for you in that:

Most Version Control systems mark their controlled files·

as read only, unless they are specifically checked-out to
you

The .eap file is an MS Jet database, and Enterprise·

Architect must be able to open this file for read/write
access when you load your model; if the model is
read-only, the system displays an error message and fails
to load the model

Version Controlling Packages in your Model

To overcome these limitations, Enterprise Architect exports
discrete units of the model - the Packages - as XMI Package
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files, and it is these XMI files, not the project file, that are
placed under Version Control. The XMI file format used by
Enterprise Architect dictates that they too be treated as
binary files - therefore it is not possible to merge the XMI
files either; however, by splitting the model into much
smaller parts, many users can work on separate parts of the
model simultaneously.

Version Controlled Nested Packages

Version Controlled nested Packages result in much smaller
XMI files being exported, as the parent Packages' XMI files
do not contain any content for the Version Controlled child
Packages.

Version Control of nested Packages, together with a model
structure of small individual Packages, provides greater
scope for multiple users to work concurrently, as individual
users are locking much smaller parts of the model.
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Version Control and Reference Data

Reference data is data that is used across a model or project;
it is not Package-specific. Version Control operates at
Package level, and therefore does not capture changes in
reference data. Where Version Control is used in a multiple
private model set up, changes in reference data are not
brought into the model when Packages are updated from
Version Control.

In a Shared Model environment, all users are accessing the
same project reference data. Changes in reference data can
be shared between users in a Version Controlled project
deployed as multiple private models, by periodically
exporting the reference data from the model where the
changes were made, and importing it into the other models
maintained by the team.

Reference data is exported and imported as an XMI file,
which contains whatever types of reference data you want to
transfer. You can place your project reference data under
Version Control by exporting the data as an XMI file and
apply Version Control to that file using your Version
Control software external to Enterprise Architect.
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Version Controlling Packages

Enterprise Architect implements Version Control of your
model by exporting Package data from the project database
to XMI Package files, which are placed under Version
Control in the source-code control application. The XMI file
format cannot be merged in the same way as ordinary text
files can be merged, which is why Enterprise Architect must
enforce serialized editing of Version Controlled Packages,
as discussed here.

The Lock-Modify-Unlock Solution

Many Version Control systems use a lock-modify-unlock
model to address the problem of different authors in a
shared source overwriting each other's work. In this model,
the Version Control repository allows only one person to
change a file at a time, and access is managed using locks.

Harry must lock a file before he can begin making changes
to it. If Harry has locked a file, Sally cannot also lock it, and
therefore cannot make any changes to that file. All she can
do is read the file, and wait for Harry to finish his changes
and release the lock. After Harry unlocks the file, Sally can
take her turn in locking and editing the file.

The Copy-Modify-Merge Solution
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Subversion, CVS and a number of other Version Control
systems use a copy-modify-merge model as an alternative to
locking. In this model, each user's client contacts the project
repository and creates a personal working copy - a local
reflection of the repository's files and directories. Users then
work simultaneously and independently, modifying their
private copies. In due course, the private copies are merged
together into a new, final version. The Version Control
system often assists with the merging, but ultimately a
person is responsible for making it happen correctly.

When Locking is Necessary

While the lock-modify-unlock model is generally
considered a hindrance to collaboration, there are still times
when locking is necessary.

The copy-modify-merge model is based on the assumption
that files are contextually merge-able: that is, that the files in
the repository are line-based text files (such as program
source code). However, for files with binary formats, such
as artwork or sound, it is often impossible to merge
conflicting changes. In these situations, it really is necessary
for users to take strict turns in changing the file. Without
serialized access, some users end up wasting time on
changes that are ultimately overwritten.

(c) Sparx Systems 2018 Page  727 of 1073



User Guide - Model Repository 21 December, 2018

Applying Version Control in a Team
Environment

This is a summary of the process of setting up a Version
Control environment and applying Version Control to a
project to be accessed by a number of users.

Version Control - Process Overview

Ste
p

Action

1 Install your Version Control product.

2 Create a Version Control repository.

3 Create a Version Control project to be used with
your Enterprise Architect project.

4 Check-out a working copy of the Version Control
project (a module, project or folder within the
Version Control system) into a local folder.
You must do this for every team member that is
accessing the Version Controlled Packages, whether
you are using a single shared model or each team
member stores his own private copy of the model.

(c) Sparx Systems 2018 Page  728 of 1073



User Guide - Model Repository 21 December, 2018

5 Before attempting to access the new Version Control
environment from within Enterprise Architect, you
should first verify that it functions correctly when
used outside of Enterprise Architect.

6 Within Enterprise Architect, define a Version
Control configuration to provide access to the
working copy files.
The name of the Version Control configuration must
be the same across all machines throughout a team.
That is, all Version Control access to a given
Package must be through Version Control
configurations with the same name, across all
models and all users.
The easiest way to perform this step (throughout the
team) is to have one user set up Version Control on
the model and then share that model with the rest of
the team.

In Shared Model deployment, all users connect to·

a single instance of the model database, so the
model is shared automatically
In Private Model deployment, it is easiest to·

distribute copies of the original model (after
Version Control has been set up) to all other
members of the team

Whenever you open a model (Private or Shared) that
uses a Version Control configuration that is not yet
defined on your workstation, a prompt displays to
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complete the definition for that configuration. This
typically means specifying the local working copy
directory and perhaps choosing the Version Control
project associated with this Enterprise Architect
project.
Once this has been done, the Version Controlled
Packages that already exist in the model are ready
for use.

7 Configure Packages within the Enterprise Architect
model for Version Control. That is, apply Version
Control to individual Packages.

8 Check-out and check-in Packages as required.

Notes

It is possible to use multiple Version Control·

Configurations within the same model; different Packages
can still use different Version Control Configurations
within the model, as long as any given Package is always
accessed via the same Version Control Configuration
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Version Control Nested Packages

When you save a Package to the Version Control system,
only stub information is exported for any nested Packages.
This protects information in a nested Package from being
inadvertently over-written by a top level Package.

Operations on Nested Packages

Operation Detail

Checking
Out

When you check out a Package, you do
not modify or delete nested Packages;
only the top level Package is modified.
As a consequence of this behavior, if you
check out or get a Version Controlled
Package with nested Packages that are
not already in your model, you see stubs
in the model for the nested Packages
only.

Get All
Latest

If you select the 'Get All Latest' option
from the Version Control menu, any new
stubs are populated from the Version
Control system.

Importing You can populate a large and complex
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Models model, by 'getting' only the root
Packages, then using 'Get All Latest' to
recursively iterate through the attached
and nested Packages.
This is a powerful and efficient means of
managing your project and simplifies
handling very large models, even in a
distributed environment.
The 'Import a Model Branch' option
combines the procedure steps into a
single operation.

Notes

It is recommended that, when sharing a Version·

Controlled model, you do not mix versions of Enterprise
Architect later than version 4.5 with earlier versions; if
this is necessary it is best to go to the 'Version Control
Settings' dialog and deselect the 'Save nested version
controlled packages to stubs only' checkbox, setting
Enterprise Architect to the pre-version 4.5 behavior (for
the current model only)

(c) Sparx Systems 2018 Page  732 of 1073



User Guide - Model Repository 21 December, 2018

Add Connectors To Locked Elements

Generally, when working in a diagram containing locked
elements, you cannot add a connector to a locked element.
However, this depends on the lock status of the source and
target elements (or more precisely, the lock status of the
parent Packages of the source and target elements, when the
source and target element are held in different Packages).
There are scenarios in which a connector can be created on a
locked element.

Lock Scenarios

Element
Status

Add Connectors

Source
unlocked,
target
unlocked

Yes, any kind of connector can be added

Source
unlocked,
target locked

Yes, except for Composition connectors

Source
locked, target

No, except for Composition connectors
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unlocked

Source
locked, target
locked

No, prohibited for all connectors

Notes

A connector can be added if its source is unlocked - you·

are modifying what the source can see

The exception is Composition connectors, where the·

target (the parent) must be unlocked - you are modifying
the parent by adding children
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Project Browser Indicators

Packages under Version Control are identified in the Project
Browser by icons that indicate the current status of the
Package.

Indicators

Icon Indicates that

This Package is Version Controlled and
not checked out to you.
You cannot edit the Package (until you
check out the Package yourself).

This Package is Version Controlled and
checked out to you.
You can edit the Package.

This Package is Version Controlled, but
you checked it out whilst not connected
to the Version Control server.
You can edit the Package but there could
be version conflicts when you check the
Package in again.

This Package is controlled and is
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represented by an XMI file on disk, but it
is not under Version Control.
You can edit this Package.
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Offline Version Control

When loading a model that uses Version Control, Enterprise
Architect normally initializes a connection to the Version
Control system for each Version Control configuration
defined in the model. If Enterprise Architect is unable to
connect a Version Control configuration for any reason, it
displays warning messages to notify you and provides
offline Version Control functionality for all Packages
associated with the failed connection.

You can prevent Enterprise Architect from starting to make
any Version Control connections, by selecting to work
offline before loading your model.

Access

Ribbon Configure > Version Control > Work
Offline

Working Offline

Concept Discussion
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Choosing to
Work Offline

Selecting to work offline is useful if you
know beforehand that Enterprise
Architect cannot connect to your Version
Control system. For example: If you are
working on a laptop computer that is
disconnected from your network, on an
Enterprise Architect model that uses a
large number of Version Control
configurations, you can select to work
offline before you load the model to
avoid all the error messages that the
system would normally display as each
Version Control connection attempt
failed.
You can switch between working offline
and working online at any time, either
before or after a model is loaded, by
toggling the 'Work Offline' menu option.
Enterprise Architect disconnects or
reconnects Version Control (depending
on the connection availability) according
to your selection.

Using
Version
Control
Whilst
Disconnected
From the
Version

Enterprise Architect 'remembers' the
status of a model’s Version Controlled
Packages. Packages that were checked
out to you prior to disconnecting from the
server are still shown as checked out to
you, even though you are no longer
connected to the server. You can still edit
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Control
Server

these Packages as you normally would.
Packages that were not checked out to
you prior to disconnecting from the
server are shown as Version Controlled
and locked. You cannot edit these
Packages until you check them out.

Offline
Check Out

You can 'check-out' and edit a Version
Controlled Package even when your
machine is disconnected from the
Version Control server. In this example,
the colored 'figure 8' icon for DFD
indicates that you have checked it out
whilst off line.

(The gray 'figure 8' icon shown against
Logical View indicates that you have
checked out a Version Controlled
Package on line.)
You should be aware that the Version
Control system, and therefore other users,
have no way of knowing that you have
'checked-out' a Package whilst offline. It
is not possible to merge changes to an
XMI file that result from two users
editing the same Package at the same
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time. If an offline checkout leads to two
people editing the same Package at the
same time, when the changes are brought
back online the first-saved set of changes
is lost.

Checking In
a Package
That Was
Checked Out
Offline

Once you reconnect your system to the
Version Control server, if the Package
you checked out offline is not currently
checked out by another user, you can
check in that Package. However, before
Enterprise Architect checks in the
Package, it compares the local working
copy of the Package file with the latest
revision in the repository. (These Package
files remain unchanged in your work area
until Enterprise Architect exports the
Package again before checking in.) If the
repository version remains unchanged
from when you last updated your local
copy, Enterprise Architect exports and
checks in your Package without further
prompting.
On the other hand, if the repository now
contains a file that has changed since you
last updated your local copy, checking in
your Package would overwrite those
changes. Enterprise Architect displays a
message warning you of the pending data
loss and giving you the opportunity to
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abort the check in. At this point, you must
decide whether to discard your own
changes, using the 'Undo Check Out'
command, or continue with your check in
and overwrite the changes that have been
committed to the repository since you last
updated your local copy from the
repository.
You can use the 'File Properties'
command to determine who checked in
the last changes to this Package. This
might help you to discover what changes
have been uploaded and decide whose
changes take precedence.

Update
Before You
Disconnect

Whenever you are connected to the
Version Control server, you are always
working with the latest version of a
Package. This is because you cannot
modify a Package until you check it out
from Version Control, and checking it out
loads the latest revision from the
repository into your model.
This cannot happen when you are
disconnected from the Version Control
server. You are working on whatever
versions you have on your machine,
dating back to the last time you updated
your local copy of each Version
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Controlled Package. So, if you are
planning to work on a model whilst
disconnected from Version Control, it is a
very good idea to make sure that you
have the latest versions of all Packages
before you disconnect. The 'Get All
Latest' option makes this a simple task.
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Version Control Branching

Currently, Enterprise Architect does not support Version
Control Branching.

Work-arounds to achieve similar results might be possible
for certain version-control products; contact Sparx Support
for advice.

Contacts

User Type Contact via

Registered
users

https://sparxsystems.com/registered/reg_s
upport.html

Trial users support@sparxsystems.com
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Version Control Product Setup

To control and maintain the different revisions of your
project Packages, Enterprise Architect uses third-party
Version Control products. Once your Version Control
product is installed and a suitable environment has been
created, Enterprise Architect can use that environment to
control your project's Packages.

Typically, Version Control products consist of:

A server component·

A client component·

Enterprise Architect integrates with the Version Control
client components for Subversion, CVS and MS Team
Foundation Server command line clients, as well as for
products having API clients that comply with the MS SCCI
specification.

Version Control System Components

Component Detail

Version
Control
Server

The server component maintains the
controlled files in their many revisions, in
a central repository.
The server component is usually located
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on a server machine that is accessible to
all team members who are using Version
Control.

Server
Configuratio
n

The steps for configuring a Version
Control server are, broadly:

Install the software·

Create a repository·

Create Version Control projects (or·

modules or folders for use with specific
projects)
Configure user IDs and passwords·

For details on configuring any particular
Version Control server, consult the
appropriate documentation provided with
the Version Control product.

Version
Control
Client

The client component manages the
working copies of the controlled files,
submitting files to or retrieving files from
the server as required.
A Version Control client must be
installed on every machine on which you
run Enterprise Architect and want to
access your Version Control system.

Client
Configuratio

The steps for configuring a Version
Control client are, broadly:
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n Install the software·

Create a new directory for use as a·

local working copy folder
Log in to the Version Control server·

Associate the working copy folder with·

its corresponding server repository
folder

For details on setting up a
product-specific Version Control
environment for use with Enterprise
Architect, click on the appropriate link in
the next column.
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System Requirements

Enterprise Architect is a Windows-based application and
requires a Windows-based Version Control client for
integration. It is independent of the Version Control server
component and the platform on which that runs.

Version Control Product Requirements

Product Detail

Subversion Subversion is free, open source software.
Subversion server components are
available to run on a wide range of
different hardware and operating systems.
Enterprise Architect is not affected by
your choice of server components, but
requires Subversion's Windows-based
command line client for integration.
There are many graphical user interface
clients available for use with Subversion,
such as TortoiseSVN; this type of client
cannot be used directly for integration
with Enterprise Architect, but can be very
useful in preparing a working Subversion
environment for use by Enterprise
Architect.
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Binary Packages are available for
download from:

http://subversion.apache.org/packages.·

html

Subversion documentation is available
from:

http://svnbook.red-bean.com/nightly/en·

/index.html

Concurrent
Versions
System
(CVS)

CVS is free, open source software.
CVS server components are available to
run on a wide range of different hardware
and operating systems.
Enterprise Architect is not affected by
your choice of server components, but
requires CVS's Windows-based
command line client for integration.
There are many graphical user interface
clients available for use with CVS, such
as TortoiseCVS; this type of client cannot
be used directly for integration with
Enterprise Architect, but can be very
useful in preparing a working CVS
environment for use by Enterprise
Architect.
The software is available for download
from:
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http://www.nongnu.org/cvs/·

CVS documentation is available from:
http://cvsbook.red-bean.com/cvsbook.h·

tml

Microsoft
Team
Foundation
Server

Enterprise Architect is able to use either
the:

Command line client for TFS, or·

MS TFS-SCC client·

Your choice of client affects how you
specify your Version Control
Configuration.
MS TFS-SCC clients are available for
download from Microsoft's web pages.
(Run an Internet search for 'TFS
MSSCCI'.)

Common
Source Code
Control
(SCC)-compa
tible products

Any Version Control product that
provides a client that complies with the
Microsoft Common Source Code Control
standard, version 1.1 or higher, can be
integrated with Enterprise Architect.
These products are SCC-compatible and
are known to successfully integrate with
Enterprise Architect:

Accurev·

ClearCase·
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MS Visual Source Safe·

MS TFS-SCC·

MKS Source Integrity·

Perforce·

Source Offsite·

Snapshot CM·

Products that do not appear in this list
should still integrate successfully with
Enterprise Architect, if there is a client
available for that product that complies
with the MS SCC API specification.
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Create a Subversion Environment

You can use Subversion as a Version Control provider for
Enterprise Architect. The first step in doing this is for a
Subversion administrator to install and configure the
appropriate software. A number of basic tasks are performed
in creating an operational Subversion environment, and
useful tools are available for performing some of these
tasks.

Tasks in Creating a Subversion Environment

Task Detail

Install server
components

Executable files for Subversion can be
obtained from the Apache Software
Foundation.
Subversion server components are
available to run on a wide range of
different hardware and operating systems;
Enterprise Architect is not affected by
your choice of server components.
VisualSVN is a package that can greatly
simplify the installation, configuration
and management of your Subversion
server.
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Create a
repository

Please consult the official Subversion
documentation.

Create
Subversion
users

Please consult the official Subversion
documentation.

Create a new
repository
sub-tree

It is good practice to create a new
repository sub-tree in Subversion for each
new Enterprise Architect model being
added to Version Control with
Subversion. Users should create a new
local working copy from the sub-tree to
be used with that model.
TortoiseSVN can greatly simplify the
process of creating new repository
sub-trees.

Install client
components

Executable files for Subversion can be
obtained from the Apache Software
Foundation.

Create a
working copy
folder

A working copy folder must exist on each
users' machine, for Enterprise Architect
to use when exporting and importing the
Version Controlled Package files. It is
this folder that is specified as the Local
Project Path, when defining your Version
Control Configurations.
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The working copy folder is the 'sandbox'
where you modify the controlled files.
The working copy folder is usually
associated with a folder that exists within
the Version Control repository. In
Subversion, to create a local working
copy you perform an initial check-out of
a folder from the Subversion repository;
this downloads a copy of the folder and
its contents, to create your local working
copy.
TortoiseSVN can greatly simplify the
initial check out of a working copy
folder.

Setting up
Subversion
under
Wine/CrossO
ver

The process of setting up and using
Subversion with Enterprise Architect
under Wine is almost identical to the
process when running natively under
Windows, apart from minor differences
in installing the Subversion client and
performing the initial check out of the
working copy folder.

Notes

Enterprise Architect relies on exclusive file locking when·
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applying Version Control to its Packages; file locking was
not introduced into Subversion until version 1.2, therefore
Enterprise Architect does not work with Subversion
releases earlier than Subversion 1.2

Enterprise Architect can only communicate with the·

Subversion server using the Subversion command line
client svn.exe
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Create a new Repository Sub-tree

When you set up Subversion as your Version Control tool, it
is good practice to create a new repository sub-tree in
Subversion for each new Enterprise Architect model. The
sub-tree can be used to control the Package files for your
model.

Create a new sub-tree in the Subversion
Repository

Ste
p

Action

1 Use Windows Explorer to create a temporary
directory on your PC file system, to be imported into
the Subversion repository as a new repository
sub-tree. The directory would have this structure:

2 Open a Windows command prompt, navigate to
tempDir and issue the Subversion command import.
For example:
    C:\Documents and Settings\user> cd \tempDir
    C:\tempDir> svn import .
https://host.example.com:8443/repos/
    --message "Repository Initialization"

(c) Sparx Systems 2018 Page  755 of 1073



User Guide - Model Repository 21 December, 2018

3 On your PC, delete the temporary directory structure
(tempDir) and all its contents.

Notes

After the import is finished, the original tree is not·

converted into a Subversion working copy; you should
delete the temporary structure and check out a fresh
working copy of the tree

The process can also be performed using TortoiseSVN's·

Repository Browser, which provides commands for
simply creating new folders directly in the repository
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Create a Local Working Copy

In order to use Subversion to provide Version Control of the
Packages in a model, you need to prepare a functional SVN
working copy folder that can be accessed through an
Enterprise Architect Version Control configuration within
that model.

Create a Subversion working copy folder

Ste
p

Action

1 Choose or create a suitable directory on your system
in which to create your Subversion working copy.

2 Open a command prompt window and navigate to
the directory you have selected. For example:
    C:\> mkdir mySVNWorkSpace
    C:\> mkdir
mySVNWorkSpace/myEAModelName
    C:\> cd mySVNWorkSpace/myEAModelName

3 Perform the initial check out from the Subversion
repository, specifying the repository folder and local
working copy folder, as well as your user name and
password. For example:
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    C:\> svn checkout
"https://myserver:8443/svn/repos_folder
    "C:\mySVNWorkSpace/myEAModelName"
    --username myUserName
    --password myPassword
(By specifying your Subversion username and
password, you ensure that they are correctly cached
by Subversion and available for use by Enterprise
Architect.)
If you specify the HTTPS protocol when performing
the initial Subversion check out, a prompt displays to
accept a security certificate; in this instance, press
the P key to permanently accept the certificate.
The nominated local folder is configured as a
Subversion working copy folder.
Any files already existing in the repository folder are
downloaded to the working copy folder as working
copy files.

4 Verify that your Subversion environment functions
correctly.

Notes

It is important that Subversion caches your username and·
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password, so that it never has to prompt for user input; a
check-out operation might not request authentication, and
if it does not you should perform an action that does
request authentication, such as adding and committing a
dummy test file

The process can also be performed using TortoiseSVN's·

Checkout command (which provides options to browse
when specifying both your repository folder and your
local folder); when prompted for authentication details by
TortoiseSVN, make sure you place a check against the
'Save Authentication Data' option
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Verify the SVN Workspace

After creating the Subversion local working copy to hold the
working copies of your Package files, you can verify that it
functions correctly before attempting to use it with
Enterprise Architect. You need to be able to add files to
Subversion, lock the files and commit changes to those files.

Verify correct operation of a Subversion
working copy folder

Ste
p

Action

1 Use Windows to open a command prompt window.

2 Select the directory you specified as the working
copy, in the Subversion checkout command when
preparing the SVN workspace. For example:
    C:\> cd mySVNWorkSpace

3 Create a test file, such as Test.txt, containing the text
Subversion Test. For example:
    C:\> echo Subversion Test > Test.txt

4 Execute each of these Subversion commands:
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svn add Test.txt·

svn commit -m"Commit comment" Test.txt·

svn update Test.txt·

svn lock Test.txt·

Use your preferred editor to modify the file and·

save the changes
svn commit -m"Second commit comment" Test.txt·

The commands should execute without any errors
and without prompting the user for any extra input.

Notes

Your environment must be set up such that you can·

perform these operations without ever being prompted for
user ID or password; for further information, please see
the Caching Client Credentials topic in the official
Subversion documentation
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Subversion Under Wine-Crossover

If you want to set up and use Subversion with Enterprise
Architect under Wine, the process is almost identical to the
process for setting up and using the systems under
Windows. When running Enterprise Architect under Wine
or CrossOver, you still use a Windows-based Subversion
command line client.

There are some minor differences in the way you prepare
the Subversion working environment, specifically in the
way you install your Subversion client and the way you
check out a working copy folder from the Subversion
repository.

System Requirements

Sparx Systems has tested the use of Enterprise Architect
with Subversion under Wine 1.2, on macOS 10.4 and
10.6.2, and on Ubuntu 10.04. All tests were passed.

When using Wine 1.2 on the Ubuntu 9.10 platform, Sparx
Systems was able to use the svn: and file: protocols to
communicate with the SVN server; but not the https:
protocol.

Installing a Subversion Client
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Wine is able to install applications from either a Windows
.exe file, or a .msi installer file.

Place the installer for your Windows Subversion client in a
convenient location on the native file system, then open a
Wine console window from within Enterprise Architect and
run the installer from within the Wine console. Your
Subversion installation can then access the same C: drive
and folders that Enterprise Architect is accessing.
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Preparing a Subversion Environment
Under Wine

Under Wine, you can install Subversion from either a
Windows .exe file, or a .msi file. By performing your
Subversion installation and initial check out from a Wine
console window opened from within Enterprise Architect,
you have access to the same C: drive and folders that
Enterprise Architect is accessing.

Set up Subversion for use with Enterprise
Architect, running under Wine

Ste
p

Action

1 Start Enterprise Architect.
You do not have to load a project at this point.

2 From the 'Start' ribbon, select 'View > Visual Style >
Customize > Tools: '
A new, blank entry is opened on the 'Tools' tab of
the 'Customize' dialog.

3 Define the new menu item entry:
In the newly-opened 'Menu contents' field, type·
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the name 'Wine Console'
In the 'Command' field, type 'wineconsole'·

In the 'Arguments' field, type 'cmd'·

Leave the 'Initial directory' field blank·

4 Click on the Close button.
The 'Customize' dialog closes.

5 Select the ribbon option: 'Configure > User Tools >
Wine Console'.
A Wine console window opens.

6 Type 'C:' and press the Enter key.
The Wine console switches to the C: drive.

7 Issue the command to install your Subversion client.
For example:
    C:\>/Installers/Subversion-client-1.9.5.win32.exe
To install from a .msi file, use Wine's msiexec
utility. For example:
    C:\>msiexec /i
"Installers\Slik-Subversion-1.9.7-win32.msi"
Installation of the Subversion command line client
begins.

8 Create a folder to serve as the working copy folder to
be used by Enterprise Architect. For example:
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    C:\>mkdir C:\VC_workspaces\SVN_workcopy

9 Issue the command to perform the initial checkout
from the Subversion repository, specifying the
repository folder, working copy folder, username
and password. For example:
    C:\>svn checkout
"https://myServer:8443/svn/repos_folder"
           "C:\VC_workspaces\SVN_workcopy "
           --username myUserName
           --password myPassword
(After specifying your Subversion username and
password, they are correctly cached by Subversion
and are available for use by Enterprise Architect.)
If the HTTPS protocol is specified when performing
the initial Subversion check out, you are prompted to
accept a security certificate; in this instance, press
the P key to permanently accept the certificate.
The nominated local folder is configured as a
Subversion working copy folder. Any files already
existing in the repository folder are downloaded to
the working copy folder as working copy files.

10 Type 'Exit' and press the Enter key.
The Wine console window closes.
You are now ready to load a project in Enterprise
Architect and apply Version Control to it, using the
normal Windows-based procedures.
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Notes

You should copy the installer for your Windows·

Subversion client to a convenient location on the native
file system, so that you can easily refer to it from within
the Wine console window in step 7
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TortoiseSVN

TortoiseSVN is a Windows shell extension for Subversion;
it provides icon overlays in Windows Explorer that are
useful as a tool for observing the status of your Subversion
controlled files. You can also use it to create your repository
sub-trees and check out local working copies from within
Windows Explorer, using simple menu commands.

You can download TortoiseSVN from
http://tortoisesvn.net/downloads.html.

Notes

Enterprise Architect can only communicate with the·

Subversion server using the Subversion command line
client svn.exe

(c) Sparx Systems 2018 Page  768 of 1073

http://tortoisesvn.net/downloads.html


User Guide - Model Repository 21 December, 2018

Create a TFS Environment

You can use Microsoft Team Foundation Server (TFS) as a
Version Control provider for Enterprise Architect. The first
step in doing this is for a TFS administrator to install and
configure the TFS server and client applications. A number
of basic tasks are performed in creating an operational TFS
environment.

Tasks in Creating a TFS Environment

Task Detail

Obtain and
install TFS

Enterprise Architect uses the TFS
command line client to integrate TFS
Version Control.
The TFS command line client is normally
available as part of your Visual Studio
installation.

Choose a
TFS project

It is good practice to create a new TFS
project, or least a new Source Control
Folder within a project, for each
Enterprise Architect project being added
to Version Control with TFS.
If you have a single Enterprise Architect
project that contains many different
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models (for example, a DBMS hosted
project with multiple model root nodes),
you might choose to create a new TFS
project for each separate model.
For further information, please consult
your TFS product documentation.

Create a TFS
workspace

A working copy folder must exist on each
users' machine, for Enterprise Architect
to use when exporting and importing the
Version Controlled Package files. It is
this folder that is specified as the Local
Project Path, when defining your Version
Control Configurations.
The working copy folder is the 'sandbox'
where you modify the controlled files.
The working copy folder is usually
associated with a folder that exists within
the Version Control repository. In TFS,
the TFS workspace is used to map a local
working folder on your PC to a Source
Control Folder within a TFS project.
TFS 2012 and VS 2012 (and later
versions) feature a new type of
workspace called 'local' workspaces. Do
not attempt to use TFS 'local' workspaces
with Enterprise Architect. You must use
only 'server' workspaces for Enterprise
Architect Version Control, as 'local'
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workspaces do not support the
application of checkout locks to files.
Enterprise Architect relies on the
presence of checkout locks to ensure that
Packages can only be checked out
exclusively and that a given Package is
not already checked-out in some other
project (for instance, in a Private Model
deployment). This is necessary because it
is not practical to merge the XMI
Package files that Enterprise Architect
uses for Version Control.
A single TFS workspace can map many
different local folders, each one to a
separate Source Control Folder. In this
case, TFS can take a long time to work
through and update the files in all of
those folders, and the system might
appear to 'freeze' whilst it waits for TFS
to hand back program control.
You can avoid this if you keep your
Version Controlled Package files in a
folder that is separate from other artifacts,
such as source code files, creating a
separate work space to use just for your
Package files, or creating and mapping a
separate folder for Package files within
an existing workspace.
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Configure
exclusive
check-outs

The XMI format files used for the
Version Control of Enterprise Architect's
Packages can not be merged as if they
were ordinary text files. Therefore,
Enterprise Architect must enforce
serialized editing of its Version
Controlled Packages. As a consequence,
it is important that TFS is configured to
use 'exclusive checkouts' for XML files.

Verify the
TFS
Workspace

Enterprise Architect uses the TFS
command line client to checkin and
checkout files from the TFS repository.
After creating the TFS workspace, it is
important to verify that the command line
client can be used to add, check-in and
check-out files residing in the working
copy folder that is mapped through this
workspace.

Notes

TFS can also be used with an SCC client; the MS·

TFS-SCC client is available for download from
Microsoft's web site

MDG Integration for Visual Studio 2005 or 2008·
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enhances TFS support by providing access to, for
example, work items and bugs within both Enterprise
Architect and the MDG Integration product
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TFS Workspaces

In order to use TFS to provide Version Control of the
Packages in a model, you prepare a functional TFS
workspace that can be accessed through an Enterprise
Architect Version Control configuration within that model.
You use the TFS workspace to map a local working folder
on your PC to a Source Control Folder within a TFS project
repository.

It is assumed that have TFS 2013 open and a TFS Team
Project already exists for you to use in Version Control of
the Packages of your Enterprise Architect project. You can
create the TFS workspace through MS Visual Studio.

TFS 2013 and later versions support the use of Local
workspaces. However, Local workspaces do not support the
application of checkout locks. For this reason, Sparx
Systems strongly advises against the use of Local
workspaces when Version Controlling your Enterprise
Architect Package files. Using Local workspaces carries a
high risk of merge conflicts when checking in, which would
almost certainly result in loss of data or a corrupted model
database.

Map a local folder to a TFS Source Control
Folder

Ste Action

(c) Sparx Systems 2018 Page  774 of 1073



User Guide - Model Repository 21 December, 2018

p

1 Connect to your TFS server.
From the TFS main menu, choose 'View | Team
Explorer'.
In the Team Explorer toolbar, click on the Connect
to Team Projects button (fourth from left, with a
power plug icon).
The 'Team Explorer Connect' page displays.

2 Click on the link 'Select Team Projects...'
The 'Connect to Team Foundation Server' dialog
displays.

3 Click on the appropriate Team Foundation Server,
Team Project Collection and Team Project, then
click on the Connect button.

4 Click on the Home page of the Team Explorer, and
then on the Source Control Explorer button.
The Source Control Explorer view displays.

5 In the Source Control Explorer, click on the
drop-down arrow in the 'Workspace' field in the
toolbar, then click on 'Workspaces' at the bottom of
the list.
The 'Manage Workspaces' dialog displays.
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6 Click on the Add button.
The 'Add Workspace' dialog displays.

7 Click on the Advanced button.
A number of new fields display on the dialog.

8 Type in an appropriate name for the new workspace
and, if required, type in a comment.

9 Set the 'Location' field to 'Server'. This setting is
important.
This setting is not available in TFS 2010 and earlier
releases, where all workspaces are Server based.

10 Click in the Source Control Folder column, then
click on the Browse button to select a Source
Control Folder.
Select the Source Control folder (in the Team
Project) to use for controlling Enterprise Architect
Packages.

11 Click on the Browse button in the 'Local Folder'
column and create a new local folder.
This is the working copy folder into which
Enterprise Architect exports the Package files.

12 Click on the OK button.
The new workspace is created and saved.
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The 'Add Workspace' dialog closes.

13 Click on the OK button.
The 'Manage Workspaces' dialog closes.

Notes

The local folder referenced in step 11 is the Working·

Copy Path that should be specified when defining an
Enterprise Architect Version Control Configuration to use
this TFS workspace
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TFS Exclusive Check Outs

The XMI format files used for the Version Control of
Enterprise Architect's Packages can not be merged as
ordinary text files can. Therefore Enterprise Architect must
enforce serialized editing of its Version Controlled
Packages, and it is important that Team Foundation Server
is configured to use 'exclusive checkouts' for XML files.
Otherwise, TFS can return file statuses that make it look as
if the Package file is not checked-out by another user when
indeed it is.

You set exclusive checkouts in the TFS workspace through
MS Visual Studio.

Configure TFS to enforce exclusive check
outs for XML files

Ste
p

Action

1 Using Visual Studio, from the main menu select
'View | Team Explorer'.

2 In the 'Team Explorer' pane, right-click on the TFS
Server name that is controlling the Enterprise
Architect Package files, then from the context menu
select 'Team Foundation Server Settings | Source
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Control File Types'.

3 Select the entry for XML files (or create an entry if
necessary) then click on the Edit button.

4 Deselect the 'Enable file merging and multiple check
out' checkbox.
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Verify the TFS Workspace

Enterprise Architect will be using the TFS command line
client to commit file updates from the local working copy
folder into the TFS repository. After creating the TFS
workspace that maps your local working copy folder to a
TFS repository folder, it is good practice to verify that the
TFS workspace functions correctly before attempting to use
it with Enterprise Architect. You need to be able to add files
to TFS, place a check-out lock on the files and check-in
changes to those files.

Verify correct operation of a TFS Workspace

Ste
p

Action

1 Use Windows to open a command prompt window.

2 Select the directory you specified as the local
working copy folder when creating the TFS
workspace.
For example:
    C:\> cd myTFSWorkingCopyFolder

3 Create a test file, such as Test.xml, containing the
text 'my TFS Test'. For example:
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    C:\> echo my TFS Test > Test.xml
(The filename extension '.xml' is used because the
TFS server should have been configured to allow
exclusive checkouts for XML files.)

4 Using the command line client, execute each of these
TFS commands:

tf.exe add Test.xml·

tf.exe checkin Test.xml /override:"Manual check·

in." /comment:"a message"
tf.exe checkout /lock:checkout Test.xml·

Use your preferred editor to modify the file and save
the changes.

tf.exe checkin Test.xml /override:"Manual check·

in." /comment:"a message"
tf.exe get . /recursive·

Notes

All of the commands in step 4 should execute without any·

errors; in particular, you should be able to apply a
checkout lock when checking out the file

If the checkout command reports any errors, you might·

have to reconfigure the TFS workspace as a server based
workspace, or you might have to configure the TFS
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Server to use 'exclusive checkouts' for XML files
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Create a CVS Environment

You can use Concurrent Versions System (CVS) as a
Version Control provider for Enterprise Architect. The first
step in doing this is for a CVS administrator to install and
configure the appropriate software. A number of basic tasks
are performed in creating an operational CVS environment,
and useful tools are available for performing some of these
tasks.

Tasks in Creating a CVS Environment

Task Detail

Install server
components

Executable files for CVS can be obtained
from March Hare Software.
CVS server components are available to
run on a wide range of different hardware
and operating systems; Enterprise
Architect is not affected by your choice
of server components.

Create a
repository

Please consult the official CVS
documentation.

Create CVS
users

Please consult the official CVS
documentation.
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Create a new
repository
module

It is recommended good practice to create
a new repository module in CVS for each
new Enterprise Architect model being
added to Version Control with CVS.
Users should create a new local working
copy folder from the module to be used
with that model.
A repository module represents a project,
or a set of related files in the repository.
TortoiseCVS can greatly simplify the
process of creating new repository
sub-trees.

Install client
components

Executable files for CVS can be obtained
from March Hare Software.
Enterprise Architect is a Windows based
application - it requires a Windows based
CVS command line client for integration.

Create a
working copy
folder

A working copy folder must exist on each
users' machine, for Enterprise Architect
to use when exporting and importing the
Version Controlled Package files. It is
this folder that is specified as the Local
Project Path, when defining your Version
Control Configurations.
The working copy folder is the 'sandbox'
where you modify the controlled files.
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The working copy folder is usually
associated with a folder that exists within
the Version Control repository. In CVS,
to create a local working copy you
perform an initial check-out of a folder
from the CVS repository; this downloads
a copy of the folder and its contents, to
create your local working copy.
TortoiseCVS can greatly simplify the
initial check out of a working copy
folder.

Setting up
CVS under
Wine/CrossO
ver

The process of setting up and using CVS
with Enterprise Architect under Wine is
almost identical to the process when
running natively under Windows, apart
from minor differences in installing the
CVS client and performing the initial
checkout of the working copy folder.

Notes

If you do not already use CVS for Version Control, you·

should consider using Subversion instead; Subversion's
client-server protocols provide a broader range of
possibilities for connecting to remote servers, with easier
set up of secure connections
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TortoiseCVS is a Windows shell extension; Enterprise·

Architect cannot use TortoiseCVS as its client, it must use
the CVS command line client
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Prepare a CVS Local Workspace

In order to use CVS to provide Version Control of the
Packages in a model, you need to prepare a functional CVS
working copy folder that can be accessed through an
Enterprise Architect Version Control configuration within
that model.

Prepare a CVS Working Copy Folder

Ste
p

Action

1 Ask your System Administrator to install CVS and
create a remote repository, with a module that you
can use to control your Enterprise Architect Package
files.
Your administrator must create a username and
password for you before you can make a connection.

2 Select or create a suitable directory to use as your
CVS working copy directory.

3 Open a command prompt window and navigate to
your CVS working copy directory. For example:
    C:\> mkdir myCVSWorkSpace
    C:\> cd myCVSWorkSpace
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4 Log in to the remote CVS repository. For example:
    C:\myCVSWorkSpace> cvs
-d:pserver:myUserID@ServerName:/reposPath login
Replace myUserID with your CVS username,
replace ServerName with the name of your CVS
server and replace reposPath with the path to the
repository on the server.
A prompt for a password displays.

5 Enter your password.
You are logged in to the CVS server.

6 Perform the initial checkout of the CVS repository
module, into the local working copy directory. For
example:
    C:\myCVSWorkSpace> cvs
-d:pserver:myUserID@ServerName:/reposPath
checkout moduleName
(Replace moduleName with the name of the
repository module that you want to check out.)
A subdirectory is created in your current working
directory, with the same name as the module being
checked out.
Any files already existing in the repository module
are downloaded to the working copy folder as
working copy files.
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7 Verify that your CVS environment functions
correctly.

Notes

Much of the process can also be performed (more simply)·

using the TortoiseCVS command 'Make New Module'
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Verify the CVS Workspace

After creating the CVS local working copy to hold the
working copies of your Package files, you can verify that it
functions correctly before attempting to use it with
Enterprise Architect. You need to be able to add files to
CVS, and commit changes to those files. You also need to
be able to register as an editor of the file and retrieve the list
of currently registered editors.

Verify correct operation of a CVS working
copy folder

Ste
p

Action

1 Use Windows to open a command prompt window.

2 Select the directory you specified as the working
copy in the cvs checkout command, when preparing
the CVS workspace. For example:
    C:\> cd myCVSWorkSpace

3 Create a test file, such as Test.txt, containing the text
CVS Test. For example:
    C:\> echo CVS Test > Test.txt
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4 Execute these CVS commands:
cvs add Test.txt·

cvs commit -m"Commit comment" Test.txt·

cvs update Test.txt·

cvs edit Test.txt·

cvs editors Test.txt·

The commands should execute without any errors
and without prompting the user for any extra input.
The editors command should produce output that
resembles this:
    Test1.txt myUserID Tue Aug 9 10:08:43 2009
GMT myComputer
    C:\myCVSWorkSpace\moduleName

5 Take note of the userID that follows the filename.
Enterprise Architect must find and use this user ID
when you create your Version Control configuration.

Notes

Your environment must be set up such that you can·

perform these operations without ever being prompted for
input, such as user ID or password
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TortoiseCVS

TortoiseCVS is a Windows shell extension for CVS; it
provides icon overlays in Windows Explorer that are useful
as a tool for observing the status of your CVS controlled
files. You can also use it to create your repository modules
and check out local working copies from within Windows
Explorer using simple menu commands.

You can download TortoiseCVS from:
http://www.tortoisecvs.org.

Notes

Enterprise Architect must use the CVS command line·

client to communicate with the CVS server; it cannot use
TortoiseCVS
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Create an SCC Environment

You can use a Microsoft Common Source Code Control
(SCC) compatible product as a Version Control provider for
Enterprise Architect. The first step in doing this is for an
administrator to install and configure the server and client
applications. A number of basic tasks are performed in
creating an operational SCC-based environment.

Tasks in Creating an SCC Environment

Task Detail

Install and
configure
your chosen
Version
Control
product

A Version Control server component is
typically installed on a dedicated server
machine. All Enterprise Architect users
who require access to Version Control
must be able to connect to the server
machine.
After installing the Version Control
software, the administrator should also
create Version Control user IDs for all
users who require access to Version
Control.
For further information, consult the
product documentation for your particular
Version Control product.
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Create a new
SCC project

It is good practice to create a new SCC
Version Control project, or least a new
folder within a project, for each
Enterprise Architect project being added
to Version Control with SCC.
If you have a single Enterprise Architect
project that contains many different
models (for example, a DBMS hosted
project with multiple model root nodes),
you might choose to create a new SCC
Version Control project for each separate
model.
For further information, consult the
product documentation for your particular
Version Control product.

Configure
your SCC
project to
support
exclusive
check-outs
for .XML
files

The XMI-format files used for the
Version Control of Enterprise Architect
Packages can not be merged in the same
way as ordinary text files can. Therefore,
Enterprise Architect must enforce
serialized editing of its Version
Controlled Packages. As a consequence,
it is important that your Version Control
application is configured to use 'exclusive
checkouts' for XML files.

Create a local A working copy folder must exist on each
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working copy
folder

users' machine, for Enterprise Architect
to use when exporting and importing the
Version Controlled Package files. It is
this folder that is specified as the Local
Project Path, when defining your Version
Control Configurations.
The working copy folder is the 'sandbox'
where you modify the controlled files.
The working copy folder is usually
associated with a folder that exists within
the Version Control repository. Your
Version Control product provides some
means by which you associate a working
copy folder with a repository folder.
For further information, consult the
documentation for your particular
Version Control product.

Notes

When installing the client component software on users'·

PCs, check that the SCC client is also installed, as it might
not be a part of the default installation
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Upgrade at Enterprise Architect
Version 4.5, Under SCC Version Control

If you are working in Enterprise Architect release 4.5 or
later and you open an SCC Version Controlled project that
was created under a release earlier than 4.5, you must
identify the SCC connection with a new unique ID. You can
assign a name to the existing SCC configuration or associate
the project with another configuration that has previously
been assigned a unique ID.

By having a unique ID for each Version Control
configuration, you can assign a configuration quickly and
efficiently using configurations that have been created
previously for other Version Controlled repositories. This
enables you to configure the many Packages to use an
existing Version Control repository; this can apply to
Packages created for more than just one model enabling a
great deal of flexibility.

Upgrade an existing SCC Version Controlled
project created before release 4.5, in
Enterprise Architect release 4.5 or later

Ste
p

Action
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1 Open the project that has an SCC Version Control
configuration created in Enterprise Architect earlier
than version 4.5.
The 'Select or Create Unique ID for Version Control'
dialog automatically displays.

2 On the dialog, either create an ID for an existing
configuration or choose a previously created one
from the 'Unique ID' drop-down list.

3 The existing SCC configuration is the initial value,
represented by SCC-XXXXX; this number is not
especially meaningful, therefore it is recommended
that the configuration be given a meaningful name.

4 You can associate the Version Controlled Package
with a previously-defined configuration by selecting
an existing configuration from the 'Unique ID'
drop-down list (if one exists).

5 After you have assigned the unique ID, click on the
OK button to load the model.
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Version Control Set Up

Once you or an Administrator have installed and configured
the Version Control product software, to start using Version
Control you must first define a Version Control
configuration within your project in Enterprise Architect, to
be used to control the Packages in the project. You can
define any number of Version Control configurations in a
single model, but any given Package is associated with only
one configuration.

Access

Ribbon Configure > Version Control > Project
Configuration

Context
Menu

Right-click on Package > Package
Control > Version Control Settings

Define Version Control Configuration

Ste
p

Action
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1 On the 'Version Control Settings' dialog, click on the
New button.

2 In the 'Unique ID' field, type a suitable configuration
name.

3 Select the Type of Version Control product you are
connecting to, by clicking on the corresponding
radio button.

4 At this point, the middle section of the dialog
changes to display a collection of fields specific to
the type of Version Control configuration you are
defining.
Enter details relating to the Version Control
workspace that this configuration is to use.

5 Click on the Save button. The new configuration is
added to the Defined Configurations list.

6 If you want to create another Version Control
configuration, return to step 1.
When you have finished defining your Version
Control configurations, click on the Close button.
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Notes

Version Control Configuration details are stored in the·

user's Windows Registry settings, but each project stores a
list of the configurations it uses, so that Version Control
connections can be initialized as the project is being
loaded

If you are using the Corporate or extended editions of·

Enterprise Architect with security enabled, the
administrator must also set up access permissions to
configure and use Version Control
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Re-use an Existing Configuration

Once a Version Control configuration has been defined for
use in one project, it is possible to re-use that configuration
in other projects to provide access to:

An already existing Version Control environment (a·

working copy directory and its associated repository that
is already in use)

Version Controlled Packages that were created (and·

Version Controlled) in another project

Access

Ribbon Configure > Version Control > Project
Configuration

Context
Menu

Project Browser | right-click on Package |
Package Control | Version Control
Settings

Select existing configuration

Ste Action
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p

1 On the 'Version Control Settings' dialog, click on the
New button.
The various fields on the dialog are cleared, ready
for data entry.

2 In the 'Unique ID' field, click on the drop-down
arrow and select one of the previously-defined
Version Control configurations.
The details of the selected configuration are
displayed in the dialog.

3 Click on the Save button.
The configuration details are saved and are ready for
use in the current project.
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Version Control Settings

Defining Version Control settings within Enterprise
Architect should only be performed after you have
successfully created the Version Control environment that
you intend to use to control your Package files. If you have
not yet done so, please refer to the Help topic Applying
Version Control in a Team Environment for a summary of
what is required.

To set up a Version Control configuration on your model, or
update an existing Version Control configuration, you
define a number of settings that control how the status of
your model is communicated to your Version Control
system. You define these settings using the 'Version Control
Settings' dialog.

Access

Ribbon Configure > Version Control > Project
Configuration

Context
Menu

Right-click on Package > Package
Control > Version Control Settings
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Configuration Options

Option Action

This model is
private

Select to specify that this model database
is to be accessed by just a single user
(Private Model).
Leave unselected (the default) or deselect
to specify that the database is to be
accessed by multiple concurrent users
(Shared Model).
If in doubt, use the default setting.

Save nested
Version
Controlled
Packages to
stubs only

Select to specify that the exported XMI
file for a Version Controlled Package will
contain Package stubs (place holders) for
nested Version Controlled child Packages
(recommended).
Deselect to specify that the exported XMI
file will contain the full content of nested
Version Controlled child Packages.

For all
packages,
create
placeholders
for external
references

Select to force all XMI 1.1 imports across
the model to exclude incoming
relationships and instead create external
references.
If the 'Create placeholders for missing
External References during XMI 1.1/2.1
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Import' checkbox is not selected in the
XML Specifications options for a user,
this field overrides that setting.

Unique ID Specify a name that uniquely identifies
the configuration. Either:

Type a name to identify a new·

configuration, or
Click on the drop-down arrow and·

select the name of a configuration
previously defined in a different project
(if any exist)

Type Click on the appropriate radio button for
the type of Version Control system you
are associating with this configuration.
The middle section of the dialog changes
to display a collection of fields relating to
the type of Version Control configuration
you are defining.
Set the type to SCC for:

MS Visual Source Safe·

Rational Clear Case·

Perforce·

AccuRev·

Any other SCC-compatible clients·

For any other product that you are using,
select the type that matches the product -
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CVS, Subversion or TFS.

New Click on this button to clear the fields and
create a new Version Control
configuration.

Save Click on this button to save the details of
a new or updated configuration.

Delete Click on an entry in the Defined
Configurations list and click this button
to remove the definition of the selected
configuration from this model.

Defined
Configuratio
ns

Review a list of configurations that are in
use in the current model.

In future, do
not prompt
for
incomplete
configuration
s

Select to specify that the user is not
prompted to complete the definition of
configurations that are not fully specified
(the default).
Deselect to prompt the user to complete
configurations that are not fully defined.

Close Close the 'Version Control Settings'
dialog.

Help Display this Help topic.
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Notes

It is important that, for any given Version Controlled·

Package file, any user accessing that file from any model
uses Version Control configurations having the same
Unique ID

When you first open a model that was created by another·

user and that uses Version Control, the Version Control
configuration(s) used by that model do not yet exist in
your Windows registry settings; you have to complete the
definitions of those configurations before you can use
Version Control in that project

If User Security is enabled, you must have 'Configure·

Version Control' permission to set up Version Control
options for the current model

It is possible to use multiple Version Control·

configurations in the same model
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SCC Settings

When you are setting up your Version Control
configurations on the 'Version Control Settings' dialog, and
you set the configuration type to 'SCC', the dialog presents a
set of fields specific to SCC-based configurations. You can
then define details such as:

The working copy folder to be used with the configuration·

The details necessary to connect to the SCC Version·

Control system

You set the Version Control configuration type to SCC for
version Control providers such as:

MS Visual Source Safe·

Rational Clear Case·

Perforce·

AccuRev·

Any other SCC-compatible clients·

Access

Ribbon Configure > Version Control > Project
Configuration: Type: SCC

Context
Menu

Right-click on Package > Package
Control > Version Control Settings:
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Type: SCC

Settings

Option Action

Local Project
Path

Displays the full path of the folder that
contains the local (working) copies of the
XMI Package files.
This field is read-only; its value can only
be set through use of the Select Path
button.

Select Path Click on this button to choose the Local
Project Path, by opening a file browser
dialog and navigating through the file
system to the appropriate folder.

After you choose the appropriate folder·

path, the 'Select SCC Provider' dialog
displays, listing all SCC providers that
are installed on the current workstation;
choose the SCC provider to use and
click on the OK button
At this point, the SCC client opens its·

own dialog to prompt you for
information; SCC products implement
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this functionality in varied ways, but
typically you are prompted to log in to
the Version Control system, then
prompted to choose the SCC project to
use and possibly a (server) folder
contained within that project
At the conclusion of this process, all of·

the SCC details should be filled in; you
can then save the definition by clicking
on the Save button on the 'Version
Control Settings' dialog

Current User Displays the user name used to log on to
the Version Control system that is
accessed through this configuration.
This field is read-only; the value it
displays is retrieved from the SCC client.

SCC
Provider

Displays the name of the SCC provider.
This field is read-only; the value it
displays is retrieved from the SCC client.

SCC Project Displays the name of the SCC Project
that this configuration attaches to.
This field is read-only; the value it
displays is retrieved from the SCC client.
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Notes

You define the SCC-specific details as part of the broader·

process of setting up a Version Control Configuration on
the 'Version Control Settings' dialog
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CVS Settings

When you are setting up your Version Control
configurations on the 'Version Control Settings' dialog, and
you set the configuration type to CVS, the dialog presents a
set of fields specific to CVS-based configurations. You can
then define details such as:

The working copy folder to be used with the configuration·

The path to the CVS command line client·

Access

Ribbon Configure > Version Control > Project
Configuration: Type: CVS

Context
Menu

Right-click on Package > Package
Control > Version Control Settings:
Type: CVS

Settings

Option Action
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Working
Copy Path

Displays the full path of the folder that
contains the local (working) copies of the
XMI Package files.
This field is read-only; its value can only
be set through use of the Select Path
button.

Select Path Click on this button to choose the
working copy path, by opening a file
browser dialog and navigating through
the file system to the appropriate folder.

Current User This field is read-only; its value is
retrieved from a file named CVS\Root,
located in the folder selected using the
Select Path button.

CVS Exe
Path

Displays the full path of the CVS
command line client executable file.
This field is read-only; its value can only
be set through use of the Select Path
button.

Select Path Click on this button to specify the path to
the CVS command line client, by opening
a file browser dialog and navigating
through the file system to locate the
appropriate file.
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VC
Time-Out
Value

Specify the amount of time that
Enterprise Architect waits for a CVS
command to complete; if the command
does not complete within the allowed
time, the system displays a Time-out
error message, detailing the command
that failed to complete.
This single time-out value is applied to
all Version Control Configurations (of
types SVN, TFS and CVS) that the user
accesses from this workstation.

Notes

When connecting to a remote CVS repository, the·

'Current User' field should display the user name used to
log into that repository; if this does not happen, it
indicates that Enterprise Architect cannot extract the user
name from the file ...\WorkingCopyPath\CVS\Root and
the configuration does not work correctly

You define the CVS-specific details as part of the broader·

process of setting up a Version Control configuration on
the 'Version Control Settings' dialog
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SVN Settings

When you are setting up your Version Control
configurations on the 'Version Control Settings' dialog, and
you set the configuration type to 'Subversion', the dialog
presents a set of fields specific to Subversion-based
configurations. You can then define details such as:

The working copy folder to be used with the configuration·

The path to the Subversion command line client·

Access

Ribbon Configure > Version Control > Project
Configuration: Type: Subversion

Context
Menu

Right-click on Package > Package
Control > Version Control Settings:
Type: Subversion

Settings

Option Action
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Working
Copy Path

Displays the full path of the folder that
contains the local (working) copies of the
XMI Package files.
This field is read-only; its value can only
be set through use of the Select Path
button.

Select Path Click on this button to choose the
Working Copy Path, by opening a file
browser dialog and navigating through
the file system to the appropriate folder.

Subversion
Exe Path

Displays the full path of the Subversion
command line client executable file.
This field is read-only; its value can only
be set through use of the associated
Select Path button.

Select Path Click on this button to specify the path to
the Subversion command line client, by
opening a file browser dialog and
navigating through the file system to
locate the appropriate file.

VC
Time-Out
Value

Specify the amount of time that
Enterprise Architect should wait for a
Subversion command to complete; if the
command does not complete within the
allowed time, the system displays a
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Time-out error message, detailing the
command that failed to complete.
This single time-out value is applied to
all Version Control Configurations (of
types SVN, TFS and CVS) that the user
accesses from this workstation.

Notes

You define the Subversion-specific details as part of the·

broader process of setting up a Version Control
configuration on the 'Version Control Settings' dialog
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TFS Settings

When you are setting up your Version Control
configurations on the 'Version Control Settings' dialog, and
you set the configuration type to 'TFS', the dialog presents a
set of fields specific to TFS-based configurations. You can
then define details such as:

The working copy folder to be used with the configuration·

The user name and password to log in to the TFS server·

The path to the TFS command line client·

Access

Ribbon Configure > Version Control > Project
Configuration: Type: TFS

Context
Menu

Right-click on Package > Package
Control > Version Control Settings:
Type: TFS

Settings

Option Action
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Working
Copy Path

Displays the full path of the folder that
contains the local (working) copies of the
XMI Package files.
This field is read-only; its value can only
be set through use of the associated
Select Path button.

Select Path Click on this button to choose the
Working Copy Path. The file browser
dialog opens, through which you navigate
through the file system to the appropriate
folder.

Server Name Displays the name of the TFS Server that
is associated with the working copy
folder specified in the 'Working Copy
Path' field.
This field is read-only; Enterprise
Architect retrieves the value it displays
by querying the TFS client.

Workspace
Name

Displays the name of the TFS Workspace
that is associated with the working copy
folder specified in the 'Working Copy
Path' field.
This field is read-only; Enterprise
Architect retrieves the value it displays
by querying the TFS client.
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User Name Type in the user name with which to log
into the TFS Server.

Password Type in the password with which to log
into the TFS Server.

Display
Name

TFS 2013 and later releases use a Display
Name to report on who owns a checkout
lock on a file. TFS 2010 uses AccountID
when reporting lock owners and so does
not require a Display Name.
If using TFS 2013, type in your TFS
Display Name as shown in the User
column of the Visual Studio Source
Control Explorer when you checkout a
file.

Checkout
Locks
Required

This checkbox defaults to selected.
TFS 2013 supports the use of Local
workspaces, but these do not support
checkout locks. If you want to use TFS
Local workspaces (not recommended),
you must deselect this checkbox.
Otherwise, leave the checkbox selected.
It is recommended that all workspaces
used for Version Controlling Enterprise
Architect Package files are set as 'Server'
workspaces.
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TFS Exe Path Displays the full path of the TFS
command line client executable file.
This field is read-only; its value can only
be set through use of the associated
Select Path button.

Select Path Click on this button to specify the path to
the TFS command line client.
The file browser dialog opens, through
which you navigate through the file
system to the appropriate folder.

VC
Time-Out
Value

Type in the number of seconds that
Enterprise Architect should wait for a
TFS command to complete; if a
command does not complete within this
allowed time, the system displays a
Time-out error message, detailing the
command that failed to complete.
This single time-out value is applied to
all Version Control configurations (of
types SVN, TFS and CVS) that the user
accesses from this workstation.

Notes
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If you automatically log in to TFS through a path external·

to Enterprise Architect (for example, through MS
Integrated Security), you can leave the 'User Name' and
'Password' fields blank

If the 'Password' field is blank, Enterprise Architect·

retrieves your Windows username and uses that value
when determining whether a Package file is checked out
to you or to another user

TFS Version Control can also be accessed using the TFS·

MSSCCI client; to make use of the TFS MSSCCI client,
please define an SCC based Version Control
configuration

You define the TFS-specific details as part of the broader·

process of setting up a Version Control configuration on
the 'Version Control Settings' dialog
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Use Version Control

Once your Version Control product is installed and you
have created a suitable environment, Enterprise Architect
can make use of that environment to control the Packages in
your project. Version Control provides a range of facilities,
as outlined in this table.

Facilities

Facility Detail

Define
Version
Control
Settings

Version Control Configurations are used
by Enterprise Architect to communicate
with your Version Control system.
You define one or more Version Control
configurations in your project and then
use those configurations to control the
Packages in your project.

Configure a
Package

To put a Package under Version Control
you mark the Package as a controlled
Package, specify the Version Control
configuration to control it, and associate
an XMI file with the Package.

Check In a Checks in all Packages involved in a
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Model
Branch

particular unit of work, as a single
operation.
Checking-in updates the reference
version of a Package or group of
Packages in the model.

Check Out a
Model
Branch

Checks out all Packages within a selected
model branch as a single operation, so
that you can update modeling objects
within them.

Check In a
Package

Checks in the Package currently selected
in the Project Browser.
Checking-in updates the reference
version of a Package or group of
Packages in the model.

Check Out a
Package

Checks out the Version Controlled
Package currently selected in the Project
Browser, so that you can update
modeling objects within it.

Undo Check
Out of a
Package

Reverses the check-out of a Package,
discarding any modifications that have
been made by restoring the Package
content to the latest revision held in
Version Control.

Import a Retrieves Packages from Version Control
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Package
From
Version
Control

that have been created by other users, or
by you in another model, and imports
them into your current model.

Apply
Version
Control to a
Model
Branch

Applies Version Control to all Packages
within the selected model branch, in a
single operation.
In this context, a model branch is a
Package in the Project Browser, and all of
the Packages contained within it.

Export a
Version
Controlled
Model
Branch

Exports Version Control information
about the root Package of a model
branch, that is used to simplify the
process of exporting and importing a
hierarchy of Packages from one model to
another.

Import a
Model
Branch From
Version
Control

Uses Enterprise Architect's Model Branch
files, of which there are few, to retrieve
information about the root Package file
and to import the model branch.
Model branch files can simplify the
process of exporting and importing a
hierarchy of Packages from one model to
another.

View Displays the change history of Version

(c) Sparx Systems 2018 Page  825 of 1073



User Guide - Model Repository 21 December, 2018

Package
Revision
History

Controlled Packages.
You can also check out a prior revision of
the Package for editing, effectively
rolling-back to a prior revision of the
Package.

Validate
Package
Configuratio
ns

You can test the validity of the Version
Control settings associated with each
Version Controlled Package within your
current model.

Resynchroniz
e the Status
of Version
Controlled
Packages

Re-synchronizes the Version Control
status of Packages within your project
with the status reported by your Version
Control provider.

Notes

Database replication should not be combined with·

Version Controlled Packages

If the Packages under Version Control contain any·

alternative images, you can export the images to the
Version Control repository when you check in the
Packages, by setting the 'Export alternate images' option
on the 'Preferences' dialog
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Configure Controlled Package

Once your Version Control application is set up and you
have Version Control configurations in place, you can place
the individual Packages in your model under Version
Control. To put a Package under Version Control, you:

Flag the Package as a controlled Package·

Specify the Version Control configuration to control it·

and

Associate an XMI file with the Package·

You can then export and import the Package data to and
from the file and issue commands to the Version Control
system.

Access

Ribbon Configure > Version Control > Package
Configuration

Keyboard
Shortcuts

Ctrl+Alt+P

Apply Version Control to a single Package
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Ste
p

Action

1 Click on the 'Control Package' checkbox to select it,
indicating that this Package is to be controlled.

2 Click on the 'Version Control' drop-down arrow and
select the Version Control configuration to be used
to control this Package.

3 The 'XMI Filename' field displays a default filename
for the Package export file, based on the Package
name.
Optionally, modify the filename. Either:

Type a new name, or·

Click on the  button to open a file selection·

dialog
The target file must be located within the working
copy folder of the selected Version Control
configuration, or one of its sub-folders.

4 The 'Version ID' field defaults to '1.0'.
Optionally, change this to a different version
number.

5 The 'Owner' field defaults to your user name.
Optionally, type or select the name of the user who
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actually owns the Package.

6 Click on the OK button.
The 'Add Package to Version Control' dialog
displays.

7 Optionally, clear the 'Keep checked out' checkbox.
After applying Version Control, the Package either
remains checked-out for editing, or is checked-in and
locked against editing, depending on this setting.

8 Click on the OK button.
The 'Add Comment' dialog displays.

9 Optionally, add any further comments to the default
comment.
Enterprise Architect provides a default comment that
includes the current date & time.

10 Click on the OK button.
The current Package is exported to the nominated
XMI file, which is then committed to Version
Control. The Package icon in the Project Browser is
updated to reflect the Package's Version Control
status.
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Notes

If you are using the Corporate or extended editions of·

Enterprise Architect with security enabled, these features
are only available to users who have been granted
permission to configure and use Version Control
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Apply Version Control To Branches

It is possible to apply Version Control to all Packages within
a selected model branch, in a single operation. In this
context, a model branch is a Package that is currently
selected in the Project Browser, and all of the Packages
contained within it.

Access

Context
Menu

Project Browser | right-click on Package |
Package Control | Add Branch to Version
Control

Apply Version Control to all Packages within
a selected model branch

Ste
p

Action

1 On the 'Apply VC to Branch' dialog, click on the
drop-down arrow in the 'Version Control
Configuration' field and select the configuration to
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use.

2 Optionally, tick the checkbox 'Export as Model
Branch'.
Once the Version Control operation is complete a
Model Branch file (.EAB file) is created for this
branch.

3 Click on the OK button.
The system creates a number of sub-folders within
the Version Control working copy folder, then
exports all of the Packages within the selected model
branch. The system generates filenames for the XMI
files, based on the Package GUIDs.

Notes

The Version Control configuration to be used in this·

operation must be defined within the model before
selecting this command

When invoked on the model root node, this command·

applies Version Control to every Package within the
model
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Package Version Control Options

When you have set up a Package for Version Control, you
gain access to a range of Version Control operations that can
be performed on that Package, such as:

Open the dialog for working with baselines of the·

Package

Check-in and check-out single Packages or a selected·

hierarchy of Packages

Update Packages to the latest revision from the Version·

Control repository

Inspect the revision history or properties of the XMI file·

associated with a Package

Revert a Package to a previous revision·

Compare the current model content of a Package, against·

the latest revision of the Package in Version Control

Import and export hierarchies of Packages (model·

branches) to and from the model, through the Version
Control system

Synchronize the status of a Package, with the Version·

Control system

Access

Context Right-click on Version Controlled
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Menu Package > Package Control

Options

Option Action

Check In
Branch

Check-in Packages contained in the
currently selected model branch (that is,
the selected Package and all of its child
Packages).
The 'Select Packages to Check In' dialog
lists all Version Controlled Packages
within that branch that are checked out to
you; you can then select Packages in the
displayed list, to be submitted for
check-in.
You can also choose to keep the
Packages checked-out after committing a
new revision to Version Control.

Check Out
Branch

Recursively check out all Packages
contained within the currently selected
model branch (that is, the selected
Package and all of its child Packages)
that are Version Controlled and
checked-in.
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Check In Commit a new revision of the currently
selected Package to the Version Control
repository and lock the Package against
further editing.
Only available for Packages that you
have checked-out yourself.

Check Out Synchronize the currently selected
Package with the latest revision from the
Version Control repository and unlock
the Package to allow editing.
Only available for Packages that are not
already checked-out (and whose
associated Package file is not
checked-out).

Undo Check
Out

Restore the selected Package to the latest
revision in the Version Control repository
and lock the Package against further
editing.

Put Latest Commit a new revision of the currently
selected Package to the Version Control
system, while keeping the Package
checked-out.
This is equivalent to checking a Package
in and immediately checking it back out
again.
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Only available for Packages that you
have checked-out yourself.

Get Latest Synchronize the currently selected
Package with the latest revision from the
Version Control repository.
Available only for Packages that are
checked in.

Get All
Latest

Updates all of the Version Controlled
Packages in the project, to the latest
revision retrieved from Version Control.
Only updates Packages that are currently
checked in.
Once the latest revisions are retrieved, the
system scans all the controlled Packages
and fixes any missing cross-references by
comparing the Package with its XMI 1.1
file.
If the cross-reference information in the
XMI does not match the model, the
system updates the model with the
information from the XMI and records
this update in the System Output window.
You can roll back such updates by
selecting the entry in the System Output
window and using the context menu
option 'Rollback Update' (or 'Rollback
Selected Updates' if multiple entries are
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selected).
Closing the model clears the entries in·

the System Output window
An entry in the System Output window·

is also cleared as and when you
roll-back the update for it

Scan XMI
and
Reconcile
Model

Scan the Package XMI files associated
with each of the project's controlled
Packages and restore any diagram objects
or cross-references that are detected as
missing from the project.
This function is useful in team
environments where each user maintains
their own private copy of the model
database (that is, multiple private project
files) and model updates are propagated
through the use of controlled Packages. It
provides no benefit when the model is
hosted in a single shared database that is
accessed by all team members.
Each controlled Package is compared
with its associated XMI file and, if the
cross-reference information in the model
does not match the XMI, the system
updates the model with the information
from the XMI and records the update in
the System Output window.
You can roll back such updates by
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right-clicking on the entry in the System
Output window and selecting the
'Rollback Update' option (or 'Rollback
Selected Updates' if multiple entries are
selected).
Closing the model clears the entries in the
System Output window; an entry in the
window is also cleared as and when you
roll-back the update for it.
This functionality is invoked
automatically as part of the 'Get All
Latest' operation.
When working in an environment that
uses a Private Model deployment and
your model contains a significant number
of cross-Package references, it is
recommended that you invoke 'Scan XMI
and Reconcile Model' from time to time,
following the re-importation of controlled
Packages - for example, after using 'Get
Latest' to update a number of Packages -
or after performing a number of Package
check-outs.

As a general rule, avoid running 'Scan·

XMI and Reconcile Model' while you
have uncommitted changes in your
model; generally, you:
    - Check-out a number of Packages
    - Invoke 'Scan XMI and Reconcile
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Model'
    - Make your modifications
    - Commit any outstanding changes
before you check-out more
       Packages and run 'Scan XMI and
Reconcile Model' again

File
Properties

Display Version Control properties
pertaining to the XMI export file
associated with the currently selected
Package; this also identifies who has
checked out the Package.

File History Display change history information for
the currently selected Package.
Revert to or check-out a prior revision of
the Package.

Compare
with
Controlled
Version

Compare the currently selected Package
with the latest revision of its associated
XMI file retrieved from Version Control.

Add Branch
to Version
Control

Apply Version Control to all Packages
within a selected model branch, in a
single operation.
In this context, a model branch is a
Package that is currently selected in the
Project Browser, and all of the Packages
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contained within it.

Export as
Model
Branch

Export a newly created model branch
from your own private copy of a model.

Import a
Model
Branch

Retrieve a model branch and import it
into either the source model or another
model.

Get Package Access Packages in the Version Control
repository that are not currently available
in your model.

Re-synch
Status With
VC Provider

Update the Version Control status value
recorded for the selected Package in the
project to match the value reported by the
Version Control provider, without
performing an XMI import or export.
Use this function when the Package's
Version Control status recorded in your
project is out of synchrony with the
Version Control status reported by your
Version Control provider.

Version
Control
Settings

Display the 'Version Control Settings'
dialog.
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Notes

You set up Version Control using options from the project·

'Version Control' submenu

If the selected Package is not under Version Control, a·

different set of options is available

If a Version Control configuration has not been defined·

for the model, no options for using Version Control are
available, only the options for configuring Version
Control
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Check Out a Package

When you need to work on a Version Controlled Package,
you check it out. The local XMI file associated with the
Package is then checked-out from Version Control. No other
user can check out the Package to make changes to it until it
has been checked in again.

Access

Context
Menu

Right-click on Package > Package
Control > Check Out

Keyboard
Shortcuts

Ctrl+Alt+L

Check out a single Package

The Package file is imported into your model, and the
'Package' icon is updated to reflect the change in the
Package's Version Control status.

When working in a Private Model, if the system detects that
the Package content in the model is already up to date with
the latest revision of the Package file retrieved from Version
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Control, then the 'Import Package' dialog displays first. This
dialog is not displayed for a Shared Model.

These options are available:

Force Reload From XMI - reload the Package from XMI·

regardless of whether it is up to date or not

Accept current Package - select to skip the process of·

re-importing the Package from XMI

Refresh model view - select to refresh the Project Browser·

and diagrams, by reloading the Package content from the
project database

Always use these settings - when selected, if you·

subsequently check out a Package that is found to be up to
date, the same settings are applied again without
displaying the dialog

Notes

If you check out a Version Controlled Package whilst·

offline, the 'Package' icon has a red figure 8 in front of it

If you have selected the 'Always use these settings'·

checkbox and you want to reconfigure the 'Import
Package' dialog, press the Ctrl key whilst you select the
'Package Control | Check Out' context menu option; the
dialog displays and you can change the settings
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Undo Check Out of a Package

If you check out a Package and then decide not to proceed,
you can undo the check-out and discard any modifications
that have been made, by restoring the Package content to the
latest revision held in Version Control. The Package returns
to a checked-in state and subsequently can be checked out
by any user, including yourself if, for example, you need to
reverse incorrect changes before checking the Package out
and starting again.

Access

Context
Menu

Right-click on Package > Package
Control > Undo Check Out

Undo check out of a selected Package

A confirmation dialog displays; click on the OK button.

The latest revision of the Package is retrieved from Version
Control and re-imported into your model. The icon against
the Package in the Project Browser is updated to reflect the
change in the Package's Version Control status.
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Check In a Package

When you have finished working on the contents of a
Package under Version Control, and you want to return it to
the model for other users to see, you check it in.

Access

Context
Menu

Right-click on Package > Package
Control > Check In

Keyboard
Shortcuts

Ctrl+Alt+S

Check in a single Package

Ste
p

Action

1 The selected Package is exported and the 'Add
Comment' dialog displays. A default comment is
provided that contains the current date and time.
Optionally, modify the default check-in comment
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2 Click OK.
The Package file is checked-in to Version Control
and the Package icon is updated to reflect the change
in Version Control status.
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Check Out a Model Branch

If you need to check out a number of related Packages
involved in a particular unit of work, to update the contents,
you can do so in a single operation by checking out the
whole model branch that contains them.

Access

Context
Menu

Right-click on Package > Package
Control > Check Out Branch

Check out a sub-tree of model Packages

Ste
p

Action

1 The selected root-node Package and all of its
contained sub-Packages are recursively checked out.
Any Packages that cannot be checked-out are listed
in a message box, with a brief description of the
problem; for example: The Package is already
checked out by user 'Fred'.
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2 When Project Security is enabled in Lock to Edit
mode, Enterprise Architect prompts you to apply a
User Lock throughout the selected model branch
before proceeding.
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Check In a Model Branch

If you need to check in a number of related Packages
involved in a particular unit of work, and that you have
updated, you can do so in a single operation by checking in
the whole model branch that contains them. You can also
commit new revisions of the affected Packages as you
complete milestones, whilst keeping the Packages
checked-out for further editing.

Access

Context
Menu

Right-click on Package > Package
Control > Check In Branch

Check in Packages from within a model
branch

Ste
p

Action

1 The 'Select Packages to Check-in' dialog lists all
Version Controlled and checked-out Packages within
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the selected model branch. By default, the entire list
is selected.
Optionally:

Click an individual Package to select just that·

Package
Ctrl+click on an individual Package to add or·

remove it from the selection
Shift+click on a range of Packages to select them·

Click on the All button to select all listed Packages·

Click on the None button to clear the selection·

2 Optionally, you can commit into Version Control a
new revision of all selected Packages, while keeping
those Packages checked out for further editing. To
do this, select the 'Keep packages checked-out after
committing new revision' checkbox.

3 Click on the OK button.
The 'Add Comment' dialog displays. A default
comment is provided that contains the current date
and time. This comment is applied to all Packages
that are checked in.

4 Optionally, modify the default check-in comment.

5 Click on the OK button.
The selected Packages are exported and checked-in.
The Package icons are updated to reflect any change
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in Version Control status. If you opted to keep
Packages checked out, there is no change in status.
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Update to the Latest Revision of
Selected Package

When you are part of a team working in a Distributed Model
environment, you will want to periodically update your
model with the changes that other team members have
committed into Version Control. You can transfer the other
users' updates from Version Control into the selected
Package in the Project Browser.

Access

Context
Menu

Right-click on Package > Package
Control > Get Latest

Update Package to latest revision

The local XMI file associated with the Package is updated to
the latest revision from Version Control. The XMI file is
imported into your model database, updating the Package in
your model.

When working in a Private Model, if the system detects that
the Package content in the model is already up to date with
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the latest revision of the Package file retrieved from Version
Control, then the 'Import Package' dialog displays first. This
dialog is not displayed for a Shared Model.

These options are available:

'Force Reload From XMI' - reload the Package from XMI·

regardless of whether it is up to date or not

'Accept current Package' - select to skip the process of·

re-importing the Package from XMI

'Refresh model view' - select to refresh the Project·

Browser and diagrams, by reloading the Package content
from the project database

'Always use these settings' - when selected, if you·

subsequently check out a Package that is found to be up to
date, the same settings are applied again without
displaying the dialog

Notes

The 'Get Latest' command is disabled for any Package that·

is checked-out (to anybody) in the currently loaded
project

When using a Shared Model environment, where all users·

are connected to a single model database, you should
reload the Package from the database, rather than using
the 'Get Latest' command

If you have selected the 'Always use these settings'·

checkbox and you want to reconfigure the 'Import
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Package' dialog, press the Ctrl key whilst you select the
'Package Control | Get Latest' context menu option; the
dialog displays and you can change the settings
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Update to the Latest Revision of All
Packages

When you are part of a team working in a Distributed Model
environment, you will want to periodically update your
model with the changes that other team members have
committed into Version Control. You can transfer the other
users' updates to all Version Controlled Packages into the
currently loaded project.

Access

Context
Menu

Right-click on Package > Package
Control > Get All Latest

Update all Packages in project to latest
revision retrieved from Version Control

All the local XMI files for all the Version Control
configurations used in the project are updated to the latest
revision from Version Control. The system then scans the
Packages in the model, to determine which ones are up to
date and which are not, compared to the latest revisions of

(c) Sparx Systems 2018 Page  857 of 1073



User Guide - Model Repository 21 December, 2018

the associated Package files.

A prompt displays, providing these import options for
Packages that are up to date:

Import changed files only·

Always import·

Prompt for each file·

Click on the OK button. The Version Controlled Packages
in your project are updated according to the option you
selected; if you chose the 'Prompt for each file' option, a
prompt displays to confirm import of each file.

Notes

There is no need to re-import Packages that are already up·

to date - re-importing Packages first deletes them from the
project and then re-imports them from the XMI file,
which is time consuming as well as unnecessary; we
strongly recommend using the default option 'Import
changed files only'

The 'Get All Latest' command does not update any·

Package that is checked-out (to anybody) in the currently
loaded project; otherwise, any changes not yet committed
to Version Control would be discarded

When using a Shared Model environment, where all users·

are connected to a single model database, the information
in the model database is always the same as, or ahead of,
what is committed into Version Control; in this situation,
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the Get All Latest command will simply refresh your view
of the model database, by reloading diagrams or reloading
Package content in the Project Browser

(c) Sparx Systems 2018 Page  859 of 1073



User Guide - Model Repository 21 December, 2018

Include Other Users' Packages

Other users might be developing Packages in their own
models that you could use in your model, or you might have
other models containing Packages that you want to use in
the current model. Unless you are sharing an SQL database
or project file, those Packages are not automatically
available to you. However, if the Packages have been placed
into Version Control, you can import them into your model
as children of one of your model's Packages.

Access

Context
Menu

Right-click on Package > Package
Control > Get Package

Import Packages from Version Control into
current model

Ste
p

Action

1 On the 'Get Shared File' dialog, click on the
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drop-down arrow of the 'Version Control
Configuration' field and select the Version Control
configuration associated with the Package to
retrieve.
The file list is populated with the names of files
available through that configuration, for retrieval and
import into your model.

2 Click on the Package file to import into your model
and click on the OK button.
The Package file is imported as a new child Package,
under the parent Package you selected.

Notes

You must have access to the Package files through the·

Version Control system and you must define a Version
Control configuration through which to access those files

The Version Control configuration must use the same·

unique ID that was originally used to add the Package to
Version Control

XMI Package files associated with Packages that are·

already part of your project, are NOT included in the list
of files available for import
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Export Controlled Model Branch

Applying Version Control to a model can result in many
XMI files being placed under Version Control. It might then
be hard to locate and import the file corresponding to the
root of a particular model branch. Using Model Branch Files
(.eab files) overcomes this problem by making it easier to
export and import Package hierarchies from one model to
another.

You could export a newly created model branch from your
own private copy of a model so that, for example:

Another user can import that branch into their own private·

copy of the same model

It can be imported for inclusion as a common branch in a·

number of different models

Access

Context
Menu

Right-click on Package > Package
Control > Export as Model Branch

Create a Model Branch File to represent a
Package hierarchy stored in Version Control
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Ste
p

Action

1 On the 'Export as Model Branch' dialog, in the 'EAB
Filename' field, type a name for your Model Branch
File.
Alternatively, click on the  button and browse for
the file location.
Note that the Package name is supplied as a default.

2 Click on the OK button.
A branch file is created to represent the selected
Package. The branch file is committed to Version
Control using the same Version Control
configuration that controls the Package you selected.

Notes

You can specify any file name, including sub-folder·

names, as long as the file is contained in or below the
working folder of your Version Control configuration

The facility is only enabled for Packages that are already·

under Version Control
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Import Controlled Model Branch

Applying Version Control to a model can result in many
XMI files being placed under Version Control. It could then
be hard to locate and import the file corresponding to the
root of a particular model branch, if you want to:

Retrieve a model branch created by another user in a·

private copy of a model, to import it into your own private
copy of the same model

Retrieve a model branch that is common in many models,·

for inclusion in a new model

Model Branch Files overcome this problem by simplifying
the retrieval of Package hierarchies for use in other models.
You use Enterprise Architect's Model Branch Files, of
which there are few, to retrieve information about the root
Package file - such as the name and type of the Version
Control configuration for the selected Package, and the
relative filename of the Version Controlled XMI file
associated with the Package. The system then uses this
information to import the branch into your model.

Prerequisites

Before you begin, you must have:

An operational Version Control environment that can be·

accessed by Enterprise Architect, and

All of the Version Controlled Package files and the model·
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branch file associated with the model branch to import, in
a valid and accessible working copy folder

Access

Context
Menu

Right-click on target Package for import
> Package Control > Import a Model
Branch

Import a Model Branch

Ste
p

Action

1 On the 'Import VC Model Branch' dialog, either:
Use the lower portion of the dialog to select a·

model branch file (this is the simpler option if the
associated Version Control configuration has
already been saved in the current model; continue
to step 2)
OR
Click on the Find a Model Branch (.EAB) file·

button (this option is useful when you have not yet
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defined the Version Control configuration that is
associated with the model branch to be imported;
see the Manually Locating Model Branch Files
topic)

2 Click on the drop-down arrow in the 'Select a
Version Control Configuration' field and select a
configuration.
A list of .eab files controlled by that configuration is
displayed in the 'Select a Model Branch (.EAB) file'
list.

3 Select the Model Branch File you need, then click on
the OK button.
The system imports the root Package specified in the
Model Branch File and recursively imports and
populates all the sub-Packages contained in the root
Package.

Notes

The Import a Model Branch command is only enabled for·

Packages that you (the current user) are able to edit, as the
imported model branch is inserted into the model under
your selected Package
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Manually Locating Model Branch Files

When importing a Model Branch File from Version Control,
you might not have the associated Version Control
configuration saved in the model that is receiving the
import. In this situation, it is simpler to manually browse the
file system to locate the Model Branch File (.eab) and let
Enterprise Architect derive the details of the configuration
from the branch file you select.

Prerequisites

Before you begin, you must have:

An operational Version Control environment that can be·

accessed by Enterprise Architect, and

All of the Version Controlled Package files and the model·

branch file associated with the model branch to import, in
a valid and accessible working copy folder

Access

Context
Menu

Right-click on target Package for import
> Package Control > Import a Model
Branch : Find a Model Branch (.EAB)
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file

Locate the Model Branch File

Ste
p

Action

1 Access the 'Import VC Model Branch' dialog, then
browse for and select the Model Branch File that
represents the model branch to import.

2 Click on the Open button.
If the Version Control configuration referenced by
the file is fully defined within the current model, the
import commences at this point.
Otherwise, Enterprise Architect displays a dialog
prompting you to complete the required
configuration.

3 Click 'Yes' to proceed with completing the definition
of the Version Control configuration.
The 'Version Control Settings' dialog is displayed.

4 Complete the definition of the configuration.
(Typically this involves simply specifying the
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working copy folder.)

5 Click on the Save button.
The configuration details are saved.
The import of the model branch proceeds.

Notes

The Import a Model Branch command is only enabled for·

Packages that you (the current user) are able to edit, as the
imported model branch is inserted into the model under
your selected Package
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Review Package History

It is possible to review the change history of Version
Controlled Packages by examining previous revisions. If
necessary, you can check out one of these earlier revisions
of a Package for editing, effectively rolling-back to that
prior revision of the Package.

Access

Context
Menu

Right-click on Package > Package
Control > File History

Review change history of a
version-controlled Package

Ste
p

Action

1 For Version Control environments using Subversion,
CVS or TFS command line clients, the 'File Version
History' dialog displays.
Click on a revision number in the 'Revisions' field, to
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select that revision and view its log entry.
For Version Control environments using SCC based
clients, your particular product opens its own 'File
Version History' dialog.

2 On the 'File Version History' dialog, you can
optionally click on either:

Check Out - the selected revision of the Package·

file is retrieved from Version Control and
imported into your model as a Package that is
checked out for editing; you can subsequently
check in this revision as a new HEAD revision,
effectively allowing you to revert the Package to a
prior revision
or
Retrieve - the selected revision of the Package file·

is retrieved from Version Control and imported
into your model, but the Package remains flagged
as checked-in and cannot be modified;
subsequently checking out the Package updates it
to the latest revision before it is unlocked for
editing

Notes

If the selected Package was already checked out in the·

(c) Sparx Systems 2018 Page  873 of 1073



User Guide - Model Repository 21 December, 2018

current model, the Retrieve and Check Out buttons are
disabled

If the selected Package contains any sub-Package that is·

already checked-out in the current model, a warning will
be displayed and the retrieval or check-out will not go
ahead

If you check out a prior revision of a Package, but do not·

want to commit it as a new revision, right-click on the
Package and select Package Control | Undo Check Out
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Review Package History - SCC Client

It is possible to review the change history of Version
Controlled Packages by examining previous revisions. If
necessary, you can check out one of these earlier revisions
of a Package for editing, effectively rolling-back to that
prior revision of the Package. The process for reviewing the
change history of Packages configured for Version Control
with an SCC client (including products such as Visual
Source Safe, TFS-SCC, ClearCase, Perforce, AccuRev and
MKS Source Integrity) differs from that for Subversion,
CVS or TFS command line clients.

Access

Context
Menu

Right-click on Package > Package
Control > File History

Review change history of a
version-controlled Package (SCC client)

Ste
p

Action
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1 The change history mechanism offered by the third
party SCC provider displays.
To import a prior revision of the Package into your
model, use the 'SCC History' dialog to retrieve the
revision, then close the dialog.

2 The SCC client notifies Enterprise Architect that a
different revision has been retrieved. A prompt then
displays, asking whether you want to check-out the
prior revision.

3 Optionally, click on either:
Yes, to check out the prior revision - the selected·

revision of the Package file is retrieved from
Version Control and imported into your model as a
Package that is checked out for editing; you can
subsequently check in this revision as a new
HEAD revision, effectively reverting the Package
to the prior revision
OR
No, to import the prior revision as read-only - the·

selected revision of the Package file is retrieved
from Version Control and imported into your
model, but the Package remains flagged as
checked-in and cannot be modified; subsequently
checking out the Package updates it to the latest
revision before it is unlocked for editing
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Notes

If the selected Package was already checked out in the·

current model, the system does not proceed with
retrieving a prior revision

If you check out a prior revision of the Package, but do·

not want to commit it as a new revision, right-click on the
Package and select 'Package Control | Undo Check Out'
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Retrieve Prior Revision - SCC Client

Depending on your Version Control product, retrieving a
prior revision of a controlled Package can involve a number
of prompts regarding overwriting the current local copy.

This example details retrieval of a prior revision from a
TFS-SCC Version Control configuration.

Access

Context
Menu

Right-click on Package > Package
Control > File History

Example Procedure - retrieve prior revision,
TFS-SCC client

Ste
p

Action

1 Display the 'TFS File History' dialog.

2 Click on the Get button.
The TFS-SCC client displays the 'Resolve Conflicts'
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dialog.
This dialog offers the 'Automerge All XML Package
files' option. DO NOT select this option.
It is important to prevent any merging of Enterprise
Architect's XML Package files.

3 Click on the Resolve button.
The TFS-SCC client displays the 'Resolve writeable
file conflict' dialog.

4 Select the 'Overwrite local file/folder' option.
The existing working copy of the Package file is
overwritten by the prior revision retrieved from
Version Control.

5 Click the OK button.
The TFS-SCC client redisplays the 'Resolve
writeable file conflict' dialog; it should now show no
conflicts.

6 Click on the Close button.
The TFS-SCC client redisplays the 'File History'
dialog.

7 Click on the Close button.
Enterprise Architect displays a prompt, asking
whether to check-out the prior revision.
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8 Click on the:
Yes button to check-out the prior revision·

No button to retrieve a read-only version of the·

Package, that is NOT checked-out and is NOT
editable

(c) Sparx Systems 2018 Page  880 of 1073



User Guide - Model Repository 21 December, 2018

Validate Package Configurations

Having defined the Version Control settings for your current
model, you can test the validity of those settings associated
with each Version Controlled Package within the model.

Access

Ribbon Configure > Version Control > Check
Configuration

Validate Version Control settings

Ste
p

Action

1 The validation process scans the model database and
verifies that the Version Control configuration
associated with each Version Controlled Package is
fully specified in the current model. It also queries
the corresponding Version Control provider to find
the status of the Package file associated with each
Version Controlled Package.
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The results of the validation process are sent to the
System Output window.

2 Open the 'Version Control Settings' dialog to
complete the definition of any invalid or missing
Version Control configurations.

3 Click on an error message in the System Output
window to highlight the corresponding Package in
the Project Browser.

4 Right-click a Package node and select 'Package
Control | Configure Package' to open the 'Package
Control Options' dialog.
Correct any problems with the Version Control
details for the Package.
Correct any problems with the Package's associated
XMI file.
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Resynchronize the Status of Version
Controlled Packages

It is possible to update the Version Control status of
Packages within your project to re-synchronize with the
status reported by your Version Control provider. This can
be useful if you are creating copies of your project, where
checking in a Package from one copy of the model leaves
the Package in the second copy of the model with an
out-of-date Version Control status.

For a given Package, the re-synchronization process queries
the corresponding Version Control provider to find the
status of the Package file associated with the Version
Controlled Package. If necessary, the process then updates
the Package flags within the model database, to synchronize
the Package status recorded in the model with the value
reported by the Version Control provider.

Access

Ribbon Configure > Version Control > Re-Synch
Status (applies to all Packages in model)

Context
Menu

Right-click on Package > Package
Control > Re-synch Status With VC
Provider (applies to single Package only)
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Resynchronize Version Control status

Ste
p

Action

1 The results of the re-synchronization process are sent
to the System Output window.

2 Double-click on any result message to select, in the
Project Browser, the corresponding Package.

Notes

This process does not cause any Package data to be either·

exported from your model to the associated Package file,
or imported from a Package file into your model's
Package data

If a Package has been checked-out and modified with·

Enterprise Architect, but your Version Control provider
reports the Package file as checked-in, running this
process marks the Package within Enterprise Architect as
being checked-in, without exporting and committing the
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pending changes; subsequently checking-out the Package
imports the latest revision of the Package file from
Version Control, effectively discarding the uncommitted
modifications from the model

Similarly, if a Package file is checked-out to you in your·

local working copy folder, but not in the Enterprise
Architect model, running this process marks the Package
within the model as checked-out, but it does not import
the associated Package file from the Version Control
system; consequently, it is possible to check-in a Package
from Enterprise Architect that is potentially out of date,
compared to the latest revision of the Package file within
the Version Control system
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Tracking Changes

If you want to track changes to data across your project, you
can use two separate but complementary facilities - Auditing
and Baselines.

Facilities

Facility Detail

Auditing of
model
changes

Auditing is a project-level feature,
available in the Corporate, Unified and
Ultimate editions, that enables you to
record model changes in Enterprise
Architect.
By enabling this feature, model
administrators can view a range of
information regarding changes, such as:

Who changed an element·

How many elements they changed·

When they changed the data·

What the previous values were, and·

What type of elements they changed·

Baselining
and

The Enterprise Architect Corporate,
Unified and Ultimate editions provide a
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differencing
to capture
and roll back
changes

facility to ' baseline ' or snapshot a model
branch in XMI format at a particular
point in time, and store it within the
model in compressed format.
More than one baseline can be stored
against a single Enterprise Architect
Package; using baselines, you can
compare Packages at the current and
earlier stages of development, using the
Compare (Diff) utility.
The Compare utility is available in the
Professional, Corporate, Unified and
Ultimate editions of Enterprise Architect;
it enables you to compare the current
model with:

A Baseline·

An exported Enterprise Architect XMI·

file on disk
A version-controlled Enterprise·

Architect XMI file on disk
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Auditing

Auditing is a project-level feature that model administrators
can use to record model changes in Enterprise Architect.
After switching Auditing on, you can view information on
changes such as:

Who changed an element·

How many elements they changed·

When they changed the data·

What the previous values were, and·

What type of elements they changed·

Auditing does not record changes to:

Document Templates·

Model Documents·

Baselines or·

Profiles·

We provide a Quickstart procedure to help you enable
Auditing and see it in action, from which point you can
explore a number of set-up options and display features.

Features

Feature Detail

The Audit To view what has been recorded by the
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View audit, use the Audit View, which
provides an interface to everything
recorded by Auditing.
If security is enabled, you must have
Audit View permission to display data in
the Audit View.

Model Views You can also obtain a snapshot of
selected items in the model, using the
Model View facility.
In the Corporate, Unified or Ultimate
editions of Enterprise Architect, you can
use this facility to automatically generate
a snapshot at intervals and, if there are
changes in the items collected by the
defined search, to trigger a notification to
you of such changes.
This helps you to monitor workflow and
other events of concern to you.

Document
Report

You can generate a document report that
includes the audit history information for
the selected element or Package, by
choosing the basic + audit template.

Audit History Using Auditing, you can track changes to
an element or connector over time.
However, enabling Auditing also enables
an 'Audit History' tab in the System
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Output window, which summarizes all
changes made to the selected element or
connector.

Performance
Issues

By enabling Auditing on a project, you
increase the time taken for most actions.
For most modeling tasks, this increase is
insignificant; however, there are some
instances where the difference is more
substantial.

Notes

The Auditing facility is available in the Corporate,·

Unified and Ultimate editions

Warning - If your site runs separate editions of Enterprise·

Architect, when Auditing is turned on in a project any
Professional edition users are locked out of the project; to
restore access, turn Auditing off in the project from the
Corporate, Unified or Ultimate edition instance of
Enterprise Architect
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Auditing Quickstart

It is very simple to enable Auditing and see it in action.

Access

Ribbon Configure > Model > Audit : Audit
Settings

Enable Auditing

Ste
p

Action

1 In the 'Audit View', click on the Audit Settings
button.
The 'Audit Settings' dialog displays.

2 Select the 'Enable Auditing' checkbox.

3 Click on the OK button to close the 'Audit Settings'
dialog.
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4 Close the 'Audit View' dialog.

5 Change and save your project.
Add a new Package·

Add a new Class·

Add a new connector·

Change the name of an element·

Delete an element·

6 Open the Audit View again and click on the Refresh
(or Load) button to display a record of the changes
you have made.
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Auditing Settings

Using the 'Audit Settings' dialog, you can change what is
recorded by the Auditing facility and:

Define the areas of processing in Enterprise Architect to·

audit

Administer your audit records·

Indicate the kind of model objects for which changes are·

to be recorded

Configure Auditing to record changes to only certain·

types of elements

Access

Ribbon Configure > Model > Audit : Audit
Settings

Configure Settings

Option Action

Enable Select this checkbox to turn the Auditing
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Auditing facility on.

Audit XMI
Import

Select this checkbox to record changes
arising from XMI importing in the audit.
As Version Control uses XMI, you must
select this option to record changes from
checking out Packages.

Audit XMI
Export

Select this checkbox to record changes
arising from XMI exporting in the audit.
As Version Control uses XMI, you must
select this option to record changes from
checking out Packages.

Audit
Reverse
Engineering

Select this checkbox to record changes
arising from reverse engineering in the
audit.

Use Database
Timestamp

Select this checkbox to use the database
server's timestamp instead of each user's
local timestamp; this improves security.
This option is not available for project
files.

Clear Logs Click on this button to permanently delete
all log data from the current project; use
the Save Logs button first, to save the
audit records outside the project.
The system prompts you to specify
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whether to clear items logged over a
specific period of time.

Click on the No button to clear all log·

items currently held in the database
Click on the Yes button to display the·

'Time Filter' dialog, on which you
select a standard time period or define
your own

This function can be accessed through the
Automation Interface.

Save Logs Click on this button to save a copy of the
logged audit items currently held in the
project. These items remain in the
project; you can use the Clear Logs
button to remove them.
The system prompts you to specify
whether to save items logged over a
specific period of time.

Click on the No button to save all log·

items currently held in the database
Click on the Yes button to display the·

'Time Filter' dialog, on which you
select a standard time period or define
your own

This function can be accessed through the
Automation Interface.
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Load Logs Click on this button to load a previously
saved set of logs back into the project. A
browser displays through which you
select the log file to reload.
If the same record exists in both project
and log file, that record is not reloaded.

Core Select this radio button to record changes
to elements (including attributes and
operations), Packages, connectors and
some model-level information.

Standard Select this radio button to record the
same changes as for the Core option, plus
changes to some of the 'housekeeping'
data for diagrams - Name, Author,
Version, Stereotype, Notes and Date
Modified.
You can check for changes to diagram
content and structure using the Baseline
facility for reviewing visual changes to
diagrams.

Extended Select this radio button to record the
same changes as for the 'Standard' option,
plus changes to project security.

Debug Select this radio button to record the
same changes as for the 'Extended' option
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plus changes to any database tables.
Some of the auditing information will not
be visible unless the Audit View mode is
set to 'Raw'.

Maintenance Select this radio button to audit changes
to maintenance elements only; that is:

Package (element)·

Requirement·

Feature·

Use Case·

Actor·

Note·

Issue and·

Change·

Core
Structural

Select this radio button to audit changes
to maintenance elements plus certain
structural elements; that is:

Package (structure)·

Class·

Interface·

Signal·

Node·

Component·

Artifact·

Part·
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Port and·

Device·

All Select this radio button to audit changes
to all types of element.

Custom Select this radio button to audit changes
to element types that you specify.
The Customize button is made available;
click on this button to display a list of
element types, and select the checkbox
against each element type to include in
the audit (or click on the Select All button
to select every element type).
Click on the OK button to save the
selection.

Notes

As the number of records increases, the performance of·

the Audit View reduces; it is recommended that audit
records that are not regularly required are saved to file,
then cleared from the project, to help ensure high
performance

Connectors are audited when they are connected to an·

element that is included in the Audit Options
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If security is enabled, you must have Audit View·

permission to turn Auditing on, and Audit Settings
permission to change the audit settings
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The Audit View

The Audit View provides an interface to the information
that has been recorded by auditing.

Access

Ribbon Configure > Model > Audit

Sections of the Audit View

The Audit View is divided into three main areas:

Section Description

View
controls

The view controls provide a variety of
settings for controlling auditing and the
display of audit records.

Audit tree The audit tree displays the log items that
have been recorded by auditing.
What is displayed in the tree is affected
by the view controls, such as:

Sorting·
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Filter (by time)·

Mode·

Auditing settings (what was actually·

recorded)
If synchronizing with the Project
Browser, it is also affected by the
Package, diagram or element you have
selected.

In the audit tree:
The green tick indicates a creation·

The yellow pencil indicates an edit·

The red cross indicates a deletion·

Right-clicking an element in the audit
tree (such as MyClass) displays a context
menu that enables you to locate the
selected element in:

The Project Browser·

Any diagrams in which it exists·

Record
display

The record display is in two parts: the
identity of the selected change, and the
actual change made.
The data in the record display is
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determined by the view controls and
mode and, if synchronizing with the
Project Browser, by the Package, diagram
or element you have selected.

Identity

The identity of a change consists of:
The Windows username of the user that·

made the change; if security is enabled,
the name is of the format
WindowsUsername(SecurityUser)
When the change was made·

The path of the change; for example:·

Class Class1 - Attribute Att1 -
Attribute Constraint Constraint

Changes
Changes are displayed in a table format,
showing the:

Property (or data item) name·

Its original value before the change and·

Its value after the change·

If you double-click on an item in the list
of changes (or right-click and select the
'Show Differences' option) the Difference
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window displays:

This shows the specific changes that have
been made, highlighting the edited,
created, deleted or formatted characters.
Changes to the format of text in the
element, made through the element
'Properties' dialog, are not apparent in the
initial table; they are visible in the
Difference window, identified by HTML
formatting tags.

Notes

If security is enabled, you must have Audit View·

permission to display data in the Audit View

(c) Sparx Systems 2018 Page  903 of 1073



User Guide - Model Repository 21 December, 2018

Audit View Controls

The Audit View controls provide a variety of settings for
controlling auditing and the display of audit records.

Options

Option Action

Load or
Refresh

Click to reload the Audit Tree, updated
with any new audit results.

Search Click to search through log items for a
particular area - you can search by Name,
Type or GUID.
The items are loaded and filtered with the
current Sort By, Time Filter and Mode
settings.
If you refresh the Audit View, you must
run the search again.

Audit
Settings

Click to open the 'Audit Settings' dialog.

Sort-by Select the appropriate radio button for the
required display setting:

Type - changes are grouped under·
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element type (such as Class or
Requirement), and then grouped under
the changed element

User - changes are grouped under user·

name, each with the number of changes
for that user

Under each user name, changes are
grouped as for the Type sort

Filter By
Date/Time

Select to enable the Filter Settings button,
to filter the audit results by time period.
Changes that occur outside the selected
filter period are not shown in the Audit
View.

Filter
Settings

Click to display the 'Time Filter' dialog,
to set the filter time period:

Today - to display changes occurring·

today
Previous Hour - to display changes·
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occurring in the last 60 minutes
Previous 24 Hours - to display changes·

occurring in the last 24 hours
Previous Week - to display changes·

occurring in the last 7 days
Previous 30 Days - to display changes·

occurring in the last 30 days
Previous Year - to display changes·

occurring in the last 365 days
Custom - to define your own time·

period, using the From and To fields
The six pre-configured time periods
automatically update when you click on
the Refresh button; custom periods are
static and do not automatically update.
If you have set a filter period, and you
deselect the 'Filter By Date/Time'
checkbox, the period remains set; the
custom time period, too, is retained so
that you can re-use it or modify it later if
required.

Status Text Read to see which:
Mode has been selected and·

Time filter is being applied to the data·

Mode Click to display a menu of options to
change the mode of the Audit View.
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Select:
'Standard' - to automatically·

synchronize with the Project Browser;
where changes have been made, the
Audit View reflects your selection
from the Project Browser - if you click
on:
    - An element, the Audit View
displays the history for that element
    - A Package, the Audit View
displays the history for that Package
       and its immediate children (but not
the contents of nested Packages)
    - A diagram, the Audit View
displays the history for that diagram
and
       its contents (which could be drawn
from a wide area of the Project
       Browser)
'Advanced' - to load large sets of log·

items independent of the Project
Browser; in this mode, a special Audit
Settings group can be displayed in the
Audit Tree, which records:
    - When Auditing has been enabled
and disabled
    - Who made the change
    - The date and time of the change
    - Changes to the Audit Settings
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    - When Audit Operations are
executed
    - Security changes (which can be
browsed in the same way as
       other changes)
'Deleted' - to display only deleted·

records, but otherwise data is shown as
in 'Advanced' mode; records can be
sorted by element type or by user as
required
'Raw' - to display all audit records in·

chronological order without sorting,
enabling you to see a progression of
changes; this can be especially useful
in determining date-time
inconsistencies
Any search and filtering you define still
apply, enabling you to view all of
today’s changes in order, or all changes
for a particular element in order, or
both
Additional database information is
displayed; this additional information
might be insignificant or only in
machine-readable format
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Audit History Tab

When Auditing is turned on, an 'Audit History' tab is
enabled in the System Output window. The tab shows a
history of changes to whichever element or connector you
have selected in the:

Current diagram·

Project Browser·

Audit View, or·

Package Browser·

As you select different elements or connectors, the 'Audit
History' tab automatically updates to reflect your current
selection. For each change made to the element or
connector, the tab shows:

Who made the change·

When the change was made·

Where the change was made·

The value of the characteristic before the change·

The value of the characteristic after the change·

Access

Ribbon Start > Explore > Browse > System
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Output > Audit History

Notes

To see this tab, you must have the Audit View open; the·

tab continues to display if you subsequently close the
Audit View

If security is enabled, you must have Audit View·

permission to display data on the 'Audit History' tab
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Auditing Performance Issues

Enabling auditing on a project increases the time taken for
most actions.

For most modeling tasks, this increase is insignificant;
however, there are some situations where the difference is
more substantial.

Operation Delays

Operation Detail

Large
Deletions

Deleting large Packages or Package
structures, or large numbers of elements,
takes significantly longer with auditing
on.
You might disable auditing before
performing such a deletion.

XMI Imports Importing XMI takes longer with auditing
enabled.
A project-level option is provided for
disabling auditing of XMI Imports.

Reverse
Engineering

Reverse engineering code takes longer
with auditing enabled.
A project-level option is provided for
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disabling auditing of reverse engineering.

Replication You cannot remove replication from a
model with Auditing enabled.
If you have to remove replication, disable
Auditing and - if prompted to do so -
allow Enterprise Architect to roll back the
database version; you can then remove
replication.
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Audit View Performance Issues

The Audit View can cause slow performance, generally
because of the volume of records it has to process.

Considerations and Responses

Consideratio
n

Detail

Navigating
the Project
Browser
Within
Auditing is
Slow

Try setting the time filter to a period in
the immediate past, such as 'Today',
'Previous 24 Hours' or 'Previous Week';
this time period updates each time you
open or refresh the Audit View.
Save log items outside the project with
the Save Logs button; if you then clear
the logs you have just saved, the load
time of the Audit View is reduced.
You can reload logs into the project at
any time, using the Load Logs button.

The Audit
View is Slow
in Loading
and
Changing

Try setting the time filter to a period in
the immediate past, such as 'Today',
'Previous 24 Hours' or 'Previous Week';
this time period updates each time you
open or refresh the Audit View.
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Modes Save log items outside the project with
the Save Logs button; if you then clear
the logs you have just saved, the load
time of the Audit View is reduced.
You can reload logs into the project at
any time, using the Load Logs button.

Navigating
the Audit
Tree is Slow

Close the 'Audit History' tab in the
System Output window
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Package Baselines

Enterprise Architect includes tools to help you manage and
review changes to your models over time. These tools apply
the concepts of Baselines, Differencing and Merges.

You use Baselines, Differencing and Merges essentially to
compare two snapshots of a specific part of your project, to
capture the differences between them and either roll back or
incorporate selected changes or all changes.

Baselines

Enterprise Architect provides a facility to create a Baseline
or 'snapshot' of the contents of a selected Package and its
child Packages at a particular point in time; this enables you
to later compare that branch of the model at that time with
the current state of the branch.

Baselines are stored in the same XML format as is used for
Version Control, but are stored within the project in
compressed format.

You can also have parallel copies of parts of your model for
team development, and create Baselines within each copy to
merge changes into the project master.

Differencing
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Differencing (Diff, or Compare) helps you to explore the
differences between:

The current state of a specific part of your project, and·

Previous or parallel versions captured in a Baseline or an·

XMI 1.1 file on disk

Merges

Once Differencing is complete, you can merge information
from the Baseline into the current project; it is not possible
to go the other way.

You can:

Merge information manually, change by change·

Merge information automatically by electing to merge in·

all changes in one batch procedure

Revert completely to the original Baseline by importing·

the stored XMI directly

Merge information and elements from a Baseline in a·

different project, making it possible to keep multiple
versions of a single model in synch

The merge options are available through the toolbar, context
menus and the keyboard on the 'Compare Utility' tab, which
shows the results of a comparison.

Visual differences in diagrams
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Changes to a model might include:

Adding or removing elements and connectors on a·

diagram, or

Changing the position of elements or the overall layout of·

a diagram

You might believe that a diagram has changed, and select to
compare it with a baseline using a ribbon option.
Alternatively, you might perform a baseline comparison on
a Package or a model and select from the comparison output
any diagrams that are flagged as changed.

Notes

Package Baseline facilities are available in the Corporate,·

Unified and Ultimate editions of Enterprise Architect

The Enterprise Architect Corporate, Unified and Ultimate·

editions provide another facility, Auditing, which you can
switch on to perform continuous monitoring of changes
across the project; you can dovetail your use of each
facility to meet the range of your change management
requirements

If a Package under Version Control forms part of a·

Baseline, and that Package is checked in to the model, you
cannot merge the original data from the Baseline into that
Package

You can also obtain a snapshot of selected items in the·
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model, using the Model Views facility; this facility
enables you to automatically generate the snapshot at
intervals and, if there are changes in the items collected
by the defined search, to trigger a notification to you of
such changes, which enables you to monitor workflow
and other events of concern to you

If security is enabled you must have 'Baselines - Manage'·

permission to create, import and delete Baselines, and
'Baselines - Restore' permission to merge data from a
Baseline; security permissions are not required to select
an existing Baseline and perform a comparison with the
model
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Baselines

Enterprise Architect provides a facility to 'Baseline'
(snapshot) a model branch at a particular point in time for
later comparison with the current Package state.

Baselines

Baseline comparison is most useful for determining the
changes made to the model during development compared
to some Baseline saved at a crucial point - for example the
completion of a phase or version iteration.

More than one Baseline can be stored against a single
Enterprise Architect Package.

Baselines are particularly useful during requirements
management to check for changes, additions and deletions
that have occurred since the start of the current work phase;
knowing how a model has changed is an important part of
managing change and the overall development process.

Baselines are stored within the model in compressed XML
format; you can save a Baseline to an external XML file for
storage or archive, or for distributing to other users working
on models derived from a master project.

Baselines are generally used in conjunction with the
Compare utility.
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Scenario

A typical scenario for using Baselines would be:

Create the base model branch to a sufficient point to·

create a Baseline (checkpoint); create and store the
Baseline as Version 0.1a

As work continues on development, managers and·

developers can check the current model branch against the
Baseline for important modifications, additions and
deletions; the Compare utility can be invoked from the
Baseline dialog to check the current model branch against
the stored version

As required, minor Baselines can be created to check·

recent progress; these 'temporary Baselines' are useful for
managing change when a lot of work is being done and it
is important to only see what has changed in, for example,
the last 24 hours

At sign-off or the move to a new version/phase, a major
Baseline can be created to capture the new state of the
model.

Minor Baselines created earlier can be deleted if required to
save space

Considerations

Baselines are based on the GUID or unique ID of a
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particular Package:

Enterprise Architect checks for that ID as the root element·

within the XML document being used as a Baseline

When you export a Package to XML, the Package you·

export is the root element; likewise when you create a
Baseline, the current Package is the root Package of the
XML Baseline

When you save information in a Version Control system,·

the current Version Controlled Package is again the root
Package of the document

It is not useful to create a Baseline by importing an XMI·

Package file created by Version Controlling a Package
that itself contains Version Controlled child Packages;
that type of XMI Package file contains stubs for the child
Packages, not full information on the child Packages and
elements

If a Package under Version Control forms part of a·

Baseline, and that Package is checked in to the model, you
cannot merge the original data from the Baseline into that
Package

XML files must be in the same format used by the Baseline
engine - currently the UML 1.3 XMI 1.1 format (plus
Enterprise Architect extensions), which contains all the
information necessary to reconstruct a UML model, even a
UML 2.x model

Notes
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The Baseline facility is available in the Corporate, Unified·

and Ultimate editions of Enterprise Architect

The Compare utility is available in the Professional·

edition of Enterprise Architect, as well as in the Corporate
and extended editions
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Manage Baselines

Enterprise Architect provides a range of facilities for
working with and managing Baselines.

Access

Ribbon Design > Package > Edit > Manage
Baselines > Manage Baselines

Keyboard
Shortcuts

Ctrl+Alt+B

Baseline Management

Create, select and process Baselines using the 'Package
Baselines' dialog.

Option Action

Current
Baselines For
Package:
<Name>

Review the Baselines for the current
model branch, listed by version reference
with the highest alphabetical/numerical
value at the top.
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If an entry is longer than the display area,
a horizontal scroll bar displays at the
bottom of the panel; use this to scroll to
the text that is not shown.

Show
Differences

Run the Compare utility on the selected
Baseline and the current model branch or
diagram, to display the differences
between the two.

Restore to
Baseline

Completely restore the model branch
from the selected Baseline.

New
Baseline

Create a new Baseline.

Delete
Selected

Delete the selected Baseline.

Load Other
Baselines

Display a drop-down menu that enables
you to load Baselines from another
model, in either a project file or a DBMS
repository.

For project files, a browser displays;·

locate the required project file
For DBMS repositories, the Windows·

'Data Link Properties' dialog displays;
select the data provider and click on the
OK button to display the 'Select Data
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Source' dialog, from which you select
the required project

In either case, the Connected To:
message at the bottom of the 'Package
Baselines' dialog changes to the name of
the alternative model.
To return the dialog to the original
project, select the third option on the drop
down list: 'Load From Selected Package'.

Import File Import an XML 1.1 file from the file
system as a new Baseline for this current
model branch.

Export File Export the selected Baseline to an XML
file on disk.

Compare
Model to File

Compare the selected model branch with
an XML 1.1 file on disk; a browser
displays, which you use to locate the file.

Options Set filters to make the comparison more
specific.

Notes
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Package Baseline facilities are available in the Corporate,·

Unified and Ultimate editions of Enterprise Architect
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Create Baselines

This topic details the basics of creating new Baselines of
Model Packages.

Access

Select a Package in the Project Browser, then open the
'Baselines' dialog using one of the methods outlined here.

In the 'Baselines' dialog, click on the New Baseline button.

Ribbon Design > Package > Edit > Manage
Baselines > Manage Baselines : New
Baseline

Keyboard
Shortcuts

Ctrl+Alt+B : New Baseline

Create a new baseline

Field Action

Name Display the Package name of the
currently selected model branch.
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Version Type a unique version reference for this
Baseline, which can consist of any
alphanumeric characters.
The 'Package Baselines' dialog sorts the
Baselines according to the value of this
field.

Include
Sub-packages

Include the entire sub-Package hierarchy
of this branch in the Baseline; this option
defaults to selected.
If you deselect the checkbox, only the
immediate contents (XMI stubs) of the
Package are included in the Baseline.

Note Edit the default current time and date to
any other value.
The field is a single-line entry, for display
on the 'Package Baselines' dialog (a
one-line-per-entry list).

OK Click to create a new Baseline and return
to the 'Package Baselines' dialog.

Notes

(c) Sparx Systems 2018 Page  928 of 1073



User Guide - Model Repository 21 December, 2018

Package Baseline facilities are available in the Corporate,·

Unified and Ultimate editions of Enterprise Architect
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The Compare Utility (Diff)

Enterprise Architect has a comprehensive and powerful built
in Compare (diff) utility, which enables you to:

Explore what has changed within a model over time·

Explore how previous versions of a model branch differ·

from what is currently in the model

Perform a full model comparison by exporting all of·

Model A to XMI, then using 'Compare Model to File'
from within the current model (Model B)

Comparing and checking model development at various
points in the process is an important aspect of managing
change and development, monitoring what is being modified
and ensuring the development and design process is on
track.

Using the Compare Utility you can:

Compare a model branch in Enterprise Architect with a·

Baseline created using the Baseline functionality
(Corporate, Unified and Ultimate editions)

Compare a model branch in Enterprise Architect with a·

Baseline stored in a different model

Compare a model branch in Enterprise Architect with an·

XML 1.1 file on disk created previously using the
Enterprise Architect XML export facility (user selects
file)

Compare a model branch in Enterprise Architect with the·

current version-controlled XMI 1.1 file on disk as created
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when using Version Control in Enterprise Architect (file
automatically selected)

Access

Select a Package in the Project Browser, then open the
'Baselines' dialog using one of the methods outlined here.

In the 'Baselines' dialog, click on the Show Differences
button.

Ribbon Publish > Model Exchange > Package
Control > Compare Package to XMI

Keyboard
Shortcuts

Ctrl+Alt+B : Show Differences

Differencing With Baselines

As a Baseline is stored within a model and contains all the
information, elements and connections for a Package at a
point in time, it can be used within Enterprise Architect to
track changes to model elements over time.

The Differencing engine first builds a representation of the
current Package in memory, based on what is currently in
the model.
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It then compares this with the stored Baseline, highlighting
changes, new elements, missing elements and elements that
have been moved to other Packages.

It is possible to filter the resultant output to display only one
particular kind of change: for example, additions to the
model.

If a Baseline has been created to ignore child Package
content, a comparison between that Baseline and the model
does not include any child Package content in the model.

See the Example comparison.

Notes

This utility is available in the Professional, Corporate,·

Unified and Ultimate editions of Enterprise Architect

You cannot compare the current model with an XMI 2.1·

file; the utility can only compare with an XMI 1.1 file
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Compare Options

You use the 'Compare Options' dialog to refine the output of
the Compare utility when it compares the current model
with a Baseline.

To display the dialog, either:

Click on the Options button on the 'Package Baselines'·

dialog, or

Click on the 'Compare Options' icon on the 'Compare·

Utility' tab toolbar

If the 'Compare Utility' tab shows the results of a Baseline
comparison, when you click on the OK button the display
refreshes to refine the information according to the options
you have selected.

Options

Option Action

Always
Expand to
Differences

Always display the list of elements fully
expanded to show changes.
If you deselect the checkbox, when the
'Compare Utility' tab is first opened it
lists the Package contents to element
level, and you expand each element as
required to show the changed items.
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For large branches of the model, it is
better to leave the checkbox unselected.

Show
Elements that
are

List elements that:
Have been changed since the Baseline·

was created
Are in the Baseline only (that is, have·

been deleted from the model since the
Baseline was created)
Are in the model only (that is, have·

been created since the Baseline was
created)
Have not changed since the Baseline·

was created (you might generally leave
this checkbox unselected)

Suppress
these
Changes

Exclude:
Changes to diagrams·

Changes to the 'Date Modified' field for·

an item
Changes to the 'Date Created' field for·

an item
Child items of a deleted item·

Changes to advanced properties·

(defaults to selected)

Baseline
Diagram

Select the checkbox to always open the
first parent Package for which there is a
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Compare
Options

Baseline, when you select the diagram for
comparison from the Project Browser.

Notes

Package Baseline facilities are available in the Corporate,·

Unified and Ultimate editions of Enterprise Architect
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Check Visual Changes to Diagrams

The Baseline Diagram Compare feature is a quick and easy
way to visually compare a current diagram with an earlier
version from a saved Baseline, and highlight any elements
in the diagram that have been added, deleted, resized or
moved.

You can then review these changes and optionally roll back
each change if needed to its previous state from the
Baseline.

The changes are identified on the 'Baseline Diagram
Compare' dialog and on the diagram itself. If the diagram is
not already open, the compare feature also opens the
diagram.

Access

Ribbon Layout > Diagram > Manage > Compare
to Baseline
Design > Diagram > Edit > Advanced >
Compare to Baseline

Processing
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In two of these access paths, you perform a comparison of a
Package and Baseline, and then select the diagram from the
results on the 'Baseline Comparison' dialog to display the
'Baseline Diagram Compare' dialog. Refer to the Results
section and the Options table.

In the other access paths, you first select the diagram to
check, and then might have the option of selecting the
Package from which to use a Baseline, on the 'Load
Baselines from Package' dialog.

This dialog displays if you have NOT selected the:

'Always open first parent with a Baseline' checkbox on the·

dialog itself or

'Baseline Diagram Compare Options' checkbox on the·

'Compare Options' dialog
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(Selecting or clearing one of these checkboxes resets the
other one as well.)

When you create a Baseline, it can be for a Package that
contains one or more levels of child Package, and you might
create Baselines for the Package(s) at each level. If the
diagram you are checking is at a lower level in the
hierarchy, there might therefore be a number of Baselines
that contain information on the diagram, perhaps taken at
different times and capturing different changes to the
diagram. The 'Load Baselines from Package' dialog provides
the facility to compare the diagram with one of a broader
range of Baselines than just those from the diagram's
immediate parent.

Click on the Package, and click on the OK button. In this
case, or if the dialog did not display at all (the checkboxes
were selected), the 'Baselines dialog displays.

Click on the required Baseline and on the Show Differences
button. The 'Baseline Diagram Compare' dialog displays.
Refer to the Results section and the Options table.

Results

The 'Baseline Diagram Compare' dialog shows the elements
that have been changed on the diagram, and what kind of
change was made ('Status' field).
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As you select elements on the dialog, images are shown on
the diagram itself to indicate where the changed element
was and what kind of change it underwent.

Options

Option Detail

Select (click
on) name of
element

The 'Status' column indicates whether the
element has been:

Moved or re-sized (Changed)·

Deleted from the diagram (Baseline·

only)
Added to the diagram since the·

Baseline was captured (Model only), or
Deleted from its parent external·
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Package, and there is no record in the
current Baseline (because the Baseline
is only for the current diagram's parent
Package)
This diagram-linked element has been
deleted from the model. The element
might be found in a different baseline
either in a parent Package baseline or a
different Package baseline outside of
the current Package. If the external
referenced element is restored to the
model, the visual comparison will be
able to resolve the missing diagram
object in the current baseline.

When an item is selected, the
corresponding element on the diagram is
highlighted as shown:

Deleted from the diagram·

Added to the diagram·
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Resized or moved to a new position·

A deleted external element on the·

diagram

The highlighted element on the diagram
is marked with a colored dot, as shown,
to indicate that it is in focus.

Position the
diagram to
show the
selected
element

To scroll the diagram so that you can see
the original (Baseline) position of an
element, double-click on the item in the
list.
To scroll the diagram so that you can see
the current (model) position of the
element, press and hold Ctrl while you
double-click on the item.

Leave the
changes in
the item as

Ensure that the checkbox against the item
is not selected.
Click on the OK button.
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they are

Roll the
changes back
to the
Baseline
position

Click on the checkbox against each
required item (or click on the Check All
button to select every item).
The 'Action' column displays the action
required to roll each element's
relationship to the diagram back to the
Baseline relationship, and on the diagram
the selected elements are represented as
shown:

This deleted element will be restored·

This added element will be removed·

This resized/repositioned element will·

be put back in its original position
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This element from another Package,·

deleted from the diagram, cannot be
restored from this Baseline

The comparison automatically shows a
blue direction arrow for each reposition
or resize that has been checked. For a
heavily edited diagram this might be
confusing. However, you can hide the
arrow for all elements except the one
currently in focus; to do this:

Deselect the 'Visually link new and old·

position for checked items' checkbox
To roll back the changes for all items for
which a checkbox is selected:

Click on the Apply button·

Notes

Diagram Baseline facilities are available in the Corporate,·

Unified and Ultimate editions of Enterprise Architect
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Example Comparison

This diagram shows the result of a comparison between a
Package (Log in/out Use Cases) in the current project and
that Package in a Baseline captured at an earlier date.

The results of the comparison are displayed on the 'Baseline
Comparison' tab.

Review Changes

Aspect Description

Interpretation A hierarchy of model elements is
displayed in the left-hand pane.
From the triangle-based icons and the
highlighted lines on the report, it is
clearly visible which items in the
hierarchy have, since the Baseline was
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captured, been:
Changed·

Deleted from the model (in the·

Baseline only)
Added to the model (in the Model·

only) or
Switched to different Packages·

(changes in the Parent Package
property)

If you click on an item in the left hand
pane, the right-hand pane displays a table
of properties showing the values of those
properties in the current model and in the
Baseline.
For each property where there is a
difference between the model and the
Baseline, the row is highlighted.
The 'Compare Utility' tab enables you to
perform operations (such as merging or
rolling back changes) on the reported
information, using the toolbar, context
menu and keyboard.

Increase
Level of
Detail

The right panel of the 'Compare Utility'
tab might, for some fields, display only
part of the value.
It might also not be immediately obvious
what a change is.
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In either case, you can double-click on
the property to display full details and to
highlight the exact differences; this
example shows the highlighted changes
to the 'Name' property.

Notes

The Compare utility is available in the Professional,·

Corporate, Unified and Ultimate editions of Enterprise
Architect
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Baseline Comparison Tab Options

The 'Baseline Comparison' tab enables you to perform
operations on the reported information, using the toolbar,
context menu, 'Merge' dialog and certain keyboard keys.

The toolbar is at the top of the left-hand panel; the icons·

operate either on the comparison as a whole or on the
currently-selected item in the left hand panel of the
'Baseline Comparison' tab

Each item in the hierarchy has a context menu, which you·

display by right-clicking on the item; the options
displayed depend on the level of the item in the hierarchy

The 'Merge' dialog enables you to specify which changes·

to roll back in the model from the baseline

You can use a selection of keyboard keys to move up and·

down the hierarchy, or to roll back changes

Toolbar Options

Option Action

Refresh Re-run the comparison to refresh the
current display.

Merge To Merge the values of the
currently-selected item in the Baseline
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Model back into the model.

Next Change Highlight the next changed item (this
skips Moved items).

Previous
Change

Highlight the previously-changed item.

Expand All Fully expand the selected item.

Collapse All Collapse the changed items in the
selected item.

Expand To
Changed
Items

Expand the selected item to show
changed items only (in the event that you
have selected to also show unchanged
items in the comparison).

Find in
Project
Browser

Highlight the item in the Project Browser.

Log To XML Log the changes to an XML file.
A browser displays, on which you specify
the file name and location.

Compare
Options

Display the 'Compare Options' dialog.
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Manage
Package
Baselines

Display the 'Package Baselines' dialog.

Help Display the Help topic Package
Baselines.

Context Menu Options

Option Action

Merge from
Baseline
Add from
Baseline

Restore the item in the model to the
Baseline state, or restore a deleted item
from the Baseline.

Delete from
Model

Remove a recently-created item from the
model.

Merge From
Baseline
(with
Options)

(For the root node of the hierarchy on the
'Compare Utility' tab.)
Display the 'Merge' dialog, which you
can use to specify options for rolling back
the whole model branch to the Baseline
state.
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Refresh (Object-level items.)
Re-run the comparison to refresh the
current display.

Find in
Project
Browser

Locate and highlight the item in the
Project Browser.

Open
Baseline
Diagram
Compare

(For a diagram listed in the comparison.)
Display the Baseline Diagram Compare
window, showing differences in diagram
content and layout.

Expand All Fully expand the selected item.

Expand To
Changed
Items

Expand the selected item to show
changed items only.

Collapse All Collapse the changed items in the
selected item.

Log To XML Log the changes to an XML file.
A browser displays, on which you specify
the file name and location.

Compare
Options

Display the 'Compare Options' dialog.
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Merge Dialog Options

Option Action

Changed Restore all changed items in the model
branch to the Baseline state.

In Baseline
Only

Restore all deleted items to the model
branch from the Baseline.

In Model
Only

Remove all recently-created items from
the model branch.

Moved Restore all moved items to their original
locations, as identified in the Baseline.

Full Restore
from XMI

Completely restore the model branch to
the version held in the Baseline XMI 1.1
file, (using the 'XMI Import' function).
(This option automatically selects all the
other options)
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Keyboard Keys

Ctrl+ ↓ - expand and highlight the next changed item·

Ctrl+ ↑ - expand and highlight the previous changed item·

Ctrl+ ← - undo the changes for a selected item (roll back·

to the Baseline values)
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Compare Projects

A number of operations can make changes to your project
that you either want to monitor carefully or not have at all.
Such events include:

Recovering from a database crash·

Restoring a backup·

Performing a Project Data Transfer·

Importing from XMI, and·

Deleting model elements·

You might have made a copy of the original project or the
purpose of the operation is to generate a copy, in which case
you can compare the size and row counts of the 'before' and
'after' copies as a convenient 'sanity check'. The copies can
be on different platforms; you have options to:

Compare a project file to another project file·

Compare a project file to a DBMS-based repository·

Compare two DBMS repositories·

The comparison examines the number of project rows in
each database, producing a report indicating the total
records in each and the difference in record count between
the two. If discrepancies are found, you must investigate
further manually. The comparison does not examine the
actual data in the tables.

Access
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Ribbon Configure > Model > Integrity Check >
Project Compare

Compare two projects

Ste
p

Action

1 On the 'Project Compare' dialog, select the radio
button for the database types of the two projects you
want to compare:

File to File·

DBMS to File·

File to DBMS·

DBMS to DBMS·

2 In the 'Source Project' and 'Target Project' fields,
type the name or connection string for the source and
target projects to compare.

3 Click on the Compare Projects button.
The results of the comparison display in the panel at
the bottom of the dialog.
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4 If you want to print the results of the comparison,
click on the Print List button.
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Project Maintenance

The repository is an important data store that must be
maintained to ensure that it is running efficiently and that
the information it contains has integrity. Enterprise
Architect has built-in features that allow you to keep the
repository in good health. These include tools to maintain
the database itself, such as Repair and Compact functions
(for file based repositories), and a series of tools to manage
the data and models, such as model validation and data
integrity checks. Reference data can be imported and
exported from the repository, and can be shared between
repositories, ensuring consistency. The Project Browser
allows repositories to be refactored easily by dragging and
dropping Packages, elements, features and diagrams to new
locations. The Element Discussion and Team Library
features allow the model to be critically analyzed and
reviewed.

Facilities

Facility Detail

Check the If you have a failed XMI import, network
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integrity of
the data in a
project

crash or other unforeseen event that could
disrupt the integrity of information in the
model, it is recommended that you run a
Project Integrity Check.

Reset Auto
Increment
Columns in
Tables

XMI Import/Export can affect the table
auto increment column values and push
them towards the maximum datatype
value; you can re-sequence the columns
to avoid this problem.

Upgrade an
old project to
enable use of
new features

The structure of Enterprise Architect
project files is occasionally changed to
support more features; when this
happens, existing project files must be
upgraded to the new format to ensure
correct operation and to take advantage of
all the new features.

Rename a
project

If you want to rename an Enterprise
Architect project, you can do so through
Windows Explorer.

Compact a
project

After some time, a project .EAP file
might benefit from compacting to
conserve space.

Repair a
project if it

If a project has not been closed properly,
such as during system or network
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did not close
properly

outages, on rare occasions the .EAP file
does not re-open correctly.

Notes

You only rename, compact and repair models created as·

.eap files; these processes are not required for models
stored in a DBMS
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Check Project Data Integrity

If you have a failed XMI import, network crash or other
unforeseen event that could disrupt the integrity of
information in the model, it is recommended that you run
the Project Integrity Check function to check that your
project data is structurally complete.

You can select a variety of items to check. The integrity
check examines all database records and ensures there are
no 'orphaned' records or inaccurate or unset identifiers. This
function does NOT check UML conformance, only the data
relationships and repository structure.

You can run the integrity checker first in report mode to
discover if anything should be corrected, and then run it
again in 'recover/clean' mode.

When Enterprise Architect 'cleans' the model, it attempts to
recover lost Packages and elements, and generates a new
Package at the model root level called _recovered_. Check
through any elements that are found and, if required, drag
them into the model proper. If they are not required, delete
them.

Access

Ribbon Configure > Model > Integrity Check >
Project Integrity
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Check the data integrity of your project

Ste
p

Action

1 Open the project.

2 Select the 'Project Integrity Check' menu option.
The 'Project Integrity Check' dialog displays.

3 Select the checkbox for each check to run:
Package Structure·

Object Structure·

Object Features·

All GUIDs·

Cross References·

Connectors·

UML 2.0 Migration·

4 Select either:
The 'Report Only' option to just view a report on·

the state of your model, or
The 'Recover/Clean' option to recover and clean·
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your project; before selecting this option back up
your project file first

5 To write a log of the integrity check, click on the
Save Results button and select a log file.

6 Click on the Go button to run the check.
If you want to display the resulting information in a
more readable layout, you can resize the dialog and
its columns.

UML 2.0 Migration

The UML 2.0 Migration check enables you to migrate the
project from UML 1.3 semantics to UML 2.0 semantics.
The migration process currently converts activities that are
invocations of operations into called operation actions as per
the UML 2.0 specification.

The UML 2.0 Migration option is an exclusive process that
does not enable any of the other checks to be selected. When
you click on the Go button to perform the migration, a
prompt displays for you to confirm the operation.

Notes
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In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
'Check Data Integrity' permission to perform a data
integrity check
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Reset Table Auto Increment or Identity
Columns

This topic explains possible impacts of XML Export/Import
on table auto increment columns, and how to re-sequence
the columns whose value approaches the maximum datatype
value.

Impacts

Impact Due
To

Impact

XML
Export/Impor
t

XML Export/Import can cause gaps in
the numbering sequence of auto
increment columns.
Each XML Import deletes rows from
several tables; the import then adds rows
starting from the maximum value of the
auto increment column.
Repeated XML imports can result in the
value of the auto increment approaching
the maximum value of the database
datatype; for example, SQL Server's int
datatype has a maximum value of
2,147,483,647.
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Replication Large auto increment values can also
arise where the project originated as an
EAP replica or design master.
The Jet engine assigns random values for
auto increment columns with each XML
Import into the project.
These random values can approach the
maximum range of the repository data
type, which could present a problem
when the EAP project is transferred to a
repository.

Access

Ribbon Configure > Model > Integrity Check >
Reset IDs

Re-sequence auto increment columns

Ste
p

Action
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1 Open the project.

2 Select the 'Reset IDs' menu option.
A dialog displays listing all non-empty tables that
contain an auto increment or identity column.

The 'Rows' column shows the number of rows in·

the table
The 'Maximum ID' column shows the current·

maximum value of the auto increment column
The 'Action' column shows either 'No Action' or·

'Reset', depending on how close the column value
is to the datatype's maximum

Tables requiring a reset are automatically selected in
the list.

3 Click on the Go button to reset the auto increment
column values.

Notes

Connection to the project must be via a direct connection;·

IDs cannot be reset while the connection to the repository
is via Cloud Services

Project Auditing must be disabled before IDs can be reset·

MySQL repositories will require re-starting of the·
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MySQL server so that the reset auto increment columns
start from the reset value

In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
'Check Data Integrity' permission to reset IDs
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Upgrade a Project

The structure of Enterprise Architect project files is
occasionally changed to support more features. In such
cases, the project might have to be upgraded. Upgrading to
the new file structure is a simple and quick process that
brings your project to the current level to:

Ensure correct operation and·

Support all the latest Enterprise Architect features·

Initial Check

When you load a project that was created in an earlier
release of Enterprise Architect (for example, an archived
project) using a recent release of Enterprise Architect, the
system determines whether the project should be upgraded
and, if the upgrade is necessary, displays the Upgrade
Wizard.

The Upgrade Project Wizard

The Upgrade Project Wizard takes you through the upgrade
process and:

Advises you of the necessity to upgrade·

Advises you to back up the current project; it is essential·
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to back up before any changes are made

Checks which upgrade path is required·

Guides you through the steps to perform the upgrade·

Opens the newly converted project·

Notes

If you are using replication in your models, and the·

upgrade wizard detects that the project you are opening is
a replica and not a Design Master, a different upgrade
path is required

Once upgraded, the project cannot be opened with the·

version of Enterprise Architect in which it was created
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Upgrade Replicas

Models that have replication features added might have to
be upgraded differently from regular projects.

If the model is a Design Master (the root model of all·

other replicas) then you can upgrade the model to suit the
current version of Enterprise Architect; after upgrading a
Design Master you should re-create the replicas, rather
than synchronizing

If the model is not a Design Master, you must first remove·

the replication features, then upgrade the project in the
normal manner; the Upgrade Wizard guides you through
the steps
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Run SQL Patches

Occasionally, Sparx Systems might release a patch to
correct a model fault.

The patch generally checks how many records are to be
updated, and reports on what is to be done.

Access

Ribbon Configure > Model > Integrity Check >
Run Patch
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Rename a Project

If you want to rename a project, you can only do so at the
Windows file system level, using Windows Explorer.

Rename an Enterprise Architect project file

Ste
p

Action

1 If you have the project open, close it.

2 Ensure no other users have the file open.

3 Open Windows Explorer and navigate to the project.

4 Rename the project file using Windows Explorer.

5 You should keep the file extension to preserve
compatibility with the default project type, as
installed in the registry at installation time.
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Compact a Project

After a period of time, through general use, a project .eap
file might occupy more disc space than necessary. You can
move the project to a local drive and compact the file to
recover the unused space.

Access

Ribbon Configure > Model > Integrity Check >
Manage .EAPX/.EAP File > Compact
.EAPX/.EAP File

Compact a project

Ste
p

Action

1 If you have the project open, shut it down.

2 Ensure no other users have the file open.

3 Select the 'Compact .EAP File' menu option.
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4 Follow the on-screen instructions to complete the
process.

Notes

Always compact projects on a local drive, never on a·

network drive

In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
Administer Database permission to compact a project
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Repair a Project

If a project has not been closed properly, such as during
system or network outages or on poor network connections,
on rare occasions the .eap file does not re-open correctly. A
message displays informing you the project is of an
unrecognized database format or is not a database file. In
such cases, you can move the project file to a local drive and
repair it.

Access

Ribbon Configure > Model > Integrity Check >
Manage .EAPX/.EAP File > Repair
.EAPX/.EAP File

Repair a project that was not closed properly

Ste
p

Action

1 Ensure that all users are logged off the project you
are attempting to repair.
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2 Copy the project file to a local drive on your
workstation.

3 In Enterprise Architect, select 'Start > View >
Preferences' to display the 'Preferences' dialog.
On the 'General' page, deselect the 'Use Jet 4.0 -
requires restart' checkbox.

4 Close and restart Enterprise Architect - you do not
need to open any model, including the one you are
repairing.

5 Select the 'Repair .EAP File' menu option, and
follow the on-screen instructions.

6 Once you have repaired the project, it is
recommended that you perform a data integrity
check.

Notes

Always repair projects on a local drive, never on a·

network drive

The 'Compact a Project' option can also repair corrupt·

.eap files
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In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
'Administer Database' permission to repair a project
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Reference Data

Reference data is used in Enterprise Architect to provide
meta-information for the modeler, and is often seen in drop
down lists and selection boxes. It includes such things as
status codes, requirement types, model authors and more.

For convenience, Enterprise Architect comes pre-configured
with useful reference data, but it is best practice to review
this existing data when setting up a project and either
replace or edit it to ensure it is appropriate for the project.

There are a number of different types of reference data,
some of which apply at a repository level - such as status
codes and authors - and some that is more technical in
nature, such as code engineering and database datatypes.

The reference data can be copied between repositories by
exporting it from one repository and importing it into
another; this mechanism can save time and ensure
consistency between repositories.

Project reference data can be entered and edited through the
'Configure > Reference Data' ribbon panel, and includes:

Stereotypes·

Tagged Value Types·

Cardinalities·

People·
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General Types·

Project Indicators·

Estimation Factors·

Datatypes·

Notes

In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
'Manage Reference Data - Update' permission to update
and delete reference items

(c) Sparx Systems 2018 Page  979 of 1073



User Guide - Model Repository 21 December, 2018

UML Types

Using the 'UML Types' dialog you can configure
stereotypes, Tagged Value types and the cardinality list for
your project. In more detail, you can:

Add, modify and delete stereotypes·

Customize stereotypes' appearance·

Update Shape Scripts and metafiles associated with·

stereotypes

Create and modify Tagged Values·

Define cardinality rules·

Access

Ribbon Configure > Reference Data > UML
Types
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Stereotype Settings

Enterprise Architect has an extensive set of Standard
Stereotypes that you can apply to any UML construct. Using
the 'Stereotypes' tab of the 'UML Types' dialog, a Technical
Developer can also customize the stereotypes for your
project by adding, modifying and deleting them. For
information on customizing stereotypes, see the Custom
Stereotypes Help Topic.

Stereotypes can be modified to make use of metafiles
(image files) or customized colors, or to make use of the
Enterprise Architect Shape Scripts to make new object
shapes to determine the shape and dimensions of the object.

Access

Ribbon Configure > Reference Data > UML
Types

Manage Stereotypes

Option Action
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Stereotype Type in the name of the new stereotype,
or click on an existing stereotype in the
list in the right-hand panel.

Group name For a stereotype that applies to an
element feature (an attribute or operation)
type in a name under which to group the
features that have the stereotype. This is
shown on diagrams in the attributes or
operations compartment of the element.
If you do not provide a group name, the
label in the feature compartment defaults
to the stereotype name.

Base Class Click on the drop-down arrow and select
an object type, so that the stereotyped
object will inherit the base characteristics
from that existing object type.

Notes Type in any notes concerning the
stereotype (and not the objects to which
the stereotype is to be applied).

None Select this radio button to use the default
object appearance.

Metafile Select this radio button to use an image
file for the appearance of the stereotyped
object.
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Shape Script Select this radio button to apply a custom
shape to the stereotyped object, which
you define using the Enterprise Architect
Shape Scripting language.

Assign Click on this button to select or define the
associated metafile or Shape Script to be
applied to the stereotyped object.

Remove Click on this button to remove the
associated metafile or Shape Script from
the stereotype.

Fill Click on the drop-down arrow and select
a default color for the background of the
object.
This color will be applied to all
occurrences of any object to which the
stereotype has been applied; if the color
is subsequently changed, the change is
immediately applied to all occurrences of
any object to which the stereotype was
applied (as for changes to any other
property of the stereotype).
However, on elements created with the
stereotype, the default color might be
overridden by other color definitions of a
higher priority that have been applied to
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the element, such as the 'Alternative
Appearance' dialog (F4) definition.

Border Click on the drop-down arrow and select
a default color for the object border.

Font Click on the drop-down arrow and select
a default color for the stereotype font.

Reset Click on this button to reset the
stereotyped object appearance definition
to the default object appearance.

Preview Provides a visual representation of the
stereotyped object definition.

New Click on this button to clear the dialog
fields so that you can define another
stereotype.

Save Click on this button to save the stereotype
definition and add it to the list of current
stereotypes.

Delete Click on this button to immediately
remove the selected stereotype from the
list of defined stereotypes.
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Shape Editor

A Technology Developer can use the Shape Editor to
specify custom shapes via a scripting language; that is, to
create Shape Scripts. These custom shapes are drawn
instead of the standard UML notation. Each script is
associated with a particular Stereotype, and is drawn for
every element of that stereotype.

Access

Ribbon Configure > Reference Data > UML
Types > Stereotypes > [select or specify a
stereotype] : Shape Script : Assign

Reference

Option Action

Format The format in which the script is written.

Import Opens a Windows browser dialog,
allowing for a script file to be loaded.
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Export Opens a Windows browser dialog,
allowing for a script file to be saved.

Edit window The area in which a script can be written.

Preview of
main

A visual representation of the compiled
script. Nothing displays until the Refresh
button is clicked.

Next Shape If a composite shape is defined within the
Edit Window, clicking on the Next Shape
button pages through the components of
the shape.

Refresh Parses your script and produces a visual
example of the shape in the Preview of
main window.

OK Exit from the Shape Editor; don't forget
to save your scripts from the 'Stereotype'
tab.

Notes

Shape Scripts adopt the same color gradient settings as·
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normal elements, as defined in the 'Standard Colors' page
of the 'Preferences' dialog

If an element's appearance is modified by a Shape Script,·

many of the 'Advanced' context menu options for that
element are disabled

Once you have finishing writing your Shape Script, click·

on the OK button; to save the Shape Script you must click
on the 'Stereotypes' tab
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Tagged Value Types

Tagged Values are used in a variety of places within
Enterprise Architect to specify additional information about
an element or connector. The 'Tagged Value Types' tab of
the 'UML Types' dialog enables a Technology Developer to
rapidly create Tagged Values, using a range of predefined
structured Tagged Values to create structured tags that
adhere to a specific format. For example, for model features
that use the predefined tag Boolean you can use the Tagged
Values window to assign a value of True or False and no
other value.

You can also add default Tagged Value names and create
predefined reference data Tagged Value types and custom
masked Tagged Value types.

Any Tagged Value names created display in the drop-down
lists of Tagged Value names in the 'Tagged Value' dialogs
for elements, operations and attributes.

Access

Ribbon Configure > Reference Data > UML
Types > Tagged Value Types
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Create a Tagged Value Type

Field Action

Tag Name Type the new name of the Tagged Value.

Description Type a description of the Tagged Value.

Detail Type any additional information
necessary.

New Click to begin creating a new Tagged
Value.

Save Click to save the details of a Tagged
Value.

Delete Click to delete a Tagged Value from the
Defined Tag Types list.

Defined Tag
Types

A list of previously defined Tagged
Values.

Notes
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You can transport these Tagged Value Type definitions·

between models, using the 'Configure > Model > Transfer
> Export Reference Data' and 'Import Reference Data'
ribbon options; Tagged Value Types are exported as
Property Types
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Cardinality

The 'Cardinality Values' tab of the 'UML Types' dialog
enables you to add, modify and delete values in the default
cardinality list.

The cardinality values are used to define the multiplicity of
source and target elements in relationships. This is the range
of instances of the role that can be active in the relationship;
for example, one employee can be assigned to tasks; for the
target role you define the range of instances (such as tasks)
the employee could be assigned to.

The cardinality values are also used to define the
multiplicity of a Classifying element; that is, the number of
instances of the element that can exist. For example, the
Class element 'Building Walls' might have a multiplicity of
2..n, meaning that at least two walls must exist (to support
the roof) but there can be many walls if the building design
required it.

The values have these formats:

*, or 0..* - zero, one or many instances·

0..n - zero or up to n instances, but no more than n·

n - exactly n instances·

n..* - n, or more than n instances.·

Access
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Ribbon Configure > Reference Data > UML
Types > Cardinality Values

Reference

Field Action

Cardinality Type the new name of the Cardinality
Value.

New Type a description of the Cardinality
Value.

Save Saves the Cardinality value and adds it to
the Cardinality List.

Delete Deletes a Cardinality value from the
Cardinality List.

Cardinality
List

A list of already defined Cardinality
values.
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Notes

You can transport these cardinality values between·

models, using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
options
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People

In your project, you can set up and configure the people and
stakeholders involved in and relevant to this model; that is:

Maintain Authors involved within a project·

Define role types that are captured within Enterprise·

Architect

Record information on project resources·

Capture client details associated with the current model·

Access

Ribbon Configure > Reference Data > Project
Types > People
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Project Authors

You can define the people who are working on a project,
such as the authors of specific elements.

Access

Ribbon Configure > Reference Data > Project
Types > People > Project Author(s)

Notes

If you enter multiple names, Enterprise Architect adds·

them separately and in alphabetical order to the 'Defined
Authors' list; if you then click on one of these names,
Enterprise Architect displays that name only in the
'Name(s)' field

If you type in a role, this is not added to the roles on the·

'Project Roles' tab

You can transport these author definitions between·

models, using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
options

(c) Sparx Systems 2018 Page  996 of 1073



User Guide - Model Repository 21 December, 2018

Reference

Field Action

Name(s) Type the name of the person registered as
a Project Author.
If you are using a Windows Active
Directory, you can select names from the
directory; click on the  button to
display the 'Select Users' dialog.
You can also type a list of names
separated by semi-colons; this enables
you to define a group of people sharing a
role, such as a team of Developers,
Testers or Analysts.
Do not leave any spaces between the
names and the semicolons.

Role (Mandatory) Enter the role the Project
Author plays in the project (such as
Designer, Analyst, or Architect).
You can type a role name or click on the
drop-down arrow and select a role
defined through the 'Project Roles' tab.

Notes Type any additional notes concerning the
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Project Author.

New Add further Authors.

Save Add the new Author to the Defined
Authors list.

Delete Removes an Author from the Defined
Authors list.

Defined
Authors

Review the Project Authors already
defined.
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Select Users

If your company is using a Windows Active Directory, you
can select the Project Author names from the local or
corporate-wide directory.

Access

Ribbon Configure > Reference Data > Project
Types > People > Project Author(s) : 

Reference

Field Action

Object
Types...

Opens the 'Object Types' dialog, which
provides a choice of object types that can
be used.

Locations... Defines the root location from which to
begin a search.

Check Matches object names listed in the Enter
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Names the object names to select section.

Enter the
object names
to select

Specify object names to search for.

Advanced... Opens the 'Advanced' dialog to provide
further search options.
For more information on this dialog,
please refer to Windows Help and
Support.

Use to

Select Project Authors from Windows Active Directory·

Notes

Multiple Entries can be typed into the 'Enter the object·

names to select' section; ensure that objects are separated
by semicolons (for example: Name01; Name02)
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Project Roles

People associated with a project play a role in analysis,
design or implementation, such as Application Analyst,
Architect, Developer and Project Manager. Project roles
define the activities that resources can undertake.

Access

Ribbon Configure > Reference Data > Project
Types > People > Project Roles

Reference

Field Action

Role Type or select the name of the role.

Description Type a description of the role.

Notes Type any additional information related
to the role.
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New Add further Roles.

Save Add the new role to the Defined Roles
list.

Delete Removes a role from the Defined Role
list.

Defined
Roles

Review the Project Roles already defined.
The 'Defined Roles' list is available for
selection for any element in the model;
for example, you can select roles on the
'Project Authors' page of the 'People'
dialog, and the Resource Allocation
window.
You can also specify other roles on these
dialogs, but such roles are not added to
the 'Defined Roles' list.

Use to

Define role types that are captured within Enterprise·

Architect
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Notes

Deleting a role has no effect on any Project Author·

definition having this role; the deleted role becomes a
simple text entry in the Project Author definition

You can transport these role definitions between models,·

using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
options
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Project Resources

Resources are, for example, project authors, analysts,
programmers and architects. That is, anyone who might
work on the system over time, either adding to the model or
programming and designing elements of the system outside
Enterprise Architect.

Access

Ribbon Configure > Reference Data > Project
Types > People > Project Resources

Reference

Field Action

Name Type or select the name of the person
listed as a resource.
The resource name is available for use in
Resource Management.

Organization Type the name of the organization
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employing the resource.

Role(s) Type or select the role the resource plays
in the project (for example, Designer,
Analyst, Architect).

Phone 1,
Phone 2,
Mobile, Fax

Type the contact telephone numbers for
the resource.

Email Type the email address for the resource.

Notes Type any additional notes on the
resource.

Available
Resources

Review resources that have already been
defined.

New Add further resources.

Save Add a new resource to the Available
Resource list.

Delete Delete a resource from the Available
Resources list.
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Use to

Record information on project resources·

Notes

You can transport these resource definitions between·

models, using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
options
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Project Clients

Project clients are the eventual owners of the software
system.

Access

Ribbon Configure > Reference Data > Project
Types > People > Project Clients

Reference

Field Action

Name Type or select the name of the client.

Organization Type the name of the organization that
employs the client.

Role(s) Type the role the client plays in the
project (for example, Manager, Sponsor).

Phone 1, Type the contact telephone numbers for
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Phone 2,
Mobile, Fax

the client.

Email Type the email address of the client.

Notes Type any additional notes on the client.

Defined
Clients

Review clients that have already been
defined.

New Add details of further clients.

Save Add a new client to the Defined Client
list.

Delete Delete a client record from the Defined
Client list.

Use to

Capture client details associated with the current model·

Notes
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You can transport these client definitions between models,·

using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
options
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General Types

When you create or edit the properties of an element, you
define the type or status of the property by selecting from a
drop-down list that initially contains system-provided
values. You can add to or replace any of these system values
with your own customized values. The properties you can
customize are:

Status·

Constraint·

Constraint Status·

Difficulty·

Priority·

Test Status·

Requirement·

Scenario·

Each of these can be separately managed through the
'General Types' dialog.

Access

Ribbon Configure > Reference Data > Project
Types > General Types
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Status Types

In an element 'Properties' definition, the status of the
element in the development management process is defined
in the element 'Status' field. You can select the appropriate
value from a drop-down list, which initially contains the
system values:

Approved·

Implemented·

Mandatory·

Proposed and·

Validated·

You can add to or replace any of these values with your own
custom values. You can also assign a color band to each
status type, and define the types of element that can display
those colors.

Access

Ribbon Layout > Diagram > Appearance >
Configure Status Colors, or
Configure > Reference Data > Project
Types > General Types > Status
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Customize Element Status Types

Field Action

Status Type the name of the status.

Description Type a short description of the status.

Status Type
Color

Using the drop-down arrow, select a
color to be applied to the current status
type.

Preview Displays a visual representation of an
element with the selected status type
color.

Restore
Default

Restore the status type color to its default
setting.

Applies to... By default, status colors only apply to
Requirement, Issue and Change elements.
You might decide to also apply these
colors to other UML elements, such as
Use Cases or Classes.
To do this, click on the Applies to ...
button and, in the 'Applied Status Colors'
list, select the checkbox against each
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element type to which to apply the status
colors.

New Clear the dialog fields to create a new
status.

Save Save the status, and add it to the Type
list.

Delete Remove the currently selected status
from the Type list.

Type Lists the current status types and
descriptions for each status.

Notes

To display status colors on your diagrams, you must select·

the 'Show status colors on diagrams' checkbox on the
'Objects' page of the 'Preferences' dialog

You can transport the status types (and the colors assigned·

to status types) between models, using the 'Configure >
Model > Transfer > Export Reference Data' and 'Import
Reference Data' ribbon options

Requirement, Feature, Issue and Change elements have a·

status color compartment, whereas the status color for
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other elements is applied to the element shadow; to show
the element shadows (and hence the status colors), select
the 'Element Shadows on' checkbox on the 'Diagram
Appearance' page of the 'Preferences' dialog
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Constraint Types

In an element 'Properties' definition, each constraint on the
element is defined by type in the 'Constraint' field. You can
select the appropriate value from a drop-down list, which
initially contains the system values:

Invariant·

Post-condition·

Pre-condition·

Process and·

OCL·

You can add to or replace any of these values with your own
custom values.

Access

Ribbon Configure > Reference Data > Project
Types > General Types > Constraint

Customize Constraint Types

Option Description
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Constraint Type the name of the constraint to define.

Description Type a brief description of the constraint.

Note Type any further details concerning the
constraint.

New Clear the fields to define a new
constraint.

Save Save the constraint definition and add it
to the Defined Constraint Types list.

Delete Remove the currently selected constraint
from the Defined Constraint Types list.

Defined
Constraint
Types

Lists the currently-defined constraint
types and their descriptions.

Notes

You can transport customized constraint types between·

models, using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
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options
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Constraint Status Types

In an element 'Properties' definition, each constraint's status
in the development process is defined in the constraint
'Status' field. You can select the appropriate value from a
drop-down list, which initially contains the system values:

Implemented·

Build·

Validated·

Approved·

Mandatory and·

Proposed·

You can add to or replace any of these values with your own
custom values.

Access

Ribbon Configure > Reference Data > Project·

Types > General Types > Constraint
Status Types

Customize Constraint Status Types
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Status
Type the name of the constraint status to
define.

Make Default
To make the selected constraint status the
default for all constraint 'Status' fields,
select the checkbox.

New
Clear the fields to define a new constraint
status.

Save
Save the constraint status definition and
add it to the Type list.

Delete
Remove the currently selected constraint
status from the Type list.

Type
Lists the currently available constraint
status types.

Move the selected constraint type higher
or lower in the Type list.
This defines the ordering used in the
Status drop down combo boxes, and in
sorting any report or list when the
Constraint Status Type is used as the
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sort-by property.

Sort
Alphabeticall
y

Reorganize the entries in the Type list
into alphabetical order.

Restore
Defaults Remove all customized constraint status

values and restore the system defaults.

Notes

You can transport customized constraint status types·

between models, using the 'Configure > Model > Transfer
> Export Reference Data' and 'Import Reference Data'
ribbon options
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Difficulty Types

Developing a particular element might be a simple task or
more complex. In the element Properties definition, the level
of difficult of developing that element is defined in the
'Difficulty' field. You can select the appropriate value from
a drop-down list, which initially contains the system values
'High', 'Medium' and 'Low'. You can add to or replace any of
these values with your own custom values.

Access

Ribbon Configure > Reference Data > Project
Types > General Types > Difficulty

Customize Difficulty Types

Difficulty
Type the name of the Difficulty to define.

Make Default
To make the selected Difficulty the
default for all 'Difficulty' fields, select the
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checkbox.

New
Clear the fields to define a new Difficulty
type.

Save
Save the Difficulty definition and add it
to the Type list.

Delete
Remove the currently selected Difficulty
from the Type list.

Type
Lists the currently available Difficulty
types.

Move the selected type higher or lower in
the 'Type' list.
This defines the ordering used in the
'Difficulty' drop down combo boxes, and
in sorting any report or list when the
Difficulty type is used as the sort-by
property.
For example: you have several Change
elements on a diagram, and you select
'Diagram View'; then you sort on the
'Difficulty' column. The 'Diagram View'
entries are grouped by difficulty, in the
order you defined in this 'Type' field.

Sort
Alphabeticall Reorganize the entries in the Type list
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y into alphabetical order.

Restore
Defaults Remove all customized Difficulty values

and restore High, Medium and Low.

Notes

You can transport customized Difficulty types between·

models, using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
options
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Priority Types

In an element Properties definition, the priority of
developing that element is defined in the 'Priority' field. You
can select the appropriate value from a drop-down list,
which initially contains the system values 'High', 'Medium'
and 'Low'. You can add to or replace any of these values
with your own custom values.

Access

Ribbon Configure > Reference Data > Project
Types > General Types > Priority

Customize Priority Types

Priority
Type the name of the Priority to define.

Make Default
To make the selected Priority the default
for all 'Priority' fields, select the
checkbox.
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New
Clear the fields to define a new Priority.

Save
Save the Priority definition and add it to
the Type list.

Delete
Remove the currently selected Priority
from the Type list.

Type
Lists the currently available Priority
types.

Move the selected type higher or lower in
the 'Type' list.
This defines the ordering used in the
'Priority' drop down combo boxes, and in
sorting any report or list when the Priority
type is used as the sort-by property.
For example: you have several Change
elements on a diagram, and you select
'Diagram View'; then you sort on the
'Priority' column. The 'Diagram View'
entries are grouped by priority, in the
order you defined in this 'Type' field.

Sort
Alphabeticall
y

Reorganize the entries in the Type list
into alphabetical order.

Restore
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Defaults Remove all customized Priority values
and restore High, Medium and Low.

Notes

You can transport customized Priority types between·

models, using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
options

(c) Sparx Systems 2018 Page 1027 of 1073



User Guide - Model Repository 21 December, 2018

Test Status Types

All tests defined in the Testing window and 'Test Details'
dialog have a status value to show what point in the testing
cycle the test has reached. The system values you can select
from the test 'Status' field are:

Not Run·

Pass·

Fail·

Deferred and·

Canceled·

You can add to or replace any of these values with your own
custom values.

Access

Ribbon Configure > Reference Data > Project
Types > General Types > Test Status

Customize Test Status Types
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Status
Type the name of the Test status to
define.

Make Default
To make the selected test status the
default for all test 'Status' fields, select
the checkbox.

New
Clear the fields to define a new Test
status.

Save
Save the Test status definition and add it
to the Type list.

Delete
Remove the currently selected Test status
from the Type list.

Type
Lists the currently available Test status
types.

Move the selected type higher or lower in
the 'Type' list.
This defines the ordering used in the test
'Status' drop down combo boxes, and in
sorting any report or list when the Test
Status Type is used as the sort-by
property.
For example: you have run several tests
on a Package, and you run a Test Details
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report; then you sort on the 'Status'
column. The report entries are grouped by
test status, in the order you defined in this
'Type' field.

Sort
Alphabeticall
y

Reorganize the entries in the Type list
into alphabetical order.

Restore
Defaults Remove all customized Test status values

and restore the system defaults.

Notes

You can transport customized Test status types between·

models, using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
options
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Requirement Types

In a Requirement definition, the requirement is categorized
according to type or function, in the 'Type' field of the
Requirement 'Properties' dialog. This helps to maintain a
single set of typed requirements. You can select the
appropriate 'Type' value from a drop-down list, which
initially contains the system values:

Display·

Functional·

Performance·

Printing·

Report·

Testing and·

Validate·

You can add to or replace any of these types with your own
customized values.

Access

Ribbon Configure > Reference Data > Project
Types > General Types > Requirement
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Customize Requirement Types

Option Description

Requirement Type the name of the requirement.

Description Type a short description of the
requirement.

Weight Type a weighting to apply to the
requirement type.

New Clears the dialog fields so that you can
define a new requirement type.

Save Saves the requirement type details and
adds it to the Defined Requirement Types
list.

Delete Deletes a selected requirement type from
the Defined Requirement Types list.

Defined
Requirement
Types

Lists the currently available requirement
types.
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Notes

You can transport these requirement types between·

models, using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
options
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Scenario Types

In the Scenario definitions for an element each scenario is of
a specific type, which you define in the 'Type' field on the
'Scenario' page of the 'Properties' dialog. You can select the
appropriate value from a drop-down list, which initially
contains the system values:

Exception·

Alternate and·

Basic Path·

You can add to or replace any of these system types with
your own customized values.

Access

Ribbon Configure > Reference Data > Project
Types > General Types > Scenario

Customize Scenario Types

Option Description

Scenario
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Type Type the name of the scenario type.

Description Type a short description of the scenario
type.

Weight Type a value for the weighting to apply to
the scenario type.

Notes Type any additional information to
describe the scenario type.

New Clears the dialog fields so that you can
define a new Scenario type.

Save Saves the scenario type and adds it to the
Defined Scenario Types list.

Delete Deletes a selected scenario type from the
Defined Scenario Types list.

Defined
Scenario
Types

Lists the currently available scenario
types to offer in the drop-down list of a
'Scenario Type' field.

Notes
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You can transport customized scenario types between·

models, using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
options
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Metrics and Estimation

TCF values, EFC values and Default Hour Rate for a project
are controlled from the 'Estimation Factors' dialog.

Risk, metric and effort types for a project are controlled
from the 'Project Indicators' dialog.

For further information on these see the Project 
Management and Project Resources topics, or specifically:

Technical Complexity Factors·

Environment Complexity Factors·

Default Hours·

Effort Types·

Metric Types·

Risk Types·
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Maintenance

Within your project, you can set up Maintenance types that
determine the base Problem Types to be used within the
model.

Access

Ribbon Configure > Reference Data > Project
Types > Maintenance
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Problem Types

NOT CURRENTLY USED

For the maintenance and change control screens, you can
use the 'Maintenance' dialog to set the base Problem Types
that are handled. Examples are hardware-related issues,
performance problems, software bugs and network
problems.

Access

Ribbon Configure > Reference Data > Project
Types > Maintenance > Problem Types

Define Problem Types

Field Action

Problem
Type

Type in the name of the problem type.

Description Type a short description of the problem
type.

(c) Sparx Systems 2018 Page 1039 of 1073



User Guide - Model Repository 21 December, 2018

Weight Provide a weighting to apply to the
problem type.

Note Type any additional information on the
problem type.

Defined
Types

Displays all of the pre-defined and saved
problem types.

New Click on this button to clear the dialog
fields so that you can add a new problem
type.

Save Click on this button to save the scenario
details and add it to the 'Defined Types'
list.

Delete Click on this button to delete a selected
scenario from the 'Defined Types' list.

Notes

You can transport these problem types between models,·

using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
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options

You transport the problem types together with test types·

as a Maintenance Types file
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Testing Types

You can use the 'Test Types' tab of the 'Maintenance' dialog
to add testing types to the basic set that comes with
Enterprise Architect. Typical test types are load tests,
performance tests and function tests.

Access

Ribbon Configure > Reference Data > Project
Types > Maintenance > Test Types

Notes

You can transport these test types between models, using·

the 'Configure > Model > Transfer > Export Reference
Data' and 'Import Reference Data' ribbon options

You can either export the test types together with the·

default problem types, as a Maintenance Types file, or
separately as a Test Types file

Reference
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Field Action

Test Type Type the name of the test type.

Description Type a short description of the test type.

Weight Type a weighting to apply to the test
type.

Note Type any additional information on the
test type.

Defined
Types

Displays all of the pre-defined and saved
test types.

New Add a new test type.

Save Saves the scenario details and adds it to
the 'Defined Types' list.

Delete Deletes a selected scenario from the
'Defined Types' list.
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Data Types

Different programming languages support different inbuilt
data types. It is possible for you to manage and extend this
set of inbuilt data types for a standard programming
language, as well as define new programming languages for
use within Enterprise Architect.

Access

Ribbon Configure > Reference Data > Settings >
Code Engineering Datatypes  or
Code > Configure > Options > Configure
Code Engineering Data Types

Programming Language Datatype Options

Option Description

Product
Name

Click on the drop-down arrow and select
the name of the programming language.

Add Product Click on this button to display a prompt
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for the name of a new programming
language.
Type the name and click on the OK
button.

Datatype Type the language-specific name of the
datatype.

Common
Type

Type the common (or generic) name of
the datatype; for example, the Java
boolean datatype has a common datatype
Boolean.

New Click on this button to clear the fields to
create a new datatype.

Save Click on this button to save the newly
created or updated datatype.

Delete Click on this button to delete the selected
datatype.
You can delete your own custom data
types, but you cannot delete any of the
predefined data types.

Defined
Datatypes for
Programming
Languages

Review the list of datatypes for the
selected language, and click on any that
you want to edit or delete. The details for
the selected datatype display in the dialog
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fields.

Notes

You do not need to set the options in the 'Size' panel·

Once you have defined at least one datatype for a new·

language, that language name is added to the drop-down
list for the 'Language' fields in the 'Programming
Languages Datatypes' dialog, in the Code Template
Editor, and in the 'Properties' dialog for each Class
element within the model

You can transport these data types between models, using·

the 'Configure > Model > Transfer > Export Reference
Data' and 'Import Reference Data' ribbon options

In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
'Configure Datatypes' permission to update and delete
data types
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Resources Window

The Resources window is a repository of project-standard
and re-usable document generation templates, MDG
Technologies, Relationship Matrix profiles, commonly-used
model elements, stylesheets, UML Profiles and Patterns.
The window provides facilities for creating and modifying
these structures and facilities and, in some cases, for
applying the facility to the current model directly from the
window.

Access

Ribbon Start > Explore > Browse > Resources
Show > Portals > Window > Explore >
Resources
Configure > Reference Data > Resources

Keyboard
Shortcuts

Alt+6

Resources available through the Resources
window
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Notes

In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
'Configure Resources' permission to maintain Resources
window items

For a number of folders in the Resources window, the·

right-click context menu also offers a 'Help' option that,
when you select it, displays a brief description of the
folder

Resource Description

Document
Generation

The Document Generation folder holds a
number of sub-folders, each of which
provides the facilities for generating a
particular type of document or report
from your model.

System Templates - this sub-folder·

itself has sub-folders containing
system-defined report templates,
Fragments, Cover Pages, Style Sheets
and Table of Contents definitions
You can right-click on these template
names and select options to display the
template contents or to copy the
template as the basis of a user-defined
template that you work on in the
Document Template Editor, under a
different name; you can also select the
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'Override' option to create a copy of the
system template as a user template with
the same name
User Templates - this sub-folder also·

has sub-folders for report templates,
Fragments, Cover Pages, Style Sheets
and Tables of Contents, but these are
the templates that you have created
yourself using the Document Template
Editor, either as new or by copying and
editing another template
You can right-click on these template
names and select options to create,
delete, rename, modify, move or copy a
user-defined template; you have
additional options to mark a report
template as a Fragment, or a Fragment
as a report template, if they are suitable
for this reclassification
You can also 'drag and drop'
user-defined templates between
user-defined groups, and between these
groups and the appropriate standard
'type' folders; for example, from
'DavidCover' to 'Cover Pages'
Technology Templates - if you have·

loaded an MDG Technology containing
document templates, those are also
listed under the Technology name
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Web Style Templates - this sub-folder·

contains the HTML style templates that
you have created as alternatives to the
system-supplied <default> template
To create a new template, right-click
on the folder name and select the
'Create HTML template' option, and
provide a template name; this opens the
HTML and CSS Style Editor, in which
you create the template from HTML
fragments
You can right-click on the template
names and select options to delete the
template or modify the template
contents
Defined Documents - this folder holds·

the Resource documents (report
specifications) you have created in the
Document Report Generator; you can
right-click on the document name to
generate documents individually or as a
batch, open the generated document, or
delete the report specification
Linked Document Templates - this·

folder holds the non-standard Linked
Document templates, either
user-defined or supplied with each
MDG Technology enabled on the
system; you can edit or delete any of
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these existing templates, or create new
ones from scratch or by copying an
existing template, including the
system-provided Linked Document
templates
You can also re-assign the templates to
different template groups, either
another of the existing groups or a new
one that you create as part of the
assignment
Legacy Templates - if you are, or have·

been, using the original (legacy)
Enterprise Architect report generator,
this sub-folder contains the report
templates that you use to generate the
documents
You can continue to create, modify, use
and delete legacy style templates, but it
is recommended that you switch to the
later report generator

MDG
Technologies

The MDG Technologies folder lists the
MDG Technologies that have been
imported directly into the Resources
window. Each technology extends the
modeling capabilities and facilities of
Enterprise Architect.
You can import Technologies into your
project by right-clicking on the MDG
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Technologies folder and selecting the
'Import Technology' menu option. The
'Import MDG Technology' dialog then
gives you the option to import the
Technology to:

'User', for your individual use; the·

Technology is imported into the
%APPDATA% folder and is not listed
in the Resources window
'Model', for all project users to access;·

the Technology is imported into the
Resources window

If you have any MDG Technologies in
the folder, each has its own subfolder
containing the Profiles, Patterns and code
modules used in the Technology. You
can right-click on these and select options
to delete the Technology, review the
Patterns or Profiles, or invoke the code
modules.
If you remove the Technology, it is
removed from the Resources window, the
'MDG Technologies' dialog, and the
model.
Consider the fact that some MDG
Technologies can be large and might
impose some delays on the workstation as
they load each time a user connects to the
model.
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Model
Patterns

The Model Patterns folder holds Model
Patterns that have been imported into the
model from external sources, including
those developed within your own
organization. Each Pattern XML file will
have a matching .rtf file to explain the
Pattern to users. Model Patterns generate
modeling structures (Packages, diagrams
and elements) within your model.

Matrix
Profiles

The Matrix Profiles folder contains a list
of Relationship Matrix Profiles that you
or your team members have created using
the Relationship Matrix or Specification
Manager. You simply double-click on a
Matrix Profile name to quickly open the
Relationship Matrix under the settings
defined in the Profile.

Favorites The Favorites folder provides a shortcut
to each commonly-used element that you
have added to the folder, so that you can
quickly and easily locate the elements
and add them to diagrams.

Stylesheets The Stylesheets folder contains XSL
stylesheets that you or your team
members have imported into the model.
These XSL stylesheets support the
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optional step of converting XMI files
exported from the model into alternative
formats such as HTML, XSL or source
code. Stylesheets imported here are then
available in the drop-down lists on the
'XML Export' dialog and the 'Generate
GML Application Schema' dialog.
Combined with UML Profiles, this is a
powerful means of extending Enterprise
Architect to generate almost any content
required.
To import a stylesheet:

Right-click on the folder name and1.
select the 'Import Stylesheet' option.
Locate and select the stylesheet file in2.
the browser, and click on the Open
button.
Provide a reference name for the file,3.
and click on the OK button.

Once the stylesheet is in the folder, you
can select context menu options to reload
it (if it has been changed at the source) or
delete it.

UML
Profiles

A Profile is a source of modified or
extended element and connector types
that you have developed from the UML
base types. You can import each new
Profile into this folder, and then create
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elements and connectors of the new types
by dragging the icons from the Profile
onto a diagram.
Once you have Profiles in the folder, you
can select options for arranging them in
order of name or type, viewing a Profile
description, or deleting a Profile.
It is possible to synchronize the Tagged
Values and constraints for any elements
created from a Profile element in the
Resources window.
Importing and applying Profiles through
the Resources window is no longer
recommended; from Enterprise Architect
release 7.0. it is recommended that you
load and apply Profiles as components of
MDG Technologies.

Patterns The Patterns folder is a folder of Design
Patterns that you or your team members
have imported into the model. A Pattern
captures complex new elements and
features that you can drag into a diagram
without having to retype or reconfigure
each element.
Within the folder, the Patterns are
grouped by type. Once you have Patterns
within a group, you can select options to
delete a selected Pattern or all Patterns in
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the group, view a Pattern's details, or
apply a Pattern to an empty diagram.
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Favorites

If you have any elements that you or your team use
frequently - such as the list of Actors in a system - you can
add them to the Favorites folder in the Resources window,
and use that as the source for conveniently dragging and
dropping instances of or links to these elements into other
diagrams. This makes it much easier to locate and use the
elements as you create and manage your model.

Access

Ribbon Start > Explore > Browse > Resources >
Favorites, or
Show > Portals > Window > Explore >
Resources > Favorites, or
Configure > Reference Data > Resources
> Favorites

Keyboard
Shortcuts

Alt+6 | Favorites
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Actions on the Favorites Folder

Action Detail

Add an
element to
the Favorites
Folder

In a diagram, right-click on the element·

to add
From the context menu select the 'Find·

| Add to Favorites' option
Switch to the Resources window and·

expand the Favorites folder; the added
element is listed within its
element-type category (such as Class)

You add elements to the Favorites folder
individually.

Delete an
element from
the Favorites
Folder

Right-click on the element within the·

Favorites folder in the Resources
window
From the context menu select the·

'Delete Favorite' option
A confirmation prompt displays; click·

on the Yes button

View
Properties of
an element in
the Favorites

Select and right-click on the element in·

the folder
From the context menu, select the·

'Element Properties' option; the
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Folder element 'Properties' dialog displays

Notes

When you have had the Favorites folder open for some·

time and other users might have been adding to it,
right-click on the folder name and select the 'Refresh
Favorites' option to update your view of the folder with
the new contents
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Sharing Reference Data

You can conveniently update your models with reference
data (including Glossary and Issue information) by
exporting the data to and importing the data from .XML
files to (for example):

Copy glossaries from one model to another·

Add additional profiles by merging new stereotypes into·

the model

Update reference data from files supplied by Sparx·

Systems as a maintenance release

Copy resources, clients and so on from one model to·

another

You import data into the model automatically or manually
from a reference data .XML file, exported from another
model or an iteration of the current model.
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Link Reference Data to a Shared
Repository

If you have a number of projects that use the same sets of
reference data, you can use a central project containing that
common data as a shared repository. The common data
includes system resources such as Security Users and
Groups, Glossary terms or Data Types. Shared repositories
make it possible for teams working on multiple projects to
leverage a common and consistent set of system resources.
Common standards and definitions can be applied across all
projects using this repository. Any time a new project is
started, that project can automatically inherit some or all of
these common resources from the repository; there is no
need to establish these resources again for each project.

Shared repositories apply to Database Management System
(DBMS) based Enterprise Architect projects and can link all
projects residing within one DBMS.

A new DBMS based project in Enterprise Architect is
initially created with its own stand-alone repository. A
single step process then allows that new project to be linked
to the shared repository residing on its DBMS. Any older or
pre-existing Enterprise Architect projects can also be linked
to the shared repository, taking their resource data from the
master version. This then allows for centralized
management of the contents of the repository, promoting or
enforcing common usage and standards.

Any changes to the shared repository are automatically
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available to every participating project.

Access

Ribbon Configure > Model > Transfer > Shared
Repository

Set up a shared repository

Ste
p

Action

1 Create the script file to set up the shared repository,
as explained in the next table.

2 Execute the generated SQL script using a third-party
tool.

Select the repository tables to share

Option Action
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Script File Type in the location into which the script
file will be generated by this dialog, or
click on the  button and search for it.

Main
Repository

Type in the name of the current main
repository.

Shared
Repository

Type in the name of the database to be
used as the shared repository.
This name cannot be the same as the
name of the main repository.

Table Groups In the list of table groups that can be
linked to the shared repository, select the
checkbox against each table group to
share in the repository.

Tables in
each group

(Read only) Review the list of database
tables in the currently-selected table
group. All of these tables in the selected
group will be available through the
shared repository.

Generate Click on this button to generate the SQL
script to link the selected tables of the
current (main) repository to the shared
repository. The script is generated into
the file location you specified in the
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'Script File' field.

View Script Click on this button to open the generated
script file in the default Code Editor, and
to close the dialog.

Close Click on this button to close the dialog.

Notes

This feature is not applicable to projects that are based on·

local project files (.eap or .feap)

Shared repositories are supported for MySQL, SQL·

Server and Oracle
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Export Reference Data

When you have a complete project set up, with fully defined
project data, it is possible to capture either selected
categories or all categories of that data, and export it to a
single XML file. You can then review the data, and import it
to another project or tool so that you do not have to define it
all again. The exported data includes all instances of the
selected data type in the project; for example, all defined
cardinality values, or all Document Style Templates.

Access

Ribbon Configure > Model > Transfer > Export
Reference Data

Select and Export Reference Data

Ste
p

Action

1 On the 'Export Reference Data' dialog, click on the
'+' box against each table group you want to expand.
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2 Select the checkbox against each table or table group
to export.
If you select the top-level, group-name checkbox, all
tables in that group are selected for export.

3 Click on the Export button.

4 When prompted to do so, enter a valid file name
with a .XML extension.

5 Click on the Save and OK buttons.
This exports the data to the file; you can use any text
or XML viewer to examine the file.

Notes

You can resize the 'Export Reference Data' dialog; drag·

the dialog edges to the size you need

If there are no instances of a selected data type in the·

project, the export does not generate any output for that
data type in the XML file

Currently, Standard Complexity Types cannot be directly·

edited and are therefore effectively standard for all
models; they can be listed using the Predefined Reference
Data Tagged Value type ComplexityTypes
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Import Reference Data

It is possible to import reference data into your model from
an .XML file that was exported from another model or from
an iteration of the current model, either:

Manually, whenever you know there is new or changed·

data to apply, or

Automatically whenever the model is reloaded into·

Enterprise Architect (if the file has changed since the
previous import)

The automatic import checks if the source file has changed
since the last import; if the file has not changed, the import
does not proceed. If the file has changed, the changed data is
imported; however, you can configure the system to display
a prompt for you to allow or cancel the import.

Access

Ribbon Configure > Model > Transfer > Import
Reference Data > Import File
Configure > Model > Transfer > Import
Reference Data > Shared File
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Import reference data manually (Import File)

Ste
p

Action

1 On the 'Import Reference Data' dialog, click on the
'Import File' tab and on the Select File button, then
select the filename to import data from.
This would be an XML file produced by the
Enterprise Architect Data Exporter.

2 If you have selected a valid file, a list of available
tables to import displays in the 'Select Datasets to
Import' panel.

3 Click on one or more of the tables to import.
Press Ctrl or Shift to click on multiple tables.

4 Click on the Import button to start the process.
A message displays when the import is complete;
generally the process is quite fast.

Import reference data automatically (Shared
File)
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Ste
p

Action

1 On the 'Import Reference Data' dialog, click on the
'Shared File' tab.

2 If you are changing an existing configuration to
import from a different XML file, click on the Clear
button to clear the dialog fields.

3 Click on the Select File button and browse for the
filename to import data from.
This would be an XML file produced by the
Enterprise Architect Data Exporter.

4 If you have entered the name of a valid file, a list of
tables to import displays in the 'Datasets in File'
panel.
Click on one or more of the tables to import. Press
Ctrl or Shift as you click on multiple tables.

5 If you prefer to control whether or not the automatic
import takes place, select the 'Always prompt before
import' checkbox.

6 Click on the Import button to import the reference
data now, and to enable the automatic check and
import for subsequent reloads.
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Notes

Concerning General Types data:

For Statuses, Constraints, Requirements and Scenarios,·

the imported data is merged with the existing data; if a
record already exists it is updated to the new values, and if
the record does not exist, a new record is added - records
are never deleted

For Constraint Status Types, Difficulty, Test Status and·

Priority, the complete existing list is replaced by the
imported list

Concerning Calendar events and event types, Team Library
configurations, Patterns and Gap Matrix Profiles:

The imported data is merged with the existing data; if a·

record already exists it is updated to the new values, and if
the record does not exist, a new record is added - records
are never deleted

Concerning Images; for MS SQLServer Repositories:

Importing images as reference data into a SQLServer·

repository is not supported when connected via Cloud
Services

To import images as reference data you must have·

additional MS SQL Server permissions, so that you can
perform 'Set Identity On/Off' commands; the role of
db_ddladmin provides the required permissions; however,
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this approach might not be allowed in your environment,
so discuss this requirement with your DBA to find an
appropriate solution
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